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KATA PENGANTAR

Buku ini merupakan buku statistik terapan yang menyajikan
aplikasi dalam menguji instrumen penelitian, menentukan besarnya
sampel, mendeskripsikan data dan menganalisisnya serta menguji
hipotesis dengan menggunakan SPSS dan Excel. Sebagai buku statistik
terapan buku ini tidak menjelaskan bagaimana rumus-rumus statistik itu
disusun dan dihasilkan.

Kehadiran buku ini merupakan tanggung jawab akademik penulis
karena sejak tahun 2004 penulis mendapat amanat untuk menjadi Ketua
Analis Data Kuantitatif STAIN Kediri dan sejak tahun 2005 penulis juga
diminta mengampu Mata Kuliah Statistik Pendidikan pada Program
Pascasarjana IAIT Kediri. Oleh karena itu, tujuan sederhana dari buku ini
adalah untuk memenuhi kebutuhan sivitas akademika pada kedua
perguruan tinggi tersebut baik ketika mahasiswa atau dosen mengadakan
penelitian dengan pendekatan kuantitatif maupun Kketika dosen
memberikan bimbingan kepada mahasiswanya.

Buku ini hampir tidak dimungkinkan sampai kepada sidang
pembaca jika tidak ada peran dari berbagai pihak. Oleh karena itu penulis
mengucapkan terima kasih kepada teman-teman peserta Pelatihan
Metodologi Sosial Keagamaan kerjasama Direktorat Pendidikan Tinggi
Islam Depag RI dan Sekolah Pascasajana UGM pada tahun 2007 dan
2008 vyang memberikan dorongan agar penulis  secepatnya
merampungkan karya ini. Terima kasih yang sama juga penulis
sampaikan kepada mahasiswa Program Pascasarjana IAIT Kediri
angkatan 2007 dan 2008 yang senantiasa menagih terselesaikannya buku
ini.

Penghargaan yang tinggi juga penulis sampaikan kepada Dr.
Kharisudin Agib, M. Ag. Direktur Program Pascasarjana IAIT Kediri
periode 2003-2008 yang telah memberikan kepercayaan penulis untuk
mengampu Mata Kuliah Statistik Pendidikan. Penghargaan yang sama
juga penulis sampaikan kepada Prof. Dr. Faturahman, Guru Besar
Fakultas Psikologi UGM yang telah banyak memberi inspirasi kepada
penulis untuk menulis karya ini. Apresiasi serupa juga penulis sampaikan
kepada Prof. Fauzan Saleh, Ph. D., Guru Besar Jurusan Ushuluddin
STAIN Kediri, Prof. Dr. Irwan Abdullah, Guru Besar Fakultas Ilmu
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Budaya UGM dan Direktur Sekolah Pascasarjana UGM, dan Prof. Dr.
Abuddin Nata, MA. Guru Besar UIN Jakarta yang telah banyak
“memprovokasi” penulis untuk senantiasa berkarya. Melalui relasi yang
sedemikian bersahabat dan produktivitas akademik yang tinggi, ketiga
Guru Besar yang disebutkan terakhir senantiasa dapat dijadikan
modelling dalam kehidupan ini.

Melalui buku ini perkenankanlah penulis mengucapkan terima
kasih kepada Sahabat penulis yang telah berkenan memberikan cobaan
dan ujian terhadap perjalanakan akademik penulis. Penulis menduga
karena pemahaman beliau yang baik tentang al-Qur’an maka beliau
berusaha untuk menjadi Khalifatu ‘llah yang hendak mempraktikkan QS
al-Baqarah/2: 214, Ali ‘Imran/3: 142, dan al-‘Ankabiit/29: 2. Hal ini
beliau lakukan sejak proses penerimaan mutasi penulis dari IAIN Bandar
Lampung ke STAIN Kediri pada tahun 2003, ketika penulis mengajukan
kenaikan jabatan fungsional ke Lektor Kepala pada tahun 2006, ketika
proses penyelesaian studi penulis pada program doktor, dan terakhir
ketika penulis berusaha mencapai karir akademik tertinggi sebagai Guru
Besar. Hanya saja, ketiga cobaan pertama ternyata Allah dalam waktu
yang tepat memberi jalan keluar, sedangkan yang keempat, yaitu
kenaikan jabatan fungsional ke Guru Besar tampaknya untuk sementara
kehendak Sahabat penulis tersebut tidak bertentangan dengan kehendak
Allah. Tetapi penulis yakin, sebagaimana Allah janjikan dalam Siarat al-
Bagarah ayat 214 di atas bahwa pertolongan Allah amat dekat. Oleh
karena itu, semoga penulis dapat berhasil menghadapi cobaan ini dan
layak disebut sebagai orang yang beriman dan akhirnya mendapat surga
di akhirat kelak.

Tanpa pengertian istri tercinta, Aini Masykurun, dan ketiga anak-
anak tersayang, Muhammad Medina Almas Ali, Nayl al-Falahi, dan
Muhammad Fa’iq Ashfa, buku ini hampir tidak mungkin terselesaikan.
Oleh karena itu, buku ini kupersembahkan buah segenap keluarga
penulis, semoga hal ini menjadikan Allah memudahkan penulis
sekeluarga untuk menjadi orang-orang yang bermanfaat. Tidak hanya itu,
semoga kehadliran buku merupakan bukti syukur penulis sekeluarga
kepada Allah atas segala nikmat yang telah Allah karuniakan.

Dengan senang hati penulis akan menerima saran untuk perbaikan
dan kritik jika ada kesalahan. Semoga buku ini bermanfa’at dan kepada
semua pihak yang memungkinkan buku ini terselesaikan diberikan pahala
oleh Allah yang berlipat ganda dan hidup dan kehidupannya ke depan

menjadi lebih barokah dan manfaat, amin.
Kediri, 25 Maget 2009.

Ali Anwar
E-mail: ali_anwar03@yahoo.co.id
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BAB |
PENDAHULUAN

A. Latar Belakang

Selama ini mahasiswa sering merasa bahwa Statistik adalah
mata kuliah yang sulit dipahami dan dipraktikkan. Perasaan tersebut
tidaklah berlebihan. Hal ini sesuai dengan temuan Singgih Santoso,
“Jika orang mendengar kata statistik, maka asosiasi mereka adalah
tentang sesuatu yang ruwet, memusingkan, penuh dengan rumus-
rumus yang rumit, membosankan, dan sebagainya.”' Sebagai
akibatnya mahasiswa yang menulis skripsi dengan pendekatan
kuantitatif menemukan banyak kesulitan untuk menentukan analisis
statistik yang tepat dan mengaplikasikan analisis yang telah dipilih.

Dengan semakin meluasnya ketersediaan komputer pada
lembaga pendidikan akhir-akhir ini, metode pengajaran Statistik di
beberapa perguruan tinggi telah mengalami perubahan yang
dramatis.” Kusnandar selanjutnya mengatakan bahwa ketersediaan
perangkat keras dan lunak komputer telah memberikan banyak
kemudahan kepada peneliti dalam menganalisis hasil penelitian.® Bila
dahulu ada anggapan bahwa penelitian yang meneliti tiga variabel
atau lebih hanya dapat dilakukan oleh peneliti setingkat mahasiswa
S2 atau bahkan S3, dikarenakan sulitnya analisis multivariat,
sekarang itu hal tersebut dapat dilakukan oleh mahasiswa S1 atau
oleh peneliti pemula. Singgih Santoso menganggap bahwa

ISinggih Santoso, Statistik Diskriptif: Konsep dan Aplikasi dengan Microsoft
Excel dan SPSS, (Yogjakarta: Penerbit Andi, 2003), hlm. iii.

’Dadan Kusnandar, Metode Statistik dan Aplikasinya dengan Minitab dan Excel,
(Yogjakarta: Madyan Press, 2004), him. 7.

3Kusnandar, Metode Statistik dan Aplikasinya, him. v.
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perkembangan Software Statistik yang pesat membuat penggunaan
metode statistik Multivariat yang sangat komplek menjadi mudah dan
praktis.* Kalau terhadap statistik Multivariat saja menjadi mudah dan
praktis, apalagi bagi statistik univariat dan bivariat.

Kejadian ini, sejauh pengamatan penulis belum banyak terjadi
di berbagai perguruan tinggi di wilayah Kediri dan sekitarnya. Belum
dimanfaatkannya teknologi ini untuk analisis statistik boleh jadi
disebabkan sivitas akademika belum tahu dan masih meragukan
tentang berbagai efektivitas, kemudahan, dan validitas dari teknologi
itu atau lembaga tersebut belum memiliki hardware yang dibutuhkan
untuk aplikasi tersebut.

Berangkat dari latar belakang masalah di atas, maka penulis
melalui buku ini berusaha memberikan kesan mudah terhadap
statistik dengan memberikan contoh dan aplikasinya dengan SPSS
dan Microsoft Excel.

B. Manfaat Statistik dalam Penelitian Kuantitatif

Setidaknya ada 4 (empat) manfaat Statistik dalam penelitian
kuantitatif:

1. Untuk menghitung besarnya anggota sampel yang diambil dari
populasi, sehingga sampel dapat lebih representatif dan dapat
dipertanggungjawabkan.

2. Untuk menguji validitas dan reliabilitas instrumen.
Teknik-teknik untuk mendeskripsikan data sehingga data lebih
komunikatif; dan

4. Alat untuk analisis data.’

C. Macam-macam Statistik

Statistik dapat dibedakan menjadi dua, deskriptif dan
inferensial. Statistik Deskriptif adalah statistik yang digunakan untuk
menggambarkan data atau menganalisis suatu hasil penelitian tetapi
tidak digunakan untuk generalisasi. Sementara statistik inferensial
adalah statistik yang digunakan untuk menganalisis data sampel dan
hasilnya akan digeneralisasikan.

*Singgih Santoso, Buku Latihan SPSS Statistik Multivariat, (Jakarta: Elex Media
Komputindo, 2003), him. v.

® Sugiyono, Statistika untuk Penelitian, (Bandung: CV Alfabeta, 2003), him. 12.



Statistika untuk Penelitian Pendidikan

Statistik inferensial dapat dibedakan menjadi dua, parametrik
dan non-parametrik. Statistik parametrik terutama digunakan untuk
menganalisis data interval atau rasio yang diambil dari populasi yang
berdistribusi normal. Sedangkan statistik non-parametrik terutama
digunakan untuk menganalisis data nominal atau ordinal.® Atau
datanya interval atau rasio tetapi tidak berdistribusi normal juga
menggunakan statistik non-parametrik. Macam-macam statistik itu
dapat digambarkan seperti di bawah ini:

STATISTIK
[
| |
DESKRIPTIF INFERENSIAL
[
| |
PARAMETRIS NON-PARAMETRIS

Dikarenakan penentuan teknik analisis ditentukan juga oleh jenis
data, maka di bawah ini akan dijelaskan jenis data dan ciri-cirinya.

. Jenis Data

Data hasil penelitian dapat dikelompokkan menjadi dua:
kualitatif dan kuantitatif. Data kualitatif adalah data yang berbentuk
kalimat, kata, atau gambar. Sedangkan data kuantitatif adalah data
yang berbentuk angka, atau kualitatif yang diangkakan.’

Data kuantitatif dapat juga dikelompokkan menjadi dua: diskrit
dan kontinum. Data diskrit adalah data yang diperoleh dari
menghitung, bukan mengukur. Data ini sering disebut dengan data
nominal. Tidak hanya itu, data yang berjenis nominal juga data yang
diperoleh dengan cara kotegorisasi atau klasifikasi. Contoh: jenis
pekerjaan diklasifikasi sebagai berikut: pegawai negeri diberi tanda 1,
pegawai swasta diberi tanda 2, dan wiraswasta diberi tanda 3. Ciri
data nominal adalah setara, dalam kasus ini pegawai negeri tidak
lebih tinggi dibanding wiraswasta dan data tipe ini tidak dapat
dilakukan operasi matematika.

Sementara data kontinum dikelompokkan menjadi tiga, yaitu
ordinal, interval, dan rasio. Data ordinal adalah data yang berjenjang

® Sugiyono, Statistika untuk Penelitian, him 13-14.
7 Sugiyono, Statistika untuk Penelitian, him 14-15.
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dan berbentuk peringkat, atau dengan kata lain data ordinal adalah
data yang diperoleh dengan cara kategorisasi atau klasifikasi yang
berjenjang dan bertingkat. Contoh: kepuasan mahasiswa diklasifikasi
sebagai berikut: sangat puas diberi tanda 5, puas diberi tanda 4,
cukup puas diberi tanda 3, tidak puas diberi tanda 2, dan sangat tidak
puas diberi tanda 1. Ciri data ordinal adalah posisi data tidak setara
(berbentuk peringkat/berjenjang), tidak dapat dilakukan rumus
matematika, dan jarak antara dua titik tidak diketahui. Data ordinal
ini dapat dibentuk dari data interval atau rasio.

Sedangkan data interval adalah data yang jaraknya sama tetapi
tidak mempunyai nol absolut atau dengan kata lain bahwa data
interval adalah data yang diperoleh dengan cara pengukuran, di mana
jarak antara dua titik diketahui. Contoh: temperatur suatu ruangan:
celcius pada 0° ¢ sampai 100° C. Ciri tipe data interval: tidak ada
kategorisasi, bisa dilakukan rumus matematika, dan tidak ada nol
absolut.

Sementara data rasio adalah data yang jaraknya sama dan
mempunyai nol absolut atau dengan kata lain data rasio adalah data
yang diperoleh dengan pengukuran dan ada nol absolut. Contoh: hasil
pengukuran panjang atau berat. Ciri tipe data rasio, tidak ada
kategorisasi, dapat dilakukan rumus matematika, dan ada nol
absolut.®

Bermacam data seperti di atas dapat digambarkan seperti di
bawah ini:

MACAM DATA

KUALITATIF KUANTITATIF

DESKRIT KONTINUM

| |
ORDINAL | [INTERVAL RASIO

8 Sugiyono, Statistika untuk Penelitian, him 14-15.
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Contoh data dalam skala pengukuran nominal dan ordinal:

Skala I )
No Penguk. Data Kualitatif Kategori
1. Sunda 2. Jawa
Suku 3Madura 4. Lai
01 Nominal .Madura 4. Lainnya
Kepemilikan .
motor 1.ya 2. tidak
. 1.PT 2. SMA
Pendidikan
3. SMP 4.SD
1. Guru 2. Lektor
Ordinal Jabatan Dosen Besar Kepala
02 rdina 3 Lektor 4. Asisten
' Ahli
1A 2.B
Nilai Akhir
Mata Kuliah 3.C 4.D
5. E°
Contoh data dalam skala pengukuran interval dan rasio:
o Skala
Data Kuantitatif Pengukuran
Suhu (Celcius atau Fahrenheit) interval
penanggalan (Masehi atau Hijriah) interval
tinggi (meter) rasio
berat (kilogram) rasio
Umur (tahun atau hari) rasio™

. Uji Validitas dan Reliabilitas Instrumen

Secara umum, salah satu perbedaan antara skripsi, tesis, dan
disertasi dapat dilihat dari aspek metodologi penelitian. Penulis
skripsi dituntut untuk menyebutkan adanya upaya untuk memperoleh
data penelitian secara akurat dengan menggunakan instrumen
pengumpul data yang valid. Penulis tesis harus menyertakan bukti-
bukti yang dapat dijadikan pegangan untuk menyatakan bahwa

® Kusnandar, Metode Statistik dan Aplikasinya, him. 5.
Ok usnandar, Metode Statistik dan Aplikasinya, hlm. 6.
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instrumen pengumpul data yang digunakan cukup valid. Bagi penulis
disertasi, bukti-bukti validitas instrumen pengumpul data harus dapat
diterima sebagai bukti-bukti yang tepat.’ Dalam  skripsi,
penyimpangan-penyimpangan yang terjadi dalam pengumpulan data
tidak harus dikemukakan, sedangkan dalam tesis terlebih lagi dalam
disertasi, penyimpangan itu harus dikemukakan beserta alasan-
alasannya, sejauh mana penyimpangan tersebut, dan sejauh mana
penyimpangan tersebut dapat ditoleransi.*

1. Langkah-Langkah Penyusunan Instrumen

Penyusunan suatu instrumen biasanya dilakukan setelah
suatu konsep yang ingin diukur didefinisikan secara jelas.
Definisi tersebut sudah harus dapat disampaikan dalam wujud
pertanyaan atau pernyataan. Dalam bahasa metodologi definisi
yang dimaksudkan sudah harus operasional. Cara untuk
mengoperasionalkan definisi, menurut Ancok, paling sedikit ada
tiga cara yaitu:

a. Mencari definisi-definisi tentang konsep yang telah ditulis di
dalam literatur oleh para ahli. Kalau sekiranya sudah ada
definisi yang cukup operasional untuk ditumpahkan ke dalam
suatu instrumen, definisi tersebut dapat langsung digunakan.
Tetapi bila definisi yang dikemukakan oleh para ahli belum
begitu operasional, maka peneliti harus menjabarkan definisi
tersebut seoperasional mungkin. Dengan demikian akan lebih
mudahlah kita menyusun pertanyaan.

b. Kalau sekiranya di dalam literatur tidak diperoleh definisi
konsep yang ingin diukur, maka peneliti harus
mendefinisikan sendiri dengan menggunakan pemikirannya
sendiri. Untuk lebih memantapkan definisi operasional yang
dibuat, sebaiknya peneliti mendiskusikan definisi tersebut
dengan ahli-ahli lain. Setelah definisi yang dibuat cukup
mantap, barulah definisi tersebut diwujudkan dalan bentuk
pertanyaan yang akan menjadi komponen instrumen yang
akan dibuat. Cara yang kedua ini dapat dilakukan dengan
cara kebalikan dengan cara yang di atas. Kita tidak memulai
dari menyusun definisi sendiri, tetapi peneliti mengumpulkan
lebih dahulu bagaimana pendapat para ahli lewat diskusi.

YAli Saukah dkk., Pedoman Penulisan Karya llmiah, (Malang: Universitas Negeri
Malang (UM), 2000), him. 3.

2Ali Saukah dkk., Pedoman Penulisan Karya llmiah, him. 3.
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Setelah cukup banyak kesamaan pendapat di kalangan para
ahli terhadap definisi suatu konsep, kemudian disusun
definisi operasional konsep yang bersangkutan.

c. Dengan menanyakan langsung kepada para responden.
Berdasarkan aspek-aspek yang dijelaskan responden tersebut
disusun pertanyaan Yyang akan menjadi komponen
instrumen.*®

Pendapat Ancok di atas dapat disederhanakan sebagai
berikut.

a. Seluruh variabel, yang dalam istilah Ancok disebut konsep,
yang terdapat dalam judul penelitian dijabarkan menjadi sub
variabel.

b. Menentukan indikator dari setiap sub variabel.

c. Menjabarkan masing-masing indikator menjadi beberapa
deskriptor.

d. Merumuskan setiap deskriptor menjadi butir-butir pertanyaan
atau pernyataan.

Agar setiap butir instrumen memenuhi validitas internal
dan eksternal, maka penyusunan instrumen tersebut harus
mengacu dan berdasarkan pada teori dan fakta empiris. Masing-
masing butir instrumen harus diteliti satu persatu untuk melihat
apakah pertanyaan atau pernyataan tersebut sudah memenubhi
persyaratan dalam penulisannya.

Di dalam menulis pertanyaan atau pernyataan, menurut
Ancok, hal-hal berikut ini perlu diperhatikan:

a. Hindari pertanyaan atau pernyataan yang dapat menimbulkan
lebih dari satu pengertian.

b. Hindari pertanyaan atau pernyataan yang tidak relevan
dengan dimensi konsep yang akan diukur.

c. Hindari pertanyaan atau pernyataan yang diperkirakan orang
akan setuju atau tidak setuju.

d. Gunakan bahasa yang mudah dimengerti, jelas, dan singkat.

¥Djamaludin Ancok, Teknik Penyusunan Skala Pengukur, (Yogjakarta: Pusat Studi
Kependudukan dan Kebijakan Universitas Gadjah Mada, 2002), him. 8-9.
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2.

e. Setiap pertanyaan atau pernyataan harus berisikan satu hal
saja. Hindarkan pertanyaan atau pernyataan yang
mengandung dua atau lebih permasalahan.**

Langkah-langkah tersebut perlu dilakukan agar responden
mendapatkan kemudahan untuk mengisi instrumen yang
diajukan.

Prosedur Uji Validitas dan Reliabilitas Instrumen

Setelah instrumen selesai disusun dan diaudit oleh tenaga
ahli, selanjutnya diujicobakan kepada sebagian responden yang
menjadi sampel penelitian tersebut yang jumlahnya paling sedikit
30 orang. Jumlah responden yang lebih dari 30 orang biasanya
cukup memadai untuk taraf uji-coba. Hal ini disebabkan
distribusi skor akan mendekati distribusi normal.

Hasil uji-coba ini kemudian akan digunakan untuk
mengetahui sejauh mana instrumen yang telah disusun memiliki
validitas dan reliabilitas. Suatu instrumen yang baik harus
memiliki validitas dan reliabilitas.

Validitas ialah indeks yang menunjukkan sejauh mana
suatu instrumen betul-betul mengukur apa yang perlu diukur.
Timbangan hanya valid untuk mengukur berat, tidak valid untuk
mengukur panjang. Sebaliknya meteran hanya valid bila
digunakan untuk mengukur panjang.

Selama ini uji validitas dilakukan dengan menggunakan
korelasi antara skor item dan Skor Total (ltem-Total
Correlation). Korelasi antara skor item dengan skor total
haruslah signifikan berdasarkan ukuran statistik tertentu. Bila
sekiranya skor semua pertanyaan atau pernyataan yang disusun
berdasarkan dimensi konsep berkorelasi dengan skor total, maka
dapat dikatakan bahwa instrumen tersebut mempunyai validitas.

Validitas yang seperti ini, menurut Ancok, disebut dengan
validitas konstruk (construct validity)."® Bila instrumen telah
memiliki validitas konstruk berarti semua item yang ada di dalam
instrumen itu mengukur konsep yang ingin diukur.

Bila instrumen yang disusun hanya memiliki jumlah item
yang sedikit (kurang dari 30 item), maka harus dilakukan koreksi

4 Ancok, Teknik Penyusunan, him. 18.
15 Ancok, Teknik Penyusunan, him. 21.
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terhadap angka korelasi yang diperoleh karena angka korelasi
tersebut kelebihan bobot. Kelebihan bobot itu terjadi karena skor
item yang dikorelasikan dengan skor total ikut sebagai komponen
skor total, dan hal ini menyebabkan angka korelasi terjadi lebih
besar. Dengan semakin banyak jumlah item, pengaruh skor item
terhadap membesarnya angka korelasi dengan skor total akan
semakin kecil.

Sedangkan rumus untuk mengoreksi koefisien korelasi
skor item dengan skor total adalah berikut ini.

pa= (r-tp)(SDy) - (SDx)
J(SDy)? + (SDx)? - 2(r.tp) (SDX)(SDy)

Keterangan:

r.pq = angka korelasi setelah dikoreksi

r.tp = angka korelasi sebelum dikoreksi

SDy = standard deviasi skor total
SDx = standar deviasi item

Sebagaimana dijelaskan di atas, bahwa uji validitas
konstruk dilakukan dengan menggunakan korelasi antara skor
item dan skor total yang dicari dengan rumus Pearson Product
Moment.*®

Contoh:

Peneliti sedang mengadakan penelitian tentang
Pengaruh Kompetensi Guru terhadap Prestasi belajar Siswa.
Peneliti menjabarkan variabel Kompetensi Guru ke dalam 4
(empat) sub variabel, vyaitu kompetensi paedagogik,
kompetensi profesional, kompetensi sosial, dan kompetensi
kepribadian. Instrumen yang digunakan untuk
mengumpulkan data tentang variabel kompetensi guru
adalah angket sedangkan prestasi belajar siswa dikumpulkan
datanya dengan menggunakan dokumentasi. Masing-masing
sub variabel dari variabel kompetensi guru dijabarkan
dengan panduan teori dan fakta di lapangan. Misalkan, item-
item pertanyaan yang dijabarkan dari sub variabel
kompetensi paedagogik berjumlah 30. Sedangkan jumlah
item untuk sub variabel lainnya menyesuaikan.

115.

18 prosedur analisis Person Product Moment dapat dibaca pada Bab IV, him. 104-
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tersebut diujicobakan kepada 30 orang calon

10

Setelah instrumen yang berupa angket selesai disusun dan
dimintakan persetujuan kepada tenaga ahli, maka instrumen

Sedangkan data yang didapatkan dari
paedagogik adalah sebagai berikut.
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Data di atas kemudian dicari koefisien korelasinya, yaitu

korelasi skor item dengan skor total. Salah satu cara untuk
mencari koefisien korelasi antara skor item dengan skor total
adalah menggunakan Data Analysis yang aplikasinya sebagai
berikut:

a.

Setelah datanya diinput, dijumlahkan dan diberi label seperti
contoh di atas, klik Tools pada worksheet Microsoft Excel,
lalu seret ke Data Analysis sebagai berikut.

Ed Microsoft Excel - uji validitas

Ele Edt iew Insert Format | Tooks | Data  Window He

O = [& % B~ <y Options. .. >
AGAD - A | Diata Analysis... |

5 L

[ Jalslclp]E|F]|G]| brrrorerore

Setelah itu pilihlah Correlation, dengan cara klik'dua kali
atau klik Ok.

Data Analysis E| E|

Analysis Tools

=
Anova: Single Fackar -

Anowar Two-Fackor With Replication Cancel
Anova: Two-Factor Without Replication

Covariance Help

Descriptive Statistics
Exponential Smoaothing
F-Test Two-Sample for Yariances

Fourier Analysis
Histagram j

Setelah keluar gambar seperti berikut ini, klik pada kolom
yang ada di depan Input Range, lalu bloklah seluruh data
yang sudah diinput. Aktifkan Label in First Row. Karena
outputnya juga banyak, maka pilihlah New Worksheet Ply
untuk Output options.

Correlation
Input
Ok
Input Range: $a41: 44431 B -
Cancel
Grouped By: * Columns 4
" Rows Help

Output options

" output Range: S
* Mew Workshest Ply:

™ MNew Workbook

d. Berikut ini adalah output aplikasi di atas. Karena jumlah item

pertanyaan untuk sub variabel kompetensi paedagogik ini
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berjumlah 30, maka tidak diperlukan aplikasi rumus untuk

mengoreksi koefisien korelasi tersebut.
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yaitu item dan total. Manakala ryiyng > rape mMaka item
dikatakan valid, akan tetapi kalau rhjung < rane maka item
tersebut disimpulkan tidak valid. Berdasarkan r tabel untuk
dk 28 dan taraf nyata (o): 0,05, didapatkan skornya riper:

0.05:26=0,374, maka seluruh item adalah valid.

Selanjutnya akan dibicarakan mengenai uji reliabilitas.
Reliabilitas adalah indeks yang menunjukkan sejauh mana suatu
alat pengukur dapat dipercaya atau dapat diandalkan. Reliabilitas
menunjukkan sejauh mana hasil pengukuran tetap konsisten bila
dilakukan pengukuran dua kali atau lebih terhadap gejala yang
sama, dengan instrumen yang sama.

Seharusnya setiap instrumen memiliki kemampuan untuk
menghasilkan pengukuran yang konsisten. Pada instrumen yang
dibuat untuk mengukur fenomena fisik seperti berat atau panjang
suatu benda, konsistensi hasil pengukuran bukanlah suatu hal
yang sulit untuk diperoleh. Tetapi untuk pengukuran gejala non-
fisik seperti sikap, opini, dan persepsi tentang perilaku, bukanlah
hal yang mudah. Dalam pengukuran gejala sosial boleh dikatakan
hampir tidak pernah terjadi hasil pengukuran ulang yang persis
sama dengan hasil pengukuran sebelumnya.

Setidaknya ada 4 (empat) teknik untuk menguji reliabilitas
instrumen, yaitu test-retest, belah dua, paralel, dan konsistensi
internal.

Test-retest dilakukan dengan cara instrumen diujicobakan
sebanyak dua kali. Interval waktu antara ujicoba pertama dan
kedua sebaiknya sekitar 15 sampai dengan 30 hari. Apabila
interval waktu terlalu pendek dikhawatirkan responden masih
ingat terhadap jawaban yang pertama, sehingga responden
cenderung hanya mengulangi jawaban pertama, tetapi kalau lebih
lama dikhawatirkan sudah terjadi perubahan pada diri responden
terkait dengan sesuatu yang diteliti.

Sebagai contoh: instrumen yang telah diujicobakan di atas,
yang telah dianalisis validitasnya, diujicobakan untuk kedua
kalinya. Setelah instrumen diisi responden dan diberi skor, maka
data dari ujicoba yang kedua tersebut dapat ditabulasikan. Untuk
mengetahui reliabilitas instrumen tersebut, maka dikorelasikan
antara skor total ujicoba pertama dan skor total ujicoba kedua.

Sedangkan data hasil ujicoba kedua ditabulasikan berikut
ini..
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Berdasarkan hasil analisis tersebut diketahui bahwa
MiungNya Sebesar 0,988. Manakala rhiwng > Fape Maka item
dikatakan reliabel, akan tetapi kalau rpjung < raper Maka item
tersebut disimpulkan tidak reliabel. Berdasarkan r tabel untuk dk
28 dan taraf nyata (a): 0,05, didapatkan skornya rpe: 0.05:26=0,374,

maka instrumen tersebut reliabel atau handal.

Sedangkan teknik kedua adalah belah dua. Bila kita ingin
menggunakan teknik belah dua sebagai cara untuk menghitung
reliabilitas instrumen, instrumen yang disusun, menurut Ancok,
harus memiliki cukup banyak item. Jumlah item sekitar 50-60
adalah jumlah yang cukup memadai. Makin besar jumlah item
reliabilitas yang diperoleh akan makin bertambah baik.*’

Langkah yang perlu dilakukan adalah sebagai berikut:

a. Menyajikan instrumen kepada sejumlah  responden,
kemudian dihitung validitas itemnya. Item-item yang valid
dikumpulkan menjadi satu, yang tidak valid dibuang.

b. Membagi item-item yang valid tersebut menjadi dua belahan.
Untuk membelah instrumen menjadi dua dilakukan dengan
dengan cara: pertama, membagi item dengan acak (random).
Separuh masuk belahan pertama yang separuh lagi masuk
belahan kedua; kedua, membagi item berdasarkan nomor
genap-ganjil. Item yang bernomor genap dikelompokkan
sebagai belahan pertama, sedangkan yang bernomor ganjil
dikelompokkan sebagai belahan kedua.

c. Skor masing-masing item pada tiap belahan dijumlahkan.
Langkah ini akan menghasilkan dua skor total untuk masing-
masing responden, yakni skor total belahan pertama dan skor
total belahan kedua.

d. Mengkorelasikan skor total belahan pertama dengan skor
total belahan kedua dengan menggunakan teknik korelasi
Pearson Product Moment.

e. Selanjutnya skor koefisien korelasi product moment tersebut
dimasukkan dalam rumus berikut:

2r.tt

r.tot =angka reliabilitas keseluruhan item

7 Ancok, Teknik Penyusunan, him. 31-32.
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rit =angka korelasi belahan pertama dan belahan kedua

Misalkan didapatkan angka korelasi belahan pertama dan
belahan kedua sebesar 0,69. Selanjutnya angka korelasi
tersebut dimasukkan ke dalam rumus di atas, hasilnya adalah:

2x0,69
1+0,69

Selanjutnya angka korelasi tersebut dibandingkan dengan
lranel UNtuk derajat kebebasan % jumlah item dikurangi 2.
Seandainya item yang dibelah semula berjumlah 50, maka
derajat kebebasannya ada pada 23. Pada dk 23 dan taraf nyata
(o) 5% dari didapati Fper. 0,03:23: 0,413. Karena riwng > fael,
maka disimpulkan kalau instrumen tersebut reliabel.

0,82 =

Teknik yang ketiga adalah paralel, yang sering juga
disebut teknik ekuivalen. Pada teknik ini, penghitungan
reliabilitas dilakukan dengan membuat dua jenis instrumen
dengan redaksi yang berbeda tetapi mengukur aspek yang sama.
Kedua instrumen tersebut diberikan kepada responden yang
sama, kemudian dicari validitasnya untuk masing-masing jenis.

Untuk menghitung reliabilitas perlu mengkorelasikan skor
total dari kedua jenis instrumen tersebut. Teknik korelasi yang
dipakai ialah teknik korelasi product moment yang rumus serta
penghitungannya telah dibahas sebelumnya.

Sedangkan teknik yang keempat adalah teknik uji
konsistensi internal. Di antara beberapa uji konsistensi internal,
Alpha Cronbach adalah yang paling sering digunakan. Oleh
karena itu, pada kesempatan ini akan dicontohkan aplikasi teknik
ini baik menggunakan SPSS maupun Micrososft Excel.

Untuk aplikasi SPSS ini sekaligus dapat digunakan untuk
menguji validitas data, di samping menguji reliabilitasnya.
Sedangkan prosedurnya adalah sebagai berikut.

a. Setelah data diinput, untuk contoh ini digunakan data yang
telah diuji validitasnya di atas, lalu klik Analyze » Scale »
Reliability Analysis..., sebagaimana gambar berikut ini.
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uji validitas - SPS5 Data Editor

File Edit View Data Transform Graphs  Ukiities ‘Window Help
~u Reports 3
EE| =]s
Elﬂ ﬂ il_l J Descriptive Statistics 3 LIEI @@
1:jml 1 Tables r
Compatre Means 4 ]
[ | 3]xafos e [ba2]xas]xia]as]xe] a7 as] as)
1 5 4] 5] 3] 4 Mized Models > 2
21 40 3| 3 4 3 carelate > 4 5 4| &5 4 3 5] 4
3| 5 4| 4 5| 4 Regression 3 41 4| 5 4 A 4] 3| &
41 3| 3 & 3| A Loginear 3 al 4, 3 4 3| & 3 3
sl 4 3| 3 4 3 Classify 4 308 4 8 4 3 4 4
5| 5/ 4| 4| 3 4 DataReduction 3 1 4 £l 9 F 1 I
71 3 2 3 4 2 3 telic A
Al 5 4 5 4 5 Monparametric Tests 3 Multidimensional Scaling. ..
Time Seties 3 Multidimensional Scaling (PROXSCAL)...
sl 3 20 20 30 A O .

b. Setelah keluar gambar seperti berikut ini, destinasikan

C.

seluruh skor ke Item, dan Model masih dibiarkan Alpha,
lalu klik Statistics.

B Reliability Analysis X

oK
Paszte
Beset
Cancel

Help

ElifEle[x

Model: Alpha -

[ List item labels Statistics...

Setelah keluar gambar seperti berikut ini, aktifkan Item,
Scale, dan Scale if item deleted, lalu klik Continue, lalu
klik Ok.

Reliability Analysis: Statistics

Descriptives for Inter-ltem
v Item r—
ancel
¥ Scale ™ Covarances 4
¥ Scale if itern deleted Help
Summaries ANOWVA T able
[ Means * Mone
™ Yarances " F test
™ Covarances " Friedman chi-sguare
™ Comrelations " Cochran chi-square
™ Hotelling's T-square ™ Tukey's test of additivity
I Intraclass corelation coefficient
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d. Berikut ini adalah output analisis Alpha Cronbach.

RELIABILITY ANALYSIS - SCALE (ALPHA)

1. X1

2. X2

3. X3

4. X4

5. X5

6. X6

7. X7

8. X8

9. X9

10. X10
11, X11
12. X12
13.  X13
14. X114
15, X15
16. X16
17.  X17
18. X18
19. X19
20. X20
21, X21
22, X22
23.  X23
24, X24
25. X25
26. X26
27.  X27
28. X28
29. X29
30. X30

Statistics for Mean

Mean

3,6333
2,9333
3,3667
3,4333
3,1333
3,7000
3,6000
3,2333
3,2333
3,8000
3,7000
3,4667
3,7667
3,4333
3,7667
3,5667
2,9333
3,7000
3,4333
2,9333
3,6000
2,9000
3,3333
3,6667
3,0667
3,7667
3,6000
3,1000
3,2333
3,7333

SCALE 102,7667

Std Dev Cases
1,0981 30,0
,7849 30,0
,9643 30,0
,8584 30,0
,9732 30,0
,9154 30,0
,9322 30,0
1,0063 30,0
1,0726 30,0
,9248 30,0
,9879 30,0
1,0417 30,0
,9353 30,0
,9714 30,0
,9353 30,0
1,0063 30,0
,8683 30,0
,9523 30,0
1,0400 30,0
,8683 30,0
1,0372 30,0
,7589 30,0
,9223 30,0
,9223 30,0
,8683 30,0
,9714 30,0
,9322 30,0
,9948 30,0
1,0400 30,0
1,0148 30,0
Variance Std Dev
298,8747 17,2880

N of

18

Variables

30

Output pertama ini menunjukkan tentang rata-rata skor
per-item, dan standard deviasinya.

RELIABILITY ANALYSIS - SCALE (ALPHA)

Item-total Statistics
Scale
Mean
if Item
Deleted
X1 99,1333
X2 99,8333
X3 99,4000

Scale
Variance
if Item
Deleted
272,6023
276,6954
285,1448

Corrected

Item-
Total

Correlation

,6913
,8258
,3930

Alpha

if Item
Deleted
,9360
,9353
,9394
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X4 99,3333 287,4713 ,3665 ,9395

X5 99,6333 276,0333 ,6770 ,9363
X6 99,0667 285,6506 ,4003 ,9392
X7 99,1667 274,6954 ,7544 ,9355
X8 99,5333 279,3609 ,5500 ,9377
X9 99,5333 276,6023 ,5920 ,9373
X10 98,9667 284,7920 ,4238 ,9390
X11 99,0667 274,3402 ,7199 ,9358
X12 99,3000 279,1138 ,5366 ,9379
X13 99,0000 283,7931 ,4509 ,9387
X14 99,3333 282,0920 ,4854 ,9384
X15 99,0000 284,6207 ,4240 ,9390
X16 99,2000 278,3034 ,5825 ,9373
X17 99,8333 284,6264 ,4606 ,9386
X18 99,0667 285,3747 ,3914 ,9394
X19 99,3333 280,2989 ,5024 ,9383
X20 99,8333 280,0747 ,6209 ,9370
X21 99,1667 274,1437 ,6887 ,9361
X22 99,8667 276,5333 ,8624 ,9351
X23 99,4333 284,9437 ,4201 ,9390
X24 99,1000 276,1621 ,7132 ,9360
X25 99,7000 279,3897 ,6453 ,9368
X26 99,0000 283,5172 ,4406 ,9389
X27 99,1667 274,1437 ,7730 ,9353
X28 99,6667 275,5402 ,6766 ,9363
X29 99,5333 277,9126 ,5733 ,9375
X30 99,0333 281,9644 ,4660 ,9387
Reliability Coefficients

N of Cases = 30,0 N of Items = 30

Alpha = ,9395

Output kedua ini menunjukkan tentang rata-rata skor
jumlah seluruh item apabila jumlah item yang ada pada baris
tersebut dihapus. Sebagai contoh, bahwa skor 99,1333 yang ada
pada baris X1 adalah hasil dari jumlah seluruh skor (3083)
dikurangi dengan jumlah skor dari X1 (109) dibagi 30. Pada
kolom ketiga menampilkan varians dari skor seluruh item apabila
jumlah salah satu item dihilangkan. Sedangkan kolom keempat
adalah koefisien korelasi antara item dan skor total yang telah
diberikan koreksi dengan rumus.
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.pq = (r.tp)(SDy) - (SDx)
J(SDy)” +(SDx)? - 2(1.tp)(SDX)(SDy)
Keterangan:
r.pq = angka korelasi setelah dikoreksi
r.tp = angka korelasi sebelum dikoreksi
SDy = standard deviasi skor total
SDx = standar deviasi item

Skor pada kolom keempat (Corrected item-total corralation)
digunakan untuk menguji validitas instrumen. Sebagaimana
sudah dijelaskan di atas bahwa pengambilan keputusan untuk
menentukan item yang valid digunakan ryyng dibandingkan
dengan rype dengan dk jumlah sampel dikurangi variabel, yang
dalam hal ini pasti 2 (dua), yaitu item dan total. Manakala ryjyng >
laper Maka item dikatakan valid, akan tetapi kalau rhiwng < Ttapel
maka item tersebut disimpulkan tidak valid. Berdasarkan r tabel
untuk dk 28 dan taraf nyata (o): 0,05, didapatkan skornya repe:
0.05:28=0,374, maka seluruh item adalah valid kecuali item nomor
4. Hanya saja karena jumlah item instrumen berjumlah 30, maka
semestinya tidak diperlukan adanya aplikasi koreksi dengan
rumus di atas. Padahal skor koefisien korelasi antara item 4
dengan skor jumlah sebelum koreksi adalah 0,4091 yang berarti
juga lebih tinggi dibanding 0,374.

Sedangkan kolom kelima adalah skor koefisien alpha
apabila skor itemnya dihapus. Apabila masing-masing skor
koefisien alpha dibandingkan dengan riper: 0,05:26=0,374, maka
seluruh item adalah reliabel. Kesimpulan dikuatkan dengan
koefisien alpha secara keseluruhan sebesar 0,9394 yang lebih
besar dibanding riper: 00s:26=0,374, maka seluruh item adalah
reliabel.

Sedangkan prosedur menguji Alpha Cronbach dengan
Microsoft Excel adalah sebagai berikut:

a. Setelah data diinput, lalu dihitung jumlah skor item yang
diperoleh dari masing-masing responden.

b. Menghitung kuadrat jumlah skor item yang diperoleh dari
masing-masing responden.

c. Menghitung varians masing-masing item.

d. Mengaplikasikan rumus Alpha Cronbach, seperti di bawah
ini.
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rl= [kk—l}{l_ Z:;?z }

di mana
5y (E
o2 = N
N

Keterangan
ril = Reliabilitas instrumen
k = Banyaknya item instrumen
Yo’ = Jumlah varians item
o = Varians total
N = Jumlah responden.

Sedangkan aplikasi penjelasan di atas dapat dilihat
pada aplikasi Microsoft Excel berikut ini.

& | AE [  aF AG AH Al

1 | = |iml

2[5 | m 10201

33 [ 1,17] %5

M

35 | 25] 288,9122 Farmula £33 =(RBE- (A2 DEOIZ0
36 | 16| 0,9395 Formula AE33  |=SUM{A33:AD32)
37 | 23] Formula AP35 |=(AF32-((AEE2"2)30130
35 9] Formula AF36  |=(30i29)"(1-(RE33AFI5))
65 | 43111431

66

Hasil analisis dengan Microsoft excel juga menghasilkan
skor koefisien alpha yang sama dengan hasil penghitungan
SPSS yaitu 0,9395.

F. Pedoman Umum Memilih Teknik Statistik

Terdapat bermacam-macam teknik statistik yang dapat
digunakan menguji hipotesis. Teknik statistik mana yang akan
digunakan tergantung pada interaksi tiga hal: macam data, terpenuhi
tidaknya asumsi, dan bentuk hipotesisnya. Sedangkan prosedur
penentuan teknik analisis tersebut dapat dilihat pada bagan berikut
ini.



Pendabulnan

BAGAN
PROSEDUR PENENTUAN TEKNIK ANALISIS

l | NOMINAL/ORDINAL |
TIPE DATA

INTERVAL/RASIO l

DISTRIBUSI DATA

STATISTIK NON
PARAMETRIK

A
NORMAL
A

JUMLAH DATA

KECIL (<30)

BESAR (>30)
\4
STATISTIK
PARAMETRIK

22

Berdasarkan bagan di atas dapat dipahami bahwa data
penelitian yang akan dianalisis dengan menggunakan analisis
parametrik disyaratkan bertipe interval atau rasio, distribusi datanya
normal, dan jumlah sampelnya 30 atau lebih. Data penelitian yang
bertipe nominal atau ordinal, teknik analisis yang dapat digunakan
adalah analisis non-parametrik. Data interval atau rasio yang tidak
berdistriusi normal juga menggunakan analisis non-parametrik.
Demikian juga data interval atau rasio yang berdistribusi normal
tetapi jumlah sampelnya kurang dari 30 juga menggunakan analisis

non-parametrik.

Secara singkat dapat dilihat pada tabel di bawah ini:

BENTUK HIPOTESIS
MACAM | Deskriptif ; Komparatif (Lebih dari -,
DATA (Satu Komparatif (Dua Sampel) dua sampel) @ma%)
Variabel) | Related Independen | Related | Independen 9
Binomial Mc Fisher Exact 2 for k 2 Contingency
NOMINAL Nemar Probability Sample w fork Coefficient
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x? One Sample
Sample x* Two Cochran
Sample Q
Median Test
Mann- Median
Sign Test Whitney U Extention Spearman
Test Friedman Rank
ORDINAL | RunTest | Wilcoxon Two-way | Kruskal- Correlation
Matched | Kolmogorov- Anova Wallis One
Pairs Smirnov Way Kendall Tau
Anova
Wald-
Woldfowitz
Pearson
Product
One-way | One-way Moment
INTERVAL T-test of T-test of Anova Anova :
RASIO ttest Related independent c OF;f élt;il on
Two-way Two-way
Anova Anova Multiple
Correlation

Buku ini akan menjelaskan secara keseluruhan teknik statistik
di atas dengan menggunakan aplikasi SPSS maupun Microsoft Excel.

G. Populasi dan Sampel

Istilah populasi dan sampel tepat digunakan jika penelitian
yang dilakukan mengambil sampel sebagai subjek penelitian. Akan
tetapi jika sasaran penelitiannya adalah seluruh anggota populasi,
akan lebih cocok digunakan istilah subyek penelitian, terutama dalam
penelitian eksperimental. Dalam survai, sumber data lazim disebut
responden’® dan dalam penelitian kualitatif disebut informan™® atau

subyek tergantung pada cara pengambilan datanya.

1. Pengertian Populasi dan Sampel

Populasi, menurut Nazir, adalah “kumpulan dari individu

dengan kualitas dan ciri-ciri yang ditetapkan.”” Sedangkan
Surakhmad kelihatannya mendefinisikan populasi
sekelompok subyek, baik manusia, gejala, nilai test, benda-

sebagai

®Responden adalah seseorang yang merespons pertanyaan atau pernyataan dari
peneliti terkait dengan keadaan diri responden sendiri.

YInforman adalah seseorang yang dapat memberikan informasi tentang keadaan
yang terkait dengan dirinya sendiri dan juga keadaan orang atau hal lain.

Moh. Nazir, Metode Penelitian, (Bogor: Ghalia Indonesia, 2005), him. 271.
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benda, atau peristiwa yang diberlakukan generalisasi dari sebuah
penelitian.? Senada dengan definisi Surakhmad, Fraenkel dan
Wallen, sebagaimana dikutip Riyanto, juga mendefinisikan
populasi sebagai “kelompok yang menarik peneliti, di mana
kelompok tersebut oleh peneliti dijadikan sebagai obyek untuk
menggeneralisasikan hasil penelitian.”? Sedangkan Sugiyono
mendefinisikan populasi dengan “wilayah generalisasi yang
terdiri atas obyek/subyek yang mempunyai kualitas dan
karakteristik tertentu yang ditetapkan oleh peneliti untuk
dipelajari dan kemudian ditarik kesimpulannya.”?

Berangkat dari empat definisi di atas, setidaknya ada tiga
hal yang perlu diperhatian terkait populasi. Pertama, populasi
menjadi wilayah generalisasi dari kesimpulan analisis data
sampel; kedua, jumlah populasi, dan ketiga, karakteristik dari
populasi.

Sedangkan sampel, menurut Nazir, adalah “bagian dari
populasi.”®* Surakhmad memberi batasan sampel dengan “bagian
dari populasi yang dipandang representatif terhadap populasi.”®
Sedangkan Riyanto menganggap bahwa sampel adalah
”sembarang himpunan yang merupakan bagian dari suatu
populasi.”® Sedangkan Sugiyono membatasi sampel dengan
”bagian dari jumlah dan karakteristik yang dimiliki oleh populasi
tersebut.” %/

Penulis berpendapat bahwa sampel tidak hanya bagian dari
populasi, tetapi yang terpenting sampel harus mencerminkan
karakteristik dari populasi. Oleh karena itu, penjelasan yang
akurat tentang karakteristik populasi penelitian perlu diberikan
agar besarnya sampel dan cara pengambilannya dapat ditentukan
secara tepat. Tujuannya adalah agar sampel yang dipilih benar-

ZWinarno Surakhmad, Pengantar Penelitian lImiah: dasar, Metode, dan Teknik,
(Bandung: Tarsito, 1990), him. 93.

2yatim Riyanto, Metodologi Penelitian Pendidikan, (Surabaya: SIC, 2001), him.
63.

23y giyono, Statistika untuk Penelitian, him. 72.

24 Nazir, Metode Penelitian, him. 271.

% surakhmad, Pengantar Penelitian Ilmiah, him. 93.
% Riyanto, Metodologi Penelitian Pendidikan, him. 63.
Z'sygiyono, Statistika untuk Penelitian, him. 73.
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benar representatif, dalam arti dapat mencerminkan keadaan
populasinya secara cermat. Kerepresentatifan sampel merupakan
kriteria terpenting dalam pemilihan sampel dalam kaitannya
dengan maksud menggeneralisasikan hasil-hasil penelitian
sampel terhadap populasinya. Jika keadaan sampel semakin
berbeda dengan karakteristik populasinya, maka semakin besar
kemungkinan kekeliruan dalam generalisasinya.

Jadi, hal-hal yang dibahas dalam bagian Populasi dan
Sampel adalah (a) identifikasi dan batasan-batasan tentang
populasi atau subyek penelitian, (b) besarnya sampel; serta (c)
prosedur dan teknik pengambilan sampel.

Teknik Penentuan Besarnya Sampel

Selama ini banyak mahasiswa S1 ketika memaparkan
tentang sub bab populasi dan sampel hanya menjelaskan tentang
jumlah populasi tanpa menjelaskan karakteristiknya. Sedangkan
ketika menentukan besarnya sampel mahasiswa sering mengutip
pendapat Suharsimi Arikunto berikut ini.

Untuk sekedar ancer-ancer maka apabila subjeknya
kurang dari 100, lebih baik diambil semua sehingga
penelitiannya merupakan penelitian populasi.
Selanjutnya, jika jumlah subjeknya besar dapat diambil
antara 10-15% atau 20-25% atau lebih, tergantung
setidaknya setidak-tidaknya:

a. Kemampuan peneliti dilihat dari waktu, tenaga, dan
dana.

b. Sempit luasnya wilayah pengamatan dari setiap
subjek, karena hal ini menyangkut banyak sedikitnya
data.

c. Besar kecilnya resiko yang ditanggung peneliti.
Untuk penelitian yang resikonya besar, tentu saja jika
sampel besar, hasilnya akan lebih baik. (Sic!)®

Ketentuan di atas semestinya sudah direvisi oleh Suharsimi
Arikunto sendiri pada buku tersebut pada halaman berikutnya,

Penentuan besarnya sampel dengan persentase seperti
yang dahulu banyak digunakan tampaknya Kini sudah
harus ditinggalkan. Agar diperoleh hasil penelitian yang
lebih baik, diperlukan sampel yang baik pula, yakni betul-
betul mencerminkan populasi. Supaya perolehan sampel

Bguharsimi Arikunto, Prosedur Penelitian: Suatu Pendekatan Praktek, (Jakarta:

Rineka Cipta, 2002), him. 112.
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lebih  akurat, diperlukan rumus-rumus penentuan

besarnya.?®

Oleh karena itu, yang perlu diperhatikan Kketika
menentukan  besarnya sampel adalah jumlah populasi,
karakteristik populasi, dan tingkat kesalahan yang ditoleransi.

Berikut ini akan diberikan contoh aplikasi dua rumus untuk
menentukan besarnya sampel apabila populasinya hiterogin.
Rumus pertama digunakan apabila jumlah populasi diketahui
sedangkan rumus kedua digunakan apabila jumlah populasi tidak

diketahui.
Rumus pertama adalah rumus Issac and Michael sebagai
berikut:
_ x°Npg
d’.(N-1)+ #%.p.q

Keterangan:
S :Jumlah sampel
x®> : Diambilkan dari %’uer Untuk tingkat kesalahan (o) 1%:

6,634891; untuk 5%: 3,841455, dan untuk 10%:

2,705541.
N : Jumlah populasi

Jumlah proporsi populasi; misalkan dari 1000 kali
pelemparan koin yang jatuh burung sebanyak 597,
maka p= 597/1000. Akan tetapi kalau proporsi tidak
diketahui, maka digunakan angka 0,5.

q 1 dikurangi nilai proporsi. Seandainya nilai proporsi
597/1000, maka nilai q adalah 403/1000.
d . Kesalahan yang ditoleransi.

Apabila rumus di atas diaplikasikan untuk jumlah populasi =
1000, p = 0,5, g = 0,5 dan kesalahan yang ditoleransi = 0,05,
maka caranya sebagai berikut:

B 3,481x1100x0,5x0,5
0,05%x(1000 -1) + 3,481x0,5x0,5

2guharsimi Arikunto, Prosedur Penelitian, him. 113.
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Untuk mempermudah pembaca ketika menentukan
besarnya sampel, berikut ini disajikan tabel yang menyajikan
jumlah populasi, jumlah sampel sebagai aplikasi rumus Issac and
Michael di atas yang diperbandingkan dengan jumlah sampel
menurut Krejcie.

TABEL
JUMLAH SAMPEL

N S S; N S S, N S S;
10 10 10 220 135 140 1200 270 291
15 14 14 230 139 144 1300 275 297
20 19 19 240 142 148 1400 279 302
25 23 24 250 146 152 1500 283 306
30 28 28 260 149 155 1600 286 310
35 32 32 270 152 159 1700 289 313
40 36 36 280 155 162 1800 292 317
45 40 40 290 158 165 1900 294 320
50 44 44 300 161 169 2000 297 322
55 48 48 320 167 175 2200 301 327
60 51 52 340 172 181 2400 304 331
65 55 56 360 177 186 2600 307 335
70 58 59 380 182 191 2800 310 338
75 62 63 400 186 196 3000 312 341
80 65 66 420 191 201 3500 317 346
85 68 70 440 195 205 4000 320 351
90 72 73 460 198 210 4500 323 354
95 75 76 480 202 214 5000 326 357
100 78 80 500 205 217 6000 329 361
110 84 86 550 213 226 7000 332 364
120 89 92 600 221 234 8000 334 367
130 95 97 650 227 242 9000 335 368
140 100 103 700 233 248 10000 336 370
150 105 108 750 238 254 15000 340 375
160 110 113 800 243 260 20000 342 377
170 114 118 850 247 265 30000 344 379
180 119 123 900 251 269 40000 345 380
190 123 127 950 255 274 50000 346 381
200 127 132 1000 258 278 75000 346 382
210 131 136 1100 265 285 100000 347 384
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Keterangan:

N :Jumlah populasi

Si : Jumlah sampel, aplikasi rumus Issac and Michael,
untuk tingkat kesalahan (a): 0,05, dan proporsi: 0,5.

S, : Jumlah sampel menurut Krejcie untuk tingkat

kesalahan () 0,05.

Apabila jumlah populasi tidak diketahui/tidak terbatas,
maka dapat digunakan rumus berikut ini:

n=()2pg
e
Keterangan:
n . Jumlah sampel
z . Diambilkan dari zyue untuk tingkat kesalahan (o)
1%: 2,58; untuk 5%: 1,96, dan untuk 10%: 1,645.

e . Kesalahan yang ditoleransi.
p :Jumlah proporsi populasi.
q 1 dikurangi nilai proporsi.

Apabila rumus di atas diaplikasikan untuk tingkat kepercayaan =
95%, p = 0,5, g = 0,5 dan kesalahan yang ditoleransi = 0,05,
maka caranya sebagai berikut:

1,96

384 = (=2
0,05

)?%0,5%0,5

Prosedur dan Teknik Pengambilan Sampel

Di samping itu, ketika jumlah sampel sudah dapat
ditentukan, maka yang juga perlu ditentukan adalah teknik
sampling dengan mendasarkan pada katakteristik dari populasi
tersebut.

Pada dasarnya teknik sampling dapat dikelompokkan
menjadi dua, yaitu random sampling dan non-random sampling.
Teknik sampling yang dikategorikan sebagai random sampling
adalah simple random sampling, proportionate stratified random
sampling, disproportionate  stratified random  sampling,
systematic sampling, cluster random sampling, dan two-stage
random sampling. Sedangkan yang termasuk non-random
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sampling adalah purposive sampling, accidental sampling, dan
snowball sampling. Untuk lebih mudahnya dapat dilihat pada
bagan berikut ini.

TEKNIK
SAMPLING
RANDOM NON- RANDOM
SAMPLING SAMPLING
Simple Random Purposive
Sampling 1 N Sampling
Proportionate Accidental
Stratified Sampling || N Sampling
Disproportionate — Snowball
Stratified Sampling || Sampling
Systematic
Sampling ]
Cluster Random
Sampling ]
Two-Stage

Random Sampling

4. Prosedur dan Teknik Pengambilan Sampel

a) Random Sampling

Random sampling, yang sering juga disebut probability
sampling, adalah teknik pengambilan sampel yang
memberikan peluang yang sama bagi setiap unsur dalam
populasi untuk menjadi sampel. Yang termasuk teknik
random sampling adalah beberapa teknik sampling berikut ini.

1) Simple Random Sampling

Teknik simple random sampling adalah teknik
pengambilan sampel yang memberikan peluang yang sama
bagi setiap unsur dalam populasi untuk menjadi sampel.
Teknik ini dilakukan bila anggota populasi dianggap
homogen.
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Aplikasi simple random sampling ini dapat
dilakukan dengan berbagai cara, misalnya seluruh anggota
populasi dicatat dan diambil satu persatu seperti dalam
arisan. Selain itu, dapat menggunakan nomor random yang
biasanya disertakan dalam buku-buku statistik atau
metodologi penelitian. Dengan perkembangan software
komputer, aplikasi simple random sampling ini menjadi
lebih cepat.

Contoh:

Seorang peneliti berkeinginan mengetahui motivasi
belajar siswa kelas | MTs Madrasah Hidayatul
Mubtadi’in Lirboyo sebanyak 729. Jumlah yang akan
diambil untuk dijadikan sampel berdasarkan
rumusnya Issac and Michael adalah 236. Dikarenakan
populasinya dianggap homogen, maka digunakan
simple random sampling.

Caranya:

a. Setelah nomor dan nama siswa diinput, klik Tools »
Data Analysis..., seperti berikut ini.

Ed Microsoft Excel - simple random sampling

@ File Edit Wiew Insert  Format | Tools | Data  Wwindow  Hel)

= @‘ H B - Options... 2
Al < I3 | Data Analysis. .. |

N = [ ¢ [————

b. Setelah itu, pilihlah sampling, lalu klik Ok.

1

Data Analysis E E|
analysis Tools -
Exponential Smoaothing J
F-Test Two-Sample for Variances Cancel
Fourier Analysis
Histogram
Moving Average Help
Randomn Mumber Generation
Rank and Percentils
Regression
t-Test: Paired Two Sample for Means J

c. Setelah itu, klik kotak Input Range lalu bloklah seluruh
nomor populasi yang berjumlah 729 yang sudah diinput.
Lalu ketiklah angka 236 (jumlah sampel). Pilihlah
tempat untuk output nomor siswa yang akan dijadikan
sampel dengan cara memilih salah satu pilihan di
Output options.
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Inpukt
Inpuk Range:

[ Labels

Sampling Method
" Perindic

Period:

(* Random

Cutput options
* Qutput Range:

™ Mew Workbook.

MNumnber of Samples:

™ Mew Worksheet Ply:
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Sampling EIE|

$A51:5A$T29 B

236

$01 g

—

OK

[ ok |
Cancel
.

Help

d. Setelah keluar hasilnya, maka nomor sampel tersebut

dapat diurutkan,

dengan submenu vyang ada di

Micrososft Excel, yaitu melalui Data » Sort. Apabila
ada nomor yang sama, maka salah satu nomor dapat
dihapus dan nomor tersebut dalam daftar populasi juga
dihapus lalu diulangi lagi untuk mengambil sampel
seperti dijelaskan di atas sampai jumlah sampel yang
ditentukan terpenuhi.

E3 Microsoft Excel - simple random sampling

E] mle Edit
DEeE @ ¢ B@-

D1

Wiew  Insert  Format  Tools  Data  Window

= £ 305

= - [l 100%

A

B
1| shtmad
2 Sodig
3 Al
4 Faig

[ D

E

305
673
562

fili)

5 Muhatnmad 408

fi Almas
7| Anarm

678
258

2) Proportionate Stratified Random Sampling

Teknik ini digunakan bila populasi mempunyai
anggota/unsur yang berstrata secara proporsional.

Contoh:
Seorang peneliti

akan meneliti

tentang motivasi

berpretasi siswa MTs MHM Lirboyo Kediri. Jumlah
populasi adalah 2.055 siswa. Jumlah siswa kelas |
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sebanyak 729 (35,47%), kelas Il sebanyak 681 (33,14),
dan kelas 11 sebanyak 645 (31,39%).

Berdasarkan aplikasi rumus penentuan besarnya
sampel dari Issac and Michael diketahui bahwa manakala
jumlah populasinya 2.055, maka didapatkan jumlah
sampelnya 298. Dari 298 sampel tersebut, 35,47%
diambilkan dari kelas I, yaitu sebanyak 106; 33,14%
diambilkan dari kelas Il, yaitu sebanyak 99 siswa, dan
31,39% dari kelas 1ll, yaitu sebanyak 94 siswa.
Selanjutnya, untuk memilih 106 siswa dari 729 siswa kelas
I, 99 siswa dari 681 siswa kelas Il, dan 94 siswa dari 645
siswa kelas Ill dilakukan secara random yang
penjelasannya telah diberikan di atas.

3) Disproportionate Stratified Random Sampling

Teknik ini digunakan bila populasi mempunyai
anggota/unsur yang berstrata secara tidak proporsional.

Contoh:

Diadakan penelitian tentang frekwensi penulisan karya
ilmiah. Di lembaga, tempat penelitian dilakukan,
memiliki dosen yang berpendidikan S3 sebanyak 7
orang, S2 sebanyak 87 orang, dan S1 sebanyak 5 orang.

Berdasarkan aplikasi rumus penentuan besarnya
sampel dari Issac and Michael diketahui bahwa manakala
jumlah populasinya 99, maka didapatkan jumlah sampelnya
77. Dikarenakan jumlah dosen setiap strata tidak
proporsional, maka sampel untuk dosen yang
berpendidikan strata S3 dan S1 diambil semua, sedangkan
sisanya, yaitu sebanyak 65 dosen dipilih secara random dari
87 dosen yang berpendidikan S2.

4) Systematic Sampling

Teknik systematic sampling merupakan pengambilan
sampel berdasarkan nomor urut ke k dalam populasi.
Pengambilan sampel secara acak hanya dilakukan pada
awalnya saja, sedangkan pengambilan sampel kedua dan
seterusnya digunakan interval tertentu sebesar k.
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Contoh:

Seorang peneliti berkeinginan mengetahui motivasi
belajar siswa kelas 1 MTs Madrasah Hidayatul
Mubtadi’in Lirboyo sebanyak 729.

Berdasarkan aplikasi rumus penentuan besarnya
sampel dari Issac and Michael diketahui bahwa manakala
jumlah populasinya 729, maka didapatkan jumlah
sampelnya 236. Untuk mendapatkan sampel sebanyak 236
dari 729 dapat digunakan kelipatan 3. Hanya saja nomor
pertama yang harus digunakan apakah 1, 2, atau 3
ditentukan secara acak.

Teknik systematic sampling ini dianggap lebih
mudah dibandingkan dengan simple random sekalipun.
Oleh karena itu, teknik ini sering dijadikan alternatif dari
teknik simple random sampling.

5) Cluster Random Sampling

Teknik ini digunakan apabila kerangka sampling
yang memuat elemen populasi tidak tersedia. Cluster
Random  Sampling yaitu teknik sampling yang
menggunakan kumpulan atau kelompok (cluster) elemen
populasi sebagai dasar penarikan sampel.

Contoh:

Diadakan penelitian tentang pengaruh sertifikasi
terhadap produktifitas kerja guru.

Karena peneliti tidak memiliki data tentang jumlah
guru yang sudah mendapat sertifikat professional pada
setiap sekolah, maka peneliti menentukan sampel
berdasarkan sekolahnya.

6) Two-Stage Random Sampling
Teknik ini merupakan penggabungan dari dua teknik
samping.
Contoh:

Peneliti menggabungkan teknik Cluster Random
Samping dan Simple Random Sampling.

Cara yang ditempuh adalah menentukan cluster yang
dijadikan sampel secara random, setelah itu elemen dari
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cluster yang akan dijadikan sampel juga ditentukan secara
random.

Untuk mendapatkan sampel yang representatif, peneliti
diperkenankan menggabungkan berbagai teknik sampling
sepanjang teknik tersebut memungkinkan didapatkannya
sampel yang sesuai dengan karakteristik populasi.

b) Non-Random Sampling

Non-random sampling, yang sering juga disebut non-
probability sampling, adalah teknik pengambilan sampel yang
tidak memberikan peluang yang sama bagi setiap unsur dalam
populasi untuk menjadi sampel. Yang termasuk teknik non-
random sampling adalah beberapa teknik sampling berikut ini.

1) Purposive Sampling
Purposive sampling, dikenal juga dengan judgement
sampling, adalah teknik penarikan sampel yang didasarkan
pada tujuan penelitian. Berdasarkan tujuan penelitian
tersebut, peneliti menentukan kriteria sampel yang akan
diambilnya.

Contoh:

Dilakukan penelitian tentang kualitas karya ilmiah
guru yang akan mengajukan kenaikan pangkat ke
IV/b, maka sampel sumber datanya adalah dosen dan
peneliti yang produktif menulis karya ilmiah. Teknik
sampling ini lebih cocok digunakan dalam penelitian
kualitatif.

2) Accidental Sampling

Teknik ini sering juga disebut convenience sampling.
Peneliti yang menggunakan teknik ini akan menjadikan
sampel siapa saja yang ketemu dengannya apabila orang
tersebut dianggap cocok sebagai sumber data. Teknik ini
digunakan apabila peneliti tidak memungkinkan untuk
mengidentifikasi karakteristik elemen populasi secara jelas.
Data yang didapatkan dengan teknik ini mempunyai
kelemahan untuk digunakan generalisasi terhadap populasi.

3) Snowball Sampling

Snowball sampling adalah teknik penentuan sampel
secara berantai. Mula-mula peneliti memilih satu dua
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orang, dan setelah mendapatkan data dari orang tersebut,
peneliti meminta informasi kepada siapa lagi harus
menggali data untuk mendapatkan data yang lebih spesifik
dan detail. Teknik ini banyak digunakan dalam penelitian
kualitatif.

Berdasarkan penjelasan di atas, ketika akan memilih
sampel dari populasi, peneliti harus memperhatikan bahwa teknik
sampling yang dipilih memungkinkan dapat menghasilkan data
yang dapat digunakan membuat generalisasi, dapat menghasilkan
presisi yang tinggi, sederhana, mudah dilaksanakan, dan
memberikan sevalid mungkin data tentang populasi dengan
biaya, tenaga, dan waktu yang minimal.

Konsep Pengujian Hipotesis

Pada dasarnya menguji hipotesis itu adalah menaksir parameter
populasi berdasarkan data sampel. Terdapat dua cara menaksir, a
point estimate dan interval estimate. Yang disebutkan pertama adalah
suatu taksiran parameter berdasarkan suatu nilai data sampel
sedangkan yang kedua adalah suatu taksiran parameter populasi
berdasarkan nilai interval data sampel.*°

Menaksir parameter populasi menggunakan nilai tunggal
mempunyai resiko kesalahan yang lebih tinggi dibandingkan dengan
menggunakan interval estimate. Makin besar taksiran maka akan
semakin kecil kesalahannya tetapi tingkat ketelitian taksiran semakin
rendah. Untuk selanjutnya kesalahan taksiran ini dinyatakan dalam
peluang yang berbentuk prosentase. Biasanya dalam penelitian
kesalahan taksiran ditetapkan lebih dahulu, yang digunakan adalah
5% dan 1%. Tingkat kesalahan ini selanjutnya dinamakan tingkat
signifikansi.®

Dalam setiap pengujian hipotesis, Kkita harus selalu
memutuskan apakah menerima ataukan menolak Ho dan selalu ada
kemungkinan bahwa kita membuat kesalahan dalam pengambilan
keputusan tersebut. Kesalahan tersebut terjadi ketika kita menolak
suatu hipotesis yang benar atau menerima hipotesis yang salah.
Kedua jenis kesalahan ini diberi nama secara khusus dalam pengujian
hipotesis:

®Kusnandar, Metode Statistik dan Aplikasinya, him. 86-88.
#Kusnandar, Metode Statistik dan Aplikasinya, him. 86-88.
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1. Salah jenis I. Kesalahan ini terjadi ketika kita menolak Ho
padahal Ho benar. Peluang terjadinya kesalahan ini dinyatakan
dengan o dan disebut taraf signifikansi.

2. Salah tipe Il. Kesalahan ini terjadi ketika kita menerima Ho
padahal Ho salah. Peluang terjadinya kesalahan ini dinyatakan
dengan B, yang disebut dengan power of statistical test.*

Dalam pengujian hipotesis kebanyakan digunakan kesalahan

tipe | yaitu berapa persen kesalahan untuk menolak hipotesis nol (Ho)
yang benar. Sebagai ilustrasi dapat dilihat pada gambar di bawah ini:

Craerah Kritisf
Penolakan Ho

&

X | *,
Titile Daerah Titile
Entis Fenerimaan Hoe  Eritis

Sebagaimana dijelaskan bahwa software yang akan digunakan
untuk menganalisis data penelitian dalam buku ini adalah SPSS dan
Microsoft Excel. Oleh karena itu, dalam sub bab berikut ini akan
dijelaskan urut-urutan dalam menginstall SPSS dengan menggunakan
versi 11.5 dan bagaimana cara menginput data. Setelah itu akan
dijelaskan juga bagaimana mengaktifkan sub menu Data Analysis
pada Program Miscrosoft Excel.

%2 Dadan Kusnandar, Metode Statistik dan Aplikasinya, him. 150.
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I.  Urut-Urutan dalam Menginstall Program SPSS Versi 11.5 dan
Proses Mengaktifkan Menu Data Analysis Microsoft Excel

Proses menginstall SPSS versi 11.5 adalah sebagai berikut:

1. Masukkan CD SPSS pada CD ROM, maka secara otomatis akan
keluar sebagaimana gambar di bawah ini. Klik Install SPSS
untuk menginstallnya.

1il SPSS 11.5 for Windows (=3

SPSS 11.5

Install SPSS
Install SmartViewer

Installation Instructions

Install Internet Explorer 6.0
Install Acrobat Reader 5.0
Install SPSS Data Access Pack
Browse the CD-ROM

Exit

o SPSS
2. Setelah keluar gambar seperti di bawah ini klik Next.

Welcome E|

Welcome ta the SPSS for Windows Setup program, This
program will ingtall SPSS for Windows on pour computer.

It is strongly recommended that you exit all Windows programs
before running this Setup program

Click Cancel to quit Setup and then close any programs you have
running. Click Mext to cantinue with the Setup program.

WaRNING: This program is protected by copyright law and
intemational treaties.

Unauthorized reproduction or distibution of this program, or aty
portion of it, may result in severe civil and criminal penalties, and
will be prosecuted ta the maximum estent possible under law.

T Cancel |

3. Setelah keluar gambar seperti di bawah ini klik Yes.
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Software License Agreement:

Please read the following software license agreement. o will
need to use the scroll bars to read the complete text

3

THIS LICENSE AGREEMEMT IS5 YOUR PROOF OF LICEMSE.

THIS |5 A LEGAL AGREEMENT FOR A SINGLE-USER LICENSE OF

THE SOFTWARE BETWEEN YOU [EITHER AM INDIMIDUAL OR ENTITY]
AND SPSS IMC. If you do not agree to the temms of this

License Agreement, immediately retum the package. This

License Agreement shall apply only if you have not signed

anather SPS5 License Agreement for this software.

Thiz zoftware iz protected by both United States copyright
law and international copyright treaty provisions.

LICENSE

<

Do pou accept the terms az set forth abowe?

1=
)

< Back Yes

4. Setelah keluar gambar seperti di bawah ini klik Next.

Choose Destination Location E

Setup will install SPSS for Windows in the follawing directory.
Tainstall to this directory, click Mexst

Tainstall to & different directory, click Browse and select anather
directory.

ou can choose not ta install SPSS for Windows by clicking
Cancel to exit Setup,

Destination Directory

C:%Fragram FileshSPSS Browse...
< Back | Ment> Cancel |

38

5. Setelah keluar gambar seperti di bawah ini ketiklah Serial
Number dari program tersebut lalu klik Next.

Enter your name, organization, and the serial number that is
printed on the CD-ROM case.

Hame: |Ali Arwar

Organization: |SBS F.edir

Serial number.  |123456789

< Back | HMext > Cancel
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6. Setelah keluar gambar seperti di bawah ini klik Next.

Setup Type ﬁ'_?

Select the type of installation you prefer.

Program will be installed with the most comman
options. Recommended far most users.

" Compact Program will be installed with minimum required
optians.

" Custom You may choose the options vou want to install.
Recommended for advanced users.

< Back IW‘ Cancel |
7. Setelah keluar gambar seperti di bawah ini klik Next.

Personal or Shared installation

Please indicate the type of installation you'd like ta perform

™ Software uses licenses from remote license server

—

7 Network or site license installation for shared use.

< Back Mext > ‘ Cancel |

8. Setelah keluar gambar seperti di bawah ini ketik Lisensi I: yang
biasanya disertakan dalam CD program tersebut, lalu Klik Update.

Product license codes B_T

SPSS shipz with one or mare license codes that gavern the
products pou may install. Please enter the license codes one at a
time, then press Lpdate to update the license status.

|3nnm 359390

License status: Update

SPSS for Windows Base - unlicensed
SPSS Regression Models - unlicensed
SPSS Advanced Models - unlicensed
SPSS Tables - urlicensed

SPSS Trends - unlicensed

SPSS Categories - unlicensed

SPSS Conjoint - unlicensed

SPSS Exact Tests - unlicensed

SPS5 Missing Walue Analysis - unlicensed
SPSS Map - unlicensed

SPSS Tables Diiginal - unlicensed

< Back | Hext > Cancel
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9. Setelah keluar gambar seperti di bawah ini ketik Lisensi 11, lalu
Klik Update selanjutnya klik Next.

Product license codes E‘

SPSS ships with one or mare license codes that gavern the
products you may install. Please enter the license codes one at a
time, then press LUpdate to update the license status.

[z0001374190

License status: Update

SPS55 for Windows Base - licensed ~
customer D 2
for wersion 14.0.x
expires 9/1/2022

SPSS Regression Models - licensed
for version 14.0.x
expires 9/1/2022
SPSS Advanced Models - licenged
for version 14.0.x
expires 8/1/2029
SPSS Tables - licensed
for version 14.0.x b

< Back IW‘ Cancel |
10. Setelah keluar gambar seperti di bawah ini Klik Next.

Select Options E‘
Select the SPSS options pou have licensed and wish to install
v 1
¥ SPSS Advanced Models [2 5 ME]
¥ SPSS Tables [3.0 MB]
¥ SPSS Trends [1.0 MB)]
¥ SPSS Categories [1.0 MB]

[ SPS5 Conjoint [1.0 ME]
¥ SPSS Exact Tests [0.8 ME]
¥ SPSS Missing Value Analysis [1.0 MEB]
¥ 5P35 Map [20.0 ME]
¥ SPSS Tables Qriginal [0.7 ME]
< Back | Mext > Cancel |

11. Setelah keluar gambar seperti di bawah ini tunggu sampai
keluar gambar berikutnya.

25755 11,5 for Windows Setup

Detemining fles o atal
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12. Setelah keluar gambar seperti di bawah ini klik Next.

Ready To Install Files E‘

Setup iz ready to begin the file transfer operation. Please
review the information below. If you need to make changes,
pleage backup and make comections before continuing.

Current Settings:

Target Directony: ~
C:A\Program FileshSPSS

Compaonents:
Sample Data
BASIC Scripting
Production made facility
Statistics Coach [requires IE 4.0 or higher]

SPSS Options:
SPSS Regression Models
SPS5 Advanced Models

< Back

Cancel |

13. Setelah keluar gambar seperti di bawah ini berarti proses instalasi
sedang berlangsung. Tunggu sampai keluar gambar berikutnya.

B

14. Setelah keluar gambar seperti di bawah ini klik Next kalau ingin
mendaftarkan program tersebut kepada SPSS Programmer, akan
tetapi kalau tidak diperlukan pendaftaran tersebut klik Register
Later dan selanjutnya klik Next.

Electronic registration El

Registered users receive regular information on products and
product updates. You have not pet registerad this product
Select the ootion vou orefer.

" Register now

* Hegster later

Mext > I Cancel
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15. Setelah keluar gambar seperti di bawah ini klik Launch ... dan
klik juga Display... untuk menghilangkan tanda contengan dan
selanjutnya Finish berarti instalasi selesai.

Setup Complete

SPSS for windows Setup is now complete.

IV Launch tutorial now?

¥ Display the Readie file now?

You may run SPSS far Windows by selecting the application
icon in the pragram graup.

<Back
Sedangkan untuk aplikasi program SPSS versi 11.5 dan cara

menginput datanya adalah sebagai berikut:

1. Kilik Start, lalu

2. seret ke SPSS for windows, lalu

3. seret ke SPSS 11.5 for windows, lalu Klik; sebagaimana gambar di
bawah ini.

@ Set Program Accass and Defauks
W Windows Cataleg.
R vindows Update
] tow Cffcs Socumant
& Open O Documert

l 1y J Ali Anwar

élmm
(-7 el
> Messenger
[ otrs | B
@ v | D st
@ Moosolt Office Tooks
@) Holy Quran Program

B eonwkzsmseies ;
[ [PTRY .5l A

Sl et g
15

N ) Trend Micro PC-clin 2002
& &) Ceron PhotoRecced
a iodth 0 Canon PDMA P10DD

@ CononPDMAPIOO Mawal b

4. Setelah keluar gambar seperti berikut ikon SPSS yang ada di depan
Open..., kalau anda akan membuka data SPSS yang telah dibuat,
tetapi kalau tidak klik Cancel.
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SPSS for Windows X

“what would you ke to do?

isling cuery

" Create new guery using Database Wizard

& Open an existing data source

(" Open ancther lype of e
o Fles

v Gionit show i dialog in the future

5. Setelah keluar gambar seperti berikut berarti lembar SPSS siap untuk
digunakan mengetik data penelitian. Dalam lembar ini ada dua sheet:
yaitu Data View untuk pengetikan Data, dan Variable View untuk
untuk memberi penjelasan variabel penelitian.

T )

e m
FEEL kel #) i TR {2

@] B || o el ] 58] ] TR 2
.... [ tme [ womn [ cocmas | e |

6. Misalkan kita akan memasukkan data penelitian tentang produktifitas
kerja pegawai sebelum dan setelah mendapatkan kendaraan dinas
seperti di bawah ini.



Pendabulnan 44

7.

uji_t_paired - SPSS Data Editor
File Edit View Data Transform Analyze Graph:

5|8 ®| ofc| L =k #
1 sebelum 7E.85
sehelum Sesudah| var |
1| 7EEs 7622
2 7795 7789
3 7865 7902
4 79,25 BO.21

Setelah data dimasukkan pada data view, maka klik variable view
untuk memberikan penjelasan tentang berbagai variabel itu.

uji_t_paired - SP55 Data Editor

File Edit View Data Transform  Analyze Graphs  Ubiities  Window Help

=S| B | L) =l o] o] e RIS [ @

8.

Mame | Type ‘ Width | Decimals | Label ‘ “alues | Missing ‘ Columns ‘ Align | Measure
1[sebelum  [Numeric a 2 Maone Maone B Right Scale
2| sesudah Murneric 8 2 Mone Mone 8 Right Scale
3

Setelah selesai, lalu simpan data itu dan siap untuk dianalisis.
Di samping menggunakan SPSS, buku ini juga berusaha

menggunakan Microsoft Excel untuk memberikan contoh aplikasi dari
analisis statistik yang dipaparkan. Aplikasi Microsoft Excel sedapat
mungkin diaplikasikan dengan tiga cara yaitu melalui Data Analysis,
aplikasi function, maupun aplikasi rumus-rumus statistik dengan berbagai
prosedurnya. Dari tiga cara tersebut, sub menu Data Analysis belum
terinstall ketika program Microsoft Excel itu diinstall. Cara mengaktifkan
program tersebut adalah sebagai berikut:

1.

Klik Tools » Add-Ins..., sebagaimana gambar berikut ini.

E3 Microsoft Excel - Book1

File Edt ‘iew Insert Format | Tools | Dats  Window Help
DEESY SRAY| §Y i F7
A1 L4 fe v’f; Error Checking. .,

A B G Speech »
1 1
> L] Share Warkbook, .,
3 Track Changes »
4
)
5 Protection r
T Onling Collaboration »
S Goal Seek...
10 Scenarios, .,
11 Formula Auditing »
12
13 Tools on the Web...
14 Macra 3
15 add-Ins...
15




45 Statistika untnk Penelitian Pendidikan

2. Setelah keluar gambar berikut ini klik pada kotak Analysis ToolPak
dan Analysis ToolPak — VBA lalu klik Ok, sebagaimana gambar

berikut ini.
Add-Ins 3

Add-Ins available:

Iv analysis ToolPak
Tl &inialhysis ToolPak, - WBA

| Conditional Sum Wizard
I~ Euro Currency Tools

[ Internet Assistant YBA

I Lookup Wizard R

[ Solver Add-in )
Automnation.. .

QK |
[ & |

Cancel

| -

WEBA Functions For Analwsis ToolPak

Analysis ToolPak - VEA

3. Setelah selesai, maka akan keluar sub menu Data Analysis pada
menu Tools, sebagaimana terlihat pada gambar di bawah ini.

E3 Microsoft Excel - Book1

File Edit Wiew Insert Format | Tools | Data  window  Help

DEEa" GRY &V wdu. o
Al - A~ & Ervor Checking. ..
B c Share workbook. .. I
Pratection 3

Opline Collaboration 3
Formula Auditing 3

Tools on the web. ..

W00~ 0 M s k)=
=
1 ]

Add-Ins...
Cuskormize. ..
10 options. ..
11 | Data Analysis, .. |
12 ¥
13
14

4. Ketika sub menu Data Analysis itu diklik, maka akan keluar gambar
yang berisi berbagai teknik analisis, sebagaimana terlihat pada
gambar berikut ini.
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Data Analysis

Analysis Tools

Anova: Two Factor Without Replication

Descripkive Statistics
Exponential Smoothing
F-Test Two-Sample For Variances
Fourier Analysis

Hiskogram

Mowing Average

Random Mumber Generation
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Aplikasi dari berbagai teknik analisis yang menggunakan cara di
atas, maupun menggunakan function, dan breakdown dari rumus-rumus
statistik akan diberikan ketika menjelaskan berbagai teknik analisis pada

bab-bab mendatang.



BAB I1
STATISTIK DESKRIPTIF

A. Pendahuluan

Statistik deskriptif, menurut Kusnandar, adalah cabang ilmu
statistik yang berkaitan dengan prosedur-prosedur yang digunakan
untuk menjelaskan karakteristik data secara umum.' Sedangkan
Sugiyono mendefinisikannya sebagai statistik yang berfungsi untuk
mendeskripsikan atau memberi gambaran terhadap obyek yang
diteliti melalui data sampel atau populasi sebagaimana adanya, tanpa
melakukan analisis dan membuat kesimpulan yang berlaku untuk
umum.? Dari dua definisi di atas dapat dipahami bahwa tujuan utama
dari statistik deskriptif adalah menggambarkan data, baik dengan
tabel, grafik, maupun ringkasan data. Berangkat dari kesimpulan
tersebut, maka berlaku prinsip dasar dalam penyajian data yaitu
komunikatif dan lengkap, dalam arti data yang disajikan dapat
menarik perhatian pembaca dan mudah dipahami isinya.

Sebagaimana dijelaskan, bahwa ada tiga cara untuk
mendeskripsikan data, yaitu:

1. Tabel, vyaitu penyajian data yang bertujuan  untuk
mengelompokkan data ke dalam beberapa kelompok yang
masing-masing mempunyai karakteristik yang sama. Bentuk tabel
yang sering digunakan adalah tabel distribusi frekuensi dan tabel
distribusi frekuensi relatif.

'Dadan Kusnandar, Metode Statistik dan Aplikasinya dengan Minitab dan Excel,
(Yogjakarta: Madyan Press, 2004), him. 10.

2Untuk elaborasi lebih jauh baca Sugiyono, Statistika untuk Penelitian, (Bandung:
CV Alfabeta, 2003), him. 21.
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2. Grafik atau diagram, yaitu penyajian data yang bertujuan
memvisualisasikan data secara keseluruhan dengan menonjolkan
karakteristik tertentu dari data tersebut.

3. Ringkasan Data Statistik, yaitu penyajian data yang digunakan
untuk menjelaskan pemusatan dan penyebaran data.

Sebelum direlease berbagai software komputer untuk aplikasi
statistik, mendeskripsikan data adalah pekerjaan yang melelahkan dan
menjemukan. Saat ini, berbagai pekerjaan itu dapat dikerjakan
dengan lebih mudah dan menghasilkan output yang lebih baik.

Contoh:

Peneliti yang sedang mengadakan penelitian di salah satu sebuah

Perguruan Tinggi

Agama

penelitian tentang tenaga edukatif sebagai berikut.

DATA TENAGA EDUKATIF

SEBUAH PERGURUAN TINGGI AGAMA ISLAM

Islam dan mendapatkan data

JABATAN MASA JENIS
NO | KEPANGKATAN FUNGSIOAN | KERJIA IJAZAH KELAMIN UMUR
1 IV/c Lektor 35 S2 Laki-laki 62
2 IVic Lektor Kepala 30 S2 Laki-laki 61
3 IV/ib Lektor 31 S2 Laki-laki 56
4 1V/b Lektor Kepala 26 S2 Laki-laki 55
5 IV/ib Lektor 30 S2 Laki-laki 56
6 1V/b Lektor Kepala 22 S2 Laki-laki 58
7 1V/b Lektor Kepala 27 S1 Laki-laki 60
8 IV/b Guru Besar 20 S3 Laki-laki 54
9 1V/b Lektor Kepala 14 S2 Laki-laki 45
10 IV/a Lektor Kepala 20 S2 Perempuan 47
11 IV/a Lektor Kepala 18 S2 Laki-laki 46
12 IV/ia Lektor 28 S2 Laki-laki 55
13 IV/a Lektor Kepala 16 S2 Laki-laki 44
14 IV/ia Lektor Kepala 15 S3 Laki-laki 41
15 IV/a Lektor Kepala 33 S2 Laki-laki 60
16 IV/ia Lektor Kepala 14 S2 Laki-laki 44
17 IV/a Lektor Kepala 13 S2 Perempuan 37
18 IV/a Lektor Kepala 15 S2 Laki-laki 48
19 IV/ia Lektor Kepala 13 S2 Laki-laki 48
20 1/d lektor 16 S1 Laki-laki 41
21 1/d lektor 10 S2 Laki-laki 39
22 1/d lektor 9 S2 Perempuan 45
23 1ni/d lektor 9 S2 Perempuan 38
24 1/d lektor 9 S2 Laki-laki 43
25 1ni/d lektor 9 S2 Perempuan 39
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26 1ni/d lektor 9 S2 Laki-laki 32
27 1/d lektor 8 S2 Laki-laki 34
28 1ni/d lektor 9 S2 Laki-laki 36
29 1ni/d lektor 8 S2 Perempuan 35
30 1ni/d lektor 7 S2 Laki-laki 38
31 1ni/d Lektor Kepala 11 S2 Laki-laki 43
32 1i/c lektor 8 S2 Laki-laki 38
33 1l/c lektor 9 S2 Laki-laki 38
34 1l/c lektor 8 S2 Laki-laki 35
35 1l/c lektor 8 S2 Laki-laki 34
36 1/c lektor 8 S2 Laki-laki 33
37 1i/c lektor 7 S2 Laki-laki 43
38 1i/c lektor 8 S2 Perempuan 35
39 1i/c lektor 7 S2 Laki-laki 34
40 1l/c lektor 7 S2 Laki-laki 33
41 1l/c lektor 6 S2 Laki-laki 40
42 1l/c lektor 12 S2 Laki-laki 43
43 1l/c lektor 7 S2 Laki-laki 35
44 /¢ lektor 7 S1 Laki-laki 35
45 1/b Asisten Ahli 10 S2 Laki-laki 34
46 11/b Asisten Ahli 4 S2 Laki-laki 33
47 1/b Asisten Ahli 4 S2 Laki-laki 33
48 I/b Asisten Ahli 4 S2 Laki-laki 32
49 /b Asisten Ahli 4 S2 Laki-laki 31
50 11/b Asisten Ahli 4 S2 Laki-laki 38
51 /b Asisten Ahli 4 S2 Laki-laki 37
52 /b Asisten Ahli 4 S2 Perempuan 34
53 /b Asisten Ahli 4 S2 Perempuan 33
54 /b Asisten Ahli 3 S2 Laki-laki 34
55 /b Asisten Ahli 7 S2 Laki-laki 42
56 /b Asisten Ahli 3 S2 Laki-laki 36
57 1/b Asisten Ahli 3 S2 Laki-laki 35
58 11/b Asisten Ahli 3 S2 Perempuan 34
59 /b Asisten Ahli 3 S2 Perempuan 34
60 /b Asisten Ahli 3 S2 Perempuan 30
61 11/b Asisten Ahli 3 S2 Perempuan 29
62 /b Asisten Ahli 3 S2 Perempuan 30
63 1/b Asisten Ahli 3 S2 Laki-laki 29
64 1/b Asisten Ahli 7 S2 Laki-laki 42
65 /b Asisten Ahli 8 S2 Perempuan 41
66 /b Asisten Ahli 6 S2 Laki-laki 38
67 1/b calon dosen 6 S2 Laki-laki 41
68 11/b calon dosen 1 S2 Perempuan 35
69 1/b calon dosen 1 S2 Laki-laki 31
70 /b calon dosen 6 S2 Laki-laki 39
71 1/b Asisten Ahli 4 S2 Laki-laki 30
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72 11/b Asisten Ahli 7 S2 Laki-laki 36
73 1l/a Asisten Ahli 7 S1 Perempuan 33
74 1l/a Asisten Ahli 7 S2 Perempuan 32
75 1l/a calon dosen 4 S1 Perempuan 30
76 Il/a calon dosen 4 S2 Perempuan 27
77 I/a calon dosen 3 S1 Perempuan 27
78 Il/a calon dosen 1 S2 Laki-laki 36
79 1l/a calon dosen 1 S2 Perempuan 35
80 1/a calon dosen 1 S2 Perempuan 34
81 1/a calon dosen 1 S1 Laki-laki 35

Agar data di atas mudah untuk dipahami, maka peneliti dapat
menyajikannya dalam bentuk tabel maupun grafik, dan untuk data
kuantitatif dapat dideskripsikan dengan ringkasan data statistik.
Berikut ini akan disajikan aplikasinya dengan SPSS dan Microsoft
Excel.

B. Aplikasi untuk Penyajian Data dengan SPSS

Untuk menampilkan data di atas dalam bentuk tabel distribusi
frekuensi, distribusi frekuensi kumulatif, dan grafik dengan SPSS
dapat dilakukan dengan cara sebagai berikut:

1. Setelah data diinput pada lembaran SPSS Data Editor, maka klik
Analyze » Descriptive Statistics » Frequencies, sebagaimana
gambar di bawah ini.

statistik deskriptif - SPS5 Data Editor
Fle Edt View Deta Transfom BACUEEN Graphs Utlties Window Help

Y Repurts Y el e
&
HE@ ﬂ M J Descriptive Statistics Frequenties...
1ino T Tabes b Destrtives..
(ompare Means ¥ Edploe.,
J‘g gu\_paﬂn? —  GeneralLinear Mockl ¥ Crosstabs . Huﬂr—\

2. Ketika keluar gambar berikut, bloklah variabel-variabel yang

akan disajikan lalu masukkan pada kolom Variable(s) dengan

mengeklik tanda gambar ». Apabila data tersebut juga ingin
ditampilkan dalam bentuk grafik, maka klik Charts.




51 Statistika untuk Penelitian Pendidikan

ariable(s]:
Cancel
Help
[v Display frequency tables
§tatislics...| Charts... | Format. . |

3. Ketika keluar gambar berikut, Pilihlah salah satu dari tiga pilihan
grafik, yaitu grafik batang (Bar Charts), grafik serabi (Pie charts),
atau histrograms. Setelah dipilih, klik Continue.

Frequencies: Charts E‘
Chart Type

t Ngne Cancel
(* Bar charts
" Pie charts Help
" Histograms:

-

Chart Yalues

* Frequencies " Percentages

4. Ketika keluar gambar berikut, klik OK.

M Freguencies El
(B no Wariable(s]: =

\:I g;:;?:el Cancel
G umur Help

[+ Display frequency tables

Statitics...| [[ERaligd Fomal. |

5. Berikut ini adalah output dari aplikasi di atas.
Frequencies

Statistics

GOL PANG | JAB FUNG | MAS KER | IJAZAH JEN_KEL UMUR
N  Vald 81 81 81 81 81 81
Missing 0 0 0 0 0 0
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GOL_PANG
Cumulative
Frequency | Percent | Valid Percent Percent
Valid  Il/a 9 11,1 1.1 111
/b 28 34,6 34,6 45,7
/e 13 16,0 16,0 61,7
/d 12 14,8 148 76,5
V/a 10 12,3 123 88,9
IV/b 7 8,6 8,6 97,5
Vic 2 2,5 2,5 100,0
Total 81 100,0 100,0
JAB_FUNG
Cumulative
Frequency | Percent | Valid Percent Percent
Valid calon dosen 11 13,6 13,6 13,6
Asisten Ahli 26 32,1 32,1 457
lektor 28 34,6 34,6 80,2
Lektor Kepala 15 18,5 18,5 98,8
Guru Besar 1 1,2 1,2 100,0
Total 81 100,0 100,0
MAS_KER
Cumulative
Frequency | Percent | Valid Percent Percent
Valid 1,00 6 7.4 7.4 7,4
3,00 10 12,3 12,3 19,8
4,00 11 13,6 13,6 333
6,00 4 4,9 4,9 38,3
7,00 11 13,6 13,6 51,9
8,00 8 9,9 9,9 61,7
9,00 7 8,6 8,6 70,4
10,00 2 2,5 2,5 72,8
11,00 1 1,2 1,2 74,1
12,00 1 1,2 1,2 75,3
13,00 2 2,5 2,5 778
14,00 2 2,5 2,5 80,2
15,00 2 2,5 2,5 82,7
16,00 2 2,5 2,5 85,2
18,00 1 1,2 1,2 86,4
20,00 2 2,5 2,5 88,9
22,00 1 1,2 1,2 90,1
26,00 1 1,2 1,2 91,4
27,00 1 1,2 1,2 92,6
28,00 1 1,2 1,2 93,8
30,00 2 2,5 2,5 96,3
31,00 1 1,2 1,2 97,5
33,00 1 1,2 1,2 98,8
35,00 1 1,2 1,2 100,0
Total 81 100,0 100,0
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IJAZAH
Cumulative
Frequency | Percent | Valid Percent Percent
Valid S1 7 8,6 8,6 8,6
S2 72 88,9 88,9 97,5
S3 2 2,5 2,5 100,0
Total 81 100,0 100,0
JEN_KEL

Cumulative
Frequency | Percent Valid Percent Percent

Valid Laki-laki 58 71,6 71,6 716

perempuan 23 284 28,4 100,0

Total 81 100,0 100,0
UMUR
Cumulative
Frequency | Percent | Valid Percent Percent
Valid 27 2 2,5 2,5 2,5
29 2 2,5 2,5 4,9
30 4 4,9 4,9 9,9
31 2 2,5 2,5 12,3
32 3 3,7 3,7 16,0
33 6 7,4 7,4 235
34 9 111 111 34,6
35 9 111 111 45,7
36 4 4,9 4,9 50,6
37 2 2,5 2,5 53,1
38 6 7,4 7,4 60,5
39 3 3,7 3,7 64,2
40 1 1,2 1,2 65,4
41 4 4,9 4,9 70,4
42 2 2,5 2,5 72,8
43 4 4,9 4,9 778
44 2 2,5 2,5 80,2
45 2 2,5 2,5 82,7
46 1 1,2 1,2 84,0
47 1 1,2 1,2 85,2
48 2 2,5 2,5 87,7
54 1 1,2 1,2 88,9
55 2 2,5 2,5 914
56 2 2,5 2,5 93,8
58 1 1,2 1,2 95,1
60 2 2,5 2,5 97,5
61 1 1,2 1,2 98,8
62 1 1,2 1,2 100,0
Total 81 100,0 100,0
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GOL_PANG

30

20

10

0 calon dosen lektor Guru Besar
wa b e wd Via Nib Wic Asisten Ahli Lektor Kepala

GOL_PANG JAB_FUNG
MAS_KER 1JAZAH

12 80

10 700 1100 1500 2200 3000 0
400 900 1300 1800 2700 3300 s1 s2 s3
MAS_KER 1JAZAH
JEN_KEL UMUR
70 10

Laki-aki perempuan 27 30 32 34 36 38 40 42 44 46 48 55 58 61

JEN_KEL UMUR

6. Dikarenakan peneliti ketika menulis laporan penelitiannya
biasanya menggunakan program Microsoft Word, maka output
SPSS harus dicopy ke Microsoft Word, dengan cara sebagai
berikut: Klik Edit » Select All, sebagaimana gambar berikut ini.
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I= Output1 - SPSS Viewer
File W28 view Insert Format Analyee Graphs Utiities window Help
= ek @ &
(2]
Paste After Chrl+y
Paste Special..

= Frequencies

Select »

Outline » Statistics

Optiens. .. [ [GoL_PanG [ JaB FUNG | MAS KER | WAZAH | JEM_KEL | UMUR |
W vaid a1 81 81 i 81 81
Missing 0 0 0 o 0 0

L& umUR

7. Setelah keluar berikut Klik Copy Object. Setelah itu buka
Microsoft Word, tempatkan krusor pada tempat yang diinginkan
dan Klik Edit » paste.

= Output1 - SPSS Viewer
File N Wiew Insert Format Analyze Graphs Uhlties Window Help

t|k| 2 & |

cut Crii
| copy Chrl+C
Copy objecks
Paste After Chri+y
Paste Special...
Delete Del
Select All Cri+a
Select »

{requencies

Qutline 3 Statistics

Options...

GOL_PAMG | JAB_FUNG [ MAS_KER IJATAH JEN_KEL UMUR
N Valid 81 81 a a1 81 a1
Missina n n n n n n

8. Dikarenakan SPSS itu menggunakan basic language Bahasa
Inggris, maka outputnya juga menggunakan Bahasa Inggris.
Untuk mengeditnya dilakukan dengan cara sebagaimana tata cara
mengedit gambar. Sebagai contoh kita akan mengedit tabel
GOL_PANG, yaitu tabel tentang golongan kepangkatan dosen
maka klik gambar tersebut, lalu klik tombol kanan mouse, lalu
klik sub menu Edit Picture..., maka akan keluar gambar berikut
ini:

Setelah keluar gambar seperti di atas, klik pada tulisan yang
akan diedit dan gantilah sesuai dengan kebutuhan.

Apabila dicermati output SPSS di atas, ada penyajian data
tentang Masa Kerja dan Umur yang terlalu panjang dan hal itu
mengakibatkan pemahaman terhadap data tersebut agak sulit. Untuk
mengatasi hal tersebut, maka tabel distribusi frekuensi tersebut perlu
dibuat berdasarkan kelas data. Salah satu cara untuk menentukan
jumlah kelas adalah dengan menggunakan rumus Struges:
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K=1+33log-n

K =Jumlah klas interval
N = Jumlah data observasi
log = Logaritma

Dikarenakan jumlah data di atas berjumlah 81, maka jumlah
kelasnya adalah: 1 + 3,3 log.81 = 1+ (3,3.1,91) = 7,30 dan dapat
dibulatkan menjadi 7 kelas.

Selanjutnya rentang datanya dihitung dengan cara mengurangi
data terbesar dengan data terkecil. Untuk kasus data masa kerja paling
sedikit 1 tahun dan paling lama 35 tahun, sedangkan data umur paling
muda 27 tahun dan paling tua 62 tahun. Dari hasil pengurangan data
terbesar dengan data terkecil dan selanjutnya hasil pengurangan
tersebut dibagi dengan jumlah kelas, maka panjang kelas sekitar 5.

Dalam rangka memproses aplikasi selanjutnya dapat digunakan
sub menu recode dalam SPSS sebagai berikut:

1. Klik Transform » Recode » Into Different Variables. Pilihan
Different Variables dimaksudkan akan ada variabel baru sebagai
hasil recode tersebut, tetapi kalau yang diinginkan hasil recode
itu menggantikan variabel yang akan dibuat kategorinya, maka
pilihlah Into Same Variables.

statistik deskri| S Data Editor
File Edit View Dat:

fnalyzs Graphs Utilties Window Help

%@ - E::::r:\er;.l‘l.‘mber Seed... Pﬂ M @@
T:no

Caunt...

Mi‘— Categarize Variables... Yariables. —
Rank Cases...

2 Automatic Recode...
Create Time Series...
Replace Missing Yalues. ..

3000 52 Lakilaki| &1
3100 52| Laki-laki) 56
2800 52| Laki-laki 55
3000 52| Laki-laki 58
2200) 520 Laki-laki| 58

2. Setelah keluar gambar berikut, bloklah variabel yang akan
direcode, lalu masukkan dalam Numeric Variable » Output
Variable dengan cara mengeklik tanda gambar ». Setelah itu
berilah Nama variabel baru itu pada kolom di bawah Name dan
labelnya dari variabel tersebut pada kolom di bawah Label.
Setelah itu klik Old and New Values.

%)

w

=

i)

@
IR
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B Recode into Different Variables

A% no

4 gol_pang
@ jab_fung
@ ijazah
& jer_kel
& umur
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Numeric Yariable -> Output Y ariable: Output Varisble
Name:
[ Fot sk —_Chann |
Label:
K. ategori Masa Kerid
1.
Old and Mew Y alues...
| ‘ Beset | Cancel ‘ Help |

3. Setelah keluar gambar berikut, maka kita dapat membagi kelas
data menjadi 7 dan panjang kelasnya adalah 5, sebagaimana
dijelaskan di atas. Oleh karena itu kita dapat menggunakan batas
bawah dan batas atas terbuka. Dalam hal ini kita dapat
mengisikan dengan cara mengeklik Range yang ada lowest
through dan pada kotak tersebut diisi dengan 4,999. Setelah itu,
Isikan angka 1 pada kolom Value yang terdapat dalam New
Value. Selanjutnya klik Range yang isilah kotak yang ada di
bawahnya dengan angka 5 dan pada kotak disebelah kanan
through diisi dengan 9,999. Setelah itu, Isikan angka 2 pada
kolom Value yang terdapat dalam New Value. Dan seterusnya
sampai selesai. Sebagaimana tertera dalam gambar berikut.
Selanjutnya klik Continue.

Recode into Different Variables: Old and New Values E|

Old Y alue

" Suystem-missing

" Range:

& Walue: |

" System- or user-missing

New Valug

i+ Walue:  Spstemn-missing

" Copy old value(s]
Old --» New:

" Range:

" Range

——

Al other values

Lowest thry 4,999 > 1 -
I 10thu 14.933-> 3

5thu 9,999 > 2

16th 19.9399-> 4

20th 24.939 -3 &

26thiu 23.999 -3 6 b’
[~ Output variables are strings ’_
-
Continue | Cancel | Help |

4. Setelah keluar gambar berikut ini, klik Change lalu klik Ok.

B Recode into Different Variables E|

Mi Murmeric Yariable -> Dutput Yariable: Olutpul Yariable
@ gol_pang Mame:
#rjab_fung m Kat_Mask Change
Piazsh Labet
@ ien_kel K.ategor Masa Kerd
A umur

If

0ld and New Yalues...

| | Reset ‘ Cancel | Help ‘
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5. Dikarenakan dalam recode tersebut, dipilih Into Different
Variables, maka akan ada tambahan satu variabel dalam
lembaran SPSS Data Editor sebagaimana terlihat pada gambar
berikut.

statistik deskriptif - SPSS Data Editor.

Fle Edt View Data Transform Anakyze Graphs Utiities Window Help

=|d |8 B || 2| =[0| o FlE EEE S 9
1:no 1
nao | gol_pang | jab_fung | mas_ker |ijaza| jen_kel |umur| kat_mask
1] Iv/c lektor 3500 52| Lakilaki| 62 =30
212 Ivic|  Lektor Kepala 30000 32| Lakilaki] &1 =30
3|3 I/ lektar 31000 52| Lakilaki| 56 =30
4[4 Wb Lektor Kepala 26000 52| Laki-laki] 55 25=288
=1 Iw/h lektar 30000 52| Lakilaki| 56 =30
B|E Wb Lektor Kepala 22000 52| Laki-laki| 58 20=248

6. Dalam recode sudah dibagi menjadi 7 kelas dengan diberi atribut
1 sampai dengan 7. Agar program SPSS mengenali yang
dimaksud dengan 1 sampai dengan 7, maka dibuat values,
dengan cara buka Variabel View, lalu klik pada value di baris
variabel yang diberi skor kategori/valuenya, dan buatlah value
tersebut dengan cara ketik 1 pada kolom value dan pada kolom
Value Label ketik < 4,9, lalu klik add, begitu seterusnya.

=|R|S| 8] || O k|| 5| Ele| SEE [ 2
4 Decimals Values

Mane
(1,00, 1lia),
{100, calon do

Walue Labels

G

3

3 3

< Cancel Nane r
8 vaelabet | {100,813 b
o T Help {1, Laki-laki} .}
y ;“E{S,B” Mane I

3
3

) ol b<a [T, < 49] ]
o e ur (1,00, < 31.3]..

7. Ketika variabel baru tersebut akan dibuat tabel distribusi
frekuensi caranya adalah klik Analyze » Descriptive Statistics
» Frequencies. Setelah itu bloklah variabel yang telah
dikategorisasi lalu masukkan pada kolom Variable(s) dengan
mengeklik tanda gambar ». Setelah itu klik Ok.

8. Berikut ini adalah Output dari tabel distribusi frekwensi tersebut.
Frequencies

Statistics

Kategori Kategori
Masa Kerja Umur
N Valid 81 81

Missing 0
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Frequency Table

Kategori Masa Kerja

Cumulative
Frequency | Percent Valid Percent Percent

Valid <49 27 333 333 333

5>99 30 37,0 37,0 704

10> 14,9 8 9,9 9,9 80,2

15>19,9 5 6,2 6,2 86,4

20> 24,9 3 3,7 3,7 90,1

25>29,9 3 3,7 3,7 93,38

> 30 5 6,2 6,2 100,0
Total 81 100,0 100,0

Histogram

Kategori Masa Kerja

40

Std. Dev = 1,73
Mean =25
0 N=281,00

1,0 20 30 40 50 60 7,0

Kategori Masa Kerja

Walaupun deskripsi data di atas sudah memberi pemahaman
yang mudah terhadap data, tetapi penyajian data seperti itu masih
sangat umum. Memang, selama ini kebanyakan peneliti pemula tidak
mengolah data mentah yang didapatkan dari lokasi penelitian untuk
disesuaikan dengan topik penelitian. Seharusnya data tersebut
disajikan dengan memperhatikan topik penelitian.

Contoh:

Seorang peneliti yang mempunyai topik penelitian tentang
pengaruh gaya kepemimpinan terhadap produktifitas kerja
dosen, maka peneliti perlu mentabulasikan data dosen yang
terkait dengan pangkat dan jabatan fungsionalnya. Hal ini
diperlukan mengingat salah satu cara untuk mengukur
produktifitas kerja dosen adalah dengan melihat apakah jabatan
fungsional dosen itu lebih tinggi dibandingkan dengan posisi
pangkat yang melingkupinya.

Untuk memperjelas hal ini dapat ditabulasikan data dosen di atas.
Sedangkan cara sebagai berikut:
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1. Setelah data diinput pada lembaran SPSS Data Editor, maka klik
Analyze » Descriptive Statistics » Crosstabs, sebagaimana
gambar berikut.

statistilc deskriptif - SPSS Data Editor

File Edit View Data Transform

Compare Means
General Linear Model

Ze| S| =] || L]
1:ra n
no | gol_pang |
1 i
2|2 Iie
EE D)
s i
55 /b
EE i
77 i
EE /b
ala D)
1010 i
1111 Iia

Mixed Madlels

L corelate
Regression

L Loginear
Classify

| DakaReductio

[ Seele

Nenparametric Tests

Time: Series
Survival
Multiple Respo

L missing value Analysis.. 52

Graphs Utilties

window  Help

0 Frequencies
> Descriptives...
»
" kat_mask |+
. >30
» . =30
» |52 Lakilaki 55 >30
» 1S2| Lakilaki 55| 25>289
v 52 Lakilaki 55 >30
n 52| Lakilaki 58| 20>249
v |81 Lakidaki| 80| 25>299
» 133 Lakidaki 54 20248
, 152 Lakilaki 45| 10>149
nse , |52 perempuan| 47| 20>249

Laki-laki 46

16199

Pl e T e

2. Masukkan variabel gol_pang pada kolom Row(s), dan variabel
jab_fung pada kolom Column(s) dengan mengeblok variabel tadi
dan mengeklik tanda gambar », setelah itu klik OK.

H Crosstabs

&} no

s> mas_ker

& ijazah

> jen_kel

& umur

%> Kategori Masa Kerja [k
4 Kategori Umur [kat_um:

N

Rowls):

< gol_pang

Column(s):
o fung.

Layer 1 of 1

J

" Display clustered bar charts

[” Suppress tables

Exact... |

Statistics... |

!

Cells... | Format..

Paste
Reset
Cancel

Help

OK

HHHNS

3. Berikut ini adalah output aplikasi di atas.

Case Processing Summary

Cases
Valid Missing Total
N Percent N Percent N Percent
GOL_PANG * JAB_FUNG 81 100,0% 0 ,0% 81 100,0%
GOL_PANG * JAB_FUNG Crosstabulation
Count
JAB FUNG

calon dosen | Asisten Ahli lektor Lektor Kepala | Guru Besar Total
GOL_PANG llla 7 2 0 0 0 9
/b 4 24 0 0 0 28
liie 0 0 13 0 0 13
lid 0 0 11 1 0 12
V/a 0 0 1 9 0 10
Vb 0 0 2 4 1 7
Vic 0 0 1 1 0 2
Total 11 26 28 15 1 81
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Tabel di atas memperlihatkan ada 4 orang dosen yang
produktifitas akademiknya rendah mengingat mereka sudah
berpengkat IV/a, IV/b, dan IV/c tetapi masih mempunyai jabatan
fungsional lektor. Di samping itu ada 2 orang yang mempunyai
produktifitas akademik tinggi karena salah satunya mempunyai
jabatan fungsional lektor kepala padahal pangkatnya baru I1l/d,
sedangkan satu lainnya sudah mempunyai jabatan fungsional Guru
Besar padahal ia baru mempunyai pangkat IV/b.?

C. Aplikasi untuk Penyajian Data dengan Microsoft Excel

Untuk menyajikan data dengan program Microsoft Excel, baik
dalam bentuk tabel maupun grafik tidak selengkap SPSS di atas.
Dalam aplikasi ini akan dicontohkan penyajian data tentang masa
kerja dosen di sebuah Perguruan Tinggi Agama Islam di atas. Salah
satu langkah yang dapat ditempuh adalah sebagai berikut:

1. Input data tentang masa kerja dosen tersebut.

2. Setelah itu, buka sub menu Data Analysis..., dengan cara klik
Tools » Data Analysis..., sebagaimana gambar berikut ini.

E3 Microsoft Excel - statistik deskriptif

@ File Edit View Insert Farmat | Tools | Data  Window Help
0O = = & [& w3 - Add-Ins... > Arial
02 - A 35 Options. ..
A B C [n] | Data Analysis. ., |3
1 |MO [PANGKAT [JABFUNGS |MASA KE ¥ UR
2 7 3 5 z 1 G
3 2 7 4 30 2 1 &1
4 3 3 Z # 2 1 56
3. Setelah keluar gambar berikut ini pilihlah Histogram lalu klik
Data Analysis [ J
Analysis Tools
Ok
Anowva: Two-Fackor \Without Replication j -
Correlation C. |
Covariance ﬁ
Descriptive Statistics
Exponential Smoothing Help
F-Test Two-Sample for Variances

Fourier Analysis

Moving Average
Random Mumber Generation j

4. Setelah keluar gambar berikut ini bloklah data yang telah diinput
tentang masa kerja dosen. Setelah itu aktifkan/pilihlah Label,

SUntuk mendapatkan penjelasan tentang kepangkatan dosen dan jabatan
fungsionalnya baca Keputusan Mendiknas nomor: 36/D/O/2001 tertanggal 4 Mei 2001
tentang Juklak. Baca Suwito dkk., Buku Pedoman Tenaga Akademik Perguruan Tinggi

Agama Islam dan PAI pada PTU, (Jakarta: Dirjen Binbaga Islam Depag RI, 2003), him.
70-93.
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Pareto (sorted histogram), Cumulative Percentage, dan Chart
Output. Setelah itu klik Ok.

Histogram @E‘
Input
Ok
Input Range: $D§2:40482 Y -
Cancel
Bin Range:
[ Labels %

Output options

" Output Range:

& Mew Worksheet Ply:
7 Mew Workhook

I8

[¥ Pareto {sorked histogram)
v

5. Gambar berikut ini adalah hasil dari aplikasi tersebut.

B3 Microsoft Excel - statistik deskriptif

&) Fle Edt Vew Iset Fomat Toos Data Window Help

DEES &R & v- &= -4 |lE 2w -0 - B[7|u EEEEF %, W3 E
Al - f Bin
A | B [ ¢ [ o | e [ F G H | J K L [
1 Bin _ Frequency umulative ¢ Bin  Frequency umuwative 6 N
2| i 5 7A0% E] 30 37 50%) Histogram
ER 5 21 3375% 5 21 6375% »
L4 ] B0 715% 1 6 7125% ) 200,00%
[5] 13 6 7875% 13 6 78,75% E 28 m WE?DUV./UU%
[E | 17 B B525% 17 6 B625% 2 e ==IFrequency
[ 7] 21 3 90,00% More 4 9125% a N g s Cumnulative %
[ 8| 25 1 9125% 21 3 8500%
=N p:] 3 9500% p:] 3 9B75% Bin
10 |more 4 10000% Pl 1 10000%
T

6. Hasil sebagaimana tertera di atas dapat diedit sesuai dengan
kebutuhan. Sebagai contoh tabel di atas dapat diedit menjadi
seperti berikut ini.

Interval Frekwensi Kumilatif % | Interval | Frekwensi Kumilatif %

1 6 7,50% 9 30 37,50%

5 21 33,75% 5 21 63,75%

9 30 71,25% 1 6 71,25%
13 6 78,75% 13 6 78,75%
17 6 86,25% 17 6 86,25%
21 3 90,00% More 4 91,25%
25 1 91,25% 21 3 95,00%
29 3 95,00% 29 3 98,75%

More 4 100,00% 25 1 100,00%

7. Sedang cara untuk mengedit gambar adalah dengan mengeklik
pada gambar tersebut, lalu klik kanan pada mouse. Selanjutnya,
editlah sesuai dengan keinginan. Sebagai contoh grafik di atas
dapat diedit menjadi seperti berikut ini.
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Histogram

60,00%
40,00%

T 20,00%

9 5 1 13 17 More 21 29 25

||:I Frequency ™=il= Cumulative %

Selain itu, untuk membuat grafik, Microsoft Excel juga
menyediakan ikon grafik.
Contoh 1:
Peneliti akan menampilkan perkembangan mahasiswa baru
Program Pascasarjana IAIT Kediri dengan tabel sebagai
berikut:

2003 | 2004 | 2005 | 2006 | 2007 | 2008
Laki-laki 13 19 18 25 46 46
Perempuan 2 2 4 3 19 17
Jumlah 15 21 22 28 65 63

1. Setelah data di atas diinput pada lembar kerja Microsoft Excel,
lalu diblok. Setelah itu, klik ikon grafik seperti gambar di bawah
ini.

E3 Microsoft Excel - perkembangan mhs pasca

File Edit ew Insert Format  Tools Data  Window Help
heEeda &k < - @@Ev%HI ? il
-

A1 & )

A | B | ¢ [ 0 | E@,”"ﬂﬂh_yT B
2003 2004 2005 2006 2007 2005

Laki-laki 13 19 18 25 46 45

Ferermpual 2 2 4 3 19 17

Jurmlah 15 21 2 25 55 53

n -b-|LAJ|r\J|—‘-
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2. Setelah keluar seperti berikut ini, pilihlah grafik sesuai dengan
kebutuhan. Setelah itu klik next.

Chart Wizard - Step 1 of 4 - Chart Type
Standard Types ] Custom Types }

Chart: type: Chart: sub-type:

[l olurn -
B Bar
;O

@ Doughnut

i Radar
@ Surface

®: Bubble

5o Stock

S

|_ EY (Scatker)
hly Area

Line with markers displayed at each data
walue.

Press and Hold ko view Sample

Cancel |

| Mext >

Finish

3. Setelah keluar seperti berikut ini, klik next.

Chart Wizard - Step 2 of 4 - Chart Source Data.

Data Range I Series ]

—=— e rempran
Jumiak

o
@
£
" —— LaFaH
El
)

Data range:

Serles in:

&+ Rows

 Columins

Cancel |

< Back. | et =

Einish

4. Setelah keluar seperti berikut ini, klik Titles, lalu pada kolom
Chart Title ketiklah judul grafik yang diinginkan, lalu pada
Category (X) axis (horisontal) ketiklah sesuai kebutuhan, dan

pada Value (Y) axis (vertikal) Kketiklah sesuai

kebutuhan.

dengan
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Chart Wizard - Step 3 of 4 - Chart Options

Titles I Aes ] Gridines 1 Legend I Data Labels DataTabIe]
Chart title:
EANGAN MAHASISYWA BARL PERKEMBANGAN MAHASISWA BARL
Category (X) axis: 0
Tahun =
E]
Yalue () axis: w A |[[amm
0 —=— Perempran
- Juniak
» - -
,7 0
N P ——
MO 04 NS 206 0T 208
Tahun
@ Cancel | < Back. | Mext = I Einish |

5. Apabila keterangan tentang laki-laki dan seterusnya ingin

diletakkan di bawah grafik, maka klik Legend, lalu pilihlah
Bottom.

Chart Wizard - Step 3 of 4 - Chart Options

Legend

Titles ] Ayes ]Grldhnes Data Labels

Data Table ]
¥ Show legend

PERKEMBANGAN MAHASISWA BARU
Placement

— =
N ———
s W

Tahun

—— LHFEH —s— Peremprar ik

oz HEEY B2

Er R T @ e

Cancel |

< Back. | Mext = I

Einish

6. Apabila skor/angka jumlah mahasiswa ingin disajikan pada
grafik, maka klik Data Labels lalu klik Value. Setelah itu klik

next.

Chart Wizard - Step 3 of 4 - Chart Options

Tiles | axes | Gridines | Legend  Datalabels | DataTable |
Label Contains
W PERKEMBANGAN MAHASISWA BARU
[ Category name b
L) &3
W value =
El
r o b
r £
B
oy -
Separator: - o i ——af
e Wel WS mE W mE
Tahun
™ Legend key
@ Cancel | < Back. | Mext = I Einish |

7. Setelah keluar gambar berikut ini klik Finish.
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Chart Wizard - Step 4 of 4 - Chart Location

Place chart:

Cancel ‘ < Back. | | Einish I

8. Berikut ini adalah hasil pembuatan grafik tersebut. Grafik
tersebut agar lebih indah dapat diedit sesuai dengan kebutuhan,
baik terkait dengan background maupun warnanya.

PERKEMBANGAN MAHASISWA BARU

70
65
60 63

50

a4 46
40

30

20 A ')')/’Aég
%g/' Lo —— I3 /._.l‘ﬁ\. 17
10 =

2003 2004 2005 2006 2007 2008

Tahun

—e— Laki-laki —=— Perempuan Jumlah

Contoh 2:

Seorang dosen yang merasa mendapatkan perlakuan tidak adil
dari atasannya ketika ~mengajukan kenaikan jabatan
fungsionalnya ke Lektor Kepala karena permohonannya tidak
mendapatkan tanggapan semestinya bahkan angka kreditnya
mendapatkan penilaian yang sangat rendah dan sebagian di
antaranya melanggar aturan, maka dosen tersebut mengajukan
kepada instansi yang ada di atasnya untuk diberikan penilaian
ulang. Akhirnya berkas yang sudah dinilai oleh Sekolah Tinggi
tersebut dinilai ulang dan mendapatkan Penetapan Angka
Kredit dari Diknas.

Cara untuk menampilkan data di atas dalam bentuk grafik
adalah sebagai berikut:
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1. Setelah data di atas diinput pada lembar kerja Microsoft Excel,

lalu diblok. Setelah itu, klik ikon grafik seperti gambar di bawah
ini.

E3 Microsoft Excel - Book1

@ File Edit ew Insert Formak Tools Data Window  Help

DeEdaSy &V &8 - & =-2]

Al - o ’
4 | B | ¢ | | E |F H
1 POIN A POINE POIM ¢ POIN D JNML /
2 |BTAIN 195 53 T 9 BES
3 |DIKHAS 103 107 24 38 272
&

2. Setelah keluar seperti berikut ini, model grafik yang diinginkan,
sebagai contoh dipilih Custom Types lalu diklik Colums with
Depth. Setelah itu klik next.

Chart Wizard - Step 1 of 4 - Chart Type

Standard Types — Custom Types l

Chart bype: Sample:
iy 2t Blocks -
30
o Area
il B2 Column e
lufly B2/ Line - Timescale 20
@ pe P.Ie = TTTAN
3 Elue Pie
o4 Calored Lines e
kil “olumn - Area Eil
I §=alumns with Depth o ’
& Cones POIN POIN POIN PO JRIL
B Floating Bars j foE D
Select from
. 3-D column chart on a right-angled (2-0)
™ User-defined [y
(% Built-in

Cancel | | Mext = | Einish

3. Setelah keluar seperti berikut ini, klik next.
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Chart Wizard - Step 2 of 4 - Chart Source Data

[ata Range l Series l

PN & POINE POINC P3N D JmL

30
230
200
15 @OSTAIN
| OIFN AT
(11}
: l
1]

[Data range: ]
Series in: * Rows
™ Colurnns
Cancel | < Back. | Mext = | Eimish |

4. Setelah keluar seperti berikut ini, klik T

itles, lalu ketik

PERBANDINGAN PENILAIAN ANGKA KREDIT DOSEN,
kakalu direncanakan angka kredit langsung tertera di atas grafik,

maka pada Axes, Value (Z) axis dinonaktifkan.

Chart Wizard - Step 3 of 4 - Chart Options

Titles fxes ] Gridines l Legend ] Data Labels l Data Tablz l

Prirnary axis
W Cateqory (%) axis PERBANDINGAN PENILAIAN Al
{* Automatic
(" Categary
" Time-scale

KREDIT DOSEN

-
[

#s.

POINA POINE POING POIND JML

NGHA

OSTAIN
B DIFNATH

@ Cancel | < Back | Mext = |

Finish |

5. Apabila keterangan tentang STAIN dan

DIKNAS ingin

diletakkan di bawah grafik, maka klik Legend, lalu pilihlah

Bottom.



69 Statistika untnk Penelitian Pendidikan

Chart Wizard - Step 3 of 4 - Chart Options

Titles ] Axes IGridIines Legend | DataLabels | Data Table

Iv show legend
PEREANDINGAN PENILAIAN ANGKA
Plac KREDIT DOSEN

o
" Corner
" Top
" Right

.-

POINA POINE POING POIND  JML

El Cancel | < Back. | Mext = I Finish |

6. Apabila skor/fangka jumlah mahasiswa ingin disajikan pada
grafik, maka klik Data Labels lalu klik Value. Setelah itu klik

next.

Chart Wizard - Step 3 of 4 - Chart Options

Titles l fes ]Gridlines Legend Datalabels | Data Table

Label Contains

[ Seties name FEREBANDINGAN PENILAIAN AHGKA

KREDIT DOSEN
r Category name

POINA POINE POINC POIND  JRL

[ Legend key [a=TAm mDES]

@ Cancel | = Back | Mext = | Finish |

7. Setelah keluar gambar berikut ini klik Finish. Berikut ini adalah
hasil pembuatan grafik tersebut. Grafik tersebut agar lebih indah
dapat diedit sesuai dengan kebutuhan, baik terkait dengan
background maupun warnanya.
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PERBANDINGAN PENILAIAN ANGKA KREDIT
DOSEN

|

POINA POINB POINC POIND JML

O STAIN B DIKNAS I

8. Berikut ini adalah hasil suntingan outpout di atas.

70

PERBANDINGAN PENILAIAN ANGKA KREDIT DOSEN

STAIN B DIKNAS I

Demikianlah langkah-langkah dalam pembuatan tabel maupun
grafik dengan menggunakan SPSS maupun Microsoft Excel.
Selanjutnya akan dipaparkan cara untuk menyajikan ringkasan data
Statistik, yaitu penyajian data yang digunakan untuk menjelaskan
pemusatan dan penyebaran data.
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D. Aplikasi untuk Penyajian Pemusatan, Penyebaran, dan Distribusi

Data dengan SPSS

Untuk contoh aplikasi ini digunakan data tenaga edukatif di
sebuah Perguruan Tinggi Agama Islam yang sudah ditampilkan tabel
dan grafiknya di atas.

1. Setelah file data tersebut di buka, maka klik Analyze »
Descriptive Statistics » Descriptives, sebagaimana gambar
berikut ini.

S5 Data Editor

‘orm WepEWEEN Graphs  Ltilities

Window  Help

J Reports L B ===l N =l |
Descripkive Statiskics Frequencies...
1 Tahbles 3 Descriptives. ..
Compare Means .3 Explore. ..
J General Linear Model 4 Crosstabs. ..
Mixed Models 3 Reatio...
L Correlate »

2. Setelah keluar gambar sebagaimana berikut ini, bloklah variabel-
variabel yang akan dicari pemusatakan, penyebaran, dan
distribusi datanya; lalu klik anak panah sehingga variabel-
variabel tersebut berpindah ke kolom Variable(s). Setelah itu
klik Options...

I Descriptives E\
Variable[s]: I:I

Reset

@

“ Kategori Masa Kerja [ka Cancel

< Kategori Umur [kat_umu
Help

[” Save standardized values as variables Options...

3. Setelah keluar gambar sebagaimana berikut ini, Klik pada kotak
yang ada di depan pilihan-pilihan yang akan ditampilkan dalam
ringkasan data. Misalnya dalam latihan ini dipilih yang akan
ditampilkan dalam ringkasan data seperti di bawah ini. Setelah
itu klik Continue.
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Descriptives: Options E‘

Display Order

(« Variahle list
" Alphabetic
" Ascending means

" Descending means

Dispersion Cancel |
Iv Std. deviati v Minl
Help
¥ Variance V¥ Maximum
v Range ¥ S.E. mean
Distribution
¥ Kurtosis v iSkegnessé

4. Setelah keluar gambar sebagaimana berikut ini, Klik Ok.

M Descriptives

5. Berikut ini adalah output dari aplikasi di atas.

<> Kategori Masa Kerja [ka'
< Kategori Umur [kat_umu

Variable(s]:

# gol_pang
& jab_fung
> mas_ker
@ ijazah
E & jen_kel

& umur

[~ Save standardized values as variables

B
_ox |
et |
e |
_Gance |
IETH

OK
Paste
Reset

Cancel

Help

Descriptive Statistics

GOL PANG | JAB FUNG | MAS KER IJAZAH JEN KEL UMUR Valid N (listwise

N Statistic 81 81 81 81 81 81 81
Range Statistic 6,00 4,00 34,00 2,00 1 35
Minimum Statistic 1,00 1,00 1,00 1,00 1 27
Maximum Statistic 7,00 5,00 35,00 3,00 2 62
Mean Statistic 3,1852 2,6173 9,7160 1,9383 1,28 39,21
Std. Error ,1793 ,1091 ,9143 ,0366 ,05 ,94
Std. Deviation ~ Statistic 1,61331 ,98194 8,22836 ,32961 ,454 8,504
Variance Statistic 2,603 ,964 67,706 ,109 ,206 72,318
Skewness Statistic ,588 ,028 1,537 -1,207 ,976 1,161
Std. Error ,267 ,267 ,267 ,267 ,267 ,267
Kurtosis Statistic -,655 -,700 1,708 5,980 -1,074 ,691
Std. Error ,529 ,529 ,529 ,529 ,529 ,529

Perlu diketahui bahwa tipe data gol _pang, jab_fung, ijazah,
dan jen_kel adalah data kategori, sedangkan mas_ker dan umur
adalah data rasio.

Kategorisasi yang dimaksud adalah sebagai berikut:

GOL_PANG JAB_FUNG IJAZAH JEN_KEL
1| =1Ill/a 1 | = Calon Dosen 1|=81 1 | = Laki-laki
2 | =1l 2 | = Asisten Ahli 2 | =82 2 | = Perempuan
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3 | =l 3 | = Lektor 3 |=S3
4 | =1ld 4 | = Lektor Kepala

5| =1IV/a 5 | = Guru Besar

6 | =IV/b

7 | =IVlc

Output di atas dapat menampilkan tentang pemusatakan data
(mean), penyebaran data (range, minimum, maximum, standard error
of mean, standard deviasi, dan variance), dan distribusi data
(skewness, kurtosis, dan standard errornya).

Untuk memperjelas prosedur statistik yang menghasilkan
output di atas akan ditampilkan dengan aplikasi Microsoft excel
dengan cara menjabarkan rumus-rumus yang terkait. Sedangkan
aplikasi Data Analysis dalam Microsoft Excel juga akan langsung
menampilkan output tanpa diketahui prosedurnya.

E. Aplikasi untuk Penyajian Pemusatan, Penyebaran, dan Distribusi
Data dengan Microsoft Excel

Microsoft Excel juga mempunyai menu yang dapat
menampilkan statistik deskriptif dan statistik inferensial secara cepat
tanpa melalui aplikasi rumus-rumus statistik yaitu dengan
menggunakan menu Data Analysis. Sebagai contoh untuk aplikasi
ini adalah penyajian statistik deskriptif tentang masa kerja tenaga
edukatif yang juga ditampilkan dengan SPSS di atas. Sedangkan
langkah-langkahnya adalah sebagai berikut:

1. Setelah data diinput, lalu klik Tools » Data Analysis...

Ed Microsoft Excel - statistik deskriptif

File Edit Wiew Insert Format | Tools | Data  wWindow  Help
DEEa &R i Ips.. i
Fiw] - A Options. ..
A, E [ ] | Data Analysis... |3
1 [NO|PANGKAT [JABFUNGS [MASA KE ¥ UR
= el ~l ~l ~ 1 ~l ~l o |

2. Setelah keluar gambar seperti di bawah ini, klik dua kali secara
cepat Descriptive Statistics.

Data Analysis 5 J
Analysis Tools
= [o]4
Anova: Two-Factor Without Replication ﬂ -
Cancel
e istics
othing J Help
F-Test Two-Sample for Wariances

Fourier Analysis
Histogram
Moving Average

Randorn Mumber Generation j
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3. Setelah keluar gambar seperti berikut ini, ketika krusor berada

keluarnya hasil

pada kolom Input Range, maka bloklah seluruh data yang berada
pada kolom Masa Kerja. Jikalau nama variabel (Masa Kerja)
akan ditampilkan data output, maka nama variabel itu harus juga
diblok, dan pada kotak Label in First Row harus diklik.
Selanjutnya klik kotak Summary Statistics lalu klik Ok.

Input
Input Range:
Grouped By: {+ Columns ﬂ
" Rows Help
[V Labels in First Row
Qukput options
" Qutput Range: %
& Mew Warksheet Ply:
" Mew Workbook
[¥ Summary statiskics
[ Confidence Level For Mean: 95 kK
[ Kth Largest: 1
[ Kth Smallest: 1
Berikut ini adalah output dari aplikasi di atas. Apabila

dibandingkan dengan aplikasi SPSS di atas ternyata hasilnya
sama. Bedanya kalau dalam aplikasi SPSS standard error dari
skewness dan kurtosis ditampilkan sedangkan dalam Microsoft
Excel kedua hal itu tidak ditampilkan.

MASA KERJA
Mean 9,716049383
Standard Error 0,914261925
Median 7
Mode 7
Standard Deviation 8,228357321
Sample Variance 67,7058642
Kurtosis 1,708296047
Skewness 1,537190627
Range 34
Minimum 1
Maximum 35
Sum 787
Count 81

Dalam rangka menjelaskan prosedur yang harus dilalui sampai
berbagai ringkasan data di atas, maka akan

diaplikasikan berbagai rumus statistik yang terkait.
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Rumus mean (rata-rata):
Me = L%
n
Rumus varians untuk populasi:

o 2 =X

o =
n

Rumus standard deviasi untuk populasi:

Z(Xi - X)2
n
Rumus varians untuk sampel:

SZ _ Z(X| _X)2
(n-1)
Rumus standard deviasi untuk sampel:

Z(Xi - X)2
(n-1)
Rumus Standard error of mean:
S
E=—

Jn

S =

Rumus Skewness:

) iZ:‘[xi—Y]s
o = () )

Rumus Kurtosis

nn+1] >l -] { 3fn-1p }
[

S ey e ey A n-2]n-3]

Keterangan:
Me= Mean (rata-rata)
Y. = Epsilon (baca jumlah)
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Xi = Nilai X ke i sampai ke n
n =Jumlah individu

o® = Varians populasi

o = Simpangan baku populasi
s = Varians sampel

s = Simpangan baku sampel

Cara untuk mencari mode adalah menghitung nilai yang
sering muncul dalam kelompok data tersebut. Sebagaimana
digambarkan pada halaman 24 diketahui bahwa nilai yang paling
sering muncul dari data masa kerja adalah 4 dan 7 yang kedua-
duanya muncul sebaganyak 11 kali. Artinya, dari 81 tenaga edukatif
ada 11 orang yang mempunyai masa kerja 4 tahun dan ada 11 orang
juga yang mempunyai masa kerja 7 tahun.

Sedangkan cara untuk mencari median adalah dengan
mengurutkan nilai dari terkecil kepada nilai terbesar atau sebaliknya,
selnjutnya ditentukan nilai tengahnya. Apabila jumlah datanya genap,
maka dua data yang ada ditengah dijumlahkah lalu dibagi dua.
Karena data masa kerja di atas karena belum urut, maka perlu
diurutkan dengan cara:

1. Klik Data » Sort, sebagaimana gambar berikut ini:

E Microsoft Excel - statistik deskriptif.
Ei\e Edit  View Insert Format  Tools | Daka | Window  Help

DEEaE SRY & e 8l s
A2 A 3 Fllter
A B c Form...
1 NIASAKERJA‘ Subkotals...

Validation.

Table

Text ta Columns. ..

2. Apabila keluar gambar sebagaimana berikut ini dan data yang
akan diurutkan sedah tertera Sort by, maka selanjutnya pilihlah
ascending apabila akan diurutkan dari data terkecil ke terbesar,
dan pilihlah descending apabila akan diurutkan dari data terbesar
ke data terkecil. Setelah itu klik Ok.

Sort @EI

* pscending
" Descending

Then by

= * Ascending

" Descending
Then by

- * pscending

™ Descending
My list has

 Header row " Mo header row

Cptions... | [s]4 Cancel
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Selanjutnya data masa kerja tersebut akan dihitung rata-rata,
standard error of mean, varians, stadard deviasi, skewness, dan
kurtosisnya. Aplikasi dari penghitungan tersebut adalah dengan cara
menjabarkan rumus-rumus yang sudah dipaparkan di atas. Adapun
langkah-langkahnya adalah sebagai berikut:

1. Menjumlah seluruh nilai dari data masa kerja.

2. Membagi hasil penjumlahan tersebut dengan jumlah data (81).
Hasil pembagian ini disebut rata-rata (mean)

Mengurangi masing-masing nilai dengan rata-rata.
Mengkwadratkan hasil pengurangan yang ada di nomor 3.
Menjumlah hasil pengkwadratan yang ada di nomor 4.

Hasil penjumlahan yang ada di nomor 5 dibagi jumlah data
dikurangi 1 (81-1). Hasil pembagian ini disebut varians sampel.

7. untuk mengetahui standard deviasi sampel, carilah akar dari
varians sampel di atas.

8. Untuk mencari skewness dimulai dengan cara masing-masing
skor hasil pengurangan yang ada di nomor 3 dipangkatkan tiga.
Selanjutnya  dijumlahkah  hasil  pengkuadratan tersebut.
Berdasarkan hasil penjumlahan tersebut dan skor standard deviasi
dapar diaplikasikan rumus skewness.

9. Untuk mencari kurtosis dimulai dengan masing-masing skor hasil
pengurangan yang ada di nomor 3 dipangkatkan empat.
Selanjutnya  dijumlahkah hasil pengkuadratan  tersebut.
Berdasarkan hasil penjumlahan tersebut dan skor standard deviasi
yang sudah diketahui dapat diaplikasikan rumus kurtosis.

Untuk lebih jelasnya aplikasi tersebut dapat disimak pada
contoh aplikasi pada halaman berikut.

Dari seluruh hasil deskripsi SPSS, hanya standard error of
skewness dan standard error of kurtosis yang tidak diketahui
rumushya. Dua standar kesalahan yang disebutkan terakhir memang
tidak ditampilkan ketika menggunakan aplikasi Data Analysis. Dari
seluruh buku statistik yang penulis miliki tidak ada satupun yang
menjelaskan hal tersebut. Sedangkan cara untuk mengetahui range
adalah dilakukan dengan cara mengurangi nilai tertinggi dengan nilai
terendah. Untuk contoh data di atas adalah 35 — 1 = 34.

o 0k~ w
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Excel, maupun menjabarkan rumus-rumus dengan Micrososft Excel)

ternyata mempunyai hasil yang sama.

ICroso

Dari ketiga cara di atas (SPSS, Data Analysis dari

Data masa kerja tenaga edukatif di atas memperlihatkan bahwa
rata-rata masa kerjanya adalah 9,7 tahun. Sedangkan rentang rata-rata
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tersebut dapat diketahui dengan output dari standard error of mean
yang bernilai 0,9 tahun. Hal ini berarti rentang rata-rata masa
kerjanya adalah antara 8,8 tahun sampai dengan 10,6 tahun. Cara
untuk mengetahui rentang rata-rata tersebut adalah rata-rata dikurangi
dan ditambahkan dengan standar kesalahan rata-ratanya. Sedangkan
median dari data tersebut adalah 7 tahun. Median ini memperlihatkan
bahwa 50% tenaga edukatif di sekolah tinggi tersebut mempunyai
masa kerja kurang dari 7 tahun dan 50% lainnya mempunyai masa
kerja lebih dari 7 tahun. Sedangkan data masa kerja tenaga edukatif
tersebut mempunyai bimode, karena nilai data yang paling sering
muncul adalah 4 dan 7. Karena nilai 4 dalam urutan data muncul
lebih dahulu, maka aplikasi SPSS menyajikan 4 sebagai mode. Dan
karena nilai 7 muncul mendekati median, maka Microsoft Excel
menyajikan 7 sebagai mode.

Seluruh penyajian di atas sering dikategorikan dengan
penyajian pemusatan data. Sedangkan penyajian tentang penyebaran,
keragaman, dan bentuk distribusi data akan dijelaskan kemudian.

Keragaman data tersebut dapat diketahui dari skor varians,
yaitu 67,7, sedangkan simpangan baku dapat diketahui diketahui dari
skor standard deviasi yang merupakan akar dari skor varians, yang
dalam data ini adalah 8,2. Simpangan baku ini dapat digunakan untuk
mengetahui posisi nilai individu bila dibandingkan dengan nilai rata-
ratanya. Bila dikaitkan dengan prosentase luas kurva normal dalam
rangka mengetahui normalitas distribusi data, maka jumlah individu
yang berada antara mean ditambah dan dikurangi 1 standard deviasi
adalah 68%, dan 95% berada antara mean ditambah dan dikurangi 2
standard deviasi, dan 99% berada antara mean ditambah dan
dikurangi 3 standard deviasi.

Di samping diketahui dengan cara di atas, normalitas data juga
dapat diketahui dengan rumus skewness (kemencengan) dan kurtosis
(keruncingan) kurva. Apabila nilai mean lebih besar dengan mode,
berarti bentuk kurva tersebut menceng ke kanan, apabila mean,
median, dan mode mempunyai skor yang sama, maka bentuk kurva
tersebut simetris, selanjutnya apabila nilai mean lebih kecil dari
modus, maka kurva menceng ke kiri. Apabila digunakan aplikasi
SPSS atau Microsoft Excel dapat dijelaskan manakala skor skewness
positif (tidak ada tanda negatif) maka kurva menceng ke kanan, tetapi
manaka skornya bertanda negatif, berarti kurva tersebut menceng ke
kiri. Sedangkan untuk skor kurtosis, manakala skornya positif (tidak
ada tanda negatif), maka kurvanya berbentuk runcing (Leptokurtik).
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Manakala skor kurtosis bertanda negatif berarti kurvanya berbentuk
flat (platikurtik).

Contoh untuk data masa kerja tenaga edukatif di atas, karena
meannya (9,7) lebih besar dibanding dengan modenya (7), dan skor
skewness adalah 1,5 (yang tidak ada tanda negatif) menunjukkan
bahwa kurva menceng ke kanan. Bila digunakan skor kurtosis (1,7)
yang juga tidak ada tanda negatif menunjukkan bahwa bentuk kurva
tersebut adalah runcing (leptokurtik). Untuk membuktikan data
tersebut dapat ditampilkan dengan grafik histogram dengan disertai
garis kurva normalnya, sebagai berikut:

40

30

20

10

Std. Dev = 823
Mean =9,7
N =81,00

0:0 5,.0 10.,0 15.,0 20.,0 25.,0 36,0 35.,0
Masa Kerja Tenaga Edukatif
Sedangkan langkah-langkah untuk menampilkan histogram
dengan kurva normal dengan SPSS adalah sebagai berikut:
1. Klik Graphs » Histogram..., sebagaimana gambar berikut ini:

statistik deskriptif - SPSS Data Editor

slalsla] || ol eln o, B
1ino 1 Map »

no | gol_pang | jab_fung  Bar...

7,00 7 ne. o0
700 4 Arean 0
6,00
6,00
6,00
6,00
6,00
6,00
6,00
5,00 p 0o
500 4 . fii}

2. Setelah keluar gambar seperti berikut ini, masukkan data masa
kerja tenaga edukatif pada kolom variable. Lalu klik kotak yang
ada di depan Display normal curve, lalu klik Ok. Maka akan
keluar sebagaimana tampilan di atas.

1 Fe
: High-Low...

@
R

=2
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M Histogram g|
W Wariable:
® sb_fung LA [®neta —

o ijazah Paste

% ien_kel Template Reset

@ ::tjgori Masa Kerja [k I Use chart specifications from: Camcel

@ K.ategor Urmur [kat_urr Help
Titles...

Berbagai penjelasan di atas adalah termasuk statistik
Deskriptif. Sebagaimana dijelaskan pada Bab | bahwa statistik
deskriptif adalah statistik yang digunakan untuk menggambarkan
data atau menganalisis suatu hasil penelitian tetapi tidak digunakan
untuk generalisasi. Pada Bab Il sampai dengan Bab VI akan
dipaparkan tentang statistik inferensial. Statistik inferensial adalah
statistik yang digunakan untuk menganalisis data sampel dan hasilnya
akan digeneralisasikan.

Dalam setiap Bab kecuali Bab yang menjelaskan regressi akan
dipaparkan kedua macam statistik inferensial, yaitu parametris dan
non-parametris. Statistik parametris terutama digunakan untuk
menganalisis data interval atau rasio yang diambil dari populasi yang
berdistribusi normal. Sementara non-parametris terutama digunakan
untuk menganalisis data nominal atau ordinal. Atau datanya interval
atau rasio tetapi tidak berdistribusi normal juga menggunakan
statistik non-parametris.
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BAB IlI
UJI SATU SAMPEL

A. Pendahuluan

Pada dasarnya, pengujian hipotesis satu sampel adalah menguji
apakah hipotesis yang diajukan dapat digeneralisasikan untuk
populasi atau tidak. Atau apakah dapat dilakukan generalisasi untuk
populasi berdasarkan hasil kesimpulan dari sampel atau tidak.

Setidaknya ada 4 teknik analisis yang dapat digunakan untuk
menguji hipotesis satu sampel:

Jenis Data Deskriptif (Satu Variabel)
. Binomial
Nominal x> One Sample
Ordinal Run Test
Interval/Rasio T-Test

B. Statistik Parametris: T-test one Sampel

Statistik parametris yang digunakan untuk menguji hipotesis
yang datanya satu sampel adalah t-test one sample.

Contoh:

Seorang peneliti merasa tertarik untuk meneliti mengapa
Rasulullah diutus ke muka bumi ini untuk menyempurnakan
akhlak, tidak mencerdaskan intelektual. Hal ini ternyata terbukti
dari suatu penelitian psikologis di Amerika Serikat bahwa 1Q
ternyata rata-rata hanya berpengaruh 6% terhadap kesuksesan
seseorang. Berangkat dari hasil penelitian di Amerika Serikat
tersebut, peneliti akan membuktikan apakah pengaruh 1Q
terhadap kesuksesan seseorang di Indonesia juga rata-rata = 6%o.
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Proses Pengambilan Keputusan.

Hipotesis:

Ho Pengaruh 1Q terhadap kesuksesan seseorang di
Indonesia = 6%

Ha Pengaruh 1Q terhadap kesuksesan seseorang di

Indonesia # 6%
Dasar Pengambilan Keputusan:
Dengan membandingkan thiwng dengan tipe dengan ketentuan:
Ho diterima  thitung < tiapel
Ho ditolak thitung = teabel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)
Ho ditolak ~ Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

Untuk membuktikan apakah hasil penelitian psikolgis di
Amerika Serikat itu juga berlaku di Indonesia atau tidak, maka
diadakan penelitian serupa di beberapa kota dan kabupaten.
Sedangkan hasil penelitian tersebut adalah sebagai berikut:

NO Koefisien Korelasi Koefisien determinasi
1 0,25 6,25
2 0,26 6,76
3 0,29 8,41
4 0,25 6,25
5 0,25 6,25
6 0,23 5,29
7 0,24 5,76
8 0,27 7,29
9 0,25 6,25
10 0,27 7,29
11 0,22 4,84
12 0,21 4,41
13 0,22 4,84
14 0,28 7,84
15 0,27 7,29
16 0,25 6,25
17 0,25 6,25
18 0,26 6,76
19 0,26 6,76
20 0,22 4,84
21 0,25 6,25
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22 0,26 6,76
23 0,28 7,84
24 0,27 7,29
25 0,28 7,84
26 0,21 4,41
27 0,23 5,29
28 0,25 6,25
29 0,25 6,25
30 0,24 5,76
31 0,23 5,29
32 0,21 4,41
33 0,23 5,29
34 0,23 5,29
35 0,22 4,84
Keterangan:

a. Yang dimaksud dengan koefisien korelasi adalah hasil
hitung tentang korelasi skor 1Q dan skor kesuksesan.

b. Sedangkan koefisien determinasi adalah pengkuadratan skor
koefisien korelasi dikalikan 100.

Karena t-test one sample termasuk parametrik, maka skor
yang akan dianalisis harus diuji normalitasnya. Cara termudah
untuk menguji ini adalah dengan program SPSS.

Prosedur untuk menguji distribusi data adalah sebagai
berikut:

1. Setelah data diinput, lalu klik Analyze » Descriptive
Statistics » Explore, sebagaimana gambar berikut ini:

Untitled - SPSS Data Editon
File Edit VYiew Data Transform BEGEMEEN Graphs  Ukilties ‘Window Help

Reports P s lEEl melsd
= =11 =
_Iﬁ .' JESCH & Skatistics Frequencies. ..

1 one_samp B Tables
Compare Means

Descriptives...

one_samp ‘ wvar

»
»
General Linear Model ¥ Crosstabs...
1 | B25 ‘ Mixed Models ¥ Ratio...
2 324 Correlate 3

2. Setelah itu akan keluar gambar berikut ini, destinasikan
variabel itu ke dalam kotak Dependent List, lalu pada
bagian Display, klik kotak Plots, Kemudian klik kotak Plots.
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]
&

" Both © Statistics & Piols

Display

M Explore

)

Dependert List

< Skor kasfsien detemir
Paste

Reset
actor List:
Cancel

el el

Help

Label Caves by,

Plots. Dpions.

88

3. Setelah itu akan keluar gambar berikut ini, aktifkan kotak
Normality Plots with tests, lalu nonaktifkan pilihan stem
and leaf, kemudian pilih None pada bagian Boxplot, Setelah
itu klik Ok.

Explore: Plots

Boxplats

" Dependents together
* None

v Momality plots with tests
Spread vs. Level with Levene
-

Descriptive
" Eactor levels together | [ Stem-and-leaf

[ Histogramn

-
E [Haturalion ]
-

&
Cancel

Help

Test

4. Berikut ini adalah hasil analisis normalitas data tersebut.

Case Processing Summary

Cases
Valid Missing Total
N Percent N Percent N Percent

Skor koefisien

determinasi 35 50,0% 35 50,0% 70 100,0%

Tests of Normality
Kolmogorov-Smirnov? Shapiro-Wilk
Statistic df Sig. Statistic df Sig.

Skor koefisien

determinasi 1140 35 ,081 ,954 35 ,151

a. Lilliefors Significance Correction

Untuk menguji normalitas dapat digunakan skor Sig. Yang
ada pada hasil penghitungan Kolmogorov-Smirnov. Bila angka
Sig. Lebih besar atau sama dengan 0,05, maka data tersebut
berdistribusi normal, tetapi apabila kurang, maka data itu tidak
berdistribusi normal. Karena Sig. Untuk variabel tersebut (0,810),
itu lebih besar dari 0,05, maka data variabel itu berdistribusi

normal.
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Hal ini juga dapat dilihat pada grafik Normal Q-Q Plot

maupun Detrended Normal Q-Q Plot. Untuk Normal Q-Q Plot itu
apabila sebaran data dari variabel itu bergerombol di sekitar garis
uji yang mengarah ke kanan atas dan tidak ada yang terletak jauh
dari sebaran data, maka data tersebut berdistribusi normal.
Sementara untuk Detrended Normal Q-Q Plot, apabila datanya
tidak membentuk suatu pola tertentu atau menyebar secara acak,
maka data itu berarti berdistribusi normal. Sesuai dengan nilai
Sig. di atas, maka hasil uji dengan dua model grafik di bawah ini
juga menunjukkan data dari variabel itu berdistribusi normal.

Normal Q-Q Plot of Skor koefisien Detrended Normal Q-Q Plot of Skol

20 5 2

15

10 a 1

20 2 o
4 5 6 7 8 9 4 5 6 7 8 9

Observed Value Observed Value

Dikarenakan data variabel itu distribusi datanya normal,

maka dapat dilakukan analisis dengan t-test one sampel.

1.

Untuk menganalisis menggunakan t-test one sample klik
Analyze » Compare Means » One-sample T Test,
sebagaimana gambar berikut ini:

raphs Utlities  Window  Help

st » %D el
T—

File Edt View Data Transfo

Setelah keluar seperti berikut ini destinasikan variabelnya ke
kotak Test Variable(s), dan pada Test Value isilah angka 6
sebagaimana skor data dari hasil penelitian psikologis di
Amerika bahwa rata-rata hanya berpengaruh 6% dan
maksimal 20% terhadap  kesuksesan  seseorang,
sebagaimana gambar berikut ini:
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Untitled - PS5 Data Editor

File Edit Wew Data Transform Analyze Graphs Utiities Window Help

&[=|8| B || 1) |u| Al FlH B|EF %9

1 one_samp E.25
| |

|
Test Variable(s): ok
4 Skor koefisien deterin J

|8 |F
z | % |2
H = |8 | &

TestVale: |6 Optians.

—lolwlol—lololelwlrl—

3. Berikut ini adalah hasil analisis di atas:

One-Sample Statistics

Std. Error
N Mean Std. Deviation Mean
Skor koefisien
determinasi 35 6,1411 1,09005 ,18425

Output di atas memperlihatkan bahwa jumlah data yang
dianalisis sebanyak 35. Rata-rata pengaruh 1Q terhadap
kesuksesan seseorang sebanyak 6,1411% dengan standard deviasi
sebanyak 1,09005, dan standard error of mean sebanyak 0,18425.
Dengan kata lain interval rata-ratanya antara 5,95985% sampai
dengan 6,32835.

One-Sample Test

Test Value = 6
95% Confidence
Interval of the
Mean Difference
t df Sig. (2-tailed) | Difference Lower Upper
iggr;?sgs;en , 766 34 ,449 ,1411 -,2333 ,5156

Output kedua ini memperlihatkan bahwa skor t-testying
nya sebesar 0,766. Bila dibandingkan dengan tipei-0,05:34 Sebesar
2,032243, maka Ho diterima dan Ha ditolak. Demikian juga
kalau digunakan skor Signifikansinya sebesar 0,449 yang lebih
tinggi dari tingkat kesalahan yang ditoleransi yaitu 0,05, maka
Ho diterima dan Ha ditolak. Oleh karena itu Hipotesis nihil yang
berbunyi pengaruh 1Q terhadap kesuksesan seseorang rata-rata
hanya 6% berlaku untuk populasi. Atau dengan kata lain bahwa
kecenderungan di Amerika bahwa pengaruh 1Q sebesar 6%
terhadap kesuksesan seseorang itu juga berlaku di Indonesia.
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2. Aplikasi dengan Microsoft Excel

Sedangkan aplikasi Micrososft Excel dapat dilakukan
dengan menggunakan rumus berikut ini.

t = X- Ho

S

Jn
t = Nilai t yang dihitung, selanjutnya disebut t hitung
X = Rata-rata X
Ho = Nilai yang dihipotesiskan
S = Simpangan baku
n = Jumlah anggota sampel

Untuk dapat mengaplikasikan rumus tersebut, maka perlu
diketahui skor standard deviasi. Langkah-langkah untuk mencari
stadard deviasi dapat dibaca pada Bab Il halaman 73-80.

C D E F G H
1 |'N_UI Koefisien Korelasi | Koefisien determinasi ¥ - mean| - mean)”
21 0,25 6,25 0,10286 001185 aplikasi rumus
32 0,26 6,76 0615836 0,38298
43 0,29 8,41 226886 514771 0141143
54 0,25 6,25 0,10886 0,01185 1,09005
RIS 0,25 6,25 0,10886 0,01185 5,91608
7|5 0,23 5,29 -0,89114] 072444
8 7 0,24 5,76 -0,38114 014527 0,766029
CRIE 0,37 7,28 1,14886) 1,31987
100 9 0,25 6,25 0,10886 0,01185
11 {10 0,27 7,29 1,14886 1,31987 aplikasi rumus
12 11 0,22 4,84 -1,30114 1,69297 formula di sel G4
1312 0,21 4,41 -1,73114 299686 =C37-6
14 {13 0,22 4,84 -1,30114 1,69297 formula di sel G4
15 14 0,28 7,54 1,69886) 2,88612 =+E39
1615 0,27 7,29 1,14886 1,31987 formula di sel GB
17 16 0,35 6,25 0,70886) 0,01185 =S0RT(35)
18117 0,25 6,25 0,10886 0,01185 formula di sel G8
19 18 0,26 6,76 0615836 0,38298 =G44G5/G6)
20149 0,26 6,76 061886 0,38298
2120 0,22 4,84 -1,30114 1,69297
2 0,25 6,25 0,10886 0,01185
2322 0,26 6,76 061886 0,3829%
2423 0,28 7,84 1,GB8E6| 2,88612
26 24 0,37 7,28 1,14886) 1,31987
25|25 0,28 7,84 1,69886 288612
2726 0,21 4,41 -1,73114 299636
268 |27 0,23 5,29 -0,85114 0,72444
29|28 0,25 6,25 0,10886 0,01185
30 29 0,25 6,25 0,10886 0,01185
3130 0,24 5,76 -0,38114| 014827
Pl EL 0,23 578 085114 072444
I3[ 32 0,21 1,41 S173114]  2,09686
34|23 0,23 5,29 -0,85114 0,72444
35|34 0,23 5,29 -0,85114 0,72444
36|35 0,22 4,84 -1,30114 1,69297
37 6,141142857 40,359935
38 1,18822
34 1,09005
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Seluruh hasil penghitungan dengan Microsoft Excel
ternyata sama dengan hasil penghitungan SPSS. Bedanya SPSS
mencantumkan skor signifikansi, sementara Microsoft Excel
tidak. Oleh karena itu, untuk memutuskan apakah menerima Ho
ataukah Ha, peneliti yang menganalisis dengan menggunakan
Microsoft Excel harus membandingkan thiwng dengan tae. Untuk
mendapatkan type dapat dilakukan melalui menu function sebagai

berikut:
=TINV{0,05;34)
2032243
Keterangan:
=TINV : formula untuk pencarian tabel t
0,05 . taraf nyata (o)
34 . derajat kebebasan (jumlah sampel (35) dikurangi

dengan variabel (1)

Dikarenakan thiwng (0,766029) lebih kecil dibanding tipe
(2,032243), maka Ho diterima dan Ha ditolak. Kesimpulan
terakhir juga sama bila digunakan skor signifikansi yang ada
pada output SPSS.

C. Statistik Non-parametris

Setidaknya ada 3 (tiga) teknik analisis yang dapat digunakan
untuk menguji satu sampel, yaitu Test Binomial, Chi Kuadrat, dan
Run Test.

1. Test Binomial

Test ini dikatakan sebagai test binomial karena distribusi
data dalam populasi itu berbentuk binomial. Distribusi binomial
adalah suatu distribusi yang terdiri dari dua kelas. Analisis
binomial ini digunakan manakala datanya maksimal 25.

Contoh:

Seorang peneliti ingin mengetahui apakah anak kyai yang
tidak memiliki pesantren ketika studi lebih memilih sekolah
ataukah madrasah. Berdasarkan 25 sampel yang dipilih
secara random ternyata 16 memilih lembaga pendidikan
yang menggunakan nama sekolah sementara sisanya, yaitu 9
memilih madrasah.
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Proses Pengambilan Keputusan.

Hipotesis:

Ho Pilihan anak kyai yang tidak memiliki pesantren
ketika studi memilih sekolah atau madrasah
secara seimbang/sama.

Ha Pilihan anak kyai yang tidak memiliki pesantren
ketika studi memilih sekolah atau madrasah
secara tidak seimbang/tidak sama.

Dasar Pengambilan Keputusan:

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (a)

a. Aplikasi dengan SPSS

Untuk analisis binomial dapat dilakukan dengan
langkah-langkah sebagai berikut:

1. Setelah data diinput, maka klik Analyxe » Nonparametric
Test » Binomial sebagaimana gambar di bawah ini.

Untitled - SPSS Data Editor
File Edit “iew Data Transform BGENEEN Graphs Uklities Window Help

~ Reports 3
HE@ ﬂ—| J Descriptive Statistics 3 M @@
1:eek 1 Tables 4
sek war Compare Means ' war | var | var
General Linear Modsl 3
1 | ShtA - Mized Models 3
2 ShA Correlate 3
3 Shid Regression }
4 Shd Loglinear 3
[ Shid Classify }
5 SMA Diaka Reduction 3
g il CI rametric Test: Chi-Square
Nonparametric Tests =
£ SA Time Seties i3l Einomial...
9 Shi Survival b Runs.
10 ShaA [ TR [

2. Setelah keluar seperti gambar berikut ini, destinasikan
variabel tersebut menuju Test Vatiable List, lalu klik Ok.
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I Binomial Test g]
oK
Paste
Beset
Cancel
Help
Drefine Dichotamy Test Proportion: |50
* Get from data
= Exact...
" Cut point: —
Options...
3. Berikut ini adalah hasil analisis binomial.
Binomial Test
Observed Exact Sig.
Category N Prop. TestProp. | (2-tailed)
Pemilihan Sekolah  Group 1 | SMA 16 ,64 ,50 ,230
Group 2 | MA 9 ,36
Total 25 1,00

Output di atas memperlihatkan bahwa anak kyai yang
tidak memiliki pesantren mempunyai kecenderungan yang
sama antara studi pada sekolah dan madrasah. Walaupun data
dari sampel itu berbeda, yaitu 16 memilih SMA dan 9 memilih
Madrasah, karena exact sig mempunyai skor 0,230 yang lebih
tinggi dari 0,05, maka yang diterima berarti Ho. Ini artinya
kesamaan pilihan itu berlaku untuk populasi.

b. Aplikasi dengan Microsoft Excel

Analisis binomial ini tidak perlu menggunakan aplikasi
Microsoft Excel. Untuk membuktikan Ho dilakukan dengan
cara membandingkan Harga x dalam test binomial dengan taraf
kesalahan yang ditetapkan 1% (0,01) atau 5% (0,05). Dalam
kasus ini dari 25 sampel, 16 memilih SMA dan 9 memilih MA.
Frekwensi terkecilnya adalah (x) adalah 9. Berdasarkan tabel
yang menjelaskan Harga-harga x dalam Test Binomial
didapatkan skornya 0,115. Skor ini ternyata lebih tinggi
dibandingkan 0,05 maupun 0,01. Oleh karena itu, maka Ho
diterima dan Ha ditolak. Kesimpulannya adalah Anak kyai
yang tidak memiliki pesantren untuk studi memilih belajar di
SMA dan MA adalah sama yaitu 50%.

2. Chi Kuadrat (x?)

Chi Kuadrat (yx?) satu sampel adalah teknik analisis yang
digunakan untuk menguji hipotesis bila dalam populasi terdiri
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dari dua kelas atau lebih, data berbentuk nominal dan sampelnya
besar.

Contoh:

Seorang peneliti ingin mengetahui apakah anak kyai yang
memiliki pesantren ketika studi akan lebih memilih
madrasah diniyah, madrasah sebagai sekolah umum yang
berciri khas Islam, atau memilih sekolah. Berdasarkan 36
sampel yang dipilih secara random ternyata 15 memilih
madrasah diniyah, 7 memilih madrasah sebagai sekolah
umum yang berciri khas Islam, dan 14 memilih sekolah.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Anak kyai yang memiliki pesantren ketika studi
akan lebih memilih madrasah diniyah, madrasah
sebagai sekolah umum yang berciri khas Islam,
atau sekolah secara seimbang/sama.

Ha Anak kyai yang memiliki pesantren ketika studi
akan lebih memilih madrasah diniyah, madrasah
sebagai sekolah umum yang berciri khas Islam,
atau sekolah secara tidak seimbang/tidak sama.

Dasar Pengambilan Keputusan:

Dengan membandingkan xzhitung dengan yapel dengan ketentuan:
Ho diterima thitung < thabel

Ho ditolak thitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

a. Aplikasi dengan SPSS

Untuk analisis Chi Kuadrat (x°) satu sampel dapat
dilakukan dengan langkah-langkah sebagai berikut:

1. Setelah data diinput, maka klik Analyze » Nonparametric
Test » Chi-Square... sebagaimana gambar di bawah ini.
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Chi Kuadrat - SPSS Data Editor
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File Edit WView Data Transform

LNEEER Graphs  Utilities

(s = -|-]

1:sek 1

sek

Window  Help

Reparts

Descriptive Statistics
Tables

Compare Maans
General Linear Model

[ madrasah diniyah ~

&5 [% 2

Mized Models

madrasah diniyah
rnadrasah diniyah
madrasah diniyah
rnadrasah diniyah
madrasah diniyah
rnadrasah diniyah
rnadrasah diniyah
madrasah diniyah

1
2
3
P
5
B
7
g
g
=

1 vl diiialb

Correlate
Regression
Loglinear
Classify

Data Reduction

Scale

Monpararetric Tests

»
»
»
»
»
»
»
»
»
»
»
»
»
Time Series »
»

Survival

Binomial. ..

|

Runs...

2. Setelah keluar seperti gambar berikut ini, destinasikan
variabel tersebut menuju Test Vatiable List, lalu klik Ok.

I Chi-Square Test

Expected Range
* Get from data

" Use specified range

—

Test Vaniable List:

Expected Values

o All categores equal

" Values

Paste
Beset
Cancel

Help

dHHEE

Exact...

Options...

U

3. Berikut
sampel.

Pemilihan Sekolah

ini adalah hasil analisis Chi Kuadrat (yx°) satu

Observed N_| Expected N_| Residual
madrasah diniyah 15 12,0 3,0
Madrasah (SUCI) 7 12,0 -5,0
sekolah 14 12,0 2,0
Total 36

Test Statistics

Pemilihan

Sekolah
Chi-Square? 3,167
df 2
Asymp. Sig. ,205

a. 0 cells (,0%) have expected frequencies less than
5. The minimum expected cell frequency is 12,0.

Output pertama memperlihatkan bahwa dari 36 anak
kyai yang memiliki pesantren terdapat 15 anak yang memilih
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madrasah diniyah sebagai tempat studi, 7 anak memilih
madrasah sebagai sekolah umum yang berciri khas Islam, dan
14 di antaranya memilih sekolah.

Output kedua memperlihatkan skor chi kuadrat sebesar
3,167. Apabila skor ini dibandingkan dengan chi kuadrat tabel
dengan dk 2 dan tingkat signifikansi 5% ternyata skornya
5,591. Dikarenakan chi kuadrat hitung lebih kecil dibanding
chi kuadrat tabel, maka Ho diterima dan Ha ditolak. Ini sesuai
dengan Asymp. Sig sebesar 0,205 yang berarti lebih besar bila
dibandingkan dengan peluang kesalahan yang 0,05.
Berdasarkan hasil analisis tersebut maka dapat disimpulkan
bahwa anak kyai pesantren memilih ketiga tipe pendidikan,
madrasah diniyah, madrasah sebagai sekolah umum yang
berciri khas Islam, dan sekolah secara berimbang atau sama.

. Aplikasi dengan Microsoft Excel

Rumus Chi Kuadrat (x?) satu sampel adalah sebagai
berikut:

K (f -f,)?
Zzzz th
=1 n

x? = Chi kuadrat
fo = Frekuensi yang diobservasi
fa = Frekuensi yang diharapkan

Untuk mengaplikasikan rumus di atas perlu dibuatkan
tabel penolong sebagai berikut:

A B c D E F
1 Alternatif fo th fo-fh | ffo-? | (fo - )
2 | Madrasah Diniyah 15 12 3 9 0,750
3 | Mladrasah SUCI il 12 -5 25 2,083
4 Sekolah 14 12 2 4 0,333
5 JUMLAH 36 36 0 38 3,167
B
7 formula di C2 =36/3
8 formula di D2 =B2-c2
9 forrmula di E2 =022
10 formula di F2 =E2/C2
1 formula di F& =SUM{F2:F4)
12

Hasil hitung Chi Kuadrat (x°) satu sampel dengan
Microsoft excel ternyata sama dengan hasil analisis yang
menggunakan SPSS, yaitu 3,167.
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3. Run Test

Run Test digunakan untuk menguji hipotesis deskriptif
(satu sampel) bila datanya ordinal. Tujuan analisis ini adalah
menguji kerandoman populasi yang didasarkan atas data sampel.

Contoh:

Seorang peneliti ingin mengetahui apakah kunci jawaban test
yang menggunakan pilihan jawaban Benar (B) dan Salah (S)
telah disusun secara random atau tidak. Peneliti
mendapatkan data terhadap kunci jawaban sebagai berikut:

1 2 3 4 5 6 7 8 9 10

B S B B S S S B B B

11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20

B B S S S B S B B B

21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30

S S S B B B S S S S

31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40

B B S S B B B S S S

41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50

S S B B B S S B B S

Proses Pengambilan Keputusan.

Hipotesis:

Ho Kunci jawaban test yang menggunakan pilihan
jawaban Benar (B) dan Salah (S) telah disusun
secara random.

Ha kunci jawaban test yang menggunakan pilihan
jawaban Benar (B) dan Salah (S) tidak disusun
secara random.

Dasar Pengambilan Keputusan:

Dengan membandingkan Zhiwng dengan zZqpe dengan ketentuan:

Ho diterima  Zhjtung < Ztael

Ho ditolak Zhitung = Ztabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima  Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (a)
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a. Aplikasi dengan SPSS

Untuk analisis Run Test dapat dilakukan dengan
langkah-langkah sebagai berikut:

1. Setelah data diinput, maka klik Analyxe » Nonparametric
Test » Runs... sebagaimana gambar di bawah ini.

Run Test - SPSS Data Editor

File Edit WYiew Data Transform BEGEREEN Graphs  Utlities  Window Help

- Reports 4
=H S _I_I J Descriptive Statistics 4 ilﬂ ’@@
1:bs 1 Tables 4
bs ar | Compare Means 4 o var
General Linear Model 4
1 | Betul » Mixed Models 4
2| Salah Correlate 4
3 Betul Regression 4
4 Eietul Loglinear 4
5| Salah Classify 4
Bl Saah Data Reduction 4
7| Salah e — s
Monparametric Tests -Square. ..
G| Betul Time Series | Einomial. .
9|  Betul Survival [l Funs...
10 Betul Multinle B esnnnee v 1samnle ks

2. Setelah keluar seperti gambar berikut ini, destinasikan
variabel tersebut menuju Test Vatiable List, lalu pada Cut
Point dapat dipilih Median, Mode, dan Mean. Lalu klik
Ok.

M Runs Test

Test Variable List:

@ Kunci Jawaban [bs]

Paste

Reset
]

Cancel

Help

Cut Paoint
¥ Median ¥ Mode

[~ Custom: Options. .

e

3. Berikut ini adalah hasil analisis Run Test satu sampel.
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Runs Test
Kunci
Jawaban
Test Valuet 2
Cases < Test Value 25
Cases >= Test Value 25
Total Cases 50
Number of Runs 20
VA -1,715
Asymp. Sig. (2-tailed) ,086
a. Median
Runs Test 2
Kunci
Jawaban
Test Valuet 1,50
Cases < Test Value 25
Cases >=Test Value 25
Total Cases 50
Number of Runs 20
z -1,715
Asymp. Sig. (2-tailed) ,086
a. Mean
Runs Test 3
Kunci
Jawaban
Test Valugt 2P

Cases < Test Value 25

Cases >= Test Value 25

Total Cases 50

Number of Runs 20

z -1,715

Asymp. Sig. (2-tailed) ,086

a. Mode

b. There are multiple modes. The mode
with the largest data value is used.

Output di atas memperlihatkan bahwa test value
(diambilkan dari nilai pemusatan data) apabila dihitung dengan
median maka nilainya 2, kalau menggunakan mean maka
nilainya 1,5, sedangkan kalau dihitung dengan mode maka
nilainya 2. Skor yang lebih kecil dari test value 25 sedangkan
yang sama dengan atau lebih besar dari test value juga 25.
Sedangkan jumlah data ada 50 yang berganti antara kelompok
satu dengan lainnya sebanyak 20 kali. Sedangkan cara
menghitung jumlah run adalah sebagai berikut:

1 2 3 4 5 6 7 8 10

9
B S B B S S S B B B
1 2 3 4 5
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11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20
B B S S S B S B B B
6 7 8 9
21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30
S S S B B B S S S S
10 11 12
31 | 32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40
B B S S B B B S S S
13 14 15 16
41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50
S S B B B S S B B S
17 18 19 20

Sedangkan z hitung adalah -1,715. Apabila z hitung
dibandingkan dengan z tabel pada Tabel | untuk uji dua pihak
untuk tingkat kesalahan 5%, maka didapatkan z tabel 1,96.
Cara untuk mengetahui z tabel adalah tingkat kepercayaan
yang digunakan, misalkan 95% (0,95) dibagi dua menjadi
0,475. Skor tersebut ternyata terdapat pada 1,9 dan 0,06. Jadi
kalau digabungkan menjadi 1,96. Karena z hitung lebih kecil
dari z tabel, maka Ho diterima dan Ha ditolak. Kesimpulan ini
juga sama dengan skor Asymp. Sig. sebesar 0,086 yang lebih
tinggi dari kesalahan yang ditoleransi yaitu paling tinggi 0,05.
Dari analisis ini dapat disimpulkan bahwa pilihan jawaban
Benar (B) dan Salah (S) telah disusun secara random.

b. Aplikasi dengan Microsoft Excel

Rumus Run Test satu sampel adalah sebagai berikut:

{

r-u,

2n,n, N

n,+n,

1}0,5

zZ = =

"

2”1”2 (annz -n, _nz)

(nl +n2)2 (nl +n, _1)

Harga (mean) p, dan simpangan baku o' dapat dihitungs

dengan rumus berikut :




Uji Satn Sampel 102

U, :[&4_1)_0,5
n,+n,

2n;n, (2n1n2 - _nz)
(nl +I’12)2 (nl +N, _1)

Sedangkan aplikasi rumus di atas dengan Microsoft
Excel sebagai berikut ini:

A B © D E
1 [run 20
2 [n1 25
3 n2 25
4
5 26 formula di B5 =({2*B2*BAMB2+B3))+1
B 65 formula di B6 =B1-B5-05
7
B 1500000 formula di B =(*B3*B31(2*B2*B3-B2-B3)
9 2500 formula di B9 =(B2+B3)"2
10 49 formula di B10 =E2+B3-1
11 122500 formula di B171 =BI'B10
12 12,245 formula di B12 =B8/B11
13 3499 formula di B13 =SQRT(B12)
14
15 1858] [formula diB15 [=B6/B13

Hasil penghitungan dengan menggunakan Microsoft
Excel ternyata tidak sama persis." Walaupun tidak sama, tetapi
selisihnya sangat sedikit sehingga tidak merubah kesimpulan
akhirnya yaitu menerima Ho dan menolak Ha. Jadi urut-urutan
jawaban antara yang Betul (B) dan Salah (S) telah tersusun
secara random.

! Ketidaksamaan hasil hitung juga terjadi dalam bukunya Sugiyono, Statistika
untuk Penelitian, (Bandung: CV Alfabeta, 2003), him. 112; bandingkan dengan bukunya
Sugiyono dan Eri Wibowo, Statistika Penelitian dan Aplikasinya dengan SPSS 10.00 for
Windows, (Bandung: CV Alfabeta, 2002), him. 94.



BAB IV
ANALISIS KORELASI

A. Pendahuluan

Dalam ilmu statistik istilah korelasi berarti hubungan antardua
variabel atau lebih. Hubungan antardua variabel disebut bivariate
correlation, sementara hubungan antarlebih dua variabel disebut
multivariate correlation.

Hubungan antardua variabel misalnya korelasi antara intensitas
mengikuti diskusi dosen (variabel x) dengan produktifitas kerja
(variabel y). Hubungan antarlebih dari dua variabel misalnya korelasi
antara kwalitas layanan kepada peserta didik (variabel x;),
kompetensi tutor (variabel x,), dengan banyaknya jumlah peserta
didik (variabel y).

B. Arah Korelasi

Hubungan antardua variabel atau lebih itu bila dilihat dari
arahnya dapat dibagi menjadi dua, yaitu hubungan yang sifatnya
searah dan berlawanan arah. Hubungan searah disebut korelasi
positif, sementara yang berlawanan arah disebut korelasi negatif.

Jadi, jika variabel x mengalami kenaikan, maka akan diikuti
kenaikan variabel y. ltulah korelasi positif. Contohnya bila layanan
terhadap mahasiswa naik (variabel x) maka naik pula jumlah
mahasiswa perguruan tinggi itu (variabel y). Sementara korelasi
negatif adalah apabila variabel x mengalami peningkatan
mengakibatkan variabel y mengalami penurunan dan sebaliknya.
Contohnya bila dominasi pimpinan kepada dosen meningkat
(variabel x) maka produktivitas kerja dosen akan mengalami
penurunan (variabel y).

103
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C. Angka Korelasi

Besar angka korelasi itu berkisar antara 0 sampai 1, baik
posisit maupun negatif. Bila dalam penghitungan diperoleh angka
korelasi lebih dari 1 berarti telah terjadi kesalahan penghitungan. Bila
angka Kkorelasi itu bertanda negatif menunjukkan korelasi
antarvariabel itu negatif. Interpretasi kasar terhadap angka korelasi
sebagai berikut:

Interval Koefisien Tingkat Hubungan
0,00 -0,199 Sangat rendah
0,20 - 0,399 Rendah
0,40 - 0,599 Sedang
0,60 — 0,799 Kuat
0,80 — 1,000 Sangat kuat

D. Macam-macam Teknik Korelasi
Setidaknya ada 8 teknik analisis korelasi sebagai berikut.

TIPE DATA TEKNIK ANALISIS

NOMINAL Contingency Coefficient
Spearman Rank Correlation

ORDINAL Kendall Tau

Pearson Product Moment
Partial Correlation
Multiple Correlation

INTERVAL
RASIO

E. Statistik Parametrik
1. Product moment

Teknik korelasi ini digunakan untuk mencari hubungan
dan membuktikan hipotesis hubungan dua variabel bila data
kedua variabel berbentuk interval atau rasio. Karena product
moment termasuk parametrik, maka harus memenuhi uji asumsi
yaitu kedua variabel itu berdistribusi normal.

Contoh:

Seorang pemilik Kursus yang memiliki cabang di seluruh
Indonesia  berkeinginan  untuk  mengetahui  apakah
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Kompetensi Tutor berkorelasi dengan jumlah peserta didik.
Oleh karena itu diambil sampel sebanyak 35 cabang kursus
untuk ditelitinya.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Kompetensi Tutor tidak berkorelasi dengan
jumlah peserta didik

Ha Kompetensi Tutor berkorelasi dengan jumlah

peserta didik
Dasar Pengambilan Keputusan:
Dengan membandingkan ryiwung dengan rypne dengan ketentuan:
Ho diterima Fhitung < I'tabel
Ho ditolak Phitung = Ttabel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

Karena product moment termasuk parametrik, maka
analisis ini dapat digunakan apabila tipe datanya interval atau
rasio, distribusi datanya normal, dan jumlah sampelnya lebih dari
30. Dalam contoh ini, tipe datanya interval dan berjumlah 35,
maka asumsi yang harus diuji adalah distribusi datanya. Cara
termudah untuk menguji ini adalah dengan program SPSS.

Prosedur untuk menguji distribusi data adalah sebagai
berikut:

Setelah data dimasukkan klik Analyze » Descriptive Statistics
» Explore, sebagaimana gambar berikut ini:

product moment - SPSS Data Editor,
File Edit View Data Transform BEGEREEN Graphs Utlities ‘Window Help

Eﬂ|n|§| nl |J Feports [ EAT = N - |
1:x 5

Descripkive Statistics Frequencies...

Tables

Descripkives. ..
Compare Means

X ¥ General Linear Model
1 | 52,00 B4 Mixed Models

2 53.00 G40 remalsta
Setelah itu akan keluar gambar berikut ini. Destinasikan kedua
variabel itu ke dalam kotak Dependent List, dengan memblok
kedua variabel itu dan mengeklik panah yang ada di sebelah Kiri

Crosstabs..,
Ratio...

rr v T
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kotak itu. Pada bagian Display, klik kotak Plots. Kemudian klik
kotak Plots.

M Explore |

Dependent List:
@ Kompetensi Tutar [ #
E @ Jumlah Peserta Dic 3 Paste

Beset

X

FEactor List:
Cancel

E Help

iz

Label Cazes by:

I —

Dizplay
" Both 7 Statistics (%

| Flots... | thions...|

3. Setelah itu akan keluar gambar seperti berikut ini. Pilih None
pada bagian Boxplot. Nonaktifkan pilihan stem and leaf.
Aktifkan kotak Normality Plots with tests. Setelah itu klik Ok

Explore: Plots

B oxplots Descriptive

" Factor levels together | [ 51
N Cancel
" Dependents together | [ H

* None Help

[v Marmality plots with tests
Spread vs. Level with Levene Test
=

Matrallos <]

S

4. Berikut ini adalah output uji normalitas data.

Case Processing Summary

Cases
Valid Missing Total
N Percent N Percent N Percent
Kompetensi Tutor 35 100,0% 0 ,0% 35 100,0%
Jumlah Peserta
Didik Baru 35 100,0% 0 ,0% 35 100,0%
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Tests of Normality

Kolmogorov-Smirnov’ Shapiro-Wilk
Statistic df Sig. Statistic df Sig.
Kompetensi Tutor ,140 35 ,082 ,961 35 241
Jumlah Peserta
Didik Baru ,118 35 ,200* ,945 35 ,079

*. This is a lower bound of the true significance.
a. Lilliefors Significance Correction

Untuk mengetahui normalitas dapat digunakan skor Sig.
yang ada pada hasil penghitungan Kolmogorov-Smirnov. Bila
angka Sig. Lebih besar atau sama dengan 0,05, maka
berdistribusi normal, tetapi apabila kurang, maka data tidak
berdistribusi normal. Karena Sig. Untuk variabel x (0,082), dan
variabel y (0,200) itu lebih besar dari 0,05, maka kedua data
variabel itu berdistribusi normal.

Hal ini juga dapat dilihat pada grafik Normal Q-Q Plot
maupun Detrended Normal Q-Q Plot. Untuk Normal Q-Q Plot itu
apabila sebaran data dari variabel itu bergerombol di sekitar garis
uji yang mengarah ke kanan atas dan tidak ada yang terletak jauh
dari sebaran data, maka data tersebut berdistribusi normal.
Sementara untuk Detrended Normal Q-Q Plot, apabila datanya
tidak membentuk suatu pola tertentu atau menyebar secara acak,
maka data itu berarti berdistribusi normal. Sesuai dengan nilai
Sig. di atas, maka hasil uji dengan dua model grafik di bawah ini
juga menunjukkan kedua data dari variabel itu berdistribusi
normal.

Normal Q-Q Plot of Kompetensi Tut Detrended Normal Q-Q Plot of Kom

2|d -3
50 60 70 80 50 60 70 80

Observed Value Observed Value
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Normal Q-Q Plot of Jumlah Peserta

Detrended Normal Q-Q Plot of Jum

90

Observed Value

100 70

Observed Value

80 90

100

Dikarenakan kedua variabel

itu distribusi

datanya

normal, maka dapat dilakukan analisis dengan product moment.

Seandainya distribusi

datanya tidak normal,

maka harus

menggunakan analisis non-parametrik, seperti kendall’s tau atau
spearman rank.

a. Aplikasi dengan SPSS

Prosedur untuk menguji hipotesis dengan product
moment adalah sebagai berikut:

1. Ketika data yang diinput pada data view, klik Analyze »
Correlate » Bivariate, sebagaimana gambar di bawah ini:

product moment - SPSS Data Editor

File Edit Yiew Data Transform BEGERECS Graphs Utilities Window Help

=|d|S| =] o | 2

1:x 5
X ¥

1] 52,00 B4 [

2 53,00 B4,

3 54,00 65,0

4 51,00 B6.C

Reparts 4
Descriptive Statiskics 3
Tables »
Compare Means »
General Linear Model b
3
3
13
3

Mixed Models
Correlake
Regression
Loglinear

i

L5+ @

Eivariate...
Partial..,
Distances...

2. Ketika sudah keluar sebﬁerrti gambar berikut ini, destinasikan

kedua variabel

itu ke dalam kotak Variables.
berkeinginan untuk menampilkan

Kalau
rata-rata dan deviasi

standar, klik Options, maka akan keluar gambar di bawah

n.:
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M Bivariate Correlations Pz|

Carrelation Coefficients
¥ Pearson | Kendal'staub [ Speaman
Test of Significance

+ Two-tailed " One-tailed

d

L . Options...
[¥ Flag significant comelations =F

3. Ketika sudah keluar seperti gambar berikut ini, Kklik pada
kotak yang ada di depan Means and .... Setelah itu klik
Continue. Abaikan yang lain dan klik Ok.

Bivariate Correlations: Options

Statistics

¥ #deanz and standard deviations;

Cancel

™ Cross-product deviations and covariances

dil],

Help
Mizzing Values

' Exclude cases painwize

" Exclude cases lishwise

4. Berikut ini adalah Output proses analisis di atas.

Descriptive Statistics

Mean Std. Deviation N
Kompetensi Tutor | 64,6857 7,23867 35
Jumlah Peserta
Didik Baru 77,2857 8,19100 35
Correlations
Jumlah
Kompetensi Peserta
Tutor Didik Baru
Kompetensi Tutor Pearson Correlation 1 ,949*X
Sig. (2-tailed) . ,000
N 35 35
Jumlah Peserta Pearson Correlation ,949*4 1
Didik Baru Sig. (2-tailed) ,000 .
N 35 35

**. Correlation is significant at the 0.01 level (2-tailed).

Dari output di atas, diketahui bahwa jumlah sampel
dari penelitian ini adalah 35. Skor rata-rata variabel x adalah
64,6857 dengan deviasi standar 7,23867. Sementara untuk
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skor rata-rata variabel y adalah 77,2857 dengan deviasi
standar 8,19100.

Adapun nilai koefisien korelasi antara variabel Xx
dengan variabel y adalah 0,949, dengan nilai Signya 0,000
dalam arti kesalahan menolak Ho hanyalah 0% atau
mendekati 0%. Hasil pada Sig. itu dapat dicek ulang dengan
membanding rhiwng 0,949 dengan rype untuk dk.: 35 (jumlah
sampel) dikurangi 2 (jumlah variabel) = 33. Nilai tabel untuk
33 dengan kesalahan 5%: 0,344 dan 1%: 0,442. Karena Injung
lebih besar dari rgpg, maka berarti Ho ditolak dan Ha
diterima. Ini mengandung pengertian bahwa kesimpulan dari
sampel ini dapat digeneralisasikan untuk populasi. Dan
karena ryiung tidak bertanda negatif, maka menunjukkan arah
korelasi ini positif. Jadi, semakin tinggi kompetensi tutor
semakin tinggi pula jumlah siswa baru kursus tersebut.

b. Aplikasi dengan Microsoft Excel
Setidaknya ada dua rumus product moment yaitu:

DXy

ly =

Dimana :

ry = Korelasi antara variabel x dan'y
x  =(Xi-X)

y =(Yi-Y)

_ ny Xy, - (in)(zyi)
DX -y - ()

Rumus terakhir digunakan bila sekaligus akan
menghitung persamaan regresi.

Aplikasi sesuai dengan rumus di atas dilakukan dengan
langkah-langkah sebagai berikut:

1. Setelah data dimasukkan, baik untuk variabel X maupun
variabel y, buatlah rata-rata dari masing-masing variabel
itu.

2. Kurangi masing-masing skor responden dengan nilai
rata-ratanya.

r
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Kuadratkan hasil pengurangan itu.
Jumlahkan hasil pengkuadratkan itu.

Untuk mengetahui varians untuk sampel, hasil
penjumlahan no.4 dibagi dengan jumlah sampel
dikurangi 1.

untuk mengetahui deviasi standar, Carilah akar varians
di atas.

Kalikan hasil pengurangan dari masing-masing reponden
antara variabel x dan y.

Jumlahkan skor hasil dari no. 7 di atas.
Setelah itu masukkan ke dalam rumus.

XY

Prosedur di atas dapat dilihat pada aplikasi Microsoft

rxy:

Excel berikut ini.
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Ternyata hasilnya sama persis dengan penghitungan

dengan SPSS.

Apabila kita menggunakan rumus 2, maka aplikasinya

sebagaimana berikut
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Caranya

Setelah data dimasukkan, baik untuk variabel x maupun

1.

iabel itu.

ing-masing var

variabel y, jumlahkan mas

i varibel x.

kor yang ada d

ing-masing s

Kuadratkan mas
Jumlahkan hasil pengkuadratkan itu.

2.

3.
4.

i varibel y.

kor yang ada d

ing-masing s

Kuadratkan mas
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o N o o

hipotesis  asosiatif yang datanya interval/rasio

Jumlahkan hasil pengkuadratkan itu.

Kalikan masing-masing skor antara variabel x dan y.

Jumlahkan skor hasil pengkalian di atas.
Setelah itu masukkan ke dalam rumus.

nyxy - (x)Xy)

N5 SR SR A S o
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Sedangkan cara yang paling cepat untuk menguji

dan

berdistribusi normal adalah menggunakan Data Analysis
dari menu Tools, sebagaimana ada pada gambar di bawah

Ini:

rutan product moment

Tools Data Window Help
¥ speling... F7
! Share Warkbook.. .
I Protection »

Online Collaboration »

Add-Ins...
Cuskamize. ..
Cpkion:

¥

1. Ketika keluar gambar sebagaimana di bawah ini Kklik

Correlation dan klik Ok..

Data Analysis EIE'
Analysis Tools
b
| ] ]
T Caneel
Anova: Two-Factor Without Replication
Carrelation I
Covariance bilp

Descripkive Statistics

Exponential Smoothing

F-Test Two-Sample For Variances

Fourier Analysis

Hiskogram j

Selah keluar gambar di bawah ini, maka bloklah seluruh
skor variabel x dan variabel y. Klik Label in First Row
kalau label dari variabel akan ditampilkan. Lalu klik

New Worksheet Ply agar hasil

analisis

nanti

ditampilkan pada worksheet tersendiri. Selanjutnya klik

Ok.
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Input

K
Input Range: $a41:4B436 £ -
Cancel
Grouped By: * Caolumns Q
" Rows Help

Cubput options
" Qutput Range: B
{* Mew Worksheet Ply:

" Mew Workbook

3. Inilah hasil dari penghitungan itu, ternyata hasilnya,
manakala di belakang koma dijadikan tiga angka maka
skornya sama persis dengan penghitungan SPSS dan
Microsoft Excel di atas.

A B coo
1 x ¥
2 x 1
3y 0,949 1
4

2. Korelasi Ganda

Korelasi ganda merupakan angka yang menunjukkan arah
dan kuatnya hubungan antara dua variabel atau lebih secara
bersama-sama dengan variabel yang lain.

Contoh:

Setelah mengetahui korelasi antara kompotensi tutor dengan
jumlah siswanya, Seorang pemilik tersebut ingin meneliti
korelasi antara kwalitas pelayanan kepada siswa dan
kompetensi tutor secara bersama-sama dengan jumlah
peserta didik.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak ada korelasi antara kwalitas pelayanan
kepada siswa dan kompetensi tutor secara
bersama-sama dengan jumlah peserta didik

Ha Terdapat korelasi antara kwalitas pelayanan
kepada siswa dan kompetensi tutor secara
bersama-sama dengan jumlah peserta didik

Dasar Pengambilan Keputusan:
Dengan membandingkan ryiwung dengan rype dengan ketentuan:
Ho diterima Mhitung < T'tabel
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Ho ditolak

rhitung 2 T'tabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima
Ho ditolak

a. Aplikasi dengan SPSS

Probabilitas > taraf nyata (o)
Probabilitas < taraf nyata (o)
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Data ketiga variabel itu dimasukkan pada data view
SPSS terlihat sebagai berikut:

il | w2 | y | 11 | 2 | ¥
1 52,00 5200 54,00 18 B8,00 7,00 78,00
2 52,00 53,00 64,00 19 65,00 67,00 78,00
3 56,00 54,00 55,00 20 B9 00 B4,00 78,00
4 76,00 51,00 66,00 21 76,00 7200 0,00
5 52,00 56,00 57,00 22 58,00 7,00 g2,00
B 5,00 56,00 57,00 23 7200 7,00 g2,00
7 56,00 57,00 53,00 24 76,00 58,00 83,00
g 59,00 52,00 £9,00 25 89,00 59,00 84,00
9 58,00 59,00 70,00 26 74,00 70,00 85,00
10 65,00 59,00 70,00 27 78,00 75,00 8500
11 79,00 57,00 7200 28 85,00 59,00 85,00
12 82,00 55,00 72,00 29 92,00 59,00 85,00
13 55,00 54,00 75,00 30 76,00 71,00 86,00
14 57,00 64,00 75,00 3 99,00 7200 86,00
15 76,00 63,00 75,00 32 85,00 77,00 88,00
16 79,00 67,00 75,00 33 86,00 59,00 88,00
17 97,00 65,00 77,00 34 99,00 75,00 90,00
18 RR NN R7 1N TR NN 35 89,00 77,00 91,00

Prosedur untuk menguji hipotesis dengan korelasi
ganda adalah sama dengan aplikasi product moment:

1. Ketika data sudah diinput pada data view klik Analyze »
Correlate » Bivariate, sebagaimana gambar di bawah ini:

korelasi ganda - SPSS Data Editor

Filz=  Edit “iew Data Transforrn BEEEREEES

ST T
E

Descriptive Statiskics

2. Setelah i'fu keluar gambar seperti di bawah
ketiga variabel itu ke dalam kotak Variables.
rata-rata dan deviasi

berkeinginan untuk menampilkan

standar, klik Options.

Graphs  Ukilities

1:w1 Tables
Zompare Means
il | 2 General Linear Model

1 | EiD,DUl 650 Mized Models

2 7500 75 0 e

3 BS 00 o0 Reqression

4 B0.00 B5.0 Loglinear

o nn an Classifuw

window  Help

»
[ 4
[ 4
»
»
»
r
[ 4
»

Distances. ..

A= | %@

arkial. ..

ini. Destinasikan

Kalau
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M Bivariate Correlations

Wariables:

Carrelation Coefficients

¥ Pearson | Kendal'staub [ Speaman

Test of Significance
+ Two-tailed " One-tailed

[¥ Flag significant comelations

(]
Paste
Beset
Cancel

Help

d

Optiong...

elifee|-

3. Setelah itu klik pada kotak yang ada di depan Means and ....
Setelah itu klik Continue. Abaikan yang lain dan klik Ok.

Bivariate Correlations: Options

© i
I™ Crozs-product deviations and covanances

Missing Y alues
* Exclude cases painwise

" Exclude cases lishwize

Statistics
. Cancel
Help

X

4, Berikut ini adalah hasil analisis di atas.

Descriptive Statistics

Mean Std. Deviation N
Pelayanan untuk Siswa | 74,2000 12,83790 35
Kompetensi Tutor 64,6857 7,23867 35
Jumlah Peserta Didik
Baru 77,2857 8,19100 35
Correlations
Jumlah
Pelayanan Kompetensi Peserta
untuk Siswa Tutor Didik Baru
Pelayanan untuk Siswa Pearson Correlation 1 ,650* , 714
Sig. (2-tailed) . ,000 ,000
N 35 35 35
Kompetensi Tutor Pearson Correlation ,650* 1 ,949*4
Sig. (2-tailed) ,000 . ,000
N 35 35 35
Jumlah Peserta Didik Pearson Correlation 7144 ,949*4 1
Baru Sig. (2-tailed) ,000 ,000
N 35 35 35

**. Correlation is significant at the 0.01 level (2-tailed).
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Dari output di atas, dapat diketahui bahwa jumlah
sampel dari penelitian ini adalah 35. Skor rata-rata variabel
X; adalah 74,2000 dengan deviasi standar 12,83790, Skor
rata-rata variabel x, adalah 64,6857 dengan deviasi standar
7,23867. Sementara untuk skor rata-rata variabel y adalah
77,2857 dengan deviasi standar 8,19100.

Adapun nilai koefisien korelasi antara variabel x;
dengan variabel y adalah 0,714, nilai koefisien korelasi
antara variabel x, dengan variabel y adalah 0,949, dan nilai
koefisien korelasi antara variabel x; dengan variabel X,
adalah 0,650. Nilai Sig untuk ketiga korelasi itu adalah 0,000
dalam arti kesalahan menolak Ho hanyalah 0% atau
mendekati 0%. Hasil pada Sig. itu dapat dicek ulang dengan
membanding rhiwung dengan rpe Untuk dk.: 35 (jumlah sampel)
dikurangi 2 (jumlah variabel) = 33. Nilai tabel untuk 33
dengan kesalahan 5%: 0,344 dan 1%: 0,442. Karena rpjung
lebih besar dari rque, maka berarti Ho ditolak dan Ha
diterima. Ini mengandung pengertian bahwa kesimpulan dari
sampel ini dapat digeneralisasikan untuk populasi. Dan
karena ryiung tidak bertanda negatif, maka menunjukkan arah
korelasi ini positif. Jadi, semakin tinggi pelayanan untuk
siswa maka semakin tinggi pula jumlah siswanya, demikian
juga semakin tinggi kompetensi tutor maka semakin tinggi
pula jumlah siswanya. Sayangnya output itu tidak
memperlihatkan skor korelasi kedua variabel x secara
bersama-sama dengan variabel y. Untuk dapat mengetahui
korelasi kedua variabel x secara bersama-sama dengan
variabel y dapat dilakukan dengan Microsoft Excel.

b. Aplikasi dengan Microsoft Excel

Rumus Korelasi Ganda adalah sebagai berikut:

2 2
Py + 10 —2ryxlryxz Nox,
e 1-r’x,

Untuk dapat mengaplikasikan rumus di atas terlebih
dahulu harus dicari koefisien korelasi antar variabel yang
caranya sama dengan pencarian koefisien Kkorelasi product
moment sebagaimana telah dipraktikkan di atas. Setelah
masing-masing  koefisien  korelasi  antar  variabel



119

Statistika untuk Penelitian Pendidikan

diketemukan, maka dapat dimasukkan ke dalam rumus
korelasi ganda di atas. prosedurnya aplikasi Microsoft Excel
pada halaman berikutnya.

Hasil  penghitungan dengan  Microsoft  Excel
menghasilkan skor yang sama dengan skor koefisien korelasi
hasil penghitungan SPSS. Kelebihannya ia juga bisa
digunakan mencari skor korelasi kedua variabel x secara
bersama-sama dengan variabel y, yaitu 0,958. Kalau kita
membandingkan riung dengan regpe untuk dk.: 35 (jumlah
sampel) dikurangi 3 (jumlah variabel) = 32. Nilai tabel untuk
32 dengan kesalahan 5%: 0,349 dan 1%: 0,449. Karena rnjung
lebih besar dari rgpe, maka berarti Ho ditolak dan Ha
diterima. Ini mengandung pengertian bahwa kesimpulan dari
sampel ini dapat digeneralisasikan untuk populasi.

Sedangkan cara yang paling cepat adalah
menggunakan Data Analysis dari menu Tools ternyata

mempunyai hasil yang sama.
A =} c D

1 7 ples r

2 |x1 1

= 0,550 1

4y 0,714 0,949 1
=]
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Analisis Korelasi

Korelasi Parsial

3.

Korelasi parsial digunakan untuk menganalisis hubungan

atau pengaruh variabel independen terhadap variabel dependen,
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di mana salah satu variabel independennya dibuat tetap atau
dikendalikan.

Contoh:

Setelah mengetahui korelasi antara kwalitas pelayanan
kepada siswa dan kompetensi tutor secara bersama-sama
dengan jumlah peserta didik, Seorang pemilik kursus
tersebut ingin meneliti korelasi antara kwalitas pelayanan
kepada siswa dengan jumlah peserta didik, manakala
kompetensi tutornya dibuat sama (diparsialkan), dan
korelasi antara kompetensi tutor dengan jumlah peserta
didik, manakala kwalitas pelayanan kepada siswa dibuat
sama (diparsialkan).

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak ada korelasi antara kwalitas pelayanan
kepada siswa dengan jumlah peserta didik,
manakala kompetensi tutornya dibuat sama
(diparsialkan).

Ha Terdapat korelasi antara kwalitas pelayanan
kepada siswa dengan jumlah peserta didik,
manakala kompetensi tutornya dibuat sama
(diparsialkan).

Ho Tidak terdapat korelasi antara kompetensi tutor
dengan jumlah peserta didik, manakala kwalitas
pelayanan  kepada siswa  dibuat sama
(diparsialkan).

Ha Terdapat korelasi antara kompetensi tutor dengan
jumlah  peserta didik, manakala kwalitas
pelayanan  kepada  siswa  dibuat sama
(diparsialkan).

Dasar Pengambilan Keputusan:

Dengan membandingkan thiwung dengan tipe dengan ketentuan:

Ho diterima  thitung < tabel

Ho ditolak thitung > tiabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima  Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)
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a. Aplikasi dengan SPSS

Untuk menganalisis korelasi parsial adalah sebagai
berikut:

1) Setelah data diinput, lalu klik Analyze » Correlate »
Partial..., sebagaimana gambar berikut ini:

KORELASI PARSIAL - SPSS Data Editor

File Edit Wiew Data Transform BEGEREES Graphs  Utilities  Window  Help

—~ Reports 3
= |E |§| | | J Descriptive Statistics 3 'I' n ’@@
1wl 5 Tables 4
Compare Means 3
il i General Linear Model 4 A val
1 | 5200 520 Mixed Models 4
2 62,00 530 Correlate 4 Eivariate...
3 6,00 540  Regression 3
4 76,00 510  Loalinear 3 Distances. ..
= [=alalal I~ lacxiFu 13

2) Setelah keluar gambar seperti berikut ini, masukkan
variabel yang akan dicari korelasinya pada kolom
Variables: sedangkan variabel yang dibuat tetap atau
diparsialkan masukkan ke kolom Controlling for: Setelah
itu klik Ok. Misalkan: yang dibuat tetap itu waktu
belajarnya, maka yang dimasukkan kolom Controlling
for: adalah variabel itu.

3

[o% |

[T |

M Partial Correlations

Wariables:

< Pelapanan untuk Siswa

\:\ @ Jumlah Peserta Didik B.

LContralling for:

Test of Significance

* Two-taled " One-tailed

DOptions...

Iv Display actual significance level

akan tetapi kalau yang dibuat tetap itu kwalitas layanan
kepada siswa, maka yang dimasukkan kolom Controlling
for: adalah variabel itu.
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H Partial Correlations PZ|
Wariables: oK
@ K.ompetensi Tutor [#2]
\:\ @ Jumlah Peserta Didik B. Baste
Bezet
Cancel
Help
Test of Significance
* Two-taled " One-tailed
DOptions...
Iv Display actual significance level 4

3) Berikut ini adalah output analisis di atas:

- - - PARTTIAL CORRELATTION c O
EFFICIENTS - - -

Controlling for.. X2
X1 Y
X1 1,0000 , 4042
( 0) ( 32)
P= . P= ,018
Y ,4042 1,0000
( 32) ( 0)
p= ,018 P=

(Coefficient / (D.F.) / 2-tailed Significance)

", " is printed if a coefficient cannot be

computed

Output di atas menunjukkan bahwa koefisien korelasi
antara kwalitas layanan kepada siswa dengan jumlah siswa
yang dimiliki apabila kompetensi tutor dibuat tetap
(diparsialkan) adalah 0,4042. Skor koefisien korelasi parsial
ini ternyata lebih rendah dibanding skor koefisien antara 2
(dua) variabel di atas manakala tidak ada yang diparsialkan,
yaitu 0,714.

- - - PARTTIAL CORRELATTION c O
EFFICIENTS - - -

Controlling for.. X1
Y X2
Y 1,0000 , 9112
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( 0) (  32)
p= P=,000
X2 ,9112 1,0000
( 32) ( 0)
pP= ,000 P= .

(Coefficient / (D.F.) / 2-tailed Significance)

", " is printed if a coefficient cannot be

computed

Output ini menunjukkan bahwa koefisien korelasi
antara kompetensi guru dengan jumlah peserta yang dimiliki
apabila kualitas layanan kepada siswa dibuat tetap
(diparsialkan) adalah 0,9112. Skor koefisien korelasi parsial
ini ternyata lebih rendah dibanding skor koefisien antara 2
(dua) variabel di atas manakala tidak ada yang diparsialkan,
yaitu 0,949.

Aplikasi dengan Microsoft Excel

Rumus korelasi parsial apabila X, yang dibuat sama
atau diparsialkan adalah sebagai berikut:

ryxl B ryXZ ) erXZ

JA=120y )20,
Rumus korelasi parsial apabila X; yang dibuat sama
atau diparsialkan adalah sebagai berikut:

rsz B ryx1' I

rxz (%) =

1X2

r =
X (XY) \/(1_ rZle )(1_ r2X1X2 )
Sedangkan uji korelasi parsial dapat dihitung dengan
rumus berukut:

t= %qn—s
\1—|"2p

Untuk dapat mengaplikasikan rumus di atas terlebih
dahulu harus dicari koefisien korelasi antar variabel yang
caranya sama dengan pencarian koefisien korelasi product
moment sebagaimana telah dipraktikkan di atas. Setelah
masing-masing  koefisien  korelasi  antar  variabel
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diketemukan, maka dapat dimasukkan ke dalam rumus

korelasi parsial di atas.

Sedangkan prosedurnya dapat dilihat pada aplikasi

Microsoft Excel sebagai berikut.
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Hasil penghitungan dengan Microsoft Excel ternyata sama dengan
skor koefisien korelasi hasil penghitungan SPSS. Selanjutnya skor
koefisien korelasi tersebut dimasukkan ke dalam rumus uji korelasi
parsial. Koefisien korelasi antara kwalitas layanan kepada siswa
dengan jumlah siswa yang dimiliki apabila kompetensi tutor dibuat
tetap (diparsialkan) adalah 0,4042. Untuk menguji hipotesis, skor
koefisien tersebut dimasukkan dalam rumus uji t di atas. Hasil
hitung uji t didapatkan skor 2,5000. Sedangkan koefisien korelasi
antara kompetensi guru dengan jumlah peserta yang dimiliki
apabila kualitas layanan kepada siswa dibuat tetap (diparsialkan)
adalah 0,9112. Ketika skor koefisien tersebut dimasukkan dalam
rumus uji t, didapatkan skor 12,516. Masing-masing skor dari thiung
tersebut dibandingkan dengan t tabel dengan dk jumlah sampel
(35) dikurangi variabel (3), yaitu 32, sebesar 2,036932. Karena t
niung 1€0IN tinggi dibanding t e, Sehingga Ho ditolak dan Ha
diterima.

F. Statistik Non-parametrik

1. Koefisien Kontingency

Teknik ini digunakan untuk menghitung hubungan
antarvariabel bila datanya berbentuk nominal. Teknik ini
mempunyai Kkaitan erat dengan Chi Kuadrat yang digunakan
untuk menguji komparatif k-sampel independent. Oleh karena itu
rumus yang digunakan mengandung nilai Chi Kuadrat.

Contoh:

Dilakukan penelitian untuk mengetahui ada tidaknya
hubungan antara penggunaan alat (teknologi) hitung dengan
benar tidaknya hasil hitung dalam penghitungan analisis
statistik. Sampel diambil 45 orang, 15 menggunakan
kalkulator, 15 menggunakan komputer dengan program
microsoft Excel, dan 15 orang menggunakan SPSS.

Proses Pengambilan Keputusan.
Hipotesis:
Ho Tidak ada hubungan antara penggunaan alat

(teknologi) hitung dengan benar tidaknya hasil
hitung dalam penghitungan analisis statistik.

Ha Terdapat hubungan antara penggunaan alat
(teknologi) hitung dengan benar tidaknya hasil
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hitung dalam penghitungan analisis statistik.

Dasar Pengambilan Keputusan:

Dengan membandingkan thiwng dengan y°upel dengan ketentuan:

Ho diterima thitung < thabel
Ho ditolak thitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)

Ho ditolak

a. Aplikasi dengan SPSS

Probabilitas < taraf nyata (o)

Data dari penelitian ini adalah data kategori, maka
cara untuk memasukkan data ke SPSS juga harus sesuai
dengan aturan data kategori. Bila sub menu value labels
dalam menu view diaktifkan maka akan keluar seperti

gambar di bawah ini.

1. Setelah data diinput, klik Analyze » Descriptive Statistics

tek_hit | valig

1 [Memakai Kalkulatar ~] Benar

2| Memakai Kalkulator Salah

3| Memakai Kalkulator Salah -

4| Memakai Kalkulator Benar tek_hit valid

5| Memakai Kalkulatar Benar 26| Microsoft Excel Benar

G| Memakai Kalkulator Benar 2z Microsoft Excel Benar

7| Memakai Kalkulator Salah 28|  Microsoft Excel Salah

8| Memakai Kalkulator Salah 29 Microsoft Excel Benar

9| Memakai Kalkulator Salah 30 Microsoft Excel Benar
10[ Memakai Kalkulator Benar 31 5PSS Eenar
11| Memakai Kalkulator Salah 32 SPSS Benar
12| Memakai Kalkulator Salah 33 SPSS Benar
13| Memakai Kalkulator Salah a4 SPSS Benar
14] Memakai Kalkulator Salah 35 Spag Benar
18] Memakai Kalkulator Benar 5 SPES Eienar
16 Microsoft Excel Benar B R Berar
17 Microsoft Excel Benar e spas Benar
18 Microsoft Excel Benar
19 Microsoft Excel Benar & EPSS Benar
20 Microsoft Excel Benar el SPes Benar
21 Microsoft Excel Salah A 5PSS Benar
22 Microsoft Excel Benar ] sPas Benar
23 Microsoft Excel Benar 43 sPss Benar
24| Microsoft Excel Benar 44 SPS3 Benar
25 Microsoft Excel Benar 45 3P3S Benar

» Crosstabs seperti di bawah ini:

Coefisien Contingency - SPSS Data Editor

File Edit WYiew Data Transform BEGEREES Graphs  Utilities ‘Window Help

=S| =)

1 : tek_hit

[ &

tek_hit
[Mermakai Kalkulator =
Memakai Kalkulator

ha

Reports L P == =l |

ics Frequencies. ..
Descripkives. ..
Explor

Descriptive

Tables

Compare Means
General Linear Model
Mixed Models
CnrreElake

rrvrr rr
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2. Setelah itu keluar gambar seperti di bawah ini, destinasikan
salah satu variabel itu ke kotak Row(s) dan variabel satunya
ke Column(s). Lalu klik Statistics.

3.

B Crosstabs

[~ Suppress tables

[~ Display clustered bar charts

Reset

Cancel

Help

LI Penggunaan Teknologi owls)
4 Kebenaran Hasil Hitung E
Column(s):
Layer 1 of 1

LHHAE],

Exact... §talislics...| Cells... ‘ Eormat...|
Setelah itu Aktifkan Chi-square dan Conting

ency

Coeficient dalam Nominal, selanjutnya klik Continue.

Setelah itu klik cells.

Crosstabs: Statistics

[ Chi-square

Nominal

[ Contingency coefficient
[~ Phi and Cramér's ¥

[~ Lamhda

[ Uncertainty coefficient

Nominal by Interval

[~ Eta

[~ Correlations
Ordinal
[~ Gamma
[~ Somers'd
[~ Kendall's tau-h

[~ Kendall's tau—c

[~ Kappa
™ Risk
[~ McNemar

[~ Cochran's and M

I-Haenszel

—

Continue
Cancel

Help

i,

4. Setelah itu aktifkan expected lalu klik Continue. Abaikan

yang lain dan klik Ok.
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Crosstabs: Cell Display

Counts

[~ Expecte

Percentages
[~ Row

[~ Column
[~ Total

Statistika untuk Penelitian Pendidikan

Continue

Cancel

aill]

Help

Residuals

[~ Unstandardized
[~ Standardized

[~ Adj. standardized

5. Berikut ini adalah output analisis di atas.

Case Processing Summary

Penggunaan Teknologi
Hitung * Kebenaran

Ccases Hasil Hitung
Valid N 45
Percent 100.0%
Missing N 0
Percent .0%
Total N 45
Percent 100.0%

Output ini menunjukkan bahwa jumlah sampel penelitian ini
adalah 45 orang.

Penggunaan Teknologi Hitung * Kebenaran Hasil Hitung Crosstabulation

Kebenaran Hasil
Hitung

Benar Salah Total
Penggunaan  Memakai Kalkulator ~Count 6 9 15
Teknologi Expected Count 11.3 3.7 15.0
Hitung Microsoft Excel Count 13 2 15
Expected Count 11.3 3.7 15.0
SPSS Count 15 0 15
Expected Count 11.3 3.7 15.0
Total Count 34 11 45
Expected Count 34.0 11.0 45.0

Output ini menunjukkan bahwa ada 6 orang yang dapat
menyelesaikan analisis kuantitatif secara benar dengan
menggunakan kalkulator, sedangkan yang menggunakan

Microsoft

Excel

ada 13 orang dan 15 orang Yyang

menggunakan SPSS seluruhnya benar. Sedangkan yang salah
terdiri 9 orang yang menggunakan kalkulator dan 2 orang
yang menggunakan Microsoft Excel.
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Chi-Square Tests

Asymp. Sig.
Value df (2-sided)
Pearson Chi-Square 16.1232 2 .000
Likelihood Ratio 18.083 2 .000
gszirifu?gtmear 14.204 1 .000
N of Valid Cases 45

a. 3 cells (50.0%) have expected count less than 5. The
minimum expected count is 3.67.

Symmetric Measures

Value Approx. Sig.
Nominal by Nominal ~ Contingency Coefficient .514 .000

N of Valid Cases 45

a. Not assuming the null hypothesis.

b. Using the asymptotic standard error assuming the null hypothesis.

Dari Output di atas dapat diketahui bahwa nilai
hitung koefisien kontingensi adalah 0,514 sementara nilai
Chi kuadratnya adalah 16,123. Karenanya Approx. Sig nya
0,000, yang lebih kecil dibanding 0,05 (kesalahan yang
ditoleransi), maka berarti kesalahan untuk menolak Ho
mendekati 0 persen, oleh karena itu, Ho ditolak dan Ha
diterima.

b. Aplikasi dengan Microsoft Excel

Sementara penghitungan dengan Excel sebagaimana
contoh berikut ini. Dari kedua penghitungan ini ternyata
menghasilkan nilai yang sama baik untuk nilai Chi kuadrat
maupun Korelasi Koefisien Kontigency.

Rumus itu adalah sebagai berikut:
2
c= |4~
N+ y

Nilai Chi Kuadrat dihitung dengan rumus:

2 (fo-fp)?
p :ZZ : h
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— .. . —m e e em e e — oy

A B C D E F

1 ALAT HITUNG
2 | KEBEMARAN | KALKULATOR | EXCEL | SPSS | JUMLAH %
3 BEMAR G 13 15 34 0,756
4 HARAPAM 11333 11,333 11,333
5 SALAH 9 2 0 11 0244
6 | HARAPAN 3667 3667 3667
7 JUMLAH 15 15 15 45
g
9 2510 0245 1,186
10 7758 0758 3 FB7
11| 16,123
12 0264
13 0,514
14
15
16 FORMULANY &
17 Wenjurnlah di sel E3 =5UM(B3:D3)
18 |Prosentase di Sel F3 =(E3/E7)
19 |Harapan Benar =(F3*B7)
20 |Harapan Salah =(F5*B7)
M
2 _ S fl, )2
Riy= 3y =0 h =({B3-B4)*(B3-B4)/B4)
23 i
24 =(B9+Ca+D9+810+C10+010)
25 7
k| C= _r =(B11HET+B11))
27 N+ g2 =SQRT(B12)

Cara Mencari Expexted adalah dengan mengkalikan
persentase jumlah yang benar dan yang salah dengan jumlah
masing-masing sampel:

Benar :0.755556 x 15 =11.3333
Salah :0.244444 x 15 = 3.6666

Untuk menguji Nilai Koefisien Kontingency
menggunakan nilai Chi Kuadrat dengan derajat kebebasan:
kategori variabel x dikurangi 1 dan kategori variabel y
dikurangi 1. Jadi 3 -1 = 2 ditambah 2 — 1= 1 sama dengan 3.
16.123 > 7,815 (kesalahan 5%) maupun 11,341 (kesalahan
1%). Kesimpulannya Ho ditolak Ha diterima. Jadi, jenis
teknologi hitung mempunyai korelasi yang signifikan dengan
kebenaran hitung sebesar 0.514. Dan kesimpulan dari data
sampel berlaku untuk populasi.

2. Spearman Rank

Sebagaimana dipaparkan pada tabel teknik analisis

korelasi, maka spearman rank adalah teknik analisis manakala
datanya berbentuk ordinal atau interval yang diordinalkan.
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Untuk mendapatkan data tentang karakteristik
pemimpin yang berpengaruh, pada tahun 1995 dan 2002
telah diadakan penelitian di Afrika, Asia, Eropa, Amerika
Utara, Amerika Selatan, dan Australia diperoleh data dengan
peringkat sebagai berikut:

Proses Pengambilan Keputusan.

Hipotesis:
Ho

Ha

karakter | thzo02 | thizes |

1] Jujur 1.00 1.00
2| Berpikiran Maju 2.00 2.00
3| Kormpeten 3.00 4.00
4| Dapat Memberi Inspirasi 4.00 3.00
S| Cerdas 5.00 7.80
G| Adil G.00 5.00
7 |Berpandangan Luas 7.00 7.50
5| Suka Mendukung 3.00 6.00
| Terus Terang Q.00 9.00
10| Dapat Diandalkan 10.00 10.00
11| Bekerjasama 11.00 12.50
12| Tegas 12.00 15.00
13| Berdaya Imajinasi 13.00 12.50
14| Berambisi 14.00 16.50
15|Berani 15.50 11.00
16| Perhatian 15.50 14.00
17| Dewasa Berfikir dan Bertindak 17.00 16.50
18| Setia 18.00 18.00
19| Penguasaan Diri 19.00 19.50
20| Mandiri 20.00 18.50

Tidak terdapat Korelasi tentang peringkat
karakteristik pemimpin yang berpengaruh

antara tahun 1995 dan 2002.
Terdapat  Kkorelasi  tentang

peringkat

karakteristik pemimpin yang berpengaruh

antara tahun 1995 dan 2002.

Dasar Pengambilan Keputusan:
Dengan membandingkan rho/thiwng dengan rho/tupe dengan

ketentuan:
Ho diterima
Ho ditolak

rhO/thitung < rho/tiapel
rhO/thitung 2 rhO/ttabeI

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima
Ho ditolak

Probabilitas > taraf nyata (o)
Probabilitas < taraf nyata (o)
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a. Aplikasi dengan SPSS

Setelah data diinput sebagaimana di atas, maka klik Analyze
» Correlate » Bivariate sebagaimana gambar berikut ini:

VRGN Graphs  Uhilties Window  Help

Reports 4

Descriptive Statistics — » M @@
I Tables '

Compare Means 4
L GeneralLinear Model — » L ﬂ
| Mixed Models 3

Correlate 3

Reqression »
2 Loglnesr b Diskances..,

Setelah keluar gambar di bawah ini, masukkan dua variabel
tersebut (th2002 dan th1995) ke dalam kolak Variables. Klik
Pearson untuk menghilangkan contengannya sebagai
gantinya klik Spearman, lalu klik Ok.

M Bivariate Correlations

Yariables:

@
@th1995

] ===

Cancel

Help

Elilzl [

Correlation Coefficients
¥ Pearson [~ Kendall's tau-t [~ Spearman

Test of Significance

+ Two-tailed " One-tailed

f

Options...
v Flag significant correlations =P

Output di bawah ini adalah hasil penghitungan SPSS,
yaitu korelasi antara hasil penelitian th 1995 dengan th 2002

yang mempunyai SKOritng: 0,959.
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Nonparametric Correlations

Correlations

TH2002 TH1995
Spearman'srho  TH2002 Correlation Coefficient 1.000 .959*4
Sig. (2-tailed) . .000
N 20 20
TH1995 Correlation Coefficient .959*4 1.000
Sig. (2-tailed) .000 .
N 20 20

**. Correlation is significant at the 0.01 level (2-tailed).

Bila dibandingklan rhogpe untuk n = 20 dengan taraf
kesalahan 5%: 0,450 dan taraf kesalahan 1%: 0,591.
Dikarenakan rhopiung (0,959) adalah lebih besar dari rhope
baik untuk kesalahan 5% maupun 1%, maka korelasi antara
penilaian tahun 1995 dan 2002 adalah positif dan signifikan
dan berlaku juga untuk populasi.

b. Aplikasi dengan Microsoft Excel

Sedangkan aplikasi dengan Excel adalah sebagai
berikut:

1. masing-masing skor pada variabel x dikurangi dengan
masing-masing skor pada variabel y.

2. masing-masing hasil pengurangan itu dikuadratkan.

3. Seluruh hasil pengkuadratan itu dijumlahkan.

4. Hasil penjumlahan itu dimasukkan ke dalam rumus di
bawabh ini

6

b
=1-
P n(n?-1)
Untuk lebih jelas dapat dilihat pada aplikasikan
Micrososft Excel pada halaman berikutnya. Hasilnya ternyata

sama persis dengan hasil penghitungan dengan SPSS.

2
i
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A B © D E
1 Katakteristik 0] i bi hi?
2 | Jujur 1 1 0 0
3 |Berpikiran Maju 2 2 0 0
4 Kompeten 3 4 1 1
5 |Dapat Memberi Inspirasi 4 3 1 1
B |Cerdas 5 75 25 625
7 |Adil 3 5 1 1
g Berpandangan Luas 7 75 05 025
9 | Suka Mendukung g 5 2 4
10 |Terus Terang 9 3 0 0
11 |Dapat Diandalkan 10 10 0 0
12 |Beketjasama 11 125 15 275
13 |Tegas 12 15 -3 9
14 |Berdaya Imajinasi 13 125 0h 125
15 |Berambisi 14 16,5 25 6,25
16 Berani 155 1 45 2025
17 | Perhatian 155 14 15 225
18 |Dewasa Berikir dan Berindak 17 165 0h 125
19 | Setia 18 158 0 0
20 |Penguasaan Diri 19 195 04 125
21 |Mandiri 20 195 05 025
22 0 545
23
24 |B x jurnlah b 327,000 =[B*EZZ)
26 nx -1 75950,000 =20%((207203-1)
26 |hasil 6 % jurlah bi® dibagi hasil nx (n®- 1) 0,00 =(B24/B25)
27 |1 dikurangi hasil pembagian di atas 0,959 =1-B25

Apabila jumlah sampel lebih dari 30, maka rhoype tidak
tersedia. Oleh karena itu, untuk menguji hipotesis digunakan rumus
sebagai berikut:

n-2
1-r?

Untuk sekedar contoh aplikasi rumus di atas digunakan

menguji hipotesis di atas

t=r

14,3606 = 0,959 P ——
1-(0,959°)

Sedangkan tgne untuk taraf nyata (a) 5% dan derajat
kebebasan 18 adalah 2,10092. Karena thitung lebih besar
dibanding tiaper-0,05:18, Maka Ho ditolak dan Ha diterima.

3. Kendall’s tau

Fungsi dari Kendall's tau semestinya sama dengan
spearman, bedanya hanyalah kalau spearman biasanya digunakan
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untuk sampel kecil, tetapi kendall's tau dapat digunakan untuk
sampel besar.

Kendall's tau juga sering digunakan untuk menganalisis
data yang semula direncanakan dianalisis dengan product
moment. Setelah diuji distribusi datanya ternyata tidak normal
atau sampelnya kurang dari 30, maka akhirnya dianalisis dengan
Kendall's tau. Untuk kasus seperti itu, bila dianalisis dengan
menggunakan excel, maka data yang semula interval atau rasio
harus dirangking.

Contoh:

Seorang peneliti ingin mengetahui korelasi antara 1Q dengan
prestasi belajar siswa. Untuk penelitian ini digunakan sampel
25 orang. Karena jumlahnya yang kurang dari 30, maka
digunakan analisis non-parametrik, yaitu kendall’s tau.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat korelasi antara 1Q dengan prestasi
belajar siswa

Ha Terdapat korelasi antara 1Q dengan prestasi

belajar siswa
Dasar Pengambilan Keputusan:
Dengan membandingkan zyjwng dengan zqpe dengan ketentuan:
Ho diterima  Zniwung < Ztabel
Ho ditolak Zhitung = Ziabel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)
Ho ditolak ~ Probabilitas < taraf nyata (o)

a. Aplikasi dengan SPSS

Sedangkan prosedur untuk analisisnya sama dengan
spearman, bedanya kalau yang diaktifkan untuk kendall’s tau
adalah kendall.
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i prestasi |
1 I el 116 | 80
2 1 n 15| 113 45
3] 130 & 16| 111 ]
4] 123 &7 17| 110 43
5] 123 1 18| 107 44
6] 124 &0 13| 105 42
il B 20| 103 41
g 122 o5 21 a7 49
al 1z 45 2 a6 a5
10| 120 g4 3 o3 ]
1] 119 g2 24 =] a0
12 118 1 25 a7 Eld

Setelah seluruh prosedur sebagaimana di spearman dilakukan
maka akan keluar output sebagaimana di bawah ini:

Correlations

1Q PRESTASI
Kendall's tau_b 1Q Correlation Coefficient 1.000 .760*4
Sig. (2-tailed) . .000
N 25 25
PRESTASI Correlation Coefficient . 760*4 1.000
Sig. (2-tailed) .000 .
N 25 25

**. Correlation is significant at the 0.01 level (2-tailed).

Berdasarkan output di atas, maka diketahui bahwa
korelasi antara variabel x (1Q) dan y (prestasi) adalah 0,760.
Selanjutnya hasil itu dimasukkan dalam rumus z, yang akan
penulis jelaskan berbarengan dengan penjelasan aplikasi
dengan excel.

Dari perhitungan ini diketahui bahwa terdapat
hubungan positif antara 1Q dan prestasi sebesar 0,76. Hal ini
berarti semakin tinggi 1Q seseorang semakin tinggi
prestasinya.

Aplikasi dengan Microsoft Excel

Sedangkan aplikasi analisis kendall's dengan excel
adalah sebagai berikut:

1. Skor dari variabel x dirangking dari rangking 1 dan
seterusnya.

2. Skor dari variabel y juga dirangking.

3. Berdasarkan rangking dari variabel y itu dicari rangking
atas (Ra), yaitu menghitung skor yang yang lebih tinggi
bila dibandingkan dengan masing-masing skor pada
variabel y.
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4. Berdasarkan rangking dari variabel y itu dicari rangking
bawah (Rb), yaitu menghitung skor yang yang lebih
rendah bila dibandingkan dengan masing-masing skor
pada variabel y.

5. Selanjutnya masing-masing skor Ra dan Rb dijumlahkan.

6. Hasilnya penjumlahan itu dimasukkan dalam rumus.

_ ZA-XB

TTN(N-D)
2
Untuk mendapatkan kejelasan prosedur tersebut dapat
dilihat pada aplikasi Micrososft Excel pada halaman
berikutnya.

Hasil penghitungan dengan Excel ini ternyata
mempunyai hasil yang sama dengan SPSS. Selanjutnya Thiwung
0,760 itu dimasukkan ke dalam rumus di bawah ini.

T 0,760

—— 53249

f2(2N+5) 2 (2x25+5)

9N (N-1) 9x25 (25-1)
Zhing: 5,3249, bila dibandingkan dengan ze pada kesalahan
1% dibagi dua (0,01/2 = 0,005) atau kesalahan 5% dibagi dua
(0,05/2 = 0,025). Demikian juga 100% dibagi dua (0,100/2 =
0,50) setelah dikurangi dengan 0,005 = 0,495 skor tabelnya
adalah 2,58 atau dikurangi 0,025 = 0,475 skorgpenya 1,96.

Ternyata Ziwng lebih besar dibanding z,,e Oleh karena itu Ho
ditolak dan Ha diterima.
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G. Koefisien Penentu

Koefisien penentu adalah digunakan untuk menjawab berapa
persen variabel x mempengaruhi variabel y. Rumus untuk mencari

Koefisien penentu adalah: (Koefisien Korelasi)? x 100.

Dari analisis korelasi yang sudah dilakukan diatas didapatkan

skor korelasi untuk:
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1. Product Moment 0,949. Skor penentunya sebesar 90,060%0. Ini
artinya pengaruh variabel x terhadap variabel y sebesar 90,060%,
sedangkan yang 9,940% ditentukan oleh variabel lainnya.

2. Korelasi Ganda juga sebesar 0,958. Skor penentunya sebesar
91,776%. Ini artinya pengaruh kedua variabel Xx; X, secara
bersama-sama terhadap variabel y sebesar 91,776%, sedangkan
yang 8,224% ditentukan oleh variabel lainnya.

3. Korelasi Parsial ketika Variabel X, yang dibuat tetap
(diparsialkan) sebesar 0,404. Skor penentunya sebesar 16,322%.
Ini artinya pengaruh variabel x; terhadap y manakala X,
diparsialkan sebesar 16,322%, sedangkan yang 83,678%
ditentukan oleh variabel lainnya.

4. Korelasi Parsial ketika Variabel X; vyang dibuat tetap
(diparsialkan) sebesar 0,911. Skor penentunya sebesar 82,922%.
Ini artinya pengaruh variabel x, terhadap y manakala X;
diparsialkan sebesar 82,922%, sedangkan yang 17,008%
ditentukan oleh variabel lainnya.

5. Koefisien Kontingensi 0,514. Skor penentunya sebesar 26,420%.
Ini artinya pengaruh variabel x terhadap variabel y sebesar
26,420%, sedangkan yang 73,580% ditentukan oleh variabel
lainnya.

6. Spearman Rank sebesar 0,959. Skor penentunya sebesar
91,968%. Ini artinya pengaruh variabel x terhadap variabel y
sebesar 91,968%, sedangkan yang 8,032% ditentukan oleh
variabel lainnya.

7. Kendall's tau 0,760. Skor penentunya sebesar 57,760%. Ini
artinya pengaruh variabel x terhadap variabel y sebesar 57,760%,
sedangkan yang 42,240% ditentukan oleh variabel lainnya.

Aplikasi untuk mencari Koefisien Penentu dengan Microsoft Excel

seperti terlihat di bawah ini:

A B & D E F
1 CARA MENCARI KOEFISIEN PENENTU
2
3 MO KETERAMNGAN K kP Rurmus
4 o Product Moment 0949 | 90,080 =[C42)"100
57 02 Korelasi Ganda 0955 31,776 =({C52100
B 03 Korelasi Parsial (¥z) 0404 16322 =(CB"2)*100
77 04 Korelasi Parsial (%) [ERN a2 g2 =(C72*100
g/ 0a Koefisien kontmgens: | 0514 26420 =(CE)*100
5 6 Spearman Rank 0959 | 91960 =(C7*2)"100
ol o7 Kendall's tau 0760 57 /B0 =({C82)*100
11




BAB V
ANALISIS REGRESI

A. Pendahuluan

Korelasi dan regresi mempunyai hubungan yang sangat erat.
Setiap regresi selalu ada korelasinya, tetapi belum tentu korelasi
dilanjutkan dengan regresi. Korelasi yang dapat dilanjutkan dengan
regresi adalah korelasi antara dua variabel atau lebih yang secara
teori atau konsep mempunyai hubungan kausal (sebab akibat) atau
hubungan fungsional.

Regresi digunakan manakala ingin diketahui bagaimana
variabel y dapat diprediksikan melalui variabel x. Hasil analisis
regresi dapat digunakan untuk memutuskan apakah naik dan turunnya
skor variabel y dapat dilakukan melalui menaikkan dan menurunkan
skor variabel x.

Analisis regresi adalah alat analisis yang termasuk dalam
statistik parametrik. Dengan demikian, untuk menggunakan regresi,
seorang peneliti harus melakukan pengujian asumsi terlebih dahulu.
Asumsi yang harus diuji adalah, normalitas distribusi data, linieritas
(jika kita hendak mempergunakan regresi linier), tiadanya
heteroskedastisitas yang sering juga disebut heteroginitas, yaitu
terjadinya ketidaksamaan varians dari residual satu data ke data yang
lain, tiadanya multikolinearitas untuk regresi ganda, yaitu korelasi
yang tinggi (di atas 0,5) antar variabel independen, serta tiadanya
autokorelasi, yaitu korelasi antara kesalahan pengganggu pada
periode t dengan kesalahan pada periode sebelumnya.

Contoh:

Seorang pemilik Kursus yang memiliki cabang di seluruh
Indonesia berkeinginan untuk memprediksikan perubahan

141
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jumlah peserta didik bila Tutornya ditingkatkan atau
diturunkan kompetensinya.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Kompetensi Tutor tidak berpengaruh terhadap jumlah
peserta didik kursus.

Ha Kompetensi Tutor berpengaruh terhadap jumlah peserta
didik kursus.

Dasar Pengambilan Keputusan:

Dengan membandingkan r/t/Fjwng dengan r/t/Fi,e dengan ketentuan:
Ho diterima  r/t/Fhjwung < r/t/Frapel

Ho ditolak I1t/Fhitung > 1/t/Frael

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima  Probabilitas > taraf nyata (a)

Ho ditolak Probabilitas < taraf nyata (o)

B. Regresi Linear Sederhana

Di dalam regresi linear, variabel yang terlibat di dalamnya
hanya dua.

1. Aplikasi dengan SPSS

a. Data diinput pada worksheet data view, lalu klik Analyze »
Regression » Linear, sebagaimana gambar di bawah ini:

regresi linear - SPSS Data Editor,
Fie Edit Yiew Data Transform ROEWEEN Graphs  Utities Window Help

~u Reports 3
Eﬂ J—| J Descriptive Statistics 4 QEI @@
104 3 Tables 4
l ¥ Cornpare Means 4 var | ar | .
General Linear Model b
1 | 3r.m 5410 Mixed Models 2
2 3300 540 correlate »
4 3600 860  Loglinear b Curve Estimation. ., l

b. Destinasikan variabel dependen (y) pada kolom yang ada di
bawah Dependent, demikian juga variabel independen ke
kolom Independent(s), sebagaimana gambar di bawah ini.
Selanjutnya klik Statistics...
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I | inear, Regression PZ|
@ Kompetensi Tutar [x1] Dependent: 0K
\:\ < Jumlah Peserta Didik E
Paste
Block 1 of 1
Nest Beset
Cancel

Method: Enter -

Selection Varable:
] [
Lasze Labels:

WS » §tatistics...| Flots... | Save... | thions...|

c. Setelah keluar gambar seperti berikut ini aktifkan juga

Descriptive untuk mendeskripkan data, Aktifkan Dubin-
Watson pada Residuals untuk mengetahui ada tidaknya
autokorelasi. Selanjutnya klik Continue untuk kembali pada
tampilan sebelumnya, lalu klik Plots...

Linear, Regression: Statistics

Fegression Coefficients v todel fit

|w Estimates ] change

Cancel

™ Confidence intervals 4
™ Covariance matrix ™ Part and partial comelations Help

I” Collinearity diagnostics
Residuals
Iv Durbin#/atzon
I” Casewise diagnostics

¢ F

~

. Destinasikan ZPRED pada kolom X dan SRESID pada kolom

Y untuk mengetahui terpenuhi tidaknya Homoskedastisitas
atau sering juga disebut homogenitas. Selanjutnya aktifkan
juga Histogram dan Normal Probability Plot untuk
mengetahui normalitas distribusi data, lalu klik Continue dan
selanjutnya klik Ok.
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d. Berikut ini adalah Output analisis regresi linear di atas..

Linear Regression: Plots g|
DEFENDNT Scatter 1 of 1
"ZFRED | et |
“ZRESID Cancel
DRESID . ™
ADJPRED x Ep
SRESID E
*SDRESID

Standardized Fesidual Plots

Iv Histagram

(8

]

“ZPRED

™ Produce all partial plats

Descriptive Statistics

Mean Std. Deviation N
Jumlah Peserta
Didik Baru 67,2857 8,19100 35
Kompetensi Tutor 49,6857 7,23867 35
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Dikarenakan jumlah Peserta Didik adalah termasuk tipe
deskrit, maka angka desimal pada mean (rata-rata) dapat
ditiadakan, sehingga dapat dikatakan bahwa rata-rata peserta
didik di seluruh kursus adalah 67 dengan standard deviasi 8;
sedangkan rata-rata kompetensi tutornya adalah 49,6857 dengan

standard deviasinya 7,23867. Sampel institusi kursus yang diteliti
sebanyak 35.

Correlations
Jumlah
Peserta Kompetensi
Didik Baru Tutor
Pearson Correlation Jumlah Peserta
Didik Baru 1,000 949
Kompetensi Tutor ,949 1,000
Sig. (1-tailed) Jumlah Peserta 000
Didik Baru !
Kompetensi Tutor ,000
N Jumlah Peserta
Didik Baru 35 3%
Kompetensi Tutor 35 35

Korelasi kompetensi tutor dengan jumlah peserta kursus

adalah 0,949. Bila digunakan skor koefisien determinasi sebesar
0,9060, maka dapat dikatakan bahwa 90,60% jumlah peserta
kursus dipengaruhi oleh kompetensi tutor. Data serupa juga

ditampilkan pada Output Model Summary di bawah ini.
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Variables Entered/Removef

Variables Variables
Model Entered Removed Method
1 Kompetgn

si Tutor

Enter

a. All requested variables entered.
b. Dependent Variable: Jumlah Peserta Didik Baru

Model Summary

Adjusted Std. Error of | Durbin-W
Model R R Square | R Square | the Estimate atson
1 ,9492 ,901 ,898 2,62089 1,847

a. Predictors: (Constant), Kompetensi Tutor
b. Dependent Variable: Jumlah Peserta Didik Baru
Berdasarkan skor Durbin-Watson sebesar 1,847 berarti

tidak terjadi korelasi antara kesalahan pengganggu pada periode t
dengan kesalahan pada periode sebelumnya. Model regresi yang
baik adalah regresi yang bebas dari autokorelasi. Secara garis
besar tolok ukur untuk menyimpulkan adanya autokorelasi atau
tidak adalah sebagai berikut:

a. Angka D-W di bawah -2 berarti terjadi autokorelasi positif.

b. Angka D-W di antara -2 sampai dengan +2 berarti tidak
terjadi autokorelasi.

c. Angka D-W di atas +2 berarti terjadi autokorelasi negatif.

ANOV A
Sum of
Model Squares df Mean Square F Sig.
1 Regression 2054,464 1 2054,464 299,090 ,0002
Residual 226,679 33 6,869
Total 2281,143 34

a. Predictors: (Constant), Kompetensi Tutor
b. Dependent Variable: Jumlah Peserta Didik Baru

Berdasarkan Fuiwng Sebesar 299,090 yang lebih tinggi
dibandingkan dengan Fipel: 0,05:1:33. dengan dk v, = 1 dan dk v, =
33, skornya sebesar 4,139252 atau dengan tingkat signifikansi
sebesar 0,000 yang jauh lebih rendah dari alpha sebesar 0,05,
maka Ho ditolak dan Ha diterima karena kesalahan untuk
menolak Ho mendekati 0%, oleh karena itu dapat disimpulkan
bahwa model regresi ini, yaitu kompetensi tutor dapat digunakan
untuk memprediksi jumlah siswa. Tidak hanya itu, hasil ini juga
menunjukkan bahwa antara variabel kompetensi tutor dengan
variabel jumlah siswa ada hubungan linear.
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Coefficients

Unstandardized Standardized
Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) 13,930 3,117 4,469 ,000
Kompetensi Tutor 1,074 ,062 ,949 17,294 ,000

a. Dependent Variable: Jumlah Peserta Didik Baru

Output di atas menyajikan koefisien regresi. Persamaan
regresinya adalah Jumlah peserta = 13,930 + 1,074 x kompetensi
tutor. Apabila pada sebuah kursus skor kompetensi tutornya
sebesar 35, maka dapat diramalkan peserta didik akan berjumlah
51,52 atau dapat dibulatkan menjadi 53 orang. Output di atas
memperlihatkan Thiung Yang berada pada garis Kompetensi Tutor
sebesar 17,294 ternyata lebih besar bila dibandingkan dengan
Traver: 0,025:33 Sebesar 2,348334, dengan signifikansi 0,0000 maka
Ho dapat ditolak. Hal ini mengandung pengertian Perubahan
jumlah peserta didik juga ditentukan oleh perubahan kompetensi
tutor.

Perlu dijelaskan bahwa di dalam analisis regresi ganda, T-
test digunakan untuk menguji pengaruh masing-masing variabel
x terhadap y, sedangkan F-test yang ditampilkan di atasnya
adalah untuk menguji pengaruh seluruh variabel x secara
bersama-sama terhadap variabel y.

Residuals Statistic$

Minimum__| Maximum Mean Std. Deviation N
Predicted Value 52,5891 80,5096 67,2857 7,77338 35
Std. Predicted Value -1,891 1,701 ,000 1,000 35
ﬁi:g?cﬁj '\E/r;ﬁ;e‘)f 44505 | 95834 | 60708 ,15709 35
Adjusted Predicted Value 52,0626 80,8316 67,2843 7,80719 35
Residual -5,4016 6,0813 ,0000 2,58206 35
Std. Residual -2,061 2,320 ,000 ,985 35
Stud. Residual -2,095 2,367 ,000 1,012 35
Deleted Residual -5,5838 6,3282 ,0014 2,72393 35
Stud. Deleted Residual -2,216 2,558 -,002 1,043 35
Mahal. Distance ,009 3,575 ,971 1,045 35
Cook's Distance ,001 ,151 ,028 ,039 35
Centered Leverage Value ,000 ,105 ,029 ,031 35

a. Dependent Variable: Jumlah Peserta Didik Baru
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Histogram

Dependent Variable: Jumlah Pesert
14

12

10

Std. Dev = 99
Mean = 0,00
0 N=35,00
-200 -100 0,00 1,00 200
-150  -50 .50 15 250

Regression Standardized Residual

Berdasarkan output histogram di atas, terlihat bahwa
sebaran data yang ada menyebar merata ke hampir semua daerah
kurva normal. Dengan demikian dapat disimpulkan bahwa data
yang kita miliki mempunyai distribusi normal. Demikian juga
dengan normal P-P Plot yang terlihat pada halaman berikutnya
memperlihatkan hasil yang sama. Untuk lebih meyakinkan
normalitas data tersebut dapat digunakan uji kolmogorov-
semirnov dengan hasil berikut:

Tests of Normality

Kolmogorov-Smimov’ Shapiro-Wilk
Statistic df Sig. Statistic df Sig.
Kompetensi Tutor ,140 35 ,082 ,961 35 ,241
Jumlah Peserta
Didik Baru ,118 35 ,200% ,945 35 ,079

*. This is a lower bound of the true significance.
a. Lilliefors Significance Correction

Output ini memperlihatkan bahwa angka Sig. dari
Kolmogorov Semirnov untuk variabel x (0,082), dan variabel y
(0,200) yang lebih besar dari 0,05 sebagai toleransi kesalahan,
maka kedua data variabel itu berdistribusi normal.
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Normal P-P Plot of Regression ¢

Dependent Variable: Jumlah Pe
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0,0 [z6°
0,0 3 5 8 10

Observed Cum Prob

Gambar di atas yang menunjukkan nilai data ada di sekitar
baris diagonal ini menguatkan kesimpulan dari hasil uji F, yang
tertera dalam Output ANOVA di atas, sehingga menunjukkan
bahwa antara variabel kompetensi tutor dengan variabel jumlah
siswa ada hubungan linear. Di samping itu, gambar tersebut juga
menunjukkan bahwa distribusi data tersebut adalah normal
karena titik-titik berada di sekitar garis diagonal.

Scatterplot

Dependent Variable: Jumlah Pesert

nnnnn

-2 -1 0 1 2

Regression Standardized Predicted Value

Output di atas memperlihatkan bahwa tidak terjadi
heteroskedastisitas dikarenakan penyebaran nilai-nilai residual
terhadap harga-harga prediksi tidak membentuk suatu pola
sehingga varians data bersifat homogen.

Untuk memastikan hasil uji homoskedastisitas dapat
digunakan metode levene test. Dan hasilnya juga sama karena
signifikasinya sebesar 0,287 yang berarti lebih tinggi dari 0,05,
artinya peneliti tidak dapat menolak Ho. Oleh karena Ho yang
diterima, maka dapat disimpulkan  bahwa  asumsi
homoskedastisitas terpenuhi.
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Test of Homogeneity of Variance

Levene
Statistic dfl df2 Sig.
skor Based on Mean 1,153 1 68 ,287
Based on Median 1,149 1 68 ,287
\,Bv?;e: d?unst'\gg‘y?n and 1,149 1| 66760 288
Based on trimmed mean 1,161 1 68 ,285

Berdasarkan penjelasan di atas, maka seluruh asumsi yang
dibutuhkan terpenuhi sehingga model yang BLUE (Best Linear
Unbiased Estimator) terpenuhi.

Aplikasi dengan Microsoft Excel

Setidaknya ada tiga cara yang dapat digunakan untuk
malakukan aplikasi analisis regresi dengan Microsoft Excel, yaitu
menjabarkan rumus, aplikasi dari function, maupun dari Data
Analysis. Hanya saja ketiganya lebih mengkonsentrasinya diri
pada pencarian persamaan regresi.

Rumus permasaan regresi linear sederhana adalah sebagai
berikut:

Y =a+bX

Dimana :

Y = Subyek dalam variabel dependen yang diprediksikan

a = Harga Y bila X = 0 (harga konstan)

b = Angka arah atau koefisien regresi, yang menunjukkan
angka peningkatan ataupun penurunan variabel
dependen yang didasarkan pada variabel independen.
Bila b (+) maka naik, dan bila (-) maka terjadi
penurunan

X = Subyek pada variabel independen yang mempunyai

nilai tertentu
Sementara rumus untuk mencari a dan b adalah sebagai berikut:

. ZXY-n()_(_)EV)
D X*-n(X")

b=Y —b(X)
Sedangkan aplikasi dari function dapat diaplikasikan
dengan fungsi slope dan intercept. Adapaun cara untuk mencari
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slope adalah dengan mencari menu tersebut pada function seperti
di bawah ini.

Insert Function El El

Search for a function:

Type a brief description of what you want to do and then Go
click Go
O select a category: |Statistical ﬂ

Select a function:

SLOPE{(known_y's;known_x's)
Returns the slope of the linear regression line through the given data points.

Help on this function Cancel

Setelah klik Ok, maka akan keluar seperti gambar berikut ini,

maka klik di kolom Known_y’s lalu bloklah seluruh data

variabel y, sedemikian juga untuk Known_x’s untuk variabel x.
Function Arguments sz'

SLOPE
Known_y's E = {54;54,;55,56;57,57.

Known_x's [42:436 el = {37;38;39,36,4 141

= 1,073868557
Returns the slope of the linear regression line through the given data paints.

Known_y's is an array o cell range of numeric dependent data points and can be
numbers or names, arrays, or references that contain numbers,

Farmula resulk = 1,074
Help on this Funckion oK | Cancel |

Sedangkan mencari intercept seperti di bawah ini:
INTERCEPT
Known_y's | e = {54;54;55;56;57;57,
Known_x's [az:035 Sl = {37,38;39;36,4 1,41,
= 13,02076798

Calculates the point at which a line will intersect the y-axis by using a best-fit regression line
plotted through the known x-values and y-values.

Known_y's is the dependent set of observations or data and can be numbers ar
names, arrays, of references that contain numbers.

Formula resulk = 13,930

Help on this funckion Ok | Cancel
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Aplikasi dari function ternyata mempunyai hasil yang

sama dibandingkan

dengan

regresi
lan berikut

pencarian persamaan

ini.

hat pada tampi

terli

seperti

barkan rumus,

menjal
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tas, dapat juga dilakukan dengan

ft Excel melalui Data Analysis seperti

d

i samping cara

D
mengaplikasi

ICroso

ini:

bawah

Data Analysis

ysis Tools

Anal

Exponential Smoothing

F-Test Two-Sample for Wariances

Fourier Analysis
Hiskogram

o
[
Tl

Random Mumnber Generation
t-Test: Paired Two Sample For Means

Moving Average
R.ank and Percentile

Sampling
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Setelah regression diklik, dan variabel diisikan sesuai dengan
tempatnya, dan menu-menu lain yang dibutuhkan diklik, maka
akan keluar output yang sebagiannya ditampilkan berikut ini.

A B c D E F
1 |SUMMARY OUTPUT
2
3 Ragression Statistics
4 |Multiple R 0,549014879
5 |R Square 0,900529241
6 | Adjusted R Sguare 0897618006
7 |Standard Error 2 B20888688
8 | Observations 35
9
10 | ANDWA
11 af 55 MS F Significance £
12 |Regression 1 2054 463989 2054 463559 299 035643 0,000
13 |Residual 33| 226 6788979 6865057512
14 | Tatal 34 2281142857
15
16 Coeficients | Standard Eror i Siat Falua Lowar 35% L
17 |Intercept 1392975798 3116834745 4 46520967 8,7308E-05 7588534988 20
18 |x 1073866057 0,062094115 17 29420837 4,12595E-18 0547537031 1.2
19
20 |PROBABILITY OUTFUT
21
2 Fercentie v Normal Probability Plot
23 1428571429 54
24 4,2857 14286 54 100 s
25 7, 142857143 5] o g leess
26 10 56
27 1285714286 57 a ' J ' ' j
28 1671426571 57 o 20 40 B0 g0 100 120
29 1867142857 a8 Sample Percentile
30 21,42857143 59
el 24 PRETIADTN RN

Dari tiga cara di atas ternyata menghasilkan skor yang
sama, yaitu slopenya = 1,074 sementara intercept (konstanta)nya
sebesar = 13,930.

C. Regresi Ganda Dua Prediktor

Regresi ganda dua prediktor adalah regresi di mana ada tiga
variabel yang terlibat di dalamnya. Dua di antara tiga variabel
tersebut menjadi variabel independen dan satu menjadi variabel
dependen.

Contoh:
Peneliti berkeinginan untuk memprediksikan naik dan turunnya

jumlah peserta kursus apabila terjadi perubahan/perbedaan
kompetensi tutor dan dana promaosi.
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Proses Pengambilan Keputusan.

Hipotesis:

Ho Kompetensi tutor dan dana promosi tidak berpengaruh
terhadap jumlah peserta didik kursus.

Ha Kompetensi tutor dan dana promosi berpengaruh

terhadap jumlah peserta didik kursus.
Dasar Pengambilan Keputusan:
Dengan membandingkan r/t/Fjwng dengan r/t/Fipe dengan ketentuan:
Ho diterima  r/t/Fhitung < M/Fapel
Ho ditolak  r/t/Fhitung > It/Fapel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)
Ho ditolak ~ Probabilitas < taraf nyata (a)

Aplikasi dengan SPSS

a. Data diinput pada worksheet data view, lalu klik Analyze »
Regression » Linear, sebagaimana gambar di bawah ini:

regresi 2 prediktor - SPSS Data Editor
File Edit Wiew Data Transform EGEREEN Graphs  Utilities  Window  Help

~u Reports 3
= |n |§| | | J Descriptive Statistics ] M ’g@
L | 5 Tables 4
Compare Means 3
il | < General Linear Model 3 bl | var
1 520 600 Mized Models »
2 550 B0 correlate 4
3 560 EeN  negression 3
4 5,80 E20 Loglinear k| Curve Estimation...
= - o - ~lemmifi =

b. Destinasikan variabel dependen (y) pada kolom yang ada di
bawah Dependent, demikian juga kedua variabel independen
ke kolom Independent(s), sebagaimana gambar di bawah ini.
Selanjutnya Klik Statistics...
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<@ Dana Promosi dalam Ji vt Ok
& Kompstensi Tutor [+2] \:\ <#» Jumlah Peserta Didik E e
Block 1 of 1
Mext Reset

[

Iethod: Enter -

Selection W anable:

] e |

D LCaze Labels:
l—
WS »» Statistics... | Flats... | Save... | Options... |

c. Setelah keluar gambar seperti berikut ini aktifkan juga
Descriptive untuk mendeskripkan data, aktifkan Collinearity
diagnostic untuk mengetahui apakah terjadi korelasi antar
variabel indenpenden atau tidak, aktifkan Dubin-Watson pada
Residuals untuk mengetahui ada tidaknya autokorelasi.
Selanjutnya klik Continue untuk kembali pada tampilan
sebelumnya, lalu klik Plots...

Linear, Regression: Statistics

Regression Coefficients [+ Model fit

Iv Estimates ™ R zquared change = I
= . ance

™ Confidence intervals [ Descriptives

Iv Covariance matrix ™ Part and partial comelations Help

Iv Collinearity diagnostics

Residuals

[ Casewise diagnostics

e o

~

d. Destinasikan ZPRED pada kolom X dan SRESID pada kolom
Y untuk mengetahui terpenuhi tidaknya Homoskedastisitas
atau sering juga disebut homogenitas. Selanjutnya aktifkan
juga Histogram dan Normal Probability Plot untuk
mengetahui normalitas distribusi data, lalu klik Continue dan
selanjutnya klik Ok.
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Linear Regression: Plots

DEFENDNT Scatter 1 of 1
"ZFRED | et |

ZRESID Cancel
*DRESID % o
*A0JPRED RSN “SRESID elp
*SRESID E

“SDRESID I:I # ["ZPRED

Standardized Fesidual Plots [~ Produce all partial plats

Iv Histagram

d. Berikut ini adalah Output analisis regresi di atas.

Descriptive Statistics

Mean Std. Deviation N
Jumlah Peserta
Didik Baru 67,2857 8,19100 35
Dana Promosi 7,4200 1,28379 35
dalam Jutaan ! ’
Kompetensi Tutor 51,9429 7,74575 35

Dikarenakan jumlah Peserta Didik adalah termasuk tipe
deskrit, maka angka desimal pada mean (rata-rata) dapat
ditiadakan, sehingga dapat dikatakan bahwa rata-rata peserta
didik di seluruh kursus adalah 67 dengan standard deviasi 8;
sedangkan rata-rata dana promosi sebesar 7.420.000,- dengan
standard deviasi sebesar 1.283.790,-; serta kompetensi tutornya
adalah 51,9429 dengan standard deviasinya 7,74575. Sampel
institusi kursus yang diteliti sebanyak 35.

Correlations

Jumlah Dana
Peserta Promosi Kompetensi
Didik Baru [ dalam Jutaan Tutor

Pearson Correlation  Jumlah Peserta

Didik Baru 1,000 ,714 ,588

Dana Promosi

dalam Jutaan 714 1,000 819

Kompetensi Tutor ,588 ,319 1,000
Sig. (1-tailed) Jumlah Peserta

Didik Baru : 000 1000

Dana Promosi

dalam Jutaan ,000 : 031

Kompetensi Tutor ,000 ,031
N Jumlah Peserta

Didik Baru 35 35 35

Dana Promosi

dalam Jutaan 35 35 35

Kompetensi Tutor 35 35 35

Korelasi kompetensi tutor dengan jumlah peserta kursus
adalah 0,588, antara Dana promosi dan jumlah peserta didik
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sebesar 0,714, sedangkan korelasi antar dua variabel independen,
yaitu dana promosi dan kompetensi tutor sebesar 0,031.

Variables Entered/Removed

Variables Variables
Model Entered Removed Method
1 Kompeten
si Tutor,
Dana
Promosi
dalam ,
Jutaan

Enter

a. All requested variables entered.
b. Dependent Variable: Jumlah Peserta Didik Baru

Model Summary’

Adjusted Std. Error of | Durbin-W
Model R R Square | R Square | the Estimate atson
1 ,8092 ,654 ,633 4,96497 1,487

a. Predictors: (Constant), Kompetensi Tutor, Dana Promosi dalam
Jutaan

b. Dependent Variable: Jumlah Peserta Didik Baru

Berdasarkan skor Durbin-Watson sebesar 1,487 berarti
tidak terjadi korelasi antara kesalahan pengganggu pada periode t
dengan kesalahan pada periode sebelumnya. Model regresi yang
baik adalah regresi yang bebas dari autokorelasi. Secara garis
besar tolok ukur untuk menyimpulkan adanya autokorelasi atau
tidak adalah sebagai berikut:

d. Angka D-W di bawah -2 berarti terjadi autokorelasi positif.

e. Angka D-W di antara -2 sampai dengan +2 berarti tidak
terjadi autokorelasi.

f. Angka D-W di bawah +2 berarti terjadi autokorelasi negatif.

ANOV A
Sum of
Model Squares df Mean Square F Sig.
1 Regression 1492,313 2 746,157 30,269 ,0002
Residual 788,829 32 24,651
Total 2281,143 34

a. Predictors: (Constant), Kompetensi Tutor, Dana Promosi dalam Jutaan
b. Dependent Variable: Jumlah Peserta Didik Baru

Berdasarkan Fuiwng sebesar 30,269 yang lebih tinggi
dibandingkan dengan Fper: 005:2:32. dengan dk v, = 2 dan dk v, =
32, skornya sebesar 3,294531 atau dengan tingkat signifikansi
sebesar 0,000 yang jauh lebih rendah dari alpha sebesar 0,05,
maka Ho ditolak dan Ha diterima karena kesalahan untuk
menolak Ho mendekati 0%, oleh karena itu dapat disimpulkan
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bahwa model regresi ini, yaitu variabel dana promosi dan
kompetensi tutor secara bersama-sama dapat digunakan untuk
memprediksi jumlah siswa. Tidak hanya itu, hasil ini juga
menunjukkan bahwa antara variabel dana promosi, kompetensi
tutor dengan variabel jumlah siswa ada hubungan linear.

Coefficients

Model
1

Dana Promosi

(Constant) | dalam Jutaan | Kompetensi Tutor

Unstandardized B 17,513 3,741 ,424
Coefficients Std. Error 6,635 ,700 ,116
Standardized Coefficients Beta ,586 ,401
t 2,640 5,347 3,654
Sig. ,013 ,000 ,001
Collinearity Statistics Tolerance ,898 ,898
VIF 1,113 1,113

a. Dependent Variable: Jumlah Peserta Didik Baru

Output di atas menyajikan tiga hal penting, yaitu
persamaan regressi, thiwng dan uji multikolinearitas. Persamaan
regresinya adalah Jumlah peserta = 17,513 + (0,424 x kompetensi
tutor) + (3,741 x Dana Promosi). Di samping itu, output di atas
memperlihatkan Thiwng Yang berada pada kolom Dana promosi
sebesar 5,347 dan pada kolom Kompetensi Tutor sebesar 3,654
ternyata lebih besar bila dibandingkan dengan Tiapei: 0,025:33 Sebesar
2,348334, dengan signifikansi 0,0000 maka Ho dapat ditolak. Hal
ini mengandung pengertian Perubahan jumlah peserta didik juga
ditentukan oleh perubahan Dana Promosi dan juga oleh
kompetensi tutor. Sedangkan uji multikolinearitas dapat diketahui
dari skor Tolenace dan VIF. Apabila skor VIF (Variance
Inflation Factor) di sekitar angka 1 dan mempunyai angka
Tolerance mendekati membuktikan bahwa model tersebut
terbebas dari multikolinearitas. Artinya, tidak diketemukan
korelasi yang tinggi antar variabel independent. VIF Dana
Promosi sebesar 1,113 dan angka tolenace sebesar 0,898
sedangkan VIF Kompetensi Tutor sebesar 1,113 dengan angka
tolerance sebesar 0,898.



Apnalisis Regresi 158

Coefficient Correlation8

Dana
Kompetensi Promosi
Model Tutor dalam Jutaan
1 Correlations  Kompetensi Tutor 1,000 -,319
Dana Promosi .319 1,000

dalam Jutaan
Covariances  Kompetensi Tutor ,013 -,026
Dana Promosi
dalam Jutaan

-,026 ,490

a. Dependent Variable: Jumlah Peserta Didik Baru

Output di atas juga digunakan untuk mendeteksi adanya
masalah multikolinearitas. Apabila koefisien korelasi antar
variabel independen di bawah 0,5 membuktikan bahwa model
tersebut terbebas dari multikolinearitas.  Artinya, tidak
diketemukan korelasi yang tinggi antar variabel independent.
Berdasarkan output di atas diketahui bahwa koefisien antara
Kompetensi Tutor dengan Dana promosi adalah -0,319. Skor ini
lebih kecil dibanding 0,5.

Collinearity Diagnosticd

Variance Proportions
Dana
Condition Promosi Kompetensi

Model _Dimension | Eigenvalue Index (Constant) [ dalam Jutaan Tutor
1 1 2,972 1,000 ,00 ,00 ,00

2 ,018 13,007 ,05 ,92 ,33

3 ,010 17,003 ,94 ,08 ,67

a. Dependent Variable: Jumlah Peserta Didik Baru
Residuals Statistic$
Minimum__| Maximum Mean Std. Deviation N

Predicted Value 54,9916 80,8260 67,2857 6,62507 35
Std. Predicted Value -1,856 2,044 ,000 1,000 35
§::g‘|’:t‘;% Egﬁjem 85168 | 221714 | 1,40011 39639 35
Adjusted Predicted Value 54,9903 81,7017 67,4676 6,64853 35
Residual -8,4160 10,7508 ,0000 4,81673 35
Std. Residual -1,695 2,165 ,000 ,970 35
Stud. Residual -1,890 2,259 -,017 1,022 35
Deleted Residual -10,4860 11,6970 -,1819 5,35378 35
Stud. Deleted Residual -1,973 2,425 -,019 1,047 35
Mahal. Distance ,029 5,809 1,943 1,601 35
Cook's Distance ,000 ,296 ,039 ,064 35
Centered Leverage Value ,001 171 ,057 ,047 35

a. Dependent Variable: Jumlah Peserta Didik Baru
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Histogram

Dependent Variable: Jumlah Pesert:

YL K>

CESLBRT

Regression Standardized Residual

Berdasarkan output histogram di atas, terlihat bahwa
sebaran data yang ada menyebar merata ke hampir semua daerah
kurva normal. Dengan demikian dapat disimpulkan bahwa data
yang kita miliki mempunyai distribusi normal. Demikian juga
dengan normal P-P Plot yang akan terlihat nanti memperlihatkan
hasil yang sama. Untuk lebih meyakinkan normalitas data
tersebut dapat digunakan uji kolmogorov-semirnov dengan hasil
berikut:

Tests of Normality

Kolmogorov-Smirnov® Shapiro-Wilk
Statistic df Sig. Statistic df Sig.
Dana Promosi
dalam Jutaan ,086 35 ,200* ,968 35 ,384
Kompetensi Tutor ,132 35 ,132 ,929 35 ,026
Jumlah Peserta
Didik Baru ,118 35 ,200* ,945 35 ,079

*. This is a lower bound of the true significance.
a. Lilliefors Significance Correction

Output ini memperlihatkan bahwa angka Sig. dari
Kolmogorov Seminrnov untuk variabel x; (0,200), variabel X,
(0,132), dan variabel y (0,200) yang lebih besar dari 0,05 sebagai
toleransi kesalahan, maka ketiga data variabel itu berdistribusi
normal.
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Normal P-P Plot of Regression ¢

Dependent Variable: Jumlah Pe

0,0

Observed Cum Prob

Gambar di atas menguatkan kesimpulan hasil uji F di atas
sehingga menunjukkan bahwa antara variabel kompetensi tutor
dan dana promosi dengan variabel jumlah siswa ada hubungan
linear. Di samping itu, gambar tersebut juga menunjukkan
normalitas distribusi data karena titik-titik berada di sekitar garis
diagonal.

Scatterplot

Dependent Variable: Jumlah Pesert
3
2
l o : o : o

o a
o -]

ofo Lo o oo o
1 o ° o
2 =] ° o

2 1 0 1 2 3

Regression Standardized Predicted Value

Output di atas memperlihatkan bahwa tidak terjadi
heteroskedastisitas dikarenakan penyebaran nilai-nilai residual
terhadap harga-harga prediksi tidak membentuk suatu pola
sehingga varians data bersifat homogen.
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Berdasarkan penjelasan di atas, maka seluruh asumsi yang
dibutuhkan terpenuhi sehingga model yang BLUE (Best Linear
Unbiased Estimator) terpenuhi.

2. Aplikasi dengan Microsoft Excel

Untuk mencari permasaan regresi ganda dapat digunakan rumus

berikut ini:

Y =a+ byx; + byXo.
Keterangan
Y = adalah skor yang diprediksikan
a = intercept atau Konstanta
X1 dan X2 = variabel bebas | dan Il
b; dan b, = koefisien regresi

Sedangkan cara untuk menghitung harga a, b;, dan b,
menggunakan persamaan rumus sebagai berikut:

bl= (szz)(ley)— Xy X xx,)
(lezxzxzz)_ (lexz)2

b2 — (ZX:LZXZXzy)—(ZleXZXlxz)
(lezxzxzz)—gxlxz)z

a=Y —b, (X)b, (X2)

Keterangan:
lez =Zx12- (le)z
n
Y X/ =¥ %’ ?Y
2 X1 % =ZX1X2'(ZXIHXX2)
X1y =Y x1y- M

n
Y X2y =3 xy- Exly)
n
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dilakukan dengan mengaplikasi

juga

di atas, dapat
Microsoft Excel melalui Data Analysis. Setelah regression diklik, dan

i samping cara

D

variabel diisikan sesuai dengan tempatnya, dan menu-menu lain yang

sebagiannya

output yang

maka akan keluar

dibutuhkan  diklik,

ni.

ditampilkan berikut
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atas ternyata menghasilkan skor

di
dalah Jumlah peserta = 17,513 + (0,424 x

kompetensi tutor) + (3,741 x Dana Promosi).

tiga cara

Dari
persamaan regresinya a
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BAB VI
ANALISIS KOMPARASI

A. Pendahuluan

Analisis komparasi berarti menguji parameter populasi yang
berbentuk perbandingan melalui ukuran sampel yang juga berbentuk
perbandingan. Hal ini juga berarti menguji hipotesis mengenai ada
tidaknya perbedaan antarvariabel yang sedang diteliti. Jika ada
perbedaan, apakah perbedaan itu signifikan atau hanya terjadi secara
kebetulan.

B. Macam-macam Teknik Analisis Komparasi

Terdapat dua model komparasi, yaitu komparasi antara dua
sampel dan komparasi antara lebih dari dua sampel. Masing-masing
juga dibagi menjadi dua jenis, yaitu komparasi antar sampel yang
berkorelasi dan komparasi antara sampel yang tidak berkorelasi.
Untuk lebih jelasnya dapat dilihat pada gambar berikut ini:

BENTUK HIPOTESIS
MACAM . Komparatif (Lebih dari dua
DATA Komparatif (Dua Sampel) sampel)
Related Independen Related Independen
Fisher Exact x* for k 2 for K
NOMINAL Me Probability Sample - for
Nemar ) Sample
¥~ Two Sample | Cochran Q
Median Test
. Mann-Whitney Median
3\;%]'” Test U Test Friedman Extention
ORDINAL Mla(t:((:);(; dn Kolmogorov- | Two-way Kruskal-
X Smirnov Anova Wallis One
Pairs
Wald- Way Anova
Woldfowitz

165
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INTERVAL | T-test of T-test of OA”;"\‘;:V OA”ﬁ'O"\‘;Zy
RASIO Related independent
Two-way Two-way
Anova Anova

C. Komparasi Dua Sampel Berkorelasi
1. Statistik Parametrik: T-test of Related

T-test of Related adalah statistik parametrik yang
digunakan untuk menguji hipotesis komparatif rata-rata dua
sampel bila datanya berbentuk interval atau rasio yang
menggunakan rancangan perbandingan sebelum dan sesudah
adanya perlakuan/treatmen.

Contoh:

Dilakukan penelitian untuk mengetahui ada tidaknya
perbedaan prestasi belajar siswa sebelum dan sesudah diberi
kursus. Berdasarkan data dari 35 siswa yang dipilih secara
random diketahui bahwa prestasi belajar siswa sebelum dan
sesudah mengikuti kursus adalah sebagai berikut:

sehelum | zesudah | 18 ?DIDDI BUIUDI
1 76,00 85 00 19 80,00 90,00
2 80,00 90,00 20 B5.00 B000
3 BE 00 75 00 21 7500 7500
1 70,00 75 00 2 50,00 85 00
5 7500 75 00 23 70,00 50,00
= 80,00 90,00 24 50,00 95,00
7 65,00 70,00 25 70,00 75,00
- 80,00 55 00 o 7500 7900
5 20,00 % 00 > 87 00 85 00
10 7500 70,00 L 78,00 79,00
T B000 B5 00 z 85,00 83,00
12 7000 75,00 20 57.00 85,00
Y 79,00 80,00
13 7500 85.00 = 80,00 8200
14 70.00 65,00 = 86,00 84,00
L7 &0.00 95,00 34 8200 8500
e 65,00 55,00 = 8400 85 00
17 75,00 a0,00

Proses Pengambilan Keputusan.

Hipotesis:

Ho Prestasi belajar siswa antara sebelum dan sesudah
kursus adalah identik/sama
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Ha Prestasi belajar siswa antara sebelum dan sesudah
kursus adalah berbeda

Dasar Pengambilan Keputusan:

Dengan membandingkan thiwng dengan tane dengan ketentuan:
Ho diterima thitung < trabel

Ho ditolak thitung = Ttabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

a. Aplikasi dengan SPSS

1. Setelah data diinput, lalu klik Analyze » Compare
Means » Paired Samples T Test sebagaimana gambar di
bawabh ini:

data utk t-test paired - SPSS Data Editor;

File Edit Yiew Data Transform QEUEEEN Graphs Utilities  Window Help

~ Reports 3
EI% —|—| J Descriptive Skatistics 3 'I' n @@
1 : sebelum 7 Tables »
sebelum | zesudah | i Compare Means 2 Means. ..
17500 500 General Linear Model M One-Sample T Test...
2 30.00 90.00 Mixed Madels 3 Independent-Samples T Test, .,
3| es00|  sm0 Correlate v S
4 70.00 7500 Regression 4 Cne-Way AMOVA,.,
5 7o n 75 n I nnlinear » T

2. Setelah keluar gambar sebagai berikut: arahkan variabel x
(sebelum) dan y (sesudah) ke dalam Paired Variables,

lalu klik OKk.
M Paired-Samples T Test fgl
< Sebelum kursus [sebel. F'aie Variables: aK
zebelum - sesudah
@ setelah kursus [sesudal Paste
\I\ FReset
Cancel
Help
Current Selections
“ariable 1:
Wariable 2:

3. Tampilan di bawabh ini adalah hasil penghitungan itu.
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Paired Samples Statistics

Std. Error
Mean N Std. Deviation Mean
Pair Prestasi Belajar
1 Sebelum Kursus 76,3714 35 7,66614 1,29581
Prestasi Belajar
Sesudah Kursus 80,2000 35 8,79438 1,48652

Output ini menunjukkan bahwa sampel penelitian ini adalah
35, rata-rata prestasi belajar sebelum mengikuti kursus adalah
76,3714 dengan standard deviasi sebesar 7,66614 dan
sesudanya adalah 80,2 dengan standard deviasi sebesar
8,79438. Jadi rentang data sebelum kursus adalah antara
53,37298 sampai dengan 99,36982. Sedangkan rentang data
setelah kursus adalah antara 53,81686 sampai dengan
106,5831. Skor ini merupakan penjabaran dari Mean + 3
Standard Deviasi. Sedangkan rentang rata-rata sebelum
kursus adalah antara 75,07559 sampai dengan 77,66721.
Sedangkan rentang rata-rata setelah kursus adalah antara
78,71348 sampai dengan 81,68652. Skor interval ini adalah
dari Mean + 1 Standard Error of Mean.

Paired Samples Correlations

N Correlation Sig.

Pair Prestasi Belajar Sebelum
1 Kursus & Prestasi Belajar 35 ,816 ,000
Sesudah Kursus

Output ini menunjukkan bahwa korelasi antara variabel
sebelum dan sesudah adalah 0,816. Hal ini menunjukkan
bahwa korelasi data dari masing-masing responden adalah

sangat erat.
Paired Samples Test
Pair 1
Prestasi Belajar Sebelum
Kursus - Prestasi Belajar
Sesudah Kursus

Paired Differences Mean -3,8286
Std. Deviation 5,10182

Std. Error Mean 86237

95% Confidence Interval  Lower -5,5811

of the Difference Upper -2,0760

t -4,440
df 34
Sig. (2-tailed) ,000
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Output ini menunjukkan bahwa perbedaan rata-rata prestasi
belajar sebelum dan sesudah kursus adalah 3,8286, dengan
standard deviasi 5,10182 dan standard error of mean sebesar
0,86237. Hal yang sangat penting dari output di atas adalah
thitung: -4,440. Bila tyiwung ini dimutlakkan akan menjadi: 4,440.
Skor ini ternyata lebih tinggi dari tupe (534 2,032243.
Dengan demikian, maka Ho ditolak dan Ha diterima.
Kesimpulan ini sama apabila digunakan skor sig untuk 2 sisi,
yaitu 0,000 yang jauh lebih kecil bila dibandingkan dengan
kesalahan yang ditoleransi yaitu 0,05 (5%). Berangkat dari
hasil analisis ini dapat disimpulkan bahwa prestasi belajar
siswa antara sebelum dan sesudah kursus adalah berbeda.

. Aplikasi dengan Microsoft Excel

Langkah-langkah untuk mengaplikasikan analisis t-test
of related dengan Microsoft Excel adalah sebagai berikut:

1. Carilah selisih masing-masing skor sebelum dan
sesudah mendapatkan perlakuan.

2. Carilah rata-rata skor dari selisih di atas.

3. Kurangilah masing-masing skor hasil selisinh di atas
dengan rata-rata selisihnya.

4. Kuadratkan masing-masing hasil pengurangan di nomor
3.

5. Jumlahkan seluruh skor dari hasil di nomor 4.
6. Hasil dari nomor 5 dimasukkan ke rumus
Md

> xid
| N(N -1)

Untuk lebih jelasnya dapat dilihat pada aplikasi Microsoft
Excel berikut ini.

t:
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Add - 5
A | B C D E F H J

1 URUTAN ANALISIS T-TEST PAIRED

2

3| No Pre Post d d-Md wd”

1 m 74 g5 0| -617| 3808 0,744 =F39/(35"34)

5[ 02 &0 a0 0| -617| 38,08 0.862 =SQRT(H4)

B 03 B4 75 0| -BA7| 3808

70 4 70 75 a7 137 4,440 =D39/H5

8 05 75 75 o] 383 1456

8 7 06 g0 50 0] 67| 38,08 A

w0 i 70 E A1 131 | e—m——

117 08 80 85 K KL 1,37 2 X

127 09 an 85 5 ERE Niy¥ - 1)

1310 73 70 AR

14 11 A 3 EERE

15 12 710 75 i ERE

16 13 75 85 0] 67| 38,08

17 14 70 B AR

18 1% g0 85 18] 11,17 124,80

18 16 [ [ o 383 1456

0 17 75 ] i ERE

21 18 710 ] 0] 617 38,08

22 18 gl a0 0] 67| 38,08

ENE [ Bl 5 8@ T

A 75 75 0| 383 1456

35 22 g0 85 R

6 23 710 B0 0] 67| 38,08

7 M an 85 E ERE

8 5 710 75 i ERE

28 76 75 78 F RN E

NN g7 B5 I 583 AW

3 78 7a 78 K 283 &

32 78 g5 EE AR

33 30 &7 85 AR

TN 79 B0 -1 283 &m

E ] iz 3 183 3

EE 3 T AR

HED g2 85 3] 083 058

S 84 85 -1 283 &m

a8 76,371| a0200] -3,829 594,37

PR N o= =iy

Di samping cara di atas, t-test juga dapat diaplikasikan

melalui menu Data Analysis sebagai berikut:

1. Setelah dipilih Data Analysis dari Tools, maka pilihlah t-
test: Paired Two Sample for Means sebagaimana gambar

berikut ini.

Analysis Tools

Histagram
Moving Average
Random Mumber Generation

: Two-Sample Assuming Equal Yariances
t-Test: Two-Sample Assuming Unequal Yariances
2-Tesk: Two Sample for Means

-

Cancel

Help




171

2. Setelah keluar gambar
Variable 1 Range, lalu

Statistika untuk Penelitian Pendidikan

seperti berikut ini, Kklik di kolom
bloklah seluruh data sebelum kursus.

Selanjutnya klik pada kolom Variable 2 Range, lalu bloklah
seluruh data setelah kursus. Aktifkan Labels kalau di atas

data yang kita ketik di

beri label dan juga termasuk diblok

untuk ditampilkan. Setelah itu klik Ok.

t-Test: Paired Two Sample for Means

Input
Variable 1 Range:

Yariable Z Range:

Hypothesized Mean Difference:
¥ Labels

Alpha: ’D,T

Oukput options

" Qukput Range:

+ Mew Worksheet Ply:

™ Mew Workbook

PX]
§CfagCsn = Cancel |

L

3. Berikut ini adalah output dari aplikasi di atas. Terlihat bahwa
hasilnya sama dengan hasil penghitungan dengan SPSS dan
penjabaran rumus dengan Microsoft Excel. Kelebihan dari

aplikasi Data Analysis
alpha 5% baik untuk uji

adalah adanya tampilan ti,e dengan
satu sisi maupun dua sisi.

14 't Critical two-tail

A B C
1 t-Test: Paired Two Sample for Means
2
3 Fra Fos?
4 |Mean 76 37142857 802
5 |Wariance 58 7697473 77 34117647
B |Observations 35 35
7 |Pearson Correlation 0,816404533
8 |Hypothesized Mean Difference 0
9 df 34
10 |t Stat -4 439618065
11 |P(T==t) one-tail 4 51832E-05
12 |t Critical one-tail 1 690923455
13 |P(T==t) two-tail 5 036E3E-05

2032243174

15

Dengan derajat kebebasan 35-1 = 34, untuk alpha 5%
taneinya adalah 2,032243 untuk uji dua sisi atau 1,690923 untuk
uji satu sisi dan untuk alpha 1% = 2,728393 untuk uji dua sisi
atau 2,441147 untuk uji satu sisi. Karena thiung -4,439618065
lebih besar dari tgpe baik untuk alpha 1% maupun 5% maka Ho
ditolak dan Ha diterima, artinya kesimpulan dari sampel bahwa
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prestasi belajar siswa berbeda antara sebelum dan sesudah
kursus, dalam kasus ini perubahan itu menuju kepada
peningkatan, berlaku untuk populasi, baik dalam kesalahan 1%
maupun 5%.

2. Statistik Non-Parametrik

a. McNemar

McNemar digunakan untuk menguji  hipotesis
komparative apabila datanya bertipe nominal yang
berkorelasi. Rancangan penelitiannya biasanya berbentuk
perbandingan  skor sebelum dan sesudah adanya
perlakuan/treatment. Jadi desain penelitiannya sering disebut
”before after”.

Contoh:

Seorang peneliti ingin mengetahui pengaruh perilaku
seorang Ketua yang bernama lkuelaji selama satu periode
menjabat terhadap jumlah suara yang diperoleh dalam
pemilihan Ketua pada suatu Sekolah Tinggi pada periode
berikutnya. Selama ia menjabat, mayoritas Tenaga Pendidik
menganggap ketua tersebut sering melakukan korupsi,
mengelola keuangan secara tidak transparan, dan gemar
menekan sivitas akademika yang Kkritis. Pada pemilihan
tahun 2005 mendapat suara 180 dari 200 Tenaga Pendidik,
Sedangkan pada pemilihan 2009 dia mendapat suara 173
suara. Dari 20 Tenaga Pendidik yang pada pemilihan 2005
tidak memilihnya 10 di antaranya menjadi memilihnya pada
tahun 2009, sedangkan 10 lainnya tetap tidak memilihnya.
Dari 180 Tenaga Pendidik pendukungnya pada tahun 2005
ada sebanyak 16 Tenaga Pendidik akhirnya tidak
memilihnya, sedangkan 164 lainnya tetap setia memilihnya.
Tabulasi Perbandingan hasil suara dapat dilihat pada tabel
berikut ini.

Pemilihan 2005 * Pemilihan 2009 Crosstabulation

Count
Pemilihan 2009
Tidak Memilih Memilih Total
Pemilihan Tidak Memilih 10 10 20
2005 Memilih 16 164 180
Total 26 174 200




173

Statistika untuk Penelitian Pendidikan

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perubahan jumlah pemilih
antara pemilihan tahun 2005 dan 2009

Ha Terdapat perubahan jumlah pemilih antara

pemilihan tahun 2005 dan 2009
Dasar Pengambilan Keputusan:

Dengan membandingkan y’iwng dengan  x’wne  dengan
ketentuan:

Ho diterima A hitung < A tabel

Ho ditolak thitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (a)

Ho ditolak Probabilitas < taraf nyata (o)

1) Aplikasi dengan SPSS

a) Setelah data diinput, maka Kklik Analyze »
Nonparametric Test » 2 Related Samples...,
sebagaimana gambar berikut ini.

McNemar - 5PS5 Data Editor.
File Edit ‘Wiew Data Transform PEREECN Graphs  Utiities  wWindow Help

— Reports
R
El% ﬂ 4|—| J Descriptive Statistics
1:th03 0 Tables

Compare Means
General Linear Model

&5 [+ 2

thos |

»
»
»
3
»

1] Tidak Memilih| Tida) i ed Models v

2| Tidak Memilih| Tid  cqrrelate »

3| Tidak Memilih| Tid  Regression 4

4| Tidak Memilih|  Tid  Loglinear 3

5| Tidak Memilih| Tid  Classify 4

6| Tidak Memilih| Tig D3taReduction *

7| Tidak Memilih|  Tid 53 - :

q Tidak Memilih Tid I"-Jl:wr||:|ara'|Eetru: Tests 4 Chl-St.lLlarE.‘.

- = - Time Series 13 Binormial. ..

9| Tidak Memilih| Tid o 0 S

10| Tidak Memilih| Tid  pyiple Response b 1-Sample K-5...

11 Tidak emilih Missing Yalue Analysis... 2 Independent Samples...

12| Tidak Memilih TMEmNAT || K Independent Samples...

13| Tidak Memilih Memilih 2 Related Samples. ..

14| Tidak Memilih Memilih K Related Samples...

AEL Tl bdeilil WA mnilib

b) Setelah keluar seperti gambar berikut ini, destinasikan
kedua kumpulan data sampel tersebut ke dalam kotak
Test Pais(s) List, lalu non-aktifkan Wilcoxon dan
aktifkan McNemar lalu klik Ok.
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B Two-Related-Samples Tesis

& Pemilihan 2005 [th05]
& Pemilihan 2005 [th0g]

[

Current 5 elections
Yariable 1:
ariable 2:

E
Test Paiflz) List:
[ |

Test pe

’ "n ™ Sign W McMemar
I Marginal Homogeneity

Exact...

| Options...

c) Berikut ini adalah Output hasil analisis di atas.

Pemilihan 2005 & Pemilihan 2009

Pemilihan 2009
Pemilihan 2005 0 1
0 10
1 16

10
164

Output di atas memperlihatkan bahwa:
1.

174

Jumlah Tenaga Pendidik yang pada pemilihan 2005

tidak memilih lkuelaji dan pada pemilihan 2009
berubah memilihnya sebanyak 10 orang (+/A).

Jumlah Tenaga Pendidik yang pada pemilihan 2005

tidak memilih lkuelaji dan pada pemilihan 2009 juga

tetap tidak memilih memilihnya sebanyak 10 orang.
Jumlah Tenaga Pendidik yang pada pemilihan 2005

memilih Ikuelaji dan pada pemilihan 2009 juga tetap

memilihnya sebanyak 164 orang.

Jumlah Tenaga Pendidik yang pada pemilihan 2005

memilih Ikuelaji dan pada pemilihan 2009 berubah

tidak memilihnya sebanyak 16 orang (-/D).

Test Statistics

Pemilihan
2005 &
Pemilihan
2009
N 200
Chi-Square? ,962
Asymp. Sig. ,327

a. Continuity Corrected
b. McNemar Test
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Output di atas memperlihatkan bahwa jumlah data
sebanyak 200. Skor x? =0,962 apabila hal ini dibandingkan
xztabe. dengan derajat kebebasan 1 = 3,841455 untuk alpha
5% dan 6,634891 untuk alpha 1%, maka Ho diterima dan
Ha ditolak, artinya kesimpulan dari sampel bahwa perilaku
seorang ketua tidak mempunyai pengaruh terhadap
perolehan suara dalam pemilihan pada pemilihan periode
berikutnya. Kesimpulan ini juga sama ketika digunakan
skor signifikansi output SPSS 0,327 yang lebih tinggi
dibandingkan alpha yang ditoleransi yaitu 0,05.

2) Aplikasi dengan Microsoft Excel

Untuk  keperluan analisis McNemar dengan
Microsoft Excel, maka data perlu dikelompokkan ke dalam
4 bagian. Kelompok A adalah data yang berubah dari
negatif menjadi positif, contoh untuk kasus ini adalah dari
tidak memilih menjadi memilih. Kelompok B adalah data
yang tetap negatif, kelompok C adalah data yang telah
positif, sedangkan kelompok D adalah data yang ada
perubahan dari positif menjadi negatif, untuk kasus ini
adalah dari memilih menjadi tidak memilih. Setelah itu
dihitung dengan rumus sebagai berikut:

_(A-D]-1?
~ A+D

Sedangkan aplikasi dengan Microsoft Excel dapat dilihat
pada tampilan berikut ini.

2

A B © D
1 Pemilihan Tahun 2003
2 Memilib Tidak Memilih
3 [ Pemilihan | Tidak Memilin| 10 (&) 10 (E)
4| Tahun2005 [ Memilin 164 [0 16 (D)
5
B 1.5684615385
7 2 _(&-D-T° =((C3-Da-1P2HC3+04)
g 54D 0,942307692
9 =iBi2

10

Hasil penghitungan Microsoft Excel ternyata tidak
menghasilkan Skor y° yang sama persis dengan hasil
hitung SPSS. Hanya saja, dari tiga rumus McNemar yang
penulis ketemukan dari berbagai buku, rumus di atas yang
hasilnya mendekati hasil hitung SPSS. Karena selisihnya
yang sangat sedikit, hasil SPSS: 0,962 dan Microsoft
Excel: 0,942307692, maka kesimpulan akhirnya tetap



Analisis Komparasi 176

sama, Yaitu menerima Ho karena xzhimng lebih kecil
dibanding thabe. baik untuk alpha 1% maupun 5%.

b. Sign Test

Sign test digunakan untuk menguji hipotesis
kompararif dua sampel yang berkorelasi apabila datanya
bertipe ordinal atau interval/rasio yang ditransform menjadi
ordinal. Analisis ini disebut sign test (uji tanda) karena
analisisnya didasarkan pada tanda + (positif) dan — (negatif).
Sebuah data akan diberi tanda + manakala skor data setelah
ada perlakukan lebih tinggi dibanding sebelumnya.
Sedangkan data yang skornya lebih rendah bila dibandingkan
sebelum adanya perlakukan, maka akan diberi tanda —.

Contoh:

Peneliti ingin mengetahui pengaruh Tunjangan Sertifikasi
Tenaga Pendidik terhadap pengeluaran untuk makan
keluarga.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Jumlah pengeluaran untuk makan keluarga
antara sebelum dan sesudah mendapatkan
tunjangan sertifikasi tenaga pendidik adalah
sama

Ha Jumlah pengeluaran untuk makan keluarga

antara sebelum dan sesudah mendapatkan
tunjangan sertifikasi tenaga pendidik adalah
berbeda

Dasar Pengambilan Keputusan:
Dengan membandingkan xzhitung dengan thabel dengan

ketentuan:
Ho diterima thitung < thabel
Ho ditolak thitung 2 thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

1) Aplikasi dengan SPSS
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a) Setelah data diinput, maka klik Analyze »
Nonparametric Test » 2 Related Samples...,
sebagaimana gambar berikut ini.

Sign Test - SPSS Data Editor,

File Edit Wiew Data Transform REENEGN Graphs  Ukilities  Window Help

~ Reparts 3
M ﬂ—| J Descriptive Statistics 3 m |§@
1: pob 0 Tables 4
Compare Means 3
sebelum | sesudah General Linear Modsl ' war | var ‘ var
1 1125000 105000 14 ed Models N
2| 1080000 123000 conrelate »
3| 1215000 149000  Regression 4
41 1128000| 135000  Loglnear »
5| 1107000 145700  Classify 4
3 957500 104250 Data Reduction 3
R i B
g 1215000 111500 I"-Jn:nn;naranEetru: Tests 3 C.hl-Sc.|uare...
Time Seties » Binarial...
9| 1125000 115000 Survival N
1a 1125000 127500 Multiple Response 3 1-Sample K-5..,
11 1107000 103200 Missing Yalue Analysis. .. 2 Independent Samples. ..
12 957500 109260071 K Independent Samples...
13( 1215000 1290000 2 Related Samples. .
14| 1107000| 1232000 K Related Samples. .

b) Setelah keluar seperti gambar berikut ini, destinasikan
kedua kumpulan data sampel tersebut ke dalam kotak
Test Pais(s) List, lalu non-aktifkan Wilcoxon dan
aktifkan Sign. Apabila berkeinginan mengaktifkan
deskripsi data, maka klik Option.

B Two-Related-Samples Tests Pz|
< Kebutuhan makan seb
< Kebutuharn makan sete

Paste

E Beset
Cancel

Help

Current Selections

“ariable 1:
‘ariable 2:

¥ Sign I~ McMemar
™ Marginal Homogeneity

Exact... | Optiong... |

c) Setelah keluar gambar berikut ini klik kotak yang ada di
depan Descriptive lalu klik Continue, lalu klik Ok.
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Two-Related-Samples: Options g|
Statistics
v [ Quartiles

Missing Y alues

* Exclude cases best-hy-test

" Exclude cases lishwize

Cancel
Help

d) Berikut ini adalah Output hasil analisis di atas.

Descriptive Statistics
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N Mean Std. Deviation | Minimum Maximum
Kebutuhan makan
Sebolum Sertian; 24 | 1115437 | 72260145 | 967500 | 1215000
Kebutuhan makan 24 | 1206896 | 132295534 | 1032000 | 1490000
setelah Sertifikasi ’

Output di atas memperlihatkan bahwa rata-rata
pengeluaran untuk makan keluarga tenaga pendidik

sebelum  mendapatkan

Rp.1.206.896.

tunjangan  sertifikasi adalah

Rp.1.115.437, sedangkan sesudahnya
Frequencies

N
Kebutuhan makan Negative Difference$ 6
setelah Sertifikasi - positive Differenced 18
Kebutuhan mg_kan_ Tiest 0

sebelum Sertifikasi

Total 24

a. Kebutuhan makan setelah Sertifikasi <
Kebutuhan makan sebelum Sertifikasi

b. Kebutuhan makan setelah Sertifikasi >
Kebutuhan makan sebelum Sertifikasi

C. Kebutuhan makan setelah Sertifikasi =
Kebutuhan makan sebelum Sertifikasi

sebanyak

Output ini memperlihatkan terdapat 6 keluarga yang
pengeluaran untuk makan keluarga setelah mendapat
tunjangan sertifikasi lebih kecil dibanding sebelumnya,
sementara 18 keluarga menunjukkan bahwa pengeluaran

untuk makan keluarga setelah sertifikasi

dibanding sebelumnya.

lebih tinggi
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Test Statistic®

Kebutuhan
makan
setelah
Sertifikasi -
Kebutuhan
makan
sebelum
Sertifikasi
Exact Sig. (2-tailed) ,0232

a. Binomial distribution used.
b. Sign Test

Output ini menghasilkan bahwa skor Exact Sig
untuk dua sisi sebesar 0,023 yang hal ini ternyata lebih
kecil dibanding alpha yang ditoleransi yaitu 0,05. Oleh
karena itu, Ho ditolak dan Ha diterima. Dengan demikian,
hipotesis yang menyatakan bahwa pengeluaran untuk
makan keluarga antara sebelum dan setelah mendapat
tunjangan sertifikasi adalah berbeda dapat diberlakukan
untuk populasi.

Untuk mencari skor signifikansi dari uji tanda
semestinya menggunakan harga-harga dalam test binomial.
Sedangkan  proses untuk  mengaplikasikan  dapat
menggunakan langkah sebagai berikut:

a) Bukalah file Sign Test.

b) Klik Transform » Compute, sebagaimana gambar
berikut ini.

Untitled - SPSS Data Editor
File Edit Wiew Data BIEREEMN Analyze Graphs b

~ = Compute... u
El—‘—‘ ﬂ —  Random Mumber Seed...

c) Berilah nama variabel pada kotak Target Variable, lalu
pilinlah CDF.BINOM(g.n.p) pada Function lalu klik
tanda segitiga. Setelah itu pada q isikan angka terkecil,
untuk kasus ini 6, karena 6 lebih kecil dibanding 18,
pada n isikan jumlah data, untuk kasus ini 24, dan pada
p isikan probabilitasnya, karena kita berkeinginan tanda
+ dan — sama besarnya, maka isikan 0,5, sebagaimana
gambar berikut ini. Setelah itu klik Ok.
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B Compute Variable g|
Target Variable: Mumeric Expression:
Prob = CDF.BINOM(E.24.0.5)
Type & Label...
< Kebutuhan makan seb \Z\
< Kebutuharn makan sete ﬂ QJ JJJ Functions: \Z\
<= J J.J ARSIMN[numeszpr] ~

[=]
J JJ JJJ ARTAN [numexpr)

COFMORM|zvalue]

Al o] COF BERNDULLIs)
J JJ Delete

QK | Easte| Beset| Eancel| Help |

d) Berikut ini adalah hasilnya, yaitu akan ada satu
tambahan  variabel baru yang berisi  angka
probabilitasnya untuk uji satu sisi. Ketika skor tersebut
dikalikan 2 maka hasilnya akan sama dengan skor
Exact Sig untuk dua sisi, yaitu sebesar 0,023.

Sign Test - SPSS Data Editor

File Edit Yiew Data Transform Analyze Graphs  Utilities  Windo

@ (Q[&] B ol )| =[r] o) FrE S
1 : sebelum 1125000
sebelum | sesudah | prob |
1| 1125000] 1050000 O11327922344208
2| 1080000, 1230000 O11327922344208

2) Aplikasi dengan Microsoft Excel

Analisis tanda dapat dilakukan dengan langkah-
langkah sebagai berikut:

a) Setelah data diinput, baik untuk sebelum maupun
sesudahnya, maka masing-masing skor sesudah adanya
berlakuan dikurangi dengan masing-masing skor
sebelum adanya perlakukan.

b) Setelah itu, buatlah satu kolom untuk digunakan
mencatat tanda + manakala hasil pengurangan tadi
positif (artinya tidak ada tanda positif), dan tanda —
apabila hasil pengurangan tadi negatif.

¢) Jumlahkan masing-masing tanda tersebut.

d) Berdasarkan jumlah terkecil dan jumlah sampel dicari
skor alpha-nya dengan menggunakan menu binomial.
Sedangkan untuk aplikasi Microsoft Excel dapat
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dilakukan dengan prosedur berikut. Carilah menu
BINOMDIST lalu klik dua kali.

Search for & function:

Or select a category: |Most Recently Used j

Select a function:

MORMSDIST ~|

BINOMDIST{number_s;trials;probability_s;cumulative)
Returns the individual term binormial distribution probability,

Help on this Function oK | Cancel |

e) Setelah itu isilah pada kolom Number’s dengan jumlah
terkecil, lalu pada kolom Trials dengan jumlah seluruh
data, pada kolom Probability s dengan 0,5 kalau
dikehendaki perubahan data sebelum dan sesudah tadi
seimbang, dan yang terakhir pada kolom Cumulative
diisi dengan True. Selanjutnya klik Ok. Sebagaimana
gambar di bawah ini.

BINOMDIST

Number_s |6

Trials [24

-

Probability_s |015

Cumulative |true

)
[
m

= 0,011327922
Returns the individual term binomial distribution probability.

Cumulative is a logical value: far the cumulative distribution function, use TRUE; for
the probability mass function, use FALSE.

Farmula resul: = 0,011327922344 208
Help on this Function oK | Cancel |

Aplikasi di atas dapat dilakukan dengan cara pintas
sebagaimana tersebut di bawah. Dan ternyata hasil
penghitungan kedua cara tersebut juga sama.
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test dengan

sign

prosedur

0,011327922344208

aplikasi

BINOMDIST(6;24,0,5;, TRUE)

menjabarkan rumus dapat dilihat pada gambar berikut

ini.

e) Sedangkan

0 yejwniag [, EpUENa] 8z
g ye|wnhiag -, epuepag iT
2l Ye|wnfiag +, EpUENag az
- |ooosidy- Joooosol [ooostil | ST
+ |ooos/dy |oo0Ss)l [ooooedl | vT
+ |oooszidd | ooDovEl [000SIZ) | ET
+ |o000Gedd [o0s /el [ 005496 | 7T
+ |oo0s/9d |ooozell [ooosolL | iE
+ |oooszldd [oooosTy [ooosTll | oz
+ |0o0ooszdd [ ooooec'l | ooooeot [ 6L
- |ooo0Sidy- [oooobLy [o0O0SEL L | 8k
+ |oooszidd [ oonoveL [ooosiz ) ) 4
INEEEE P INEATED
EWILENP BH ™E[0HR 0 + |oo0szldd |ooozEzL [ooos0LL |G
500 > £20°0] + |ooogssdd | ooooezl ] 0oosicl |kl
+ |oooszidd |oosEe0l | o0si9s | EL
£20°0] 7 UEAi[EAIp nEjey - |oo0S/dd- |ooDZED [o00i0L ) | ZF
BOZFYECCRIZELLDD + |oooosidd [oonsse L [oooszll Lk
L10°0] 12981 Weep io4s + |oo0Szdd | oo0osLl [000SZLL Ok
[ 17axia) epuey (| R N I ET PR
[ + |ooo0dd | ooosEll [ooosTll | &
+ |ooogs/dd |oosErol [o0sioe | 2
(0'52azdldILNNDI= + |oDoosedd |ooossel (000400 | 9
Lo S22 AILNNDD= + |oDoSeedd |oonosel [oo0SzlL | G
L+, 52020 HIINN0D= + |O00G/c9d [ooDOosP L [0OOSIZL | b
.0, 78=2v)dl+. 28=2v) 4l Z8<ev]dl= + |0000519Y [ 00007’ )L [ oooo80'lL | &
Tv7a= - |ooosidd- |oooosol [ooosTll | €
waNWl| Hvdy |HvdNs3s|wni3g3s| |
A r H 9 a 2 g w7
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Dari seluruh prosedur ternyata menghasilkan skor

yang sama, yaitu skor alpha 0,023 yang lebih kecil dari

alpha maksimal yang ditoleransi yaitu 0,05. Oleh karena

itu, Ho ditolak dan Ha diterima.
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Apabila jumlah sampel lebih besar dari 25, maka uji
statistiknya menggunakan Chi Kuadrat yang rumusnya

sebagai berikut:
Zz _ [(nl — nz)_1]2
n,+n,
Di mana:
n;= Banyak data positif
n,= Banyak data negatif.

Chi Kuadrat tersebut dibandingkan dengan Chi Kuadrat
tabel dengan dk= 1.

¢. Wilcoxon Matched Pairs

Analisis Wilcoxon Matched Pairs pada dasarnya
merupakan penyempurnaan dari sign test. Sebagaimana
dijelaskan di atas bahwa dalam sign test tidak
memperhitungkan besarnya selisih nilai angka positif dan

negatif. Dalam Wilcoxon, besarnya selisin ikut
diperhitungkan.
Contoh:

Seorang peneliti  berkeinginan untuk mengetahui
perbedaan angka kredit penelitian sebelum dan sesudah
pelatihan. Atau dengan kata lain, peneliti berkeinginan
untuk mengetahui  pengaruh pelatihan terhadap
produktifitas penelitian dosen.

Proses Pengambilan Keputusan.
Hipotesis:
Ho Jumlah angka kredit dosen dari unsur

penelitian antara sebelum dan sesudah
mengikuti pelatihan adalah sama

Ha Jumlah angka kredit dosen dari unsur
penelitian antara sebelum dan sesudah
mengikuti pelatihan adalah berbeda/tidak
sama

Dasar Pengambilan Keputusan:

Dengan membandingkan zhiwung dengan Zqpe dengan ketentuan:
Ho diterima Zhitung < Ztabel

Ho ditolak Zhitung > Ziabel



Analisis Komparasi 184

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

Dikarenakan tipe data penelitian ini adalah data rasio,
maka direncanakan digunakan analisis t-test apabila
asumsinya terpenuhi.

1) Aplikasi dengan SPSS

Salah satu asumsi yang harus terpenuhi untuk
menggunakan t-test sebagai analisis parametrik adalah
distribusi datanya harus normal. Prosedur untuk menguji
distribusi data adalah sebagai berikut.

Setelah data diinput, lalu klik Analyze »
Descriptive Statistics » Explore. Setelah itu destinasikan
variabel itu ke dalam kotak Dependent List, lalu pada
bagian Display, klik kotak Plots, Kemudian klik kotak
Plots. Setelah itu aktifkan kotak Normality Plots with
tests, lalu nonaktifkan pilihan stem and leaf, kemudian
pilih None pada bagian Boxplot, Setelah itu klik Ok.
Berikut ini adalah hasil analisis normalitas data tersebut.

Case Processing Summary

Tests of Normality

Kolmogorov-Smirnov? Shapiro-Wilk
Statistic df Sig. Statistic df Sig.

Angka Kredit

Penelitian Dosen ,179 30 ,015 ,896 30 ,007
sebelum pelatihan

Angka Kredit

Penelitian Dosen ,275 30 ,000 ,756 30 ,000
sesudah pelatihan

a. Lilliefors Significance Correction

Untuk membuat kesimpulan tentang normalitas data
dapat digunakan skor Sig. Yang ada pada hasil
penghitungan Kolmogorov-Smirnov. Bila angka Sig.
Lebih besar atau sama dengan 0,05, maka data tersebut
berdistribusi normal, tetapi apabila kurang, maka data itu
tidak berdistribusi normal. Karena Sig. Untuk data sebelum
pelatihan skor sig-nya = 0,015 dan yang sesudah pelatihan
sebesar 0,000 yang lebih kecil dibanding 0,05, maka data
kedua variabel itu tidak berdistribusi normal.
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Karena distribusi datanya tidak normal, maka tidak
dapat digunakan analisis t-test. Sebagai gantinya akan
digunakan analisis Wilcoxon. Sedangkan langkah-langkah
untuk analisis tersebut adalah sebagai berikut.

a) Setelah data diinput, maka klik Analyze »
Nonparametric Test » 2 Related Samples...,
sebagaimana gambar berikut ini.

Wilcoxon - SPS5 Data Editor

File Edit Yiew Data Transform BUEVEEM Graphs Utlities Window Help

~ Repotts 3
ﬂ@ JJ J Descriptive Statistics 3 M @@
1 sehelum 7 Tables }
Compare Means 3
sebelum | sesudah ereral Uroar Madel ¥ var | var | ¥
1 70 14 Mixed Models 3
2 70 14 correlate 3
3 7h 20| Regression b
4 7h 15| Loglinear 3
5 75 15| Classify 3
B 50 g DataReduction 3
! an 18 Ca‘e tric Test: Chi-Si
onparametric Tests -SUErE. .
B 140 Tirne Series ¥ Binomidl...
9 40 5 Survival ¥ Runs...
10 140 19 Multiple Respanse b 1-Sample K-5...
11 150 30| Missing Yalus Analysis... 2 Independent Samples. ..
12 150 4O KIndependent Samples,
13 160 180 2 Related Samples...
14 150 140 K Related Samples...
ar 4r In 4 In

b) Setelah keluar seperti gambar berikut ini, destinasikan
kedua kumpulan data sampel tersebut ke dalam kotak
Test Pais(s) List. Apabila berkeinginan mengaktifkan
deskripsi data, maka klik Option.

B Two-Related-Samples Tests

A Angka Kredit Peneitiar Test Pails) List
& Angka Kredit Penelitiar sebelum - sesudsh
Paste
E Beset
Cancel
Help
Current Selections Test Type
‘Wariable 1: v wilcoeon [ Sign [ McMemar
Variable 2: [ Marginal Hamogeneity
Exact... | Dptionz... |

c) Setelah keluar gambar berikut ini klik kotak yang ada di
depan Descriptive lalu klik Continue, lalu klik Ok.
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Two-Related-Samples: Options |

Statistics

£y

Caontinue

[ Quartiles

Cancel

dif

Missing Yalues Help
* Exclude cases test-by-test

" Exclude cases Jistwise

d) Berikut ini adalah Output hasil analisis di atas.

Descriptive Statistics

N Mean Std. Deviation | Minimum | Maximum

Angka Kredit
Penelitian Dosen 30 15,117 5,0355 7,0 225
sebelum pelatihan
Angka Kredit

Penelitian Dosen 30 18,350 5,1947 14,0 30,0
sesudah pelatihan

Output di atas memperlihatkan bahwa sebelum
mengikuti pelatihan, rata-rata dosen memiliki 15,117 angka
kredit untuk penelitian dalam satu tahun; sedangkan setelah
pelatihan rata-rata angka kreditnya adalah 18,350.

Ranks
N Mean Rank | Sum of Ranks
Angka Kredit Penelitian ~ Negative Ranks g2 8,94 71,50
Dosen sesudah _ Positive Ranks 21° 1731 363,50
pelatihan - Angka Kredit i c
Penelitian Dosen Ties 1
sebelum pelatihan Total 30

a. Angka Kredit Penelitian Dosen sesudah pelatihan < Angka Kredit Penelitian
Dosen sebelum pelatihan

b. Angka Kredit Penelitian Dosen sesudah pelatihan > Angka Kredit Penelitian
Dosen sebelum pelatihan

C. Angka Kredit Penelitian Dosen sesudah pelatihan = Angka Kredit Penelitian
Dosen sebelum pelatihan

Output di atas memberitahukan bahwa terdapat 8
orang yang angka kredit penelitian menurun setelah
pelatihan, 21 orang meningkat, dan 1 di antara 30 orang
mempunyai angka kredit penelitian tetap.
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Test Statistics

Angka Kredit
Penelitian
Dosen
sesudah
pelatihan -
Angka Kredit
Penelitian
Dosen
sebelum

pelatihan
z -3,1862
Asymp. Sig. (2-tailed) ,001

a. Based on negative ranks.
b. Wilcoxon Signed Ranks Test

Output terakhir ini adalah skor zpjyng: -3,186. Untuk
alpha 5% maka zgngnya adalah 1,96. Dikarenakan skor
Zniung: -3,186 merupakan skor mutlak, maka ia lebih besar
dibandingkan z,p, Sehingga Ho ditolak dan Ha diterima.
Hal ini juga sesuai dengan skor Asymp. Sig. (2-tailed)
sebesar 0,001 yang jauh lebih kecil dibanding alpha 0,05.

2) Aplikasi dengan Microsoft Excel

Prosedur untuk menganalisis dengan menggunakan
Wilcoxon adalah sebagai berikut:

a) Input data dari kedua sampel tersebut ke dalam dua
kolom.

b) Masing-masing skor data sesudah pelatihan dikurangi
dengan masing-masing data sebelum pelatihan.

c) Berdasarkan skor hasil pengurangan tersebut, buatlah
ranking dari skor terkecil menuju kepada skor terbesar
tanpa memperhatikan tanda negatif. Apabila ada skor
yang sama, maka skor ranking tersebut dijumlahkan lalu
dibagi dengan jumlahnya. Misalkan untuk kasus data ini
yaitu ranking 2 (berupa angka 1) ternyata ada 12. Cara
untuk membuat ranking yang skornya sama adalah
sebagai berikut:
2+3+4+5+6+7+8+9+10+11+12+13 90 _

12 12

d) Memisahkan antara ranking yang positif dan negatif.
Maksud positif dan negatif di sini adalah ranking
tersebut berasal dari hasil pengurangan yang bertanda
negatif atau tidak.

75




Analisis Komparasi 188

e) Selanjutnya hasil ranking tersebut dijumlahkan.

Jumlah terkecil dari hasil pengurangan tersebut
dibandingkan dengan skor tabel yang mendasarkan pada
jumlah sampel. Seandainya jumlah penelitian itu 21, maka
skor tabelnya adalah 59. Tabel yang tersedia untuk
Wilcoxon adalah jumlah sampel maksimal 25. Apabila
jumlah sampel lebih besar dari 25, maka distribusi akan
mendekati distribusi normal. Oleh karena itu digunakan
rumus z dalam pengujiannya. Sedangkan rumusnya adalah
sebagai berikut:

Di mana:

T merupakan jumlah jenjang/ranking yang kecil. Untuk
kasus contoh di atas adalah 79,5. Sedangkan penjabaran
Uy dan o sebagaimana dijabarkan di bawah ini.

nin +1
iy =1041

o - \/n(n+1)(2n +1)
24

Untuk lebih jelasnya dapat dilihat pada aplikasi berikut ini.
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Skor  Zhing adalah  -3,173. Apabila skor ini
dibandingkan dengan Zppe00s Sebesar 1,96, maka Ho
ditolak dan Ha diterima, karena ketika zpiung dimutlakkan
maka menjadi 3,173 itu lebih besar dibanding 1,96.
Berdasarkan hasil analisis ini dapat disimpulkan bahwa
hipotesis yang berbunyi terdapat berbedaan angka kredit
dosen dari penelitian antara sebelum dan sesudah pelatihan
dapat diterima dan berlaku untuk populasi.

D. Komparasi Dua Sampel Independen
1. Statistik Parametrik: T-test of Independent

T-test of Independent digunakan untuk menguji hipotesis
komparatif dua sampel independent bila tipe datanya adalah
interval atau rasio.

Contoh:
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Dilakukan penelitian untuk mengetahui kecepatan memasuki
dunia kerja antara lulusan SMA dan STM.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Masa menunggu untuk mendapatkan pekerjaan
antara alumni STM dan SMA adalah sama.

Ha Masa menunggu untuk mendapatkan pekerjaan

antara alumni STM dan SMA adalah tidak sama.

Dasar Pengambilan Keputusan:

Dengan membandingkan thiwng dengan tipe dengan ketentuan:
Ho diterima thitung < tiabel
Ho ditolak thitung = ttabel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima  Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

a. Aplikasi dengan SPSS

Sebelum  menjelaskan

prosedur

analisis  t-test

independent dengan SPSS, akan dijelaskan data hasil
penelitian tentang perbandingan waktu
pekerjaan antara lulusan SMA dan STM sebagai berikut:

mendapatkan

nunggu | luluzan |
[g(¥gt=l=10] | Iulusan | 21 1.00 =,
1 5.00] SMA, 22 4.00 Shia,
2 300 S, 23 2.00 ST
3 500 S, 24 1.00 ST
4 200 S, 25 300 SThd
5 500 Shid, 26 1.00 ST
] 1.00 Shs 27 3.00 ST
Z 2.00 Shidy 28 2.00 STh
3 200 S, 29 2.00 STh
g 1.00 St 30 1.00 STH
10 3.00 Shas, 31 3.00 =T
i 2.00 St 32 1.00 ST
iz .00 Sha, 33 1.00 STM
il
= Son Mo 35 .00 ST
T 300 A 36 200 ST
I 100 A a7 1.00 SThd
= =00 ML 35 200 ST
1a 1.00 Sl 39 200 STh
z0 3.00 Sl 40 1.00 =T

1) Setelah data diinput, lalu klik Analyze » Compare Means
» Independent Samples T Test sebagaimana gambar di

bawah ini:
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data untuk t-test independent - SPSS Data Editor
File Edit Wiew Data Transform BEGENEES Graphs  Utilities  ‘Window Help

~ Reports »
- | E |§| | | J Descriptive Statistics L4 .I. I_' @@
1 nunggu &  Tables »
ALIRGGL | alusan | el Compare r'-'1e.ar|s 3 Means...

= 00 = General Linear Model b One-Sample T Test...
22 4.00 ShA, Mixed Models » Independent-Samples T Tesk...
23 2.00 ST Correlate 3 Faired-Samples T Test...
24 1.00 STM Regression 3 One-Way ANOWA, ..

2) Setelah keluar gambar seperti di bawah ini destinasikan
variabel masa nunggu di Test variable(s) dan lulusan pada
Grouping variable. Setelah itu klik Define Groups.

M |ndependent-Samples T Test

Test Variable(s):
< Masa Nunggu Kerja [tah

\:I Reset
Cancel
Help

M,

Grouping Variable:

lulusan(? ?)

Options...

3) Setelah keluar gambar seperti di bawah ini ketiklah 1 di
group 1, dan 2 di kolom Group 2. lalu klik Continue, lalu

klik Ok.

Define Groups

i+ Use specified values Continue |

Group 1: ‘1 Cancel

Group 2: |2 Help
" Cut point:

4) Tampilan di bawah ini adalah out-put hasil penghitungan t-
test independent dengan SPSS.

Group Statistics

Masa Nunggu Kerja
(tahun)
LULUSAN
SMA STM
N 22 18
Mean 2.9091 1.7778
Std. Deviation 1.50899 .80845
fﬂtse'f"or 32172 | 19055

Tampilan di atas menunjukkan bahwa sampel lulusan SMA
sejumlah 22 dan lulusan STM 18 orang. Rata-rata lulusan
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SMA memasuki dunia kerja setelah menunggu selama 2,9091
tahun sementara lulusan STM menunggu 1,7778 tahun.

Independent Samples Test

Masa Nungau Kerja (tahun)

Equal variances
assumed

Equal variances
not assumed

Levene's Test for

E

Equality of Variances Sig.

t-test for Equality of
Means

t

df

Sig. (2-tailed)
Mean Difference

Std. Error Difference

95% Confidence Interval Lower

of the Difference

Upper

5.162
.029
2.858
38
.007

1.1313

.39578

.33009

1.93253

3.026
33.262
.005

1.1313

.37392

.37080
1.89182

Hasil analisis t-test independent dengan SPSS
senantiasa ada dua kolom, yaitu kolom untuk hasil analisis
manakala variansnya homogen dan satunya untuk yang
hiterogin. Penggunakan kolom ditentukan oleh hasil F-test
atau signifikansinya. Apabila signifikansinya paling tinggi
0,05, maka hasil yang ada di kolom hiterogin (equal variances
not assumed) yang digunakan. Sebaliknya kalau signifikansi
untuk F-test lebih tinggi dari 0,05 maka yang digunakan
adalah kolom yang homogen (Equal variances assumed).
Karena signifikansi dari F-test 0,025 yang lebih kecil dari
0,05, maka yang digunakan adalah hasil hitung dalam kolom
hiterogin.

Thiwng  UNtuk analisis ini adalah 3,026. Apabila
dibandingkan dengan tupeio0s:33 Sebesar 2,034517, maka Ho
ditolak dan Ha diterima karena tyiung lebih besar dibandingkan
tneio0s:33.  Kesimpulan yang sama kita dapatkan ketika
digunakan skor signifikansi sebesar 0,005 yang jauh lebih
rendah dibandingkan dengan skor alpha 0,05. Berangkat dari
hasil analisis ini, maka Ha yang berbunyi masa menunggu
untuk mendapatkan kerja antara lulusan SMA dan STM itu
berbeda dapat diterima dan berlaku untuk populasi.

b. Aplikasi dengan Microsoft Excel

Terdapat 2 rumus t-test yang dapat digunakan untuk
menguji hipotesis komparatif dua sampel independent bila
tipe datanya adalah interval atau rasio, yaitu.
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Rumus 1
X1 —Xs

2 21 1
(n1'1)51 +(n2_1)52 (n +nJ

1 2

t=

n,+n,—-2
Rumus 2

Bila jumlah anggota sampel 1 dan 2 sama dan varians
homogens, maka dapat digunakan rumus 1 dan 2. Untuk
mengetahui t tabel digunakan dk yang besarnya= n; + n, —
2.

Bila jumlah anggota sampel 1 dan 2 tidak sama dan varians
homogen, maka dapat menggunakan rumus 2. Besarnya dk
adalah n; - n, — 2.

Bila jumlah anggota sampel 1 dan 2 sama dan varians tidak
homogens, maka dapat digunakan rumus 1 dan 2. Untuk
mengetahui t tabel digunakan dk yang besarnya= n, — 1 atau
n, — 1.

Bila jumlah anggota sampel 1 dan 2 tidak sama dan varians
tidak homogens, maka dapat digunakan rumus 1. Untuk
mengetahui t tabel digunakan dk yang besarnya=n; — 1 dan
n, — 1, dibagi dua dan kemudian ditambah dengan harga t
yang terkecil. Sebagai contoh nl = 25, berarti dk = 24,
maka harga t tabel = 2,797. n2 = 13, dk = 12, harga t tabel =
3,005 (untuk kesalahan 1%, uji dua fihak. Jadi harga t tabel
yang digunakan adalah (3,005 - 2,797) : 2 = 0,104.
Selanjutnya harga ini ditambah dengan t yang terkecil. Jadi
0,104 + 2,797 = 2,901.

Untuk  menguji homogenitas varians adalah  dengan
menggunakan rumus:

Varians Terbesar
Varians terkecil

Bila F hitung lebih kecil atau sama dengan F tabel, maka

F=

varians homogens.
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Manakala dihitung dengan excel, maka terlihat aplikasinya

sebagai berikut:
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(ee)1H0S=
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(g1229)=
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(zz)1yoS=
(lz/gea)=
(sza:valwns=
(Sz9:¥9)39vy3AY=
(Szvvv)39vdanY=
(rdavd)=
(9z89%-va)=
(r2.#0)=
(928vs-1v)=
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Carilah mean dari sampel SMA maupun STM.

1.

Kurangi masing-masing skor dengan mean masing-masing

2.

Kuadratkan masing-masing skor hasil pengurangan nomor

3.

Jumlahkan seluruh skor hasil pengkuadratan pada sampel

masing-masing

4.

Hasil nomor 4 dibagi dengan jumlah sampel dikurangi 1

(Inilah variansnya).

5.
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6. Carilah homogenitas varians dengan cara varians terbesar
dibagi dengan varians terkecil.

7. Bandingkan hasilnya itu dengan Fpe, manakala Fhiwng lebih
kecil atau sama dengan Fyhe, mMaka berarti varians
homogen.

Ternyata hasilnya: 3,483896104 lebih besar dari tabel:
2,218897, sehingga variannys hiterogin. Karena jumlah sampel
tidak sama dan variansnya hiterogin, maka berlaku ketentuan
nomor 4 (pada halaman 194).

Di samping cara di atas, Untuk menguji homogenitas
varians juga dapat diaplikasikan melalui menu Data Analysis
sebagai berikut:

1. Setelah dipilih Data Analysis dari Tools, maka pilihlah F-
test Two Samples for Variances sebagaimana gambar
berikut ini.

Data Analysis EI E|

Analysis Tools

= OF
Anova: Single Fackar - -
Anova: Two-Factor With Replication Cancel
Anova: Two-Factor Without Replication

2. Setelah keluar gambar seperti berikut ini, klik di kolom
Variable 1 Range, lalu bloklah seluruh data SMA.
Selanjutnya klik pada kolom Variable 2 Range, lalu bloklah
seluruh data STM. Aktifkan Labels kalau di atas data yang
kita ketik diberi label dan tadi juga termasuk diblok untuk
ditampilkan. Setelah itu klik Ok.

F-Test Two-Sample for Variances E]@

Input

OF
Variable | Range: fadl$aE23 ES -
‘ariable Z Range: $E$1:4B$19 = Cancel
¥ Labels Help
Alpha: 0,05
Cutput options
* Qukput Range:! $0§2 Y
™ New Warksheet Ply:
™ Mew Workbook
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3. Berikut ini adalah output dari aplikasi di atas.

A B £ D E F
1 ShA ST
2 5 2 F-Test Two-Sample for Variances
3 3 1
4 5 3 SMA STM
5 2 1 Mean 2908090909 1777777778
B 5 3 Yariance 2277086277 0653594771
7 1 2 Observations 22 18
] 2 2 df 21 17
9 3 1 F 3,483896104
10 1 3 P(F==f) one-tail 0005793262
1 3 1 F Critical one-tail 2 215897066

Skor Fhiung Sebesar 3,483896104 dan nilai kritis sebesar
2,218897 ternyata juga sama dengan hasil penjabaran rumus di
atas.

Di samping cara menjabarkan rumus di atas, t-test
independen yang variansnya hiterogin juga dapat diaplikasikan
melalui menu Data Analysis sebagai berikut:

1. Setelah dipilih Data Analysis dari Tools, maka pilihlah t-
test: Two Sample Assuming Unequal Variances
sebagaimana gambar berikut ini.

Analysis Tools

Histagram ﬂ

Moving Average Cancel
Random Mumber Generation
Rank and Percentils
Reqgression
Sampling
t-Test: Paired Two Sample for Means
ing Equal Yariances

Ok

Help

dd

2-Test: Two Sample for Means

2. Setelah keluar gambar seperti berikut ini, klik di kolom
Variable 1 Range, lalu bloklah seluruh data SMA.
Selanjutnya klik pada kolom Variable 2 Range, lalu bloklah
seluruh data STM. Apabila peneliti berhipotesis bahwa tidak
terjadi perbedaan masa menunggu untuk mendapatkan kerja
antara lulusan SMA dan STM, maka pada kolom
Hypothesized Mean Different diisi dengan 0. Selanjutnya
aktifkan Labels kalau di atas data yang kita ketik diberi label
dan tadi juga termasuk diblok untuk ditampilkan. Setelah itu
klik Ok.
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t-Test: Two-5ample Assuming Unequal Variances @@
Input
Yariable 1 Range: bodl a3 ;
Variable 2 Range: $B51:$0419 B Qf_ancel
Hypothesized Mean Difference: i} Help
W Labels
Alpha: 0,05

Cutput options
+ Qutput Range: $0f2 =%,

™ Mew Workshest Ply:

™ Mew Workbook

3. Berikut ini adalah output dari aplikasi di atas.

A B C D E F
1 |EMA|STM
206 2 t-Test: Two-Sample Azsuming Unequal Vartances
33 1
4 5 3 ShdA ST
5 2 1 Mean 2,909090909| 1777777778
6| 5 3 Variance 2277056277 0,653534771
71 2z Ohbservations 22 18
a 2 2 Hypothesized Mean Difference 0
9 3 1 df 33
m) 1 3 t Stat 302557876
1M 3 1 P(T==t) one-tai 0,002390792
12 2 1 t Critical one-tail 1,692360456
13 4 1 P(T==t) two-tail 0,004751585
14 3 3 t Critical two-tail 2,053451691

Dari seluruh penghitungan di atas ternyata hasilnya sama.
Karena thiwng lebih besar dari taps, maka Ho ditolak dan Ha
diterima. Oleh karena itu, Ha yang berbunyi terjadi perbedaan
masa menunggu untuk mendapatkan pekerjaan antara lulusan
SMA dan STM dapat diterima dan berlaku untuk populasi.

Contoh 2:

Peneliti  berkeinginan  mengetahui  perbedaan masa
menunggu untuk mendapatkan pekerjaan antara lulusan
Perguruan Tinggi Negeri (PTN) dan Perguruan Tinggi
Swasta (PTS). Peneliti mengambil sampel 22 alumni PTN
dan 22 alumni PTS.

Proses Pengambilan Keputusan.
Hipotesis:

Ho Masa menunggu untuk mendapatkan pekerjaan
antara alumni PTN dan PTS adalah sama.
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Ha Masa menunggu untuk mendapatkan pekerjaan

antara alumni PTN dan PTS adalah tidak sama.

Dasar Pengambilan Keputusan:

Dengan membandingkan thiung dengan tipe dengan ketentuan:

Ho diterima  thjwung < tiavel
Ho ditolak thitung = Ttabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima  Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

Data penelitian tersebut adalah sebagai berikut:

a. Aplikasi dengan SPSS

o [ s ptn_ | alumni |
ptn | alumni 23 3.00 FTS
1 6.00] PTH 24 5.00 FTS
2 3.00 PN 25 4.00 PTS
3 5.00 FTr 36 2.00 FTS
4 2.00 PN 27 4.00 FTS
5 5.00 PTH =5 =00 TS
6 1.00 PTH =5 =00 TS
7 2.00 PTH 5 S0 TS
] =00 FTN 31 3.00 FTS
13 1333 Em 32 2.00 FTS
o S — 33 1.00 FTS
5 T — 34 2.00 FTS
13 3.00 PTH ES 2.00 FTS
14 4.00 PTH ER 3.00 PTS
18] 200, PN il 4.00 FTS
16| 200 PTN EH 3.00 PTS
17| 100 PN Ed 2.00 PTS
18] 500 FTN i 4.00 PTS
19 1.00 PTM 41 2.00 FTS
20 3.00 PTH 42 2.00 FTS
21 1.00 PTH 43 2.00 FTS
22 4.00 PTN 44 3.00 FTS

Adapun caranya sama dengan yang tertera pada
halaman 190-192. Tampilan di bawah ini adalah output hasil
penghitungan t-test independent dengan SPSS.

Group Statistics

Masa Nunggu lulusan
PT
ALUMNI
PTN PTS

N 22 22
Mean 2.9091 2.8636
Std. Deviation 1.50899 1.08213
Std. Error
Mean 32172 .23071
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Jumlah sampel lulusan PTN dan PTS adalah sama 22.
Lulusan PTN rata-rata menunggu untuk mendapatkan
pekerjaan selama 2,9 tahun, sedangkan lulusan PTS rata-rata
menunggu untuk mendapatkan pekerjaan selama 2,86 tahun.

Independent Samples Test

Masa Nunggu lulusan PT
Equal variances | Equal variances
assumed not assumed

Levene's Test for F 2.005
Equality of Variances  sjg, 164

t-test for Equality of t 115 115

Means df 42 38.081

Sig. (2-tailed) .909 .909

Mean Difference 0455 0455

Std. Error Difference 30589 39589

95% Confidence Interval  Lower -.75349 -.75593

of the Difference Upper .84439 .84684

Berdasarkan signifikansi dari F-test sebesar 0,164 yang lebih
tinggi dibanding dengan alpha 0,05, maka varians data
penelitian ini adalah homogen. Oleh karena itu, seluruh
analisis didasarkan pada hasil yang ada pada kolom Equal
Varians Assumed. Thiwng: 0,115 dan Sig (2-tailed): 0,909.
Karena skor signifikansi lebih besar dibanding alpha 0,05,
maka Ho diterima dan Ha ditolak. Kesimpulan penelitian ini
adalah tidak terjadi perbedaan masa menunggu untuk
mendapatkan pekerjaan antara lulusan PTN dan PTS.

Aplikasi dengan Microsoft Excel

Cara untuk mengaplikasikan analisis t-test independen
adalah sama dengan yang dipaparkan pada halaman 195-196.
Yang membedakan dengan analisis tersebut adalah jumlah
sampelnya sama dan variansnya ternyata homogen. Oleh
karena itu, sebagaimana dijelaskan pada halaman 193,
manakala sampel 1 dan 2 jumlahnya sama dan variannya
homogen, maka dapat digunakan rumus 1 atau rumus 2.

Selain dijelaskan dengan aplikasi pada halaman berikut
ini pada aplikasi Microsoft Excel, homogenitas varians juga
akan dideteksi dengan aplikasi Data Analysis, dengan hasil
berikut ini:
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A B €
1 F-Test Two-Sample for Variances
2
3 BN B8
4 |Mean 2905090909 2,563636364
5 |Wariance 2 277056277 | 1,170995671
B |Observations 22 22
7 |df 21 21
aF 1944547135
9 |Pi{F<=f) one-tail | 0,067600709
10 |F Critical one-tail | 2 084188822

Karena Fpiwng 1,944547135 lebih kecil dibanding Fiaper:
2,084188822, maka Ho diterima, artinya variansnya
homogen.

Sedangkan untuk aplikasi  Microsoft dengan
menjabarkan rumus dapat diperhatikan pada contoh berikut.
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Untuk menguji hipotesis dengan membandingkan antara tyitung

42 untuk

kesalahan 5%, dengan uji 2 fihak adalah 2,018082341, ternyata
thiung 0,115 lebih kecil dari pada tw,e 2,018082341, maka Ho
diterima dan Ha ditolak, berarti tidak terdapat perbedaan masa

menunggu untuk mendapatkan pekerjaan antara alumni PTN dan

alumni PTS.

dengan tipe. Traper UNtUK derajat kebebasan 22 + 22 - 2
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Di samping cara menjabarkan rumus di atas, t-test
independen yang variansnya homogen juga dapat diaplikasikan
melalui menu Data Analysis sebagai berikut:

1. Setelah dipilih Data Analysis dari Tools, maka pilihlah t-
test: Two Sample Assuming Equal Variances sebagaimana
gambar berikut ini.

Analysis Tools
QK

Hiskogram -

Randormn Murmber Generation

Help

Mowing fverage J Cancel

z-Test: Two Sample for Means 4

2. Setelah keluar gambar seperti berikut ini, Kklik di kolom
Variable 1 Range, lalu bloklah seluruh data PTN.
Selanjutnya klik pada kolom Variable 2 Range, lalu bloklah
seluruh data PTS. Apabila peneliti berhipotesis bahwa tidak
terjadi perbedaan masa menunggu untuk mendapatkan kerja
antara lulusan PTN dan PTS, maka pada kolom
Hypothesized Mean Different diisi dengan 0. Selanjutnya
aktifkan Labels kalau di atas data yang kita ketik diberi label
dan tadi juga termasuk diblok untuk ditampilkan. Setelah itu

klik Ok.
t-Test: Two-Sample Assuming Equal Variances @g|
Inpuk
‘Yariable 1 Range: i 3 i
‘ariable Z Range: $B$1:$E$23 %, Cancel
Hell
Hypothesized Mean Difference: o g
v Labels
Alpha: |o,05
Cukput opkions
% Qutput Range: $0$2 Y

" Mew Woarksheet Ply:

" Mew Workbook

3. Berikut ini adalah output dari aplikasi di atas. Terlihat bahwa
hasilnya sama dengan hasil penghitungan dengan SPSS dan
penjabaran rumus dengan Microsoft Excel. Kelebihan dari
aplikasi Data Analysis adalah adanya tampilan tyn dengan
alpha 5% baik untuk uji satu sisi maupun dua sisi.
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A B € D E F
1 FTN FTS
2 5] 3 t-Test: Two-Sample Assuming Equal Variances
3 3 [
4 5 4 FTN F7s
5 2 3 Mean 2909090909 | 2 863636364
5 5 4 “atiance 2277056277 | 1,17099567 1
7 1 2 Observations 2 2
g 2 ) Pooled Yariance 1724025574
] 3 2 Hypothesized Mean Difference a
10 1 3 df 42
1 3 2 t Stat 0,114815827
12 2 1 PT==t) one-tail 0,4545659131
13 4 2 t Critical one-tail 16581951289
14 3 2 PT==t) two-tail 0909135263
15 4 3 t Critical two-tail 2018082341
1= a2 A

Dari seluruh penghitungan di atas ternyata hasilnya sama.
Karena thiung: 0,114815827 itu lebih kecil dibandingkan tiper.
2,018082341 untuk alpha 5% dan uji dua sisi, maka Ho diterima
dan Ha ditolak. Oleh karena itu, Ho yang berbunyi tidak terjadi
perbedaan masa menunggu untuk mendapatkan pekerjaan antara
lulusan PTN dan PTS dapat diterima dan berlaku untuk populasi.

Statistik Non-Parametrik

a. Fisher Exact Probability Test

Fisher Exact Probability Test digunakan untuk menguji
hipotesis komparatif apabila datanya bertipe nominal yang
jumlah sampelnya kecil. Apabila jumlah sampelnya besar
digunakan Chi Kuadrat (x°). Untuk lebih jelasnya dapat
diperhatikan ketentuan berikut ini:

1. Jika n; + n, > 40,dapat dipakai test Chi Kuadrat dengan
koreksi kontinuitas dari Yates.

2. Jika n; + n, antara 20 — 40 dan jika tidak satu selpun
memiliki frekuensi yang diharapkan > 5, dapat digunakan
Chi Kuadrat dengan koreksi kontinuitas dari Yates. Bila
frekuensinya < 5 maka dipakai test Fisher.

3. Jika n; + n, < 20 maka digunakan test Fisher.!

Contoh:

Peneliti berkeinginan untuk membandingkan frekuensi

dosen menulis karya ilmiah antara yang mempunyai
golongan kepangkatan Ill1 dan IV. Bagi yang menulis 4

! Sugiyono, Statistika untuk Penelitian, (Bandung: CV Alfabeta, 2003), him. 249.
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artikel atau lebih dalam waktu dua tahun, maka
dikategorikan sering; sedangkan yang kurang dari 4
dikategorikan jarang. Dalam penelitian ini diambil
sampel 7 dosen untuk masing-masing golongan.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan frekuensi menulis
artikel karya ilmiah antara dosen yang
mempunyai golongan kepangkatan Il dan 1V.

Ha Terdapat perbedaan frekuensi menulis artikel
karya ilmiah antara dosen yang mempunyai
golongan kepangkatan 111 dan IV.

Dasar Pengambilan Keputusan:
Dengan membandingkan y’wng dengan  x’wne  dengan

ketentuan:
Ho diterima thitung < % tabel
Ho ditolak thitung = thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

Langkah-langkah analisis Fisher Exact Probability
dengan SPSS adalah sebagai berikut:

a) Setelah data diinput, klik Analyze » Descriptive
Statistics » Crosstabs, sebagaimana gambar berikut
ini.

Fisher Exact - SPSS Data Editor,
File Edit Wiew Data Transform BEUGEVEEN Graphs  Ukiities  Window Help
Reports F el =
= =
|n |§| .' | | Diescriptive Statiskics Frequencies...
1: produk 1 Tahles

Descriptives. ..
Compare Meaans Explare. ..

»
3

roduk
P General Linear Model +
3
3

—

| Sering Menulis Karya  mied Modsls
2| Sering Menulis Karya | coprelate

b) Setelah keluar gambar seperti berikut ini destinasikan
salah satu variabel ke kotak Row(s) dan variabel satunya
pada kotak Column(s). Selanjutnya klik Statistics.
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I Crosstabs rz'
Fow(s]: k.
o W —
-~ Reset
LColurnn(z):
Cancel
E Help

Laper 1 of 1

™ Display clustered bar charts
™ Suppress tables

Exact... | §tatistics...| Cells... | Eormat...|

c) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Chi-square. Selanjutnya klik Continue,
setelah itu klik Cells.

Crosstabs: Statistics f'5_<|

™ Corelations
Mominal Ordinal
Cancel

I™ Caontingency coefficient ™ Gamma

™ Phiand Cramér's ¥ [ Somers'd hich:
™ Lambda ™ Kendall's tau-b
I™ Uncertainty cosfficient ™ Kendall's tau-c
Morminal by [nteryal [~ Kappa
[~ Eta ™ Risk
[~ McMemar

I™ Cochran's and Mantel-Haenszel statistics

—

d) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Expected. Selanjutnya klik Continue,
setelah itu klik Ok.

Crosstabs: Cell Display

],

= Cancel
v Expected
Help
Percentages Residuals
[~ Bow [~ Unstandardized
[~ Colurnn | Standardized

[ Total ™ Adj. standardized
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e) Berikut ini adalah Output analisis di atas.

Case Processing Summary

Produktifitas Karya limiah

Ccases * Golongan/Kepangkatan
Valid N 14
Percent 100,0%

Missing N 0
Percent ,0%

Total N 14
Percent 100,0%
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Output ini memperlihatkan bahwa jumlah sampel

adalah 14.
Produktifitas Karya Iimiah * Golongan/Kepangkatan Crosstabulation
Golongan/Kepangkatan |
Dosen Dosen
Golongan lll_| Golongan IV. Total
Produktifitas  Sering Menulis  Count 5 3 8
Karya limiah  Karya limiah Expected Count 4,0 4,0 8,0
Jarang Menulis  Count 2 4 6
Karya llmiah
Expected Count 3.0 3.0 6.0
Total Count 7 7 14
Expected Count 7,0 7,0 14,0

Output ini menyajikan bahwa ada 5 orang dosen dari
golongan 11l yang sering menulis karya ilmiah, 2 lainnya
termasuk jarang. Sedangkan dosen dari golongan IV yang
sering menulis karya ilmiah sebanyak 3 sedangkan 4
lainnya jarang menulis karya ilmiah

Chi-Square Tests

Asymp. Sig. | Exact Sig. | Exact Sig.
Value df (2-sided) (2-sided) (1-sided)
Pearson Chi-Square 1,167° ,280
Continuity Correctio® ,292 ,589
Likelihood Ratio 1,185 ,276
Fisher's Exact Test ,592 ,296
;:;fg ;ﬂ);h'”ear 1,083 298
N of Valid Cases 14

a. Computed only for a 2x2 table

b. 4 cells (100,0%) have expected count less than 5. The minimum expected count is

3,00.

Dikarenakan jumlah sampel hanya 14, dan frekuensi
yang diharapkan (expected count) seluruhnya lebih kecil
dari lima, maka hasil analisis yang digunakan adalah dari
Fisher’s Exact Test. Skor Exact Sig untuk dua sisi sebesar
0,592 yang lebih tinggi dibandingkan alpha: 0,05, maka
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Ho diterima dan Ha ditolak. Dari hasil ini dapat
disimpulkan bahwa tidak terdapat perbedaan frekuensi
penulis karya ilmiah antara dosen yang mempunyai
golongan 11l dan IV.

. Aplikasi dengan Microsoft Excel

Rumus yang digunakan untuk analisis Fisher’s Exact

Test adalah sebagai berikut:
(A+B)Y (C+D) (A+C) (B+D)
N! Al B! C! D!

Nilai Faktorial dapat dilihat pada tabel V (lampiran) atau
dapat dicari dari menu function Microsoft Excel; misalnya
20! = 2.432.902.008.176.640.000. Skor ini merupakan
hasil dari aplikasi menu fungsi FACT dan pada kolom
number diketik 20, lalu Ok.

FACT

Number |20 =2

= 2,4329E+18
Returns the Factarial of a number, equal ko 1¥2%3%, . * Number.

Number iz the nonnegative number wou want the Factarial of .

Formula result = 2,4329E+18
Help on this Function ok | Cancel |

Atau langsung diketik pada sembarang sel pada Microsoft
Excel seperti di bawah ini:

=FACT(20)
Untuk mempudahkan aplikasi rumus Fisher’s Exact
Test di atas, maka perlu dibuat tabel kontingensi 2 x 2
seperti berikut ini:

Kelompok | Il Jumlah

I A B A+B

I C D C+D
Jumlah A+C B+D A+B+C+D

Sedangkan aplikasi analisis Fisher’s exact Test
dengan Microsoft excel seperti tercantum di bawah ini:
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A B > Bl E F
1 Kepangkatan/Golongan Dosen
2 Golangan Il Golongan IV JUMLAH
3 | Seting Menulis 5 3 8
4 | Jarang Menulis 2 4 6
] Jurnlah 7 7 14
5
7 737.418.608.640.000 =(FACTEFACTENFACT M FACTY
g 3.012.881.743.872.000 =(FACT(1 4 (FACTE ) (FACTEN (FACTEN FACTEN
a 0245 =B10/B11
10 0,490 =422
1Al
12 _lA+BIIC+DIIA+CIB+DI
13 B= NI &1 Bl CI DI
14

Hasil penghitungan dengan Microsoft Excel ini
ternyata tidak sama persis dengan hasil hitung dengan
SPSS. Hanya saja, karena selisihnya sedikit --skor dari
SPSS: 0,592 sedangkan penjabaran rumus skornya: 0,490--
maka kesimpulan akhirnya masih tetap sama, yaitu
menerima Ho dan menolak Ha.

b. ¥ Two Sample Independent

x*> Two Sample Independent digunakan untuk menguji
hipotesis komparatif apabila datanya bertipe nominal yang
jumlah sampelnya besar.

Contoh:

Peneliti berkeinginan untuk membandingkan frekuensi
dosen menulis karya ilmiah antara yang mempunyai
golongan kepangkatan Il dan IV. Bagi yang menulis 4
artikel atau lebih dalam waktu dua tahun, maka
dikategorikan sering; sedangkan yang kurang dari 4
artikel dikategorikan jarang. Dalam penelitian ini diambil
sampel 25 dosen untuk masing-masing golongan.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan frekuensi menulis
artikel karya ilmiah antara dosen yang
mempunyai golongan kepangkatan Il dan IV.

Ha Terdapat perbedaan frekuensi menulis artikel
karya ilmiah antara dosen yang mempunyai
golongan kepangkatan 111 dan IV.
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Dasar Pengambilan Keputusan:
Dengan membandingkan thitung dengan thabel dengan ketentuan:

Ho diterima A hitung < A tabel

Ho ditolak thitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS
Langkah-langkah  analisis %> Two Sample
Independent dengan SPSS adalah sebagai berikut:
a) Setelah data diinput, klik Analyze » Descriptive
Statistics » Crosstabs, sebagaimana gambar berikut
ini.

Chi Kuadrat 2 Sampel - SPSS Data Editor
File Edit WYiew Data Transform [EUEMEER Graphs  Utlities  window Help

Reports L B ==l el - |
=& = |
n @ .' Descriptive Statistics Frequencies. ..
42 prod 2 Tables Descriptives. ..
Compare Means Explore. ..

n pr.od General Linear Model
23| Sering Menulis Karya | i od Modsls
24[Jarang Menulis Karya Correlate

251 Serinn Meannlis Karva Ranracdnn ]

b) Setelah keluar gambar seperti berikut ini destinasikan
salah satu variabel ke kotak Row(s) dan variabel satunya
pada kotak Column(s). Selanjutnya klik Statistics.

»
»
»
»
»

I Crosstabs E|

Raowls)k ok

\:I @ prod Paste
— Beset
_g e Cancel

E Help

Layer 1 of 1

Fravius| _tien |

?

[ Dizplay clustered bar charts

[™ Suppress tables

Exact. Statistics.. Cells... Format...
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c) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Chi-square. Selanjutnya klik Continue,
setelah itu klik Cells.

Crosstabs: Statistics &|

[™ Comelations
Ordinal Care]

[~ Contingency coefficient [T Gamma
. . Help
[~ Phi and Cramér's [ Somers'd
[~ Lambda ™ Kendall's taub
[ Uncertainty coefficient I Kendall's tau-c
Mominal by Interval I~ Kappa
[~ Eta ™ Risk
[~ McMemar

™ Cochran's and Mantel-H aenszel statistics

—

d) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Expected. Selanjutnya klik Continue,
setelah itu klik Ok.

Crosstabs: Cell Display

= Cancel
[v Expected
Help
Percentages Residual:
[~ Bow [~ Unstandardized
[~ Column [” Standardized
[ Tatal [ Adj standardized

e) Berikut ini adalah Output analisis di atas.

Case Processing Summary

Cases PROD * PEND
Valid N 50
Percent 100,0%
Missing N 0
Percent ,0%
Total N 50
Percent 100,0%

Output ini memperlihatkan bahwa jumlah sampel
adalah 50.



211

Statistika untuk Penelitian Pendidikan

PROD * PEND Crosstabulation

PEND
Dosen Dosen
Golongan lll_| Golongan IV Total
PROD Sering Menulis  Count 19 8 27
Karya limiah Expected Count 135 135 27,0
Jarang Menulis  Count 6 17 23
Karya limiah
Expected Count 15 115 230
Total Count 25 25 50
Expected Count 25,0 25,0 50,0

Output ini menyajikan bahwa ada 19 orang dosen
dari golongan Il yang sering menulis karya ilmiah, 6
lainnya termasuk jarang. Sedangkan dosen dari golongan
IV yang sering menulis karya ilmiah sebanyak 8 sedangkan
17 lainnya jarang menulis karya ilmiah

Chi-Square Tests

Asymp. Sig. | Exact Sig. | Exact Sig.
Value df (2-sided) (2-sided) (1-sided)
Pearson Chi-Square 9,742 1 ,002
Continuity Correctio® 8,052 1 ,005
Likelihood Ratio 10,097 1 ,001
Fisher's Exact Test ,004 ,002
Linear-by-Linear
Associati}:)n 9,548 1 002
N of Valid Cases 50

a. Computed only for a 2x2 table
b. 0 cells (,0%) have expected count less than 5. The minimum expected count is

11,50.

Dikarenakan jumlah sampelnya lebih dari 40, maka
digunakan skor Chi Kuadrat dengan koreksi kontinuitas
dari Yates (Continuity Correction). SKor y’hiung Sebesar
8,052 yang lebih besar dibanding ¥wper 0051 3,841455.
Demikian juga skor Asymp. Sig untuk dua sisi sebesar
0,005 yang jauh lebih kecil dari alpha, yaitu 0,05, maka Ho
ditolak dan Ha diterima. Dari hasil ini dapat disimpulkan
bahwa terdapat perbedaan frekuensi penulis karya ilmiah
antara dosen yang mempunyai golongan Il dan IV.

2. Aplikasi dengan Microsoft Excel

Rumus yang digunakan untuk analisis Chi Kuadrat
dengan koreksi kontinuitas dari Yates adalah sebagai

berikut:
P n(|ad—bc| —%n)Z

~(a+b)(@a+c)(b+d)(c+d)
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Sebagaimana untuk aplikasi Fisher’s Exact Test,
dalam aplikasi Chi Kuadrat dengan koreksi kontinuitas dari
Yates juga perlu dibuatkan tabel kontingensi sebagai

berikut:
Frekuensi Pada Jumlah
Sampel Obyek | Obyek | Ssampel
Sampel | a b a+b
Sampel 11 c d c+d
Jumlah a+c b+d n

Aplikasi dari rumus di atas dapat dilihat pada gambar

berikut ini:
A, B c o] E F G

1 Dosen
2 Golongan Il [Golongan V| JUMLAH %
3 | Sering Menulis 19 8 27 054
4 Harapan 135 135 27
5 | Jarang Menulis 6 17 23 0,46
B Harapan 115 115 23
7 Jurnlah 25 25 50
g
9
10 i 2241|=(B3-B4)"2)/B4
11 2 241 [=((C3-C4)2)/Ca k AT
12 2 £30|=((B5-B6)"2/ER ¥t = T‘_w
13 2 F30|=((C5-CB)"2)/CR = fy
14 9,742 |=SUM{A10:A13}
15
16 3125000 |=07*{((E3*CE)-(C3BE)-0 507 )2 ol |ad _ bc| _ Vn 7
17 368125 |=(B3+C3) (B3+B5) (C3+05) (B5+Ca) |37 = 2
18 8,052 |=A16/A17 lat+biatcib+dic+d)
19

Hasil hitung dengan Microsoft Excel ternyata sama
persis dengan SPSS, baik untuk skor xzhitung: 9,742 maupun
yang dikorekasi kontinuitasnya dari Yates: 8,052. Skor ini
lebih besar dibanding xztabe.; 0051. 3,841455; oleh karena itu,
Ho ditolak dan Ha diterima.

c. Median Test

Penggunaan median test pada dasarnya sama dengan
dua teknik analisis yang digunakan di atas, yaitu Fisher’s
Exact Probability Test dan x*> Two Sample Independent.
Bedanya, kalau Fisher Exact Probability Test digunakan untuk
menganalisis sampel kecil, x> Two Sample Independent untuk
sampel besar, maka Median Test digunakan untuk
menganalisis jumlah sampel di antara keduanya. Teknik
analisis ini disebut Median Test karena pengujian didasarkan
atas median dari sampel yang dianalisis.
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Contoh:

Peneliti berkeinginan untuk membandingkan prestasi
belajar antara mahasiswa yang jarak tempat tinggalnya
dengan kampus kurang dari 5 km dan yang jaraknya 5 km
atau lebih. Penelitian ini menggunakan sampel 11
mahasiswa yang jarak tempat tinggalnya dengan kampus
kurang dari 5 km dan 13 mahasiswa yang jarak tempat
tinggalnya dengan kampus 5 km atau lebih. Data
penelitiannya adalah sebagai berikut:

JARAK
< 5km >=5km
IPK 2,75 0 1
2,80 0 1
2,85 1 0
2,90 1 0
2,95 1 1
3,00 0 1
3,10 0 1
3,20 0 2
3,23 2 2
3,30 1 2
3,43 1 0
3,45 0 1
3,52 1 0
3,54 1 0
3,56 1 1
3,60 1 0
Total 11 13
Proses Pengambilan Keputusan.
Hipotesis:
Ho Tidak terdapat perbedaan prestasi belajar

antara mahasiswa yang rumahnya berjarak
kurang 5 km dengan yang 5 km atau lebih
berdasarkan mediannya.

Ha Terdapat perbedaan prestasi belajar antara
mahasiswa yang rumahnya berjarak kurang 5
km dengan yang 5 km atau lebih berdasarkan
mediannya.

Dasar Pengambilan Keputusan:

Dengan membandingkan xzhitung dengan X,ztabel dengan ketentuan:
Ho diterima thitung < thabel

Ho ditolak thitung = thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:

Ho diterima Probabilitas > taraf nyata (a)
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Ho ditolak Probabilitas < taraf nyata (a)

1. Aplikasi dengan SPSS
Langkah-langkah yang dapat ditempuh untuk
menganalisis dengan Median test adalah sebagai berikut:

a) Setelah data diinput, klik Analyze » Nonparametric
Tests » K Independent Samples, sebagaimana gambar
berikut ini.

Median Test - SPSS Data Editor
File Edit View Data Transform BEGEREEN Graphs  Utilities  Window Help

~u Reports 3
= |n |§| | | J Descripkive Statistics 3 'I' I_' ’gﬂ
1:ipk 2 Tables 4
N n Compare Means 3
oS [t General Linear Model 3 A | war | e
1 | 255 <5 Kl pived Models 3
2 3,23 <5kl Carelate »
3 352 <5kl Regression 4
4 2580 <5kl Loglinear »
& 323 < f ki Classify 4
5 3,43 < E | DataReduction 4
! 354 <5 K C| rarmetric Test Chi-Square
Monparamettic Tests -
E 285 Time Series ¥ Binomial...
g 330 <5k Survival ¥ Runs..
10 356 <5 ki Multiple Response 3 1-Sample K-5...
11 R0 <8kl Missing Yalue Analysis. .. 2 Independent Samples. ..
12 320 EERN (1) e R | [ndependent Samples. ..
13 275 =5 km 2 Related Samples. ..
14 3,30 == 5 km K Related Samples. ..
15 345 ==4 km

b) Setelah keluar gambar seperti berikut ini, destinatikan
data tentang IPK ke Test Variable List, variable
kategori, yaitu jarak ke Grouping Variable, Non
aktifkan Kruskal-Wallis H, dan aktifkan Median, lalu
klik Define Range..

M Tests for Several Independent Samples |

Test Varniable List:

A ipk
Ij Paste
Beset

E Grouping W ariable: Cancel

X

El |

Help

Test Type
[ Eruzkalwalis H v Median

T

™ Jonckheere-Terpstra Options...
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c) Setelah keluar gambar seperti berikut ini, Isilah angka 1

pada kotak Minimun, dan angka 2 pada kotak
Maximum, lalu klik Continue, lalu klik Ok.

Sewveral Independent Samples: Define ... g]

Range for Grauping Yariable
Mimirnuim:

iy Cancel
M gwirnum: 2 Help

d) Berikut ini adalah outputnya.

Frequencies

JARAK
<5km >=5km
IPK > Median 6 4
<= Median 5 9

Output ini memperlihatkan bahwa terdapat 6 mahasiswa
yang jarak tempat tinggalnya dengan kampus kurang
dari 5 km yang mempunyai IPK lebih dari 3,23; 5
mahasiswa lainnya mempunyai IPK 3,23 atau lebih
rendah. Sedangkan mahasiswa yang jarak tempat
tinggalnya dengan kampus 5 km atau lebih yang
mempunyai IPK lebih tinggi dibanding 3,23 sebanyak 4
orang, sedangkan 9 lainnya mempunyai IPK 3,23 atau
lebih rendah.

Test Statistic®

IPK
N 24
Median 3,2300
Exact Sig. ,408

a. Grouping Variable: JARAK

Output di atas memperlihatkan bahwa sampel penelitian
ini adalah 24 mahasiswa. Median [IPK seluruh
mahasiswa yang dijadikan sampel adalah 3,23. Skor
Exact Signifikansi adalah 0,408 yang lebih tinggi
dibanding a=5%, oleh karena itu Ho diterima dan Ha
ditolak. Dari hasil ini dapat disimpulkan bahwa tidak
terdapat perbedaan IPK mahasiswa yang jarak tempat
tinggalnya dengan kampus kurang dari 5 km dan
mahasiswa yang jarak tempat tinggalnya dengan kampus
5 km atau lebih.

2. Aplikasi dengan Microsoft Excel



Analisis Komparasi 216

Untuk mengaplikasikan test median, maka seluruh
data harus diurutkan dan dicari mediannya. Skor data yang
lebih tinggi dari median dipisahkan dengan data yang sama
dengan median atau lebih rendah. Selanjutnya data tersebut
dikelompokkan seperti berikut ini.

Kelompok I Il Jumlah

> Median A B A+B

<= Median C D C+D
Jumlah A+C=n B+D=n, N=n;+n,

Untuk menguiji hipotesis dapat digunakan rumus y?
sebagai berikut:
N [(AD—BC)—%Y
(A+B) (C+D)(A+C) (B+D)

Untuk lebih jelasnya dapat dilihat pada aplikasi
Microsoft Excel berikut ini.

2

X =

A B c D
1 JARAK

7 <5km | >=5km | JUMLAH
3 [ [PK. > Median 5 4 10

4 [IPK. <= Median 5 5 14

5 [ JUMLAH 1 13 74

6

7 11616 =DS*(((B3*C4)-(C3*BAY-(DS2))
5 20020 =DI*D4*BS*CS

5 058021978 =AT/AS

10

1 N [IAD—BCI—E}

12 \ 7

13 ¥ -Ta+BIIC+D) (A+C1 B+D)
14

Analisis dengan Microsoft Excel menghasilkan skor
X ning SEbesar 0,58021978. Apabila dibandingkan dengan
Yuberoos1 Yaitu 3,841455338, maka Ho diterima dan Ha
ditolak karena xzhitung lebih kecil dibandingkan dengan
Yube. Kesimpulan ini juga sama dengan skor signifikansi
hasil aplikasi SPSS.

d. Mann-Whitney U-Test

U-test, begitu biasanya teknik analisis ini disebut,
digunakan untuk menguji hipotesis komparatif dua sampel
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independen bila datanya berbentuk ordinal. Teknik ini sering
juga digunakan untuk menganalisis data penelitian yang
direncanakan menggunakan t-test of independent tetapi
ternyata sebagian asumsi untuk menggunakan t-test tidak
terpenuhi. Untuk kasus terakhir ini, maka data yang semula
bertipe interval atau rasio harus diubah menjadi ordinal.

Contoh:

Peneliti ingin  membandingkan motivasi berprestasi
antara alumni pesantren dan alumni non-pesantren.
Dalam penelitian itu diambil 30 sampel dari alumni
pesantren dan 40 sampel dari alumni non-pesantren.
Dikarenakan data dalam penelitian itu bertipe interval,
maka direncanakan untuk menggunakan t-test of
independent. Setelah data diuji distribusinya dan ternyata
tidak normal, sebagaimana output berikut ini, maka
teknik analisis yang digunakan akhirnya adalah Mann-
Whitney U-Test.

Tests of Normality

Motivasi Berpretasi
LULUSAN

alumni pesantren_| alumni non-pesantren

Kolmogqrov-  Statistic 247 ,250
Smirnov df 30 40
Sig. ,000 ,000

Shapiro-Wilk  Statistic ,814 ,820
df 30 40

Sig. ,000 ,000

a. Lilliefors Significance Correction

Kedua skor signifikansi Kolmogorov Smirnov, baik untuk
data alumni pesantren maupun non-pesantren ternyata 0,000
yang berarti di bawah 0,05. Oleh karena itu, distribusi kedua
data tersebut tidak normal.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan tentang motivasi
berprestasi antara alumni pesantren dan non-
pesantren

Ha Terdapat  perbedaan  tentang  motivasi
berprestasi antara alumni pesantren dan non-
pesantren

Dasar Pengambilan Keputusan:
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Dengan membandingkan zyiwung dengan Zqpe dengan ketentuan:

Ho diterima Zhitung < Ztabel

Ho ditolak Zhitung = Ztabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (a)

1. Aplikasi dengan SPSS

Langkah-langkah yang dapat ditempuh untuk
menganalisis dengan Mann-Whitney U-Test adalah sebagai
berikut:

a) Setelah data diinput, klik Analyze » Nonparametric

Tests » 2 Independent Samples, sebagaimana gambar
berikut ini.

Mann-Whitney LI-Test - SPSS Data Editor
File Edit View Data Transform BEGENEEN Graphs Utilities  Window Help

=~ Reports 3
= |n |§| | | J Descriptive Statistics 3 M @@
13: Tables 4
motpres | lulus Compare Means ’ | var | var
- General Linear Model »
1 33| alumni pe Mized Models 3
2 39| alumni pe  cCoprelate »
3 36| alumni pE Regression 4
4 33| alumni pe  Loglinear 3
5 36 | alumni pg  Classify 4
5 36| alumni pe Daka Reduckion 3
! 33 alumni pe cl rametric Test: Chi-Square
B Nonparametric Tests - e
& 3 alumn? Re Time Series » Binomial...
3 33 alumn? PE  Survival 4 Runs...
10 45| alurnni pe Multiple Response » 1-3ample K-5...
11 33| alumni pe  Missing Yalue Analysis. .. 2 Independent Samples. ..
12 39| alumni pesantren T i ¥ Independent Samples. ..
13 33| alumni pesantren 185 2 Related Samples...
14 42| alurnni pesantren 64,0 K Related Samples...
1R AR aliimni nesantran wn

b) Setelah keluar gambar seperti berikut ini, destinasikan
variabel Motivasi Berprestasi ke kotak Test Variable
List, dan lulusan ke Grouping Variable. Setelah itu
klik Define Group.
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B Two-Independent-Samples Tests El
Test Variable List:
& RANK of MOTPRES [r i oK
@ Motivasi Berpretasi [me
\:I Paste
Reset
\:I Grouping ¥ ariable: Cangel
lulusan(1 2) Hel
p
Test Type
v Manr-whitney U I Eolmogoroy-Smirmoy 2

I Mozes extreme reactions [ WaldWolfowitz rurs

Exact... | Optionz... |

c) Setelah keluar gambar seperti berikut ini, Isilah 1 untuk
Group 1 dan 2 untuk Group 2, selanjutnya klik
Continue, lalu klik Ok.

Two Independent Samples: Defi... E|

Group 1: ’1_
Group 2: ,21_ Cancel
Help

d) Berikut ini adalah Output analisis Mann-Whitney U-

Test.
Ranks
LULUSAN N Mean Rank | Sum of Ranks |
Motivasi Berpretasi alumni pesantren 30 33,32 999,50
alumni non-pesantren 40 37,14 1485,50
Total 70

Output ini memperlihatkan bahwa jumlah sampel
dari alumni pesantren sebanyak 30, dengan rata-rata
ranking: 33,32, dan jumlah ranking: 999,50, sedangkan
jumlah sampel alumni non-pesantren sebanyak 40 dengan
rata-rata ranking: 37,17 dan jumlah ranking: 1485,50.
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Test Statistics

Motivasi

Berpretasi
Mann-Whitney U 534,500
Wilcoxon W 999,500
z -,821
Asymp. Sig. (2-tailed) 412

a. Grouping Variable: LULUSAN

Output terakhir ini menghasilkan skor Mann-
Whitney: 534,500 (menggunakan rumus 2), skor Zjwng: -
0,821. Untuk tingkat kepercayaan 95% dan uji dua sisi
didapat skor zg,e = 1,96. Karena zpung lebih kecil
dibandingkan z,,y maka Ho diterima dan Ha ditolak.
Kesimpulan ini juga sama apabila digunakan skor Asymp.
Sig. Dua sisi: 0,412 yang lebih besar dibanding alpa: 0,05.

Aplikasi dengan Microsoft Excel

Setidaknya ada dua rumus untuk mencari skor
Mann-Whitey U-Test. Kedua rumus tersebut harus
digunakan semuanya dan yang nantinya digunakan untuk
menguji hipotesis penelitian adalah hasil yang lebih kecil.
Sedangkan rumus yang dimaksud sebagaimana tercantum
berikut ini:

Rumus 1
M (n, +1)
2

Rumus 2
n, (n,+1
Uzznlnz+%2)—R2

_Rl

Hasil penghitungan dengan rumus di atas langsung
dapat dibandingkan Mann-Whitney tabel manakala jumlah
masing-masing n; dan n, paling banyak 20. Manakala salah
satu dari n; atau n, ada yang lebih banyak dibandingkan 20,
maka digunakan dengan pendekatan kurva normal rumus z
sebagai berikut:
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SR, - ( N +1]
2
n,.n, n,.n,.((N+2)?)
R R —en 2
\/N(N -1) [Z n+ 2R, ] 4.(N-1)
Untuk dapat mengaplikasikan seluruh  rumus
tersebut, langkah-langkahnya adalah sebagai berikut::
a) Seluruh data, baik n; maupun n, secara bersama dicari
rankingnya.
b) Setelah dibuat ranking secara bersama, data dan ranking

dari ny dipisahkan dari data n;.
¢) Masing-masing kelompok ranking, baik dari n; maupun
n, dijumlahkan.

d) Setelah itu dapat diaplikasikan rumus 1 maupun rumus 2
Mann-Whitney U-Test.

e) Sedangkan untuk mengaplikasikan rumus z, masing-
masing ranking dikuadratkan.

f) Setelah itu, hasil pengkuadratan tersebut dijumlahkan
untuk setiap kelompok sampel.
Untuk lebih dijelasnya dapat dilihat aplikasinya pada
Microsoft Excel berikut ini.

Z=
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atas diketahui bahwa hasil

di

aplikasi

Dari
penghitungan rumus 1 adalah 665,5, dan rumus 2 sebesar

534,5. Karena hasil dari rumus 2 yang lebih kecil, maka
yang digunakan adalah hasil yang kecil tersebut. Hanya

saja karena jumlah sampel baik untuk n; maupun n, lebih
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banyak dibandingkan 20, maka digunakan hasil rumus z,
yaitu -0,8208238. Untuk tingkat kepercayaan 95% dan uji
dua sisi didapat skor zgne Sebesar + 1,96. Karena Zpjung
lebih kecil dibandingkan zg,y maka Ho diterima dan Ha
ditolak. Hasil ini sama persis yang Output SPSS di atas.

e. Kolmogorov Semirnov

Kolmogorov  Semirnov  termasuk statistik non-
parametrik yang digunakan untuk menguji hipotesis
komparatif dua sampel independen bila datanya bertipe
ordinal yang tersusun pada tabel distribusi frekuensi
kumulatif.

Contoh:

Dilakukan penelitian untuk membandingkan kedisiplinan
kerja antara alumni Madrasah Aliyah dan SMA. Masing-
masing kelompok sampel diambil 19 orang. Dengan
menggunakan checklist dengan berisi instrumen tentang
kedisiplinan kerja, peneliti melakukan observasi selama 3
bulan.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Kedisiplinan kerja antara alumni Madrasah
Aliyah dan SMA adalah sama

Ha Kedisiplinan kerja antara alumni Madrasah

Aliyah dan SMA adalah tidak sama
Dasar Pengambilan Keputusan:
Dengan membandingkan Xpiwung dengan Xener dengan ketentuan:
Ho diterima Xhitung < Xtabel
Ho ditolak Xhitung = Xtabel
Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (a)

1. Aplikasi dengan SPSS

a) Setelah data diinput, klik Analyze » Nonparametric
Tests » 2 Independent Samples, sebagaimana gambar
berikut ini.
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Kolmogorov Semirnov - SPS5 Data Editor

File Edit Wiew Data Transform REGEREEN Graphs  Utlities  Window  Help

~ Reports 3
4 | n |§ | | | J Descripkive Statistics 4 m @@
11 disker 7 Tables 4
. Compare Means .3
e | g General Linear Model 3 | var | var
1 B2 alurr Mized Models »
2 63 alum  Correlate »
3 B4 alurr  Regression 4
4 BE alur  Loglinear 3
5 67 alurn  Classify 4
5 =] alupy  Data Reduction 3
7 B9 alum 50 d
g 7 Monparametric Tests 3 Chi-square. ..
Time Seties ¥ Binomial...
3 72 alurr Survival 3 Runs...
10 73 alurn Mulkiple Response 3 1-Sample K-5...
11 75 alur  Missing value Analysis. ., 2 Independent Samples...
12 76 alumni SHA K Independsnt Samples..,
13 77 alumni Shas 2 Related Samples. ..
14 78 alumni ShA K Related Samples. ..

b) Setelah keluar gambar seperti berikut ini, destinasikan
variabel kedisiplinan dalam kerja ke kotak Test
Variable List, sedangkan variabel lulusan ke kotak
Grouping Variable, lalu non-aktifkan Mann-Whitney
U dalam Test Type, lalu aktifkan Kolmogorov-
Semirnov, lalu klik Define Groups.

B Two-Independent-Samples Tesis

Test Variable List: oK

@ Kedisiplinan dalam ker

\:I Paste

Reset

Grouping Yariabls: Cancel

i

ezl 8

Help

Test Type
[T Mannwhitney U v Kaolmogoroy-Smimay 2

I Moses extreme reactions [ Waldwolfowitz rurs

Exact... | Optionz... |

c) Setelah keluar gambar seperti berikut ini, ketiklah 1 pada
kotak Group 1 dan 2 pada kotak Group 2, lalu klik
Continue, lalu klik Ok.
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Two Independent Samples: Defi... EI

Group 2: 2 Cancel

Help

d) Berikut ini adalah outputnya.

Frequencies

LULUSAN N
Kedisiplinan dalam kerja  alumni SMA 19

alumni MA 19

Total 38

Output ini memperlihatkan bahwa sampel untuk masing-
masing alumni SMA dan MA adalah 19 orang.

Test Statistic®

Kedisiplinan

dalam kerja

Most Extreme Absolute ,158
Differences Positive 1158
Negative -,158

Kolmogorov-Smirnov Z ,487
Asymp. Sig. (2-tailed) ,972

a. Grouping Variable: LULUSAN

Output ini menunjukkan skor hasil hitung Kolmogorov
Smirnov yang dalam keadaan positif adalah 0,158 dan
dalam keadaan negatif juga sama yaitu -0,158. Skor
tersebut kemudian dibandingkan dengan tabel untuk n;
19 dan n, 19 diketahui skor tabelnya adalah 0,44124.
Karena kolmogorov smirnov hitung lebih kecil
dibanding kolmogorov smirnov tabel, maka Ho diterima
dan Ha ditolak. Kesimpulan yang sama akan diperoleh
manakala digunakan skor Asymp. Sig. (2 sisi) sebesar
0,972 yang jauh lebih tinggi dibandingkan taraf nyata
(), yaitu 0,05.

2. Aplikasi dengan Microsoft Excel

Langkah-langkah yang perlu ditempuh Kketika
menganalisis data dengan kolmogorov smirnov adalah:
a) Masing-masing data dibuat ranking dengan nomor urut
dari yang terkecil sampai kepada yang terbesar.
b) Dicocokkan skor yang sama antara n; dan n, dengan
menempatkan skor yang sama pada baris yang sama.
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c) Membuat nomor urut (kumulatif) yang dijadikan
pembilang ketika diaplikasikan pengurangan Sn; (X)
dengan Sn, (x). Sedangkan penyebutnya adalah jumlah
masing-masing data n; dan n,

d) Dari hasil pengurangan tersebut dicari skor terbesar baik
dalam keadaan positif maupun negatifnya. Skor terbesar
dari yang positif itulah skor Kolmogorov Smirnov.

e) Sedangkan untuk mencari tabel digunakan rumus di
bawah ini.

Untuk lebih jelasnya dapat diamati dari aplikasi
Microsoft Excel berikut ini.

A B c D E |F G H
1 # Hy Formula i C2

2 62 0,053 1 0 =D2/19-E2/19

3 63 0,105 Z 0

4 ] 0,158 3 0 Formula di €29

5 £ ] 0,158 3 1 =MAX(C2:C26)
6 &7 &7 0,158 5 2 Formula di C30
7 68 63 0,158 5 3 =MIN(C2:C26)

8 ] ] 0,155 7 3

9 70 0,105 7 5 Formula di E30
10| 71 70 0,105 g 5 ={19+199/(19*%1%)
SR 72 0,105 5 7 Forrula di E31
12 73 73 0,105 10 5 =1,36*(SQRT(E33))
13 73 0,053 10 g

14 7 0,000 10 10

15 7 0,053 10 i1

16 75 0,105 10 12

7 75 0,105 11 13

12 7% 76 0,105 12 4

19 76 0,158 12 15

| T 0,158 13 16

N 0,105 14 T

22| 80 ] 0,105 15 7

23| 8l 5l 0,105 16 13

4| 82 0,053 17 13
25| 53 0,000 1z 13
6| &4 54 0,000 13 13
77
28
20 0.158
30 0,158 0105263 D =136 |1t %2
31 0,44124 X%,
37

Skor hasil hitung Kolmogorov Smirnov yang dalam
keadaan positif adalah 0,158 dan dalam keadaan negatif
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juga sama yaitu -0,158. Skor ini sama dengan hasil hitung
dengan SPSS. Skor tersebut kemudian dibandingkan
dengan tabel untuk n; 19 dan n, 19 diketahui skor tabelnya
adalah 0,44124. Karena kolmogorov smirnov hitung lebih
kecil dibanding kolmogorov smirnov tabel, maka Ho
diterima dan Ha ditolak.

f. Wald Woldfowitz Runs

Teknik analisis ini digunakan untuk menganalisis
hipotesis komparatif dua sampel independen bila datanya
bertipe ordinal. Untuk aplikasi dengan Microsoft Excel, kedua
datanya disatukan dan disusun dalam bentuk run.

Contoh:
Dalam rangka mengetahui performance sebuah
pendidikan  tinggi, diadakan penelitian  tentang

keterlambatan kehadiran pimpinan dan staf lembaga
tersebut dalam seminggu.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Lamanya keterlambatan datang antara
pimpinan dan staf adalah sama

Ha Lamanya keterlambatan datang antara

pimpinan dan staf adalah sama
Dasar Pengambilan Keputusan:

Dengan membandingkan runhiyng 0engan  rungpe dengan
ketentuan:

Ho diterima FUNhitung > MUNiapel
Ho ditolak MUNhitung = MNtapel

Apabila salah satu atau kedua-duanya n; atau n, > 20, maka
pengambailan keputusan dengan membandingkan zg,e dengan
taraf nyata (o) dengan ketentuan:

Ho diterima Zianel > taraf nyata (o)

Ho ditolak Zianel < taraf nyata ()

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (a)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS
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klik Analyze » Nonparametric

Tests » 2 Independent Samples, sebagaimana gambar

berikut ini.

Wald-Wolfowitz runs - SPSS Data Editor,

File Edit WYiew Data Transform EGEEEN Graphs  Utilities ‘window  Help

s g = L]
1: terlamba 3
terlamba jab

1 366] Pimpinz
2 32| Pimping
3 198 Pimping
4 144| Pimpinz
5] 180| Pimpinz
B 282 Pimpinz
7 270 Pimping
8 2558 Pimpinz
9 246| Pimping
10 216| Pimpinz
11 276| Pimping
12 252| Pirpinan

Reports 3

Descriptive Statiskics 3 m @@
Tables 3

Compare Means 3

General Linear Model 3 kGl | hill | A
Mixed Models 3

Correlate 3

Regression 3

Loglinear 3

Classify 3

Data Reduction 3

Scale 3

Monparametric Tests 3 Chi-Square. ..
Tirne Series ¥ Binomial. ..
Survival ¥ Runs...

Multiple Response 3 1-5ample K-5...

Missing Yalue Analysis... 2 Independent Samples. ..

K. Independent Samples. ..

b) Setelah keluar gambar seperti berikut ini destinasikan
variabel Keterlambatan pegawai pada kolom Test

Variable List,

dan variabel Jab pada Grouping

Variable. Selanjutnya non-aktifkan Mann-Whitney U
dan aktifkan Wald-Wolfowitz runs, lalu klik Define

Groups

B Two-Independent-Samples Tests | |

Test Type

M

[ Moses extreme reactions

Cd

£y

Test Yarable List:

@ Keterdambatan pegaw:

Reset

Grouping ariabls: Cancel

ab[? 7]

Define Groups...

I Eolmogoroy-Smirmoy 2

Eliel [

Help

v wWhald-w/olfowitz rns

Exact... | Optionz... |

c) Setelah keluar gambar seperti berikut ini, ketiklah 1 pada
kotak Group 1 dan 2 pada kotak Group 2, lalu klik
Continue, lalu klik Ok.
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Two Independent Samples: Defi... EI

Group 2: 2 Cancel

Help

d) Berikut ini adalah outputnya.

Frequencies

Jabatan N
Keterlambatan Pimpinan 15
pegawai dalam menit  gtaf 15

Total 30

Output ini memperlihatkan bahwa sampel untuk masing-
masing pimpinan dan staf adalah 15 orang.

Test Statistics ¢

Number Exact Sig.
of Runs Z (1-tailed)
Keterlambatan Minimum Possible 122 -1,301 ,097
pegawai dalam menit  Maximum Possible 152 -,186 424

a. There are 2 inter-group ties involving 4 cases.
b. Wald-Wolfowitz Test
C. Grouping Variable: Jabatan

Output ini memperlihatkan bahwa jumlah run dari kedua
kelompok data tersebut adalah minimal 12 manaka skor
yang sama antara data keterlambatan pimpinan dan staf
tidak dihitung, akan tetapi kalau data yang sama itu
dihitung, maka maksimal jumlah run adalah 15. Apabila
jumlah run ini dibandingkan dengan run tabel (Tabel VII
a) dengan n; dan n, masing-masing 15 adalah 10. Karena
MUNhiwng l€bih tinggi dibanding rungpe, maka Ho diterima
dan Ha ditolak. Kesimpulan sama akan didapatkan
ketika digunakan skor Exact Sig sebesar 0,424 yang jauh
lebih tinggi dibanding taraf nyata (a): 0,05. Oleh karena
itu, Ho yang berbunyi Lamanya keterlambatan datang
antara pimpinan dan staf adalah sama diterima.

2. Aplikasi dengan Microsoft Excel

Langkah-langkah yang perlu ditempuh ketika
menganalisis data dengan Wald-Wolfowitz runs adalah:

a) Data dari kedua sampel itu dijadikan satu dan diurutkan.

b) Dihitung run-nya dengan cara setiap pergantian antara
data dari satu sampel ke sampel lainnya dihitung satu.
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¢) Jumlah run tersebut dibadingkan dengan run tabel.

d) Apabila jumlah n; atau n, ada yang lebih banyak dari 20,
maka uji statistiknya menggunakan rumus berikut ini.

2n,n
r—| “MM2 1] 05
N n,+n,
o, 2n,n, (2n,n, —n, —n,)

(nl + nz)2 (nl +n, _1)

Untuk lebih jelasnya dapat diperhatikan aplikasi dengan
Microsoft Excel berikut ini.

A B G D g F G H I
1 | 43 |Pumpman| 1 o 2n;n, +1]=05
2 48 [ swf [ 2 e — ’
j 22 Pmslf:;an j a, j2r11n2 '2r121n2 —n;—n,)
5 o6 Staf ‘gf i 40, M ing+n,—1)
1] 108 Staf
7 108 Staf
8 138 Staf 15 — [21515 + 1] _ D,S
9 | 138 | staf 15 +15
1 13z Staf \/2.15.15 (2.15.15 -15 =15 )
11 144 | Pimpman| 35 (15 +15) (15 +15 - 1)
12| 156 Staf fi
13| 162 | staf L[R5 L 5* 1515+ 150+ 1)-0.5
14 | 130 |Punpinan| 7 139000|=2*15%1 5% (2*15%15-15-15)
15 192 | Staf | 3 26100|=((15+15)"2)*(15+15-1)
16 | 198 | Pimpinan 9 7,241379|=E14/ELS
17 204 Staf 10 2690981 [=SQRT(ELS)
18 | 210 Staf -0,55742|=E13/EL7
19 | 216 |Pimpinan| 11 0,2856|=NOERMEDIST(-0,55742)
200 216 Staf 12
21| 246 |Pumpman| 13
22 [ 252 |Pimpinan
33 | 253 | Pimpinan
24 | 770 | Pimpinan
25 | 776 | Pimpinan
26 | 282 | Pimpinan
27| 288 Staf 14
28 | 312 |Pumpman| 15
29 [ 330 | Pimpinan
30 | 366 | Pimpinan
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Hasil aplikasi Microsoft Excel ini menghasilkan jumlah run
sebanyak 15. Hal ini sama dengan jumlah maksimal run
hasil aplikasi SPSS.

E. Komparasi k Sampel Berkorelasi

1. Statistik Parametrik: One-way Anova

One-way Anova digunakan untuk menguji hipotesis
komparatif 3 sampel atau lebih bila datanya berbentuk interval
atau rasio, berdistribusi normal, dan variannya homogen. Untuk
sub bab ini menguji sampel berpasangan dalam arti sebelum dan
sesudah perlakukan/treatment. Oleh karena itu, maksud dari 3
sampel atau lebih, artinya setiap sampel mendapatkan perlakukan
tiga kali atau lebih.

Contoh:
Dilakukan penelitian tentang perbedaan prestasi belajar

siswa sebelum kursus, setelah kursus berjalan 3 bulan, dan
setelah mendapatkan kursus 6 bulan.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan prestasi belajar dengan
adanya kursus (kursus tidak berpengaruh
terhadap prestasi belajar)

Ha Terdapat perbedaan prestasi belajar dengan
adanya kursus (kursus berpengaruh terhadap
prestasi belajar)

Dasar Pengambilan Keputusan:
Dengan membandingkan Fpwyng dengan Fepe dengan ketentuan:

Ho diterima Fhitung < Frabel

Ho ditolak Fhitung > Frabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (a)

Ho ditolak Probabilitas < taraf nyata (o)

a. Aplikasi dengan SPSS

Langkah-langkah dalam menggunakan analisis ini
adalah sebagai berikut:
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1. Setelah data diinput, lalu klik Analyze » Compare
Means » One-way ANOVA sebagaimana gambar di
bawah ini:

one way anova - 5PS5 Data Editor

File Edit View Data Transform BEGEFSEM Graphs  Utiities  window  Help

Y Reporks »
EI% —u J Descriptive Statistics » .I. '_' &IQI
E1 : preshel 7 Tables *
Compare Means > Means...
presbel | wkt S e el b One-Sample T Test. .
i) 80,00 Mixed Models 3 Independent-Samples T Test...
B0 /a0 Correlate 3 Paired-Samples T Test...
B 78,00] Regression v E d...
B2 81,00 Loglinear v T

2. Setelah keluar gambar seperti berikut ini, destinasikan
Prestasi Belajar Siswa ke kotak Dependent List dan wkt
ke kotak Factor. Selanjutnya klik Post Hoc...

H One-Way ANOVA

Dependent List:

<& Prestasi Belajar Siswa

3
E Paste
et |
]
[ ]
|

Beset
Cancel
Factar: Help
A —

Qontrasts...| F'ostﬂoc:...| Options...

3. Setelah keluar gambar seperti berikut ini, aktifkan
Bonferroni dan Tukey untuk mengetahui perbedaan
antara sampel satu dengan lainnya. Selanjutnya Kklik
Continue dan Options.

One-Way ANOVA: Post Hoc Multiple Comparisons F§|

Equal ¥ariances Assumed

[T S-MK [~ waller-Duncan
[v Bonferroni v Tukey
[ Sidak [~ Tukey's-b [~ Durnett
[~ Scheffe [~ Duncan
[~ B-E-GwWF [~ Hochberg's GT2
[~ R-E-Gw O [~ Gabriel = i i

Equal ¥ ariances Mot Azzumed

[T Tamhane's T2 [ Dunnett's T3 [ Games-Howel [ Dunnett's C

Significance level |05

Eontinuel Cancel | Help |

3. Setelah keluar gambar seperti berikut ini, aktifkan
Descriptive untuk mendiskripsikan data ketiga sampel
tersebut dan Homogeneity of variance test untuk
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mengetahui varians ketiga sampel tersebut homogen atau

tidak.

One-Way ANOVA: Options

Statistics

[~ welch

™ Fixed and random effects

Iv Homogeneity of variance test Help

™ Brown-Forspthe

™ Means plot
Mizsing Yalues

% Exclude cases analysis by analysis

" Exclude cases lishwise

Cancel

3

3. Berikut ini adalah Output one-way ANOVA..

Descriptives

Prestasi Belajar Siswa

Prestasi Belajar | Prestasi Belajar setelah | Prestasi Belajar setelah

sebelum Kursus 3 bulan Kursus 6 bulan Kursus Total
N 30 30 30 90
Mean 74,7667 76,4333 78,6667 76,6222
Std. Deviation 5,98091 5,85858 5,68321 5,99546
Std. Error 1,09196 1,06963 1,03761 ,63198
95% Confidence Lower Bound 72,5334 74,2457 76,5445 75,3665
Interval for Mean  Upper Bound 77,0000 78,6210 80,7888 | 77,8779
Minimum 65,00 67,00 70,00 65,00
Maximum 87,00 89,00 92,00 92,00

Output pertama

ini mendiskripsikan data, misalnya
rata-rata prestasi belajar siswa sebelum mengikuti kursus
adalah 74,7667, standard deviasinya 5,98091, dan standard
error of mean-nya 1,09196.

Test of Homogeneity of Variances

Prestasi Belajar Siswa

Levene
Statistic

dfl df2

Sig.

,128

2 87

,880

Output kedua ini terkait uji asumsi untuk ANOVA
yaitu variannya harus homogen.
signifikansi sebesar 0,880 yang lebih tinggi dibanding taraf
nyata (o): 0,05, maka varians ketiga sampel adalah homogen.

Berdasarkan

ANOVA
Prestasi Belajar Siswa
Sum of
Squares df Mean Square F Sig.
Between Groups 229,756 2 114,878 3,366 ,039
Within Groups 2969,400 87 34,131
Total 3199,156 89

skor
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Output ketiga ini terkait uji hipotesis. Skor Fpiyngnya
sebesar 3,366. Bila dibandingkan dengan Fpe untuk
pembilang 2 (m-1) dan penyebut 87 (N-m) maka diketahui
sebesar:

3,101292
=FINV{0,05.2:87)

karena Fuiung lebih besar dibandingkan Fipe, maka Ha
diterima dan Ho ditolak. Oleh karena itu, kesimpulan dari
penelitian ini adalah terdapat perbedaan prestasi belajar
dengan adanya kursus (kursus berpengaruh terhadap prestasi
belajar). Kesimpulan yang sama akan didapatkan ketika
digunakan skor sig sebesar 0,039 yang lebih kecil dibanding
taraf nyata (a): 0,05.

Multiple Com parisons

Mean
Difference 95% Confidence Interval

() WKT _ () WKT _ (-J) Std. Error Sig. Lower Bound | Upper Bound

Tukey HSD sPerT):i?'l iilraSJ:; :rsj:?Ki??lﬂzr setelah -1,6667 1,50844 ,514 -5,2635 1,9302
grsj:;iKBu??azr setelah -3,9000* 1,50844 ,030 -7,4969 -,3031

:I:j[:'flKi?Ladzr setelah Eézzﬁ.s.rl] iillgl?; 1,6667 1,50844 ,514 -1,9302 5,2635
gfsj:;iKi??lﬂzr setelah -2,2333 1,50844 ,305 -5,8302 1,3635

ij[:r?IKZT?‘Er setelah Eézzﬁ.s.rl] iilzl?; 3,9000* 1,50844 ,030 ,3031 7,4969
grsj:;iKBu??azr setelah 2,2333 1,50844 ,305 -1,3635 5,8302

Bonferront ::;:3:1 iilra;:; gfj::szﬁr setelah -1,6667 1,50844 ,817 -5,3490 2,0157
;’Tsjaé\siKBuflsfﬂzr setelah -3,9000* 1,50844 ,034 -7,5823 -,2177

:fj[:leiflsadzr setelah Eézzﬁ.s.rl] iilzl?; 1,6667 1,50844 ,817 -2,0157 5,3490
grsj:;iKBu??azr setelah -2,2333 1,50844 427 -5,9157 1,4490

lej[:rsllKi?lsadzr setelah Eézzﬁ.s.rl] iilzl?; 3,9000* 1,50844 ,034 ,2177 7,5823
:rsjzsiKBu?:ﬂzr setelah 2,2333 1,50844 427 -1,4490 5,9157

*. The mean difference is significant at the .05 level.
Output keempat ini mendeteksi perbedaan antar

sampel. Untuk menentukan antar sampel mana yang berbeda
secara signifikan digunakan skor signifikansi dibandingkan
dengan taraf nyata (o). Apabila skor signifikansi < taraf nyata
(o), maka antar sampel tersebut berbeda secara signifikan.
Output di atas memperlihatkan bahwa yang berbeda hanyalah
prestasi belajar sebelum kursus dengan prestasi belajar
setelah 6 bulan kursus sebesar 3,9000, karena skor
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signifikansinya sebesar 0,034 yang < taraf nyata (a): 0,05.
Sedangkan antara prestasi belajar sebelum kursus dengan
setelah kursus 3 bulan dan prestasi belajar setelah kurus 3
bulan dan setelah kurus 6 bulan ternyata tidak berbeda secara
signifikan karena skor signifikansinya yang lebih tinggi
dibanding taraf nyata (a): 0,05.

Prestasi Belajar Siswa

Subset for alpha = .05
WKT N 1 2

Tukey HSI} Prestasi Belajar
sebelum Kursus 30 74,7667

Prestasi Belajar setelah
3 bulan Kursus

Prestasi Belajar setelah
6 bulan Kursus

Sig. ,514 ,305
Means for groups in homogeneous subsets are displayed.
a. Uses Harmonic Mean Sample Size = 30,000.

30 76,4333 76,4333

30 78,6667

Output kelima ini menunjukkan bahwa Kketiga
kelompok data tersebut dapat dikelompokkan menjadi 2,
yaitu kelompok pertama berisi data sampel sebelum kursus
dan setelah kursus 3 bulan; dan kelompok kedua data sampel
setelah kurus 3 bulan dan data setelah kursus 6 bulan.

Aplikasi dengan Microsoft Excel

Sedangkan prosedur analisis one-way ANOVA dengan
Microsoft Excel adalah sebagai berikut:
1. Data diinput ke dalam kelompok sampel masing-masing.
2. Mencari varians dari masing-masing sampel.

3. Menguji homogenitas varians dengan menggunakan uji F,
yaitu dengan cara varians terbesar dibagi dengan varians
terkecil. Apabila Fpiwung < Frane, maka variansnya homegen,
akan tetapi kalau Fpiwng > Franel, Mmaka variansnya hiterogen.
Apabila variansnya homogen, maka analisis one-way
ANOVA dapat diteruskan.

4. Masing-masing skor pada masing-masing sampel
dikuadratkan.

5. Masing-masing skor pada masing-masing sampel
dijumlahkan.

6. Masing-masing skor hasil pengkuadratan dari masing-
masing skor sampel dijumlahkan.

7. Hasil penjuamlahan nomor 5 dijumlahkan.
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8. Hasil penjuamlahan nomor 6 dijumlahkan.
9. Selanjutnya dimasukkan ke dalam rumus berikut ini.
a. Menghitung jumlah kuadrat total (JK+o;) dengan rumus:

Q Xw)?
‘]Ktot :zzxtotz _Z:N”

b. Menghitung jumlah kuadrat antar kelompok (JKantar)
dengan rumus:

S 0F O xw)?
‘]Kantzz %k _ZN

¢. Menghitung jumlah kuadrat dalam kelompok (JKgaiam)
dengan rumus:

IK o = I, —IK

d. Menghitung mean kuadrat antar kelompok (MKanar)
dengan rumus:

dalam antar

JK&H ar
MKamar = m 'EI_

e. Menghitung mean kuadrat dalam kelompok (MK gaam)
dengan rumus:
_ ‘JKdaIam
dalam — N -m
. Menghitung Fiwng dengan rumus:
MK

F _ antar

hitung — MK

MK

—h

dalam
Untuk lebih jelasnya tentang prosedur analisis one-way

ANOVA dapat dilihat pada aplikasi Microsoft Excel berikut
ini.
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I a

ini juga sama

Hasil aplikasi

dengan hasil aplikasi SPSS di atas.

3,366. Skor
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2. Statistik Non-Parametrik

a. x* k Sample Related
x*> k Sample Related digunakan untuk menguji
hipotesis komparatif tiga sampel atau lebih apabila datanya
bertipe nominal.
Contoh:
Peneliti berkeinginan untuk membandingkan angka
kredit yang dapat dikumpulkan dosen di 4 fakultas antara

yang dapat mengumpulkan lebih dari 100 dan yang
mengumpulkan 100 atau kurang dalam 1 tahun.

Proses Pengambilan Keputusan.
Hipotesis:
Ho Tidak terdapat perbedaan angka kredit yang

dapat dikumpulkan dosen dalam 1 tahun di 4
fakultas tersebut.

Ha Terdapat perbedaan angka kredit yang dapat
dikumpulkan dosen dalam 1 tahun di 4
fakultas tersebut.

Dasar Pengambilan Keputusan:
Dengan membandingkan thitung dengan y’upel dengan ketentuan:

Ho diterima thitung < thabel

Ho ditolak thitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

Langkah-langkah analisis y* k Sample Related
dengan SPSS adalah sebagai berikut:

a) Setelah data diinput, klik Analyze » Descriptive
Statistics » Crosstabs, sebagaimana gambar berikut
ini.
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Chi Kuadrat k Sampel related - SPS5 Data Editor,
File Edit Wiew Data Transform BEGEWEEE Graphs  Utiities  Window Help

Reports Y e el e
=S| =] o[
n @ . Descripkive Statistics Frequencies...
1 kum 1 Tables Descriptives. ..

Compare Means Explore...

k_um General Lingar Model
1] KUM diatas 100 %) yied Models
3 LTIM i atas 1000~

b) Setelah keluar gambar seperti berikut ini destinasikan
salah satu variabel ke kotak Row(s) dan variabel satunya
pada kotak Column(s). Selanjutnya klik Statistics.

3
4
4
3

Ratia...

M Crosstabs

X

Fowl(z): oK
] [ KUM Dosen dalam 1 t:

Bl Reset

LColumn(s):

| @ Fakultas [fak] _Cancel
E Help
Layer 1 of 1

_tien |

=Nl

™ Display clustered bar charts

I™ Suppress tables

Exact... | ﬁtatistics...| Cells... | Eormat...|

c) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Chi-square. Selanjutnya klik Continue,
setelah itu klik Cells.

Crosstabs: Statistics f'5_<|

: I Correlations
MNominal Ordinal Cancal

[~ Contingency coefficient [ Gamma
[~ Phiand Cramér's ¥ [ Somers'd
[~ Lambda ™ Kendalls taub
[~ Uncertainty coefficient ™ Kendall's tau-c
Mominal by Interval [~ Kappa
[~ Eta ™ Risk

[ MecMemar

[ Cochran's and MantelH aenszel statistics

—

d) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Expected. Selanjutnya klik Continue,
setelah itu klik Ok.
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Crosstabs: Cell Display |

Counts Cantinue
Vi f
v Expected

£

Cancel

dif

Help
Percentages Fiesidualz
[~ Bow [~ Unstandardized
[~ Calurnn | Standardized
[ Tatal ™ Adj standardized

e) Berikut ini adalah Output analisis di atas.

Case Processing Summary

Cases

Valid Missing Total

KUM Dosen dalam
1 tahun * Fakultas

N Percent N Percent N Percent

70 100,0% 0 ,0% 70 100,0%

Output ini memperlihatkan bahwa jumlah sampel
adalah 70.

KUM Dosen dalam 1 tahun * Fakultas Crosstabulation

KUM Dosen dalam 1 tahun

20,0
20,0
15,0
15,0
70,0

KUM di atas 100 KUM 100 atau kurang Total
Count Expected Count Count Expected Count Count Expected Count
Fakultas Tarbiyah 14 7,4 6 12,6 20
Syari'ah 7 7,4 13 12,6 20
Dakwah 3 5,6 12 9,4 15
Ushuluddin 2 5,6 13 9,4 15
Total 26 26,0 44 44,0 70

Output ini menyajikan bahwa ada 14 orang dosen
dari Fakultas Tarbiyah yang mempunyai angka kredit di
atas 100 dalam 1 tahun dan 6 lainnya mempunyai angka
kredit 100 atau kurang dalam 1 tahun. Di Fakultas Syari‘ah
ada 7 orang dosen yang mempunyai angka kredit di atas
100 dalam 1 tahun dan 13 lainnya mempunyai angka kredit
100 atau kurang dalam 1 tahun. Di Fakultas Dakwah ada 3
orang dosen yang mempunyai angka kredit di atas 100
dalam 1 tahun dan 12 lainnya mempunyai angka kredit 100
atau kurang dalam 1 tahun. Di Fakultas Ushuluddin ada 2
orang dosen yang mempunyai angka kredit di atas 100
dalam 1 tahun dan 13 lainnya mempunyai angka kredit 100
atau kurang dalam 1 tahun.
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Chi-Square Tests

Asymp. Sig.
Value df (2-sided
Pearson Chi-Square 14,8182 3 ,002
Likelihood Ratio 15,235 3 ,002
Linear-by-Linear
Associatiyon 13,010 1 000
N of Valid Cases 70

a. 0 cells (,0%) have expected count less than 5. The
minimum expected count is 5,57.

Skor thitung sebesar 14,818 yang lebih besar
dibanding thabek 00s3. 7,8147247. Demikian juga skor
Asymp. Sig untuk dua sisi sebesar 0,002 yang jauh lebih
kecil dari alpha, yaitu 0,05, maka Ho ditolak dan Ha
diterima. Hal ini berarti terjadi perbedaan angka kredit
yang dapat dikumpulkan dosen dalam satu tahun di 4
fakultas tersebut.

2. Aplikasi dengan Microsoft Excel
Rumus yang digunakan adalah sebagai berikut:

f, -f )2
lz _ z Z( 0 h)
fy
Untuk dapat mengaplikasikan rumus tersebut, maka

perlu dibuat tabel kotingensi. Untuk lebih jelasnya dapat
dilihat pada aplikasi Microsoft Excel berikut ini.

A B c D E
1 KUM Jumlah | Harapan
2 Fakultas =100 14 743 4,81
3 Tarhiyah == 100 B 1257 344
4 Fakultas =100 7 743 00z
5 Syariah == 100 13 1257 0,01
B Fakultas =100 3 557 119
7 Dakwah == 100 12 9,43 070
g Fakultas =100 2 557 229
9 | Ushuluddin == 100 13 943 1,35
10 26 14818
11 44
12 70
13

Hasil penghitungan ini juga menghasilkan skor 2
sebesar 14,818. Apabila ini dibandingkan dengan x° tabel
dengan dk 2:

=CHIIN'V(0,05;3)
7814725

maka kita menerima Ha dan menolak Ho karena xzhitung
lebih besar di banding y? e
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Sedangkan prosedur pembuatan tabel kontingensi
dan aplikasi rumus dapat dilihat pada beberapa formula di

bawabh ini.
14 Formula C10 |=C24C44+C5+C8
15 Formula G111 |=C3+05+C7+C8
16 |Formula €12 |=C10+C11
17
18 Faormula D2 FCHI0ACHI 220
19 Formula 03 FCRT/FCH12720
20 Formula D4 FCH10/ACHI 220
21 |Formula 05 FCHT/SCHIZ20

22 [Formula DB
23 [Formula D7
24 Formula 03
25 Formula 09

FCH/RCHIZ™ME
FCHI0/FCHI ™S
FCH/CHI21MS

( )
{ )
( )
{ )
($CH10/3CH12)15
( )
{ )
{ )

27 Formula B2 | =(c2-02p202) |

29 Formula E10 [ =SUMEZED |

b. Cochran’s Q

Teknik analisis ini digunakan untuk menguji hipotesis
komparatif tiga sampel atau lebih apabila datanya bertipe
nominal dikhotomis. Misalnya: vya-tidak, sukses-gagal,
disiplin-tidak disiplin, dan terjual-tidak terjual.

Contoh:

Peneliti berkeinginan untuk mengetahui keberhasilan
aplikasi analisis statistik antara yang menggunakan
kalkulator, Microsoft excel, dan SPSS. Ada 25 mahasiswa
yang dilatih analisis statistik menggunakan tiga media
penghitungan yang berbeda. Setelah dirasa memahami
dan dapat mengaplikasikan, maka 25 mahasiswa tersebut
diuji dengan diberikan data yang hampir sama untuk
dianalisis dengan menggunakan 3 media penghitungan
tersebut.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan keberhasilan
disebabkan perbedaan media analisis statistik.

Ha Terdapat perbedaan keberhasilan disebabkan

perbedaan media analisis statistik.
Dasar Pengambilan Keputusan:
Dengan membandingkan Qhiwng dengan thabe| dengan ketentuan:
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Ho diterima thtung < thabel

Ho ditolak Qnitung = X tabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

a) Setelah data diinput, klik Analyze » Nonparametric
Test » K Related Samples, sebagaimana gambar
berikut ini.

Cochran's Q - SP55 Data Editor,

File Edit View Data Transform EOEPEES Graphs  LUtiities  Window  Help

N Reports 4
EI% —u J Descriptive Statistics 3 QEI 5@
1 ka 0 Tables »
Compars Means 3
| EarE] General Linear Model 3 A | ar |
1| Gagal ~ Berhas e models 3
2 Gagal Berhas  correlate »
3 Berhasil Berhas  Regression 4
4| Berhasil| Berhazs Loglinear 3
5|  Berhasil Gag ~ Classify 4
5 Gagal Gag Data Reduction »
i Gagal Berhas C| ramettic Test Chi-Square
Monparametnc Tests - e
g Gagal Berha; Time Series 3 EBinomial...
9 Berhasil Bethas < ival N
10 Gagal Berhas Multiple Response 3 1-Sample K-5...
11 Berhasil Berhas Missing Value Analysis... Z Independent Samples. ..
12 Gagal BethasilT BefRasl] | KIndependent Samples...
13 Gagal Berhasil Berhasil 2 Related Samples...
14 Gagal| Berhasil| Berhasil K Related Samples...

b) Setelah keluar gambar seperti berikut ini, destinasikan
ketiga variabel yang akan dianalisis ke Test Variables.
Selanjutnya non-aktifkan Friedman dan aktifkan
Cochran’s, lalu klik ok.

Ml Tests for Several Related Samples

TestVarables:
@ Analizis Statistik. Meng
@ Analizis Statistik. Meng Paste
@ Analizis Statistik. Meng

K

Beset
Cancel

Help

Test Type Exact...
™ Friedman [ Kendal's' W Cochran's O

-]
1E lgle

Statigtics. ..

c¢) Berikut ini output analisis di atas.
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Frequencies

Value
0 1

Analisis Statistik

Menggunakan Kalkulator 14 u
Analisis Statistik

Menggunakan Microsoft 4 21
Excel

Analisis Statistik

Menggunakan SPSS 0 2

Output ini memperlihatkan ada 14 mahasiswa ketika
menggunakan kalkulator untuk analisis statistik yang gagal,
11 lainnya mengalami keberhasilan. Terdapat 4 mahasiswa
ketika menggunakan Microsoft Excel untuk analisis
statistik yang gagal, 21 lainnya mengalami keberhasilan.
Sedangkan ketika 25 mahasiswa tersebut menggunakan
SPSS seluruhnya berhasil.

Test Statistics

N 25
Cochran's Q 19,5002
df 2
Asymp. Sig. ,000

a. 0 is treated as a success.

Output ini menunjukkan bahwa jumlah sampel yang
diteliti sebanyak 25 mahasiswa. Skor Cochran’s sebesar
19,5. Skor tersebut dibandingkan dengan tabel y* dengan
dk. 2:

=CHIINWV{D,05,2)
5991476

maka Ha diterima dan Ho ditolak karena Qpiwng lebih besar
dibanding thabeh Hal ini berarti terdapat perbedaan
keberhasilan disebabkan perbedaan media analisis statistik.

Penggunakan yZ%me ini  disebabkan  distribusi
sampling Q mendekati distribusi .

2. Aplikasi dengan Microsoft Excel
Rumus Cochran’s Q adalah sebagai berikut:

2
kK kK
(k-1 kZGf—{ZGjJ
=1 =1
Q= N N
kY L-> 1
=1

1=1 i
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Untuk dapat mengaplikasikan rumus di atas, maka
jumlah yang berhasil dijumlahkan untuk setiap kelompok,
lalu hasil penjumlahan tersebut dijumlahkan. Masing
keberhasilan individu sampel dijumlahkan, lalu hasil
penjumlahan  tersebut  dikuadratkan, dan  hasil
pengkuadratan itu juga dikuadratkan. Selanjutnya
diaplikasikan dalam rumus.

A B c D E f

1 | Kalkulator Excel SPS5  |jml berhasil jmi®
2 Gagal Berhasil Berhasil 2 4
3 Gagal Berhasil Berhasil 2 4
4 Berhasil Berhasil Berhasil 3 9
5 Berhasil Berhasil Berhasil 3 9
=] Berhasil Gagal Berhasil 2 4
7 Gagal Gagal Berhasil 1 1
=] Gagal Berhasil Berhasil 2 4
9 Gagal Berhasil Berhasil 2 4
10 | Berhasil Berhasil Berhasil 3 9
11 Gagal Berhasil Berhasil 2 4
12 | Berhasil Berhasil Berhasil 3 g
13 Gagal Berhasil Berhasil 2 4
14 Gagal Berhasil Berhasil 2 4
15 Gagal Berhasil Berhasil 2 4
16 Gagal Gagal Berhasil 1 1
17 | Berhasil Berhasil Berhasil 3 9
18 | Berhasil Gagal Berhasil 2 4
19 | Berhasil Berhasil Berhasil 3 9
20 | Berhasil Berhasil Berhasil 3 9
21 Gagal Berhasil Berhasil 2 4
22 Gagal Berhasil Berhasil 2 4
23 | Berhasil Berhasil Berhasil 3 g
24 | Berhasil Berhasil Berhasil 3 9
25 Gagal Berhasil Berhasil 2 4
26 Gagal Berhasil Berhasil 2 4
27 11 21 25 57 139
28

29 [farmula A27 [=COUNTIF{A2:A26;"Berhasil") |
30 [forrmula D2 [=COUNTIF(AZ:C2; "Bethasil |

3
2 524 000 [=((3-1 P {3 (A2T 2 +B27 "2+ C27°2)- (D27 *21[l)
] 32,000 |=(3 D27 E27

34 19,500 [=A32/A33

Hasil analisis di atas ternyata juga sama dengan hasil
analisis SPSS, di mana Qpiwng Sebesar: 19,5.

c. Friedman Two-way anova

Teknik analisis ini digunakan untuk menguji hipotesis
komparatif 3 sampel atau lebih yang berpasangan apabila
datanya berbentuk ordinal.

Contoh:

Seorang pimpinan berkeinginan untuk mengetahui
efektifitas kerja stafnya apabila gaya kepemimpinan
berbeda. Dalam tahun pertama dia menggunakan gaya
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kepemimpinan partisipatif, tahun kedua menggunakan
gaya kepemimpinan direktif, dan pada tahun ketiga dia
menggunakan gaya kepemimpinan supportif.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan efektifitas kerja staf
disebabkan perbedaan gaya kepemimpinan
atasannya.

Ha Terdapat perbedaan efektifitas kerja staf
disebabkan perbedaan gaya kepemimpinan
atasannya.

Dasar Pengambilan Keputusan:
Dengan membandingkan szmng dengan X,Ztabel dengan ketentuan:

Hoditerima  %’hitung < X tabel

Ho ditolak thitung = thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

a) Setelah data diinput, klik Analyze » Nonparametric
Test » K Related Samples, sebagaimana gambar
berikut ini.

Friedman - 5PSS Data Editor

File Edit View Data Transform BEGEREEE Graphs  Ltiities  Window Help

~u Reports 3
= |n |§| | | J Descriptive Statistics 3 I_'IEI ’@@
1: part 7 Tables 4
n Compare Means 3
[t il General Linear Model 3 A | A | 4]
1 | 7600 &7 [ Mixed Models 3
2 77,00 7680 carrelate 3
3 E7 00 770 Regression 4
4 7800 G50 Loglnear »
5] 77,00 BE,0  Classify 4
= £7.,00 53 Data Reduction 3
7 76 00 Bon Sk e —
g 77 00 BT L I"-J|:|r||:|aranEetru: Tests 3 C.hl-Sc.|uare. "
Time Seties » Binarnial. ..
9 76,00 83,0 Survival 3 Rurs...
10 77,00 760 Multiple Response 3 1-Sample K-5...
11 G500 780 Missing Value Analysis. .. 2 Independent Samples...
12 77 oo 7,00 e K Independent Samples...
13 83,00 78,00 77.00 2 Related Samples. ..
14 89,00 77.00 50,00 K. Related Samples. ..
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b) Setelah keluar gambar seperti berikut ini, destinasikan
ketiga variabel yang akan dianalisis ke Test Variables.
Selanjutnya klik Statistics.

M Tests for Several Related Samples g|
TestVarables:
@ Efektifitaz kerja yg Pim
@ Efekliftas keria yg Pim Baste
@ Efeklifitas keria yg Pim Beset
E Cancel
Help
Test Type Exact...
¥ Friedman [ Kendal's' [ Cochran's O b
= = = Statigtics. ..

c) Setelah keluar gambar berikut ini, aktifkan Descriptive,
lalu klik Continue, lalu klik Ok.

Several Related Samples: Stat... g|

[~ Quartiles Cemee]
[[Es ]

Help

d) Berikut ini output analisis di atas.

Descriptive Statistics

N Mean Std. Deviation | Minimum Maximum
Efektifitas Kerja yg
pimpinannya Partisipatif 30 | 80,2000 7,03391 66,00 90,00
;ﬁ;’::;ﬁ];: g?riﬁm 30 | 78,0667 7,49682 65,00 90,00
Efektifitas Kerj
pinipin'aﬁy: giggomf 30 | 757000 5,85544 65,00 89,00

Output ini menunjukkan bahwa rata-rata skor
efektifitas kerja staf yang pimpinannya partisipatif adalah
80,20 dengan standard deviasi sebesar 7,03391. Hal ini
menunjukkan bahwa rentang efektifitas kerja staf yang
pimpinannya partisipatif berkisar antara 59,09827 sampai
dengan 101,3017. Rentang data ini hasil dari mean + 3
standard deviasi. Demikian juga untuk data lainnya.
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Ranks

Mean Rank

2,40

Efektifitas Kerja yg
pimpinannya Patrtisipatif
Efektifitas Kerja yg
pimpinannya Direktif
Efektifitas Kerja yg
pimpinannya Supportif

1,90

1,70

Output ini  memperlihatkan rata-rata ranking
efektifitas kerja staf yang pimpinan partisipatif sebesar 2,4,
yang pimpinanannya direktif sebesar 1,9, dan yang
pimpinannya supportif sebesar 1,7.

Test Statistics?

N 30
Chi-Square 7,800
df 2
Asymp. Sig. ,020

a. Friedman Test

Output ini menunjukkan bahwa jumlah sampel yang
diteliti sebanyak 30 staf. Skor thimng sebesar 7,8. Skor
tersebut dibandingkan dengan tabel x* dengan dk. 2:

=CHIINWV{D,05:2)
5991476

maka Ha diterima dan Ho ditolak karena xzhitung lebih besar
dibanding thabe.. Kesimpulan yang sama akan didapatkan
kalau digunakan skor signifikansi sebesar 0,02 yang jauh
lebih kecil dibanding dengan taraf nyata (a): 0,05. Hal ini
berarti efektifitas kerja staf berbeda dikarenakan berbedaan
gaya kepemimpinan atasannya diterima dan berlaku untuk
populasi.
2. Aplikasi dengan Microsoft Excel
Rumus teknik analisis ini sebagai berikut.

, 12 LS
= NK=D) ;(Rj) 3N(k +1)

Untuk dapat mengaplikasikan rumus di atas, setiap
skor efektifitas kerja dari masing-masing individu dibuat
ranking. Selanjutnya ranking tentang efektifitas kerja staf
dari setiap gaya kepemimpinan dijumlahkan. Selanjutnya
dimasukkan dalam rumus di atas.

V4
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A B © D E F H | J
1 | part |direct| supp [rank part| rank direct |rank supp
2 76 | 67 | B 3 2 1 farrmula D2
3 77 | 76 | BB 3 2 1 =RAMKAZ,AZ:C2,1)
4 | B7 | 77 | B8 1 3 2
578 | 65 | B9 3 1 2 farrmula E2
6| 77 | B6 | 78 2 1 3 =RAMK(BZ,A2:C2,1)
7 E7 | BB | BS 2 3 1
8 76 | B9 | 77 2 1 3 farrmula F2
9 77 | B | 7B 3 1 2 =RAMK(CZ,A2:C2,1)
10| 76 | B9 | 67 2 3 1
1M 77 | 76 | 78 2 1 3 0,033333[=12430°3*(3+1))
12/ 88 | 78 | 77 3 2 1 11034 |=D32+2+E322+F 3242
13 77 | 76| 78 2 1 3 360[=3730*3+1)
1488 | 78 | 77 3 2 1 7,800 =H11*H12-H13
15 89 | 77 | 80 3 1 2
16| B | 76 | 88 1 2 3
17| 78 | 88 | 77 2 3 1
1888 | 78 | 77 3 2 1
19| 78 | 88 | 77 2 3 1
20 B0 [ 90 | 78 2 3 1
2. 77 | "6 | 78 2 1 3
2. 78 |8 |77 2 3 1
23 87 | 78 | B9 2 1 3
24 88 | B | 7B 3 2 1
25 590 |88 | 77 3 2 1
2 76 | 89 | B 2 3 1
277 | e | 78 2 1 3
2B 88 | 78| 77 3 2 1
25 88 | 75| 77 3 2 1
30, 88 | 78 | 77 3 2 1
3 89 | 77 | &0 3 1 2
32 72 57 5
33 80,20(78,07|75,70| 2,40 1,90 1,70

Aplikasi rumus di atas ternyata juga menghasilkan

skor yang sama dengan aplikasi SPSS.

F. Komparasi k Sampel Independent

1. Statistik Parametrik: One-way Anova

One-way Anova digunakan untuk menguji hipotesis
komparatif 3 sampel atau lebih bila datanya berbentuk interval
atau rasio, berdistribusi normal, dan variannya homogen. Untuk
sub bab ini menguji sampel independen.

Contoh:

Dilakukan penelitian tentang perbedaan produktivitas kerja
dosen antara dosen alumni UIN Jakarta, UIN Yogjakarta,
dan UIN Malang.

Proses Pengambilan Keputusan.

Hipotesis:
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Ho Tidak terdapat perbedaan produktivitas kerja
dosen berbedasarkan perbedaan latar belakang
pendidikan (latar belakang pendidikan tidak
berpengaruh terhadap produktivitas kerja dosen)

Ha Terdapat perbedaan produktivitas kerja dosen
berbedasarkan  perbedaan  latar  belakang
pendidikan  (latar  belakang  pendidikan
berpengaruh terhadap produktivitas kerja dosen)

Dasar Pengambilan Keputusan:

Dengan membandingkan Fpiwng dengan Fepe dengan ketentuan:

Ho diterima Fhitung < Fiapel

Ho ditolak Fhitung > Fravel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (a)

Ho ditolak Probabilitas < taraf nyata (o)

Salah satu asumsi yang harus terpenuhi ketika akan
menggunakan analisis Varians adalah datanya berdistribusi
normal. Dari ketiga data tersebut diketahui bahwa ketiganya
berdistribudi normal karena signifikansi > taraf nyata (a): 0,05, di
mana sig untuk data alumni UIN Jakarta: 0,200, alumni UIN
Yogjakarta: 0,200, dan alumni UIN Malang: 0,198. Karena
datanya berdistribusi normal, maka analisis one-way ANOVA
dapat diteruskan.

Tests of Normality

Produktivitas Kerja Dosen
Latar Belakang Perguruan Tingqgi

Alumni UIN Jakarta | Alumni UIN Yogjakarta | Alumni UIN Malang

Kolmoggqrov-  Statistic ,126 ,113 ,131
Smirnov df 30 30 30
Sig. ,200* ,200* ,198

Shapiro-Wilk  Statistic ,933 ,933 ,939
df 30 30 30

Sig. ,059 ,059 ,088

*. This is a lower bound of the true significance.
a. Lilliefors Significance Correction

a. Aplikasi dengan SPSS

Langkah-langkah dalam menggunakan analisis ini
adalah sebagai berikut:
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1. Setelah data diinput, lalu klik Analyze » Compare
Means » One-way ANOVA sebagaimana gambar di
bawah ini:

one way anova independent - 5PS5 Data Editor

File Edit Wiew Data Transform BEGEREEE Graphs  Utilities  Window  Help

,,_ Reports 3
= |E |§| | | J Descriptive Statistics 3 'I' I_‘ @@
1 : prodker 4 Tables 4
- ol Compare Means 3 Means. ..
- General Linear Model ¥ One-Sample T Test...
1 | 46,00 Alurnni Mixed Models 3 Independent-Samples T Test, ..
2 25,00 Alumnl correlate ¥ Paired-Samples T Test...
3 23,00 Alumni  Regression A on MOYA, .,
4 458 00 Alumni  Loglinear T

2. Setelah keluar gambar seperti berikut ini, destinasikan
Produktifitas Kerja Dosen ke kotak Dependent List dan
Latar Belakang Pendidikan ke kotak Factor.
Selanjutnya klik Post Hoc...

B One-Way ANOVA (%]

Dependent List:

X

()
-

& Produktivitas Kerja Do

] E

aste

Cancel

Factor: Help

E > Latar Belakang Pe

il

Qontrasts...| Postﬂoc...| Dptions...

3. Setelah keluar gambar seperti berikut ini, aktifkan
Bonferroni dan Tukey untuk mengetahui perbedaan
antara sampel satu dengan lainnya. Selanjutnya Klik
Continue dan Options.

One-Way ANOVA: Post Hoc Multiple Comparisons r5__<|
Equal ¥ ariances Azsumed
r [T S-MK [~ waller-Duncan
[v Bonferroni v Tukey
[~ Sidak ™ Tukey'sb [~ Dunnett
I~ Scheffe I~ Duncan
[~ B-E-GwWF [~ Hochberg's GT2
[~ REGWQ I~ Gabriel {+ - i

Equal ¥ ariances Mot Azzumed

[T Tamhane's T2 [ Dunnett's T3 [ Games-Howel [ Dunnett's C

Significance level |05

Contiriue | Cancel Help
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3. Setelah keluar gambar seperti berikut ini, aktifkan
Descriptive untuk mendiskripsikan data ketiga sampel
tersebut dan Homogeneity of variance test untuk
mengetahui varians ketiga sampel tersebut homogen atau

tidak.

One-Way ANOVA: Options

Statisti
"

[ Brown-Forspthe
I~ welch

™ Means plat

Mizzing Values

™ Fixed and random effects

Iv Homogeneity of variance test Help

" Exclude cases |

Cancel

% Exclude cazes analysis by analysis

liztwize

X

3. Berikut ini adalah Output one-way ANOVA..

Descriptives
Produktivitas Kerja Dosen
Alumni UIN Jakarta | Alumni UIN Yogjakarta | Alumni UIN Malang Total

N 30 30 30 90
Mean 38,0333 36,0333 33,0333 35,7000
Std. Deviation 9,76441 9,75381 9,55017 9,80077
Std. Error 1,78273 1,78079 1,74361 1,03309
95% Confidence Lower Bound 34,3872 32,3912 29,4672 33,6473
Interval for Mean  ypper Bound 41,6794 39,6755 36,5994 37,7527
Minimum 23,00 21,00 18,00 18,00
Maximum 53,00 51,00 49,00 53,00

yaitu

Output pertama ini mendiskripsikan data, misalnya
rata-rata produktivitas kerja dosen alumni UIN Jakarta adalah
38,0333, standard deviasinya 9,76441, dan standard error of
mean-nya 1,78273.

Test of Homogeneity of Variances

Produktivitas Kerja Dosen
Levene
Statistic dfl df2 Sig.
,020 2 87 ,980

Output kedua ini terkait uji asumsi untuk ANOVA

variannya harus

homogen.

Berdasarkan

skor

signifikansi sebesar 0,980 yang lebih tinggi dibanding taraf
nyata (o): 0,05, maka varians ketiga sampel adalah homogen.
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ANOVA
Produktivitas Kerja Dosen
Sum of
Squares df Mean Square F Sig.
Between Groups 380,000 2 190,000 2,024 ,138
Within Groups 8168,900 87 93,895
Total 8548,900 89

Output ketiga ini terkait uji hipotesis. Skor Fpiungnya
sebesar 2,024. Bila dibandingkan dengan Fpe untuk
pembilang 2 (m-1) dan penyebut 87 (N-m) maka diketahui
sebesar:

3101292
=FINV(0,05,2:37)

maka Ho diterima dan Ha ditolak karena Fyiung lebih kecil
dibandingkan Fipe. Oleh karena itu, kesimpulan dari
penelitian ini adalah Tidak terdapat perbedaan produktivitas
kerja dosen berbedasarkan perbedaan latar belajang
pendidikan (latar belakang pendidikan tidak berpengaruh
terhadap produktivitas kerja dosen). Kesimpulan yang sama
akan didapatkan ketika digunakan skor sig sebesar 0,138
yang lebih besar dibanding taraf nyata (a): 0,05.

Multiple Com parisons

Dependent Variable: Produktivitas Kerja Dosen

Mean

(1) Latar Belakang (J) Latar Belakang Difference 95% Confidence Interval
Perguruan Tinggi Perguruan Tinggi (I-J) Std. Error Sig. Lower Bound | Upper Bound
Tukey HSD  Alumni UIN Jakarta Alumni UIN Yogjakarta 2,0000 2,50194 , 704 -3,9658 7,9658
Alumni UIN Malang 5,0000 2,50194 ,119 -,9658 10,9658
Alumni UIN Yogjakarta Alumni UIN Jakarta -2,0000 2,50194 ,704 -7,9658 3,9658
Alumni UIN Malang 3,0000 2,50194 ,457 -2,9658 8,9658
Alumni UIN Malang Alumni UIN Jakarta -5,0000 2,50194 ,119 -10,9658 ,9658
Alumni UIN Yogjakarta -3,0000 2,50194 ,457 -8,9658 2,9658
Bonferroni  Alumni UIN Jakarta Alumni UIN Yogjakarta 2,0000 2,50194 1,000 -4,1076 8,1076
Alumni UIN Malang 5,0000 2,50194 ,146 -1,1076 11,1076
Alumni UIN Yogjakarta Alumni UIN Jakarta -2,0000 2,50194 1,000 -8,1076 4,1076
Alumni UIN Malang 3,0000 2,50194 ,701 -3,1076 9,1076
Alumni UIN Malang Alumni UIN Jakarta -5,0000 2,50194 ,146 -11,1076 1,1076
Alumni UIN Yogjakarta -3,0000 2,50194 ,701 -9,1076 3,1076

Oleh karena Ho yang diterima, maka Output keempat
menjadi tidak ada artinya, karena output keempat ini
digunakan mendeteksi perbedaan antar sampel.
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Produktivitas Kerja Dosen

Subset
for alpha
Latar Belakang =.05
Perguruan Tinggi N 1
Tukey HSB  Alumni UIN Malang 30 33,0333
Alumni UIN Yogjakarta 30 36,0333
Alumni UIN Jakarta 30 38,0333
Sig. ,119

Means for groups in homogeneous subsets are displayed.
a. Uses Harmonic Mean Sample Size = 30,000.

Demikian juga Output kelima ini, karena Ho diterima,
maka wajar apabila ketiga kelompok data tersebut hanya
dikelompokkan menjadi satu.

b. Aplikasi dengan Microsoft Excel

Sedangkan prosedur analisis one-way ANOVA dengan
Microsoft Excel adalah sebagai berikut:

1. Data diinput ke dalam kelompok sampel masing-masing.
2. Mencari varians dari masing-masing sampel.

3. Menguji homogenitas varians dengan menggunakan uji F,
yaitu dengan cara varians terbesar dibagi dengan varians
terkecil. Apabila Fpiung < Franel, maka variansnya homegen,
akan tetapi kalau Fpiwng > Franel, Maka variansnya hiterogen.
Apabila variansnya homogen, maka analisis one-way
ANOVA dapat diteruskan.

4. Masing-masing skor pada masing-masing sampel
dikuadratkan.

5. Masing-masing skor pada masing-masing sampel
dijumlahkan.

6. Masing-masing skor hasil pengkuadratan dari masing-
masing skor sampel dijumlahkan.

7. Hasil penjuamlahan nomor 5 dijumlahkan.
8. Hasil penjuamlahan nomor 6 dijumlahkan.
9. Selanjutnya dimasukkan ke dalam rumus berikut ini.
a. Menghitung jumlah kuadrat total (JK+,;) dengan rumus:

Q Xw)?
‘]Ktot :zzxtotz _Z:N”

b. Menghitung jumlah kuadrat antar kelompok (JKantar)
dengan rumus:



255 Statistika untuk Penelitian Pendidikan

S 0F O xw)?
‘]Kantzz Zn:k _ZN

¢. Menghitung jumlah kuadrat dalam kelompok (JKgaiam)
dengan rumus:

JK =JK

d. Menghitung mean kuadrat antar kelompok (MKantar)
dengan rumus:

-JK antar

dalam tot

‘JKan ar
MKamar = m_;-

e. Menghitung mean kuadrat dalam kelompok (MKgaam)
dengan rumus:

JK
IledaIam = N fa;:n

f. Menghitung Fpiwng dengan rumus:

MK
itung — MK
Untuk lebih jelasnya tentang prosedur analisis one-way

ANOVA dapat dilihat pada aplikasi Microsoft Excel berikut
ini.

antar

F,

dalam
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Hasil aplikasi
2,024 juga sama dengan hasil hitung SPSS.
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2. Statistik Non-Parametrik

a. x* k Sample Independent
x*> k Sample Independent digunakan untuk menguji
hipotesis komparatif tiga sampel atau lebih apabila datanya
bertipe nominal.
Contoh:

Peneliti berkeinginan untuk membandingkan perbedaan
alasan orang tua memilihkan anaknya sekolah.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan alasan memilihkan
anaknya tipe sekolah berdasarkan perbedaan
profesi orang tua.

Ha Terdapat perbedaan alasan memilihkan
anaknya tipe sekolah berdasarkan perbedaan
profesi orang tua.

Dasar Pengambilan Keputusan:
Dengan membandingkan xzhitung dengan thabel dengan

ketentuan:
Ho diterima thitung < thabel
Ho ditolak thitung > 7 abel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)
Ho ditolak Probabilitas < taraf nyata (a)

1. Aplikasi dengan SPSS
Langkah-langkah analisis y* k Sample Independent
dengan SPSS adalah sebagai berikut:

a) Setelah data diinput, klik Analyze » Descriptive
Statistics » Crosstabs, sebagaimana gambar berikut
ini.
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Chi Kuadrat k Sampel independen - SP5S Data Editor

File Edit Yiew Data Transform BEGENEEN Graphs  Utliies  wWindow Help

Reparts 3
HEIEEEEE : fe el T ol
Frequencies...
1 milihzek 1 Tables 3 Descriptives...
- Compare Means 3 Explore
milihsek
- General Linear Model 4
1 | Biaya murah Mixed Models 3
2 Ralalah Mand - '

b) Setelah keluar gambar seperti berikut ini destinasikan
salah satu variabel ke kotak Row(s) dan variabel satunya
pada kotak Column(s). Selanjutnya klik Statistics.

M Crosstabs fgl

Rowi(s]: oK,

< Alazan Merilinkan Seb Paste
Beset

[
B M Concel|
x [z ]

Laper 1 of 1

™ Display clustered bar charts
™ Suppress tables

Exact... | §tatistics...| Cells... | Eormat...|

c) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Chi-square. Selanjutnya klik Continue,
setelah itu klik Cells.

Crosstabs: Statistics &|

[™ Comelations
Marminal Ordinal Cancel

[~ Contingency coefficient [T Gamma
[~ Phi and Cramér's [ Somers'd
[~ Lambda ™ Kendall's taub
[ Uncertainty coefficient [ Kendall's tawc
Mominal by Interval I~ Kappa
[~ Eta ™ Risk

[~ McMemar

™ Cochran's and Mantel-H aenszel statistics

—

d) Setelah keluar gambar seperti berikut ini klik kotak yang
ada di depan Expected. Selanjutnya klik Continue,
setelah itu klik Ok.
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Crosstabs: Cell Display

W

- d Cancel
v Expected 4

Help

Percentages Fiesidualz
[~ Bow [~ Unstandardized
[~ Calurnn | Standardized
[ Tatal ™ Adj standardized

e) Berikut ini adalah Output analisis di atas.

Case Processing Summary

Cases

Valid Missing Total

N Percent N Percent N Percent

Alasan Memilihkan
Sekolah Anak * 90 100,0% 0 ,0% 90 100,0%
Profesi Orang Tua

Output ini memperlihatkan bahwa jumlah sampel
adalah 90.

Alasan Memilihkan Sekolah Anak * Profesi Orang Tua Crosstabulation

Profesi Orang Tua
Pegawai Pegawai
Negeri swasta Wiraswasta Total

Alasan Memilihkan  Biaya murah Count 7 4 1 12
Sekolah Anak Expected Count 4,0 4,0 4,0 12,0
Kwalitas Tinggi  Count 0 17 24 41

WalauMahal - Expected Count 137 137 137 41,0

Sekolah Negeri  Count 23 9 5 37

Expected Count 12,3 12,3 12,3 37,0

Total Count 30 30 30 90
Expected Count 30,0 30,0 30,0 90,0

Output ini menyajikan bahwa ada 7 orang orang tua
yang berprofesi sebagai pegawai negeri, 4 orang orang tua
yang berprofesi sebagai pegawai swasta, dan 1 orang orang
tua yang berprofesi sebagai wiraswasta yang memilihkan
sekolah anaknya dengan alasan biaya murah. Terdapat 17
orang orang tua yang berprofesi sebagai pegawai swasta
dan 24 orang orang tua yang berprofesi sebagai wiraswasta
yang memilihkan sekolah anaknya dengan alasan kwalitas
tinggi walau biaya mahal. Terdapat 23 orang orang tua
yang berprofesi sebagai pegawai negeri, 9 orang orang tua
yang berprofesi sebagai pegawai swasta, dan 5 orang orang
tua yang berprofesi sebagai wiraswasta yang memilihkan
sekolah anaknya dengan alasan sekolah negeri.
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Chi-Square Tests

Asymp. Sig.
Value df (2-sided) |
Pearson Chi-Square 41,2792 4 ,000
Likelihood Ratio 53,478 4 ,000
Linear-by-Linear
Associatiyon 5079 1 024
N of Valid Cases 90

a. 3 cells (33,3%) have expected count less than 5. The
minimum expected count is 4,00.

Skor xzhimng sebesar 41,279 yang lebih besar
dibanding ¥ %aper 00s4. 9,487728. Demikian juga skor
Asymp. Sig untuk dua sisi sebesar 0,000 yang jauh lebih
kecil dari alpha, yaitu 0,05, maka Ho ditolak dan Ha
diterima. Hal ini berarti terdapat perbedaan alasan
memilihkan anaknya tipe sekolah berdasarkan perbedaan
profesi orang tua.

2. Aplikasi dengan Microsoft Excel
Rumus yang digunakan adalah sebagai berikut:

(fo -f)?
2= z Z 0" 'h
fh
Untuk dapat mengaplikasikan rumus tersebut, maka

perlu dibuat tabel kotingensi. Untuk lebih jelasnya dapat
dilihat pada aplikasi Microsoft Excel berikut ini.

A B c Bl E F
1 Profesi Orang Tua
2 Peg. Megeri| Pey. Swasta [ Wiraswasta | Jumlah
3 Biaya Murah 7 4 1 12
4 Harapan 4 4 4
5 Alasan Kualitas Tinggi Walau Mahal 1] 17 24 41
B | Memilihkan Harapan 13 67 1367 1367
7 Sekolah Sekolah Megeri 23 9 =] 37
a Anak Harapan 12,33 12,33 12,33
9 30 30 30 a0
10 2,260 =((C3-C4PTa
1 0,000 =({D3-D4)*2)/04
12 2,250 =({E3-E4)"2)/E4
13 13,667 =((Ca-CEYE)/CE
14 0,813 =((Da-DE)*=)/06
15 7,813 =((E5-EBY2)ER
16 9,225 =((C7-CEP)CE
17 0,201 =((D7-Day<)/08
18 4,360 =((E7-E8)<)/ER
19 41,279 =SUM{H3:H11)

Hasil penghitungan ini juga menghasilkan skor 2
sebesar 41,279. Apabila ini dibandingkan dengan y? tabel
dengan dk 4:



261

Statistika untuk Penelitian Pendidikan
=CHIINV{(0,05:4)
QABTTZE

maka Ha diterima dan Ho ditolak karena thitung lebih besar
di banding ” el

b. Median Extention

Teknik analisis ini digunakan untuk menguji komparatif
tiga sampel independen atau lebih yang datanya bertipe
ordinal. Sesuai dengan namanya, pengujian didasarkan atas
median dari sampel yang dianalisis.

Contoh:

Peneliti berkeinginan untuk membandingkan nilai MK
Statistika Pendidikan antara mahasiswa yang dibimbing
oleh Dosen yang berbeda. Sampel penelitian ini adalah 20
mahasiswa dibimbing oleh Dosen A, 19 mahasiswa
dibimbing oleh Dosen B, dan 20 mahasiswa dibimbing oleh
Dosen C.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan nilai Mata Kuliah
Statistika Pendidikan mahasiswa berdasarkan
perbedaan Dosen Pembimbingnya.

Ha Terdapat perbedaan nilai Mata Kuliah
Statistika Pendidikan mahasiswa berdasarkan
perbedaan Dosen Pembimbingnya.

Dasar Pengambilan Keputusan:
Dengan membandingkan xzhitung dengan thabe| dengan ketentuan:

Ho diterima thitung < thabel

Ho ditolak thitung = thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (a)

1. Aplikasi dengan SPSS

Langkah-langkah yang dapat ditempuh untuk
menganalisis dengan Median test adalah sebagai berikut:
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a) Setelah data diinput, klik Analyze » Nonparametric
Tests » K Independent Samples, sebagaimana gambar

berikut ini.

Median - SPSS Data Editor

File Edit Yiew Data Transform BEGENEEN Graphs  Utliies  wWindow Help

~u Reports 3
] <=
= |n |§| ﬂ | | J Descriptive Statistics 3 LIEI @@
1 rilai 8 Tables 4
nilai dosen Compare Means ’ var | var | val
General Linear Model 3
1 | 80,00 Dosen Mixed Models 3
2 8300 Dosen Correlate »
3 8400 Dosen Regrassion 4
4 88,00 Dosen| Loglinear »
5 80,00, Dosen| Classify 4
= 53,00 Diosen Data Reduction 3
7 B400| Dosen| 53 d
g 5500 Dosen I"-Ju:unp.aranEetriu: Tesks 3 C.hi-Sc.]uare. "
Time Seties » Binarnial. ..
9 62,00 Dosen Survival ¥ Runs...
10 78,00 Dosen Multiple Response 3 1-Sample K-5...
11 80,00 Dosen Missing Yalue Analysis, .. 2 Independent Samples. ..
12 7800 Dosen A K Independent Samples. ..
13 F700 Dosen A 2 Related Samples. ..
14 7500 Dosen A K. Related Samples. ..

b) Setelah keluar gambar seperti berikut ini, destinatikan
data tentang nilai statistika pendidikan ke Test
Variable List, variable Kkategori, yaitu dosen ke
Grouping Variable, Non aktifkan Kruskal-Wallis H,
dan aktifkan Median, lalu klik Define Range..

Bl Tests for Several Independent Samples |

Test Variable List: oK

< Milai Statistika Pendidit

Grouping W ariable:

Ij dozen(1 3]

X

Paste
Beset
Cancel

Help

i
IF |oleE

Test Type
[ Eruzkalwalis H
™ Jonckheere-Terpstra

v Median
Options...

c) Setelah keluar gambar seperti berikut ini, Isilah angka 1
pada kotak Minimun, dan angka 3 pada kotak
Maximum, lalu klik Continue, lalu klik Ok.



263

Statistika untuk Penelitian Pendidikan

Several Independent Samples: Define ... E|

Fange for Grauping ¥ ariable
Finimun; 1 Cancel
S ER 2 Help

d) Berikut ini adalah outputnya.

Frequencies

DOSEN
Dosen A Dosen B Dosen C
Nilai Statistka > Median 16 6 4
Pendidikan <= Median 4 13 16

Output ini memperlihatkan bahwa terdapat 16 mahasiswa
yang dibimbing oleh Dosen A, 6 dibimbing oleh Dosen B,
dan 4 dimbimbing oleh Dosen C yang mempunyai nilai
statistika pendidikan lebih tinggi dibanding mediannya.
Terdapat 4 mahasiswa dibimbing oleh Dosen A, 13
dibimbing oleh Dosen B, dan 16 dimbimbing oleh Dosen C
yang mempunyai nilai statistika pendidikan sama dengan
mediannya atau lebih rendah.

Test Statistics

Nilai Statistika
Pendidikan
N 59
Median 77,0000
Chi-Square 16,3792
df 2
Asymp. Sig. ,000

a. 0 cells (,0%) have expected frequencies less than
5. The minimum expected cell frequency is 8,4.

b. Grouping Variable: DOSEN
Output di atas memperlihatkan bahwa sampel
penelitiannya ini adalah 59 mahasiswa. Median seluruh
mahasiswa yang dijadikan sampel adalah 77. Skor thitung
adalah 16,379. Skor tersebut dibandingkan dengan tabel y
dengan dk. 2:

=CHIINWV{D,05:2)
5991476

maka Ha diterima dan Ho ditolak Karena xzhitung lebih
ktinggi dibanding dengan 2.y Hal ini sesuai dengan skor
Asymp. Signifikansi adalah 0,000 yang lebih rendah
dibanding a=5%. Penelitian ini berkesimpulan bahwa
terdapat perbedaan nilai Mata Kuliah Statistika Pendidikan
mahasiswa berdasarkan perbedaan Dosen Pembimbingnya.
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2. Aplikasi dengan Microsoft Excel

Untuk mengaplikasikan teknik analisis Median
Extention, maka seluruh data harus diurutkan dan dicari
mediannya. Skor data yang lebih tinggi dari median
dipisahkan dari skor yang sama dengan median atau lebih
rendah. Untuk menguiji hipotesis dapat digunakan rumus x?
sebagai berikut:

(foij _fh__)z

2 _ 1)

x —Zifhij

Untuk lebih jelasnya dapat dilihat pada aplikasi Microsoft
Excel berikut ini.

A B o8 o E F €] H |
1 | Dosen AlDosen B|Dosen C
2 80 75 78 16 10,00 3 500
3 83 513} 75 4 10,00 3 500
4 g4 57 75
5 a8 78 7B 51 2.50 1,289
=] a0 a0 75 13 9.50 1,289
7 83 72 75
8 84 75 72 4 10,00 3 500
a g5 72 i) 16 10,00 3,600
10 g2 |51} 59 16,979
11 78 50 7o
12 80 B2 75 formula E2 =COURNTIF (A2 AZ1, " =77
13 78 78 78 formula E3 =COURNTIF(AZ: A21, " <=77")
14 7 85 54 formula ES =COUNTIF(B2:B21;"=77"
15 75 7B a3 formula E6 =COUNTIF(B2:B21;"==77")
16 7B a7 77 formula E8 =COUNTIF(CZ:C21;" =77
17 Fi=] ag 53 formula E3 =COUNTIF(CZ2: C21,"«=77")
18 78 77 70
19 g0 72 1 formula G2 [=((E2-F2yr2)/F2
20 g1 7B 72
21 a0 77 formula 510 [=SUM{G2:G2)
22

Hasil analisis Median Extention dengan Microsoft Excel
ternyata menghasilkan skor yang sama dengan aplikasi
SPSS.

c. Kruskal-Wallis One-way Anova

Uji Kruskal-Wallis digunakan untuk menguji hipotesis
komparatif yang mempunyai 3 atau lebih sampel independen
bila datanya berbentuk ordinal. Pada dasarnya, uji ini
merupakan salah satu alternatif dari uji F atau Anova apabila
ada asumsi yang tidak terpenuhi, misalkan data tidak bertipe
interval/rasio atau distribusi datanya tidak normal. Untuk
kasus terakhir ini, maka data yang semula bertipe interval atau
rasio harus diubah menjadi ordinal.

Contoh:
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Dilakukan penelitian perbandingan tentang prestasi kerja
alumni Tarbiyah, Syari’ah, Ushuluddin, dan Dakwah.
Sampel yang digunakan adalah 15 alumni Tarbiyah, 15
alumni Syari’ah, 10 alumni Ushuluddin, dan 10 alumni
Dakwah.

Proses Pengambilan Keputusan.

Hipotesis:

Ho Tidak terdapat perbedaan prestasi kerja antara
alumni Tarbiyah, Syari’ah, Ushuluddin, dan
Dakwah.

Ha Terdapat perbedaan prestasi Kkerja antara
alumni Tarbiyah, Syari’ah, Ushuluddin, dan
Dakwah.

Dasar Pengambilan Keputusan:

Dengan membandingkan H/y%ung dengan  x’wne  dengan
ketentuan:

Ho diterima HIyhitung < X tabel

Ho ditolak H/XZhitung > thabel

Dengan menggunakan angka probabilitas, dengan ketentuan:
Ho diterima Probabilitas > taraf nyata (o)

Ho ditolak Probabilitas < taraf nyata (o)

1. Aplikasi dengan SPSS

a) Setelah data diinput, klik Analyze » Nonparametric
Tests » K Independent Samples, sebagaimana gambar
berikut ini.
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Kruskal-Wallis - 5PSS Data Editor

File Edit %iew Data Transform BGEFEEN Graphs  Utilities  Window Help

EM Reports 3
D|n |§| | | J Descripkive Statistics 4 QD ,@@
1: presker 3 Tables 4
Compare Means »
presker ol General Linear Model r il | Ll |
1 | 98,00 Tarbiys Mixed Models 4
2 9200 Tarbiys  caorrelate »
3 83,00 Tarbive  Regression 4
4 73000 Tarbiys Loglinear 4
5 B500| Tarbiys Classify 4
B 5100 Tarhiyz Data Reduction 4
7 7900 Tarbiy C' S F—
- Monparametric Tests -
= 7700 Tarhws Time Seties b Binomial...
&l 5800 Tarbiyz Survival ¥ Runs...
10 7800|  Tarbiyz  mukiple Response b 1-Sample K-35,
11 86,00 Tarbiys  Missing Yalue Analysis... 2 Independent Samples...
12 B84 00 Tarbiyati K. Independent Samples. ..
13 8200| Tarbiyah 2 Related Samples...
14 7600 Tarhiyah K Related Samples. ..
1ic od N Tevliiimla

b) Setelah keluar gambar seperti berikut ini, destinatikan
data tentang Prestasi Kerja ke Test Variable List,
variable kategori, yaitu fak ke Grouping Variable, lalu
klik Define Range..

B Tests for Several Independent Samples [z|

TestYariable List:
® Frestasi Kerja [presker
\:I Paste
Reset
Grouping Y ariable: Cancel
\:I fak[1 4] Help

Test Type

WV Kuskalwalis H I Median Exact...
[~ Jonckheere-Terpstra Optionz. ..

c) Setelah keluar gambar seperti berikut ini, Isilah angka 1
pada kotak Minimun, dan angka 4 pada kotak
Maximum, lalu klik Continue, lalu klik Ok.

Several Independent Samples: Define ... r5__<|

Range for Grouping Yariable

Mimirnuimn: '1_ Cancel
[GERT |4|_ Help




267

Statistika untuk Penelitian Pendidikan

d) Berikut ini adalah outputnya.

Ranks

FAK N Mean Rank

Prestasi Kerja  Tarbiyah 15 36,53
Syari‘ah 15 23,07
Ushuluddin 10 17,60
Dakwah 10 20,50
Total 50

Output ini memperlihatkan bahwa sampel penelitian dari
alumni Tarbiyah sebanyak 15 orang dengan rata-rata
ranking 36,53, alumni Syari‘ah sebanyak 15 dengan rata-
rata ranking 23,07, alumni Ushuluddin sebanyak 10 dengan
rata-rata ranking 17,60, alumni Dakwah sebanyak 10
dengan rata-rata ranking 20,50. Seluruh sampel berjumlah
50.

Test Statistic$P

Prestasi Kerja
Chi-Square 13,197
df 3
Asymp. Sig. ,004

a. Kruskal Wallis Test
b. Grouping Variable: FAK

Output di atas memperlihatkan bahwa skor thitung
adalah 13,197. Skor tersebut dibandingkan dengan tabel y
dengan dk. 3, yaitu: 7,814725.

=CHIINV{,05:3)
7514725

maka Ha diterima dan Ho ditolak karena xzhitung lebih tinggi
dibanding dengan y?upe. Hal ini sesuai dengan skor Asymp.
Signifikansi sebesar 0,004 yang lebih rendah dibanding
a=5%. Penelitian ini berkesimpulan bahwa  terdapat

perbedaan prestasi kerja antara alumni Tarbiyah, Syari’ah,
Ushuluddin, dan Dakwah.

. Aplikasi dengan Microsoft Excel

Rumus Kruskan Wallis H adalah sebagai berikut.

H=—""— % 1 _3N+1)
N(N-1) £ n;
Untuk dapat mengaplikasikan rumus tersebut, maka seluruh
skor data dijadikan satu, lalu diranking. Setelah itu baru

dipisahkan berdasarkan masing-masing sampel. Ranking



Analisis Komparasi

268

dari masing-masing sampel tersebut dijumlahkan. Setelah
itu baru dimasukkan rumus di atas.

A B © D E F G H
1 |Tarbiyvah| Ranking |Syari'ah|Ranking|Ushulud. [Ranking | Dakwah | Ranking
2 95 50 7 1758 78 2848 7a 10
3 92 49 a7 445 77 175 70 2
4 85 47 74 285 72 45 73 BA
5 75 235 81 3458 70 2 77 175
5 85 42 g2 5] 73 65 79 285
7 81 345 a8 47 75 10 75 235
g 78 285 78 235 7 175 76 13
9 77 175 76 13 78 235 g0 35
10 85 47 75 10 a1 345 81 45
11 78 235 77 175 a0 1 g2 5]
12 86 43 87 445
13 84 405 7B 13
14 g2 35 72 45
15 75 235 70 2
16 84 405 74 a
17 548 346 176 205
18 36,53 23,07 17,60 20,50
19
20 0.005|=12/(E50"1)
21 35301 A33|=(B17 21 5)HIDT 70 5)+HIF 17201 0)+H(H172/10)
22 153.000(=3"51
23 13,124|=B20"B21-B22
BT

Hasil hitung dengan Microsoft Excel ini berbeda sedikit
dengan hasil hitung SPSS. xzhimng dengan SPSS adalah
13,197, sedangkan thimng dengan Microsoft Excel adalah
13,124. Hanya saja, karena sedikitnya perbedaan tersebut
tidak berakibat pada perbedaan kesimpulan yaitu menerima
Ha dan menolak Ho.
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TABEL |
LUAS DI BAWAH LENGKUNGAN KURVA NORMAL
DARI0s.d. Z

0,0 | 0000 | 0040 | 0080 | 0120 | 0160 | 0199 | 0239 | 0279 | 0319 | 0359

0,1 | 0398 | 0438 | 0478 | 0517 | 0557 | 0596 | 0636 | 0675 | 0714 | 0753

0,2 | 0793 | 0832 | 0871 | 0910 | 0948 | 0987 | 1026 | 1064 | 1103 | 1141

03 | 1179 | 1217 | 1255 | 1293 | 1331 | 1368 | 1406 | 1443 | 1480 | 1517

0,4 | 1554 | 1591 | 1628 | 1664 | 1700 | 1736 | 1772 | 1808 | 1844 | 1879

0,5 | 1915 | 1950 | 1985 | 2019 | 2054 | 2088 | 2123 | 2157 | 2190 | 2224

0,6 | 2258 | 2291 | 2324 | 2357 | 2389 | 2422 | 2454 | 2486 | 2517 | 2549

0,7 | 2580 | 2612 | 2642 | 2673 | 2703 | 2734 | 2764 | 2794 | 2823 | 2852

0,8 | 2881 | 2910 | 2939 | 2967 | 2995 | 3023 | 3051 | 3078 | 3106 | 3133

0,9 | 3159 | 3186 | 3212 | 3238 | 3264 | 3289 | 3315 | 3340 | 3365 | 3389

1,0 | 3413 | 3438 | 3461 | 3485 | 3508 | 3531 | 3554 | 3577 | 3599 | 3621

1,1 | 3643 | 3665 | 3686 | 3708 | 3729 | 3749 | 3770 | 3790 | 3810 | 3830

1,2 | 3849 | 3869 | 3888 | 3907 | 3925 | 3944 | 3962 | 3980 | 3997 | 4015

1,3 | 4032 | 4049 | 4066 | 4082 | 4099 | 4115 | 4131 | 4147 | 4162 | 4177

1,4 | 4192 | 4207 | 4222 | 4236 | 4251 | 4265 | 4279 | 4292 | 4306 | 4319

1,5 | 4332 | 4345 | 4357 | 4370 | 4382 | 4394 | 4406 | 4419 | 4429 | 4441

1,6 | 4452 | 4463 | 4474 | 4484 | 4495 | 4505 | 4515 | 4525 | 4535 | 4545

1,7 | 4554 | 4564 | 4573 | 4582 | 4591 | 4599 | 4608 | 4616 | 4625 | 4633

1,8 | 4641 | 4649 | 4656 | 4664 | 4671 | 4678 | 4686 | 4693 | 4699 | 4706

19 | 4713 | 4719 | 4726 | 4732 | 4738 | 4744 | 4750 | 4756 | 4761 | 4767

2,0 | 4772 | 4778 | 4783 | 4788 | 4793 | 4798 | 4808 | 4808 | 4812 | 4817

2,1 | 4821 | 4826 | 4830 | 4834 | 4838 | 4842 | 4846 | 4850 | 4854 | 4857

2,2 | 4861 | 4864 | 4868 | 4871 | 4875 | 4878 | 4881 | 4884 | 4887 | 4890
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23 | 4898 | 4896 | 4898 | 4901 | 4004 | 4906 | 4909 | 4911 | 4913 | 4916
24 | 4918 | 4920 | 4922 | 4025 | 4927 | 4929 | 4931 | 4932 | 4934 | 4936
2,5 4938 | 4940 | 4941 | 4043 | 4945 | 4946 | 4948 | 4949 | 4951 | 4952
2,6 4953 | 4955 | 4956 | 4957 | 4959 | 4960 | 4961 | 4962 | 4963 | 4964
2,7 4965 | 4966 | 4967 | 4968 | 4969 | 4970 | 4971 | 4972 | 4973 | 4974
2,8 4074 | 4975 | 4976 | 4977 | 4977 | 4987 | 4979 | 4979 | 4980 | 4981
2,9 4981 | 4982 | 4982 | 4083 | 4984 | 4984 | 4985 | 4985 | 4986 | 4986
30 | 4987 | 4987 | 4987 | 4988 | 4988 | 4989 | 4989 | 4989 | 4990 | 4990
31 | 4990 | 4991 | 4991 | 4991 | 4992 | 4992 | 4992 | 4992 | 4993 | 4993
32 | 4993 | 4993 | 4994 | 4994 | 4994 | 4994 | 4994 | 4994 | 4995 | 4995
33 | 4995 | 4995 | 4995 | 4986 | 4996 | 4996 | 4996 | 4996 | 4997 | 4997
34 | 4997 | 4997 | 4997 | 4997 | 4997 | 4997 | 4997 | 4997 | 4997 | 4998
35 | 4998 | 4998 | 4998 | 4998 | 4998 | 4998 | 4998 | 4998 | 4998 | 4998
3,6 4998 | 4998 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999
3,7 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999
3,8 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999 | 4999
3,9 5000 | 5000 | 5000 | 5000 | 5000 | 5000 | 5000 | 5000 | 5000 | 5000
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TABEL 11
NILAI-NILAI DALAM DISTRIBUSI t
a untuk uji dua fihak (two tail test)
| o0s0 | o020 010 | o005 | o002 | oo
o untuk uji satu fihak (one tail test)
dk 0,25 0,10 0,005 0,025 0,01 0,005
1 1,000 3,078 6,314 12,706 31,821 63,657
2 0,816 1,886 2,920 4,303 6,965 9,925
3 0,765 1,638 2,353 3,182 4,541 5,841
4 0,741 1,533 2,132 2,776 3,747 4,604
5 0,727 1,486 2,015 2,571 3,365 4,032
6 0,718 1,440 1,943 2,447 3,143 3,707
7 0,711 1,415 1,895 2,365 2,998 3,499
8 0,706 1,397 1,860 2,306 2,896 3,355
9 0,703 1,383 1,833 2,262 2,821 3,250
10 0,700 1,372 1,812 2,228 2,764 3,165
11 0,697 1,363 1,796 2,201 2,718 3,106
12 0,695 1,356 1,782 2,178 2,681 3,055
13 0,692 1,350 1,771 2,160 2,650 3,012
14 0,691 1,345 1,761 2,145 2,624 2,977
15 0,690 1,341 1,753 2,132 2,623 2,947
16 0,689 1,337 1,746 2,120 2,583 2,921
17 0,688 1,333 1,740 2,110 2,567 2,898
18 0,688 1,330 1,743 2,101 2,552 2,878
19 0,687 1,328 1,729 2,093 2,539 2,861
20 0,687 1,325 1,725 2,086 2,528 2,845
21 0,686 1,323 1,721 2,080 2,518 2,831
22 0,686 1,321 1,717 2,074 2,508 2,819
23 0,685 1,319 1,714 2,069 2,500 2,807
24 0,685 1,318 1,711 2,064 2,492 2,797
25 0,684 1,316 1,708 2,060 2,485 2,787
26 0,684 1,315 1,706 2,056 2,479 2,779
27 0,684 1,314 1,703 2,052 2,473 2,771




Lampiran 278
28 | 0,683 1,313 1,701 2048 | 2467 | 2763
29 0,683 1,311 1,699 2045 | 2462 | 2756
30 | 0683 1,310 1,697 2042 | 2457 | 2750
40 0,681 1,303 1,684 2,021 2,423 2,704
60 0,679 1,296 1,671 2,000 2,390 2,660
120 0,677 1,289 1,658 1,980 2,358 2,617
0 0,674 1,282 1,645 1,960 2,326 2,576

Formula untuk mencari skor t.,e adalah:

2,05953711

=TINV/(0,05;25)
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TABEL 111
NILAI-NILAI r PRODUCT MOMENT
N Taraf Signif N Taraf Signif N Taraf Signif
5% 1% 5% 1% 5% 1%

3 0,997 0,999 27 0,381 0,487 55 0,266 0,345
4 0,950 0,990 28 0,374 0,478 60 0,254 0,330
5 0,878 0,959 29 0,367 0,470 65 0,244 0,317
6 0,811 0,917 30 0,361 0,463 70 0,235 0,306
7 0,754 0,874 31 0,355 0,456 | 75 | 0,227 0,296
8 0,707 0,834 32 0,349 0,449 | 80 | 0,220 0,286
9 0,666 0,798 33 0,344 0,442 | 85 | 0,213 0,278
10 0,632 0,765 34 0,339 0,436 | 90 | 0,207 0,270
1 0,602 0,735 35 0,334 0,430 | 95 | 0,202 0,263
12 0,576 0,708 36 0,329 0,424 | 100 | 0,195 0,256
13 0,553 0,684 37 0,325 0,418 | 125 | 0,176 0,230
14 0,532 0,661 38 0,320 0,413 | 150 | 0,159 0,210
15 0,514 0,641 39 0,316 0,408 | 175 | 0,148 0,194
16 0,497 0,623 40 0,312 0,403 | 200 | 0,138 0,181
17 0,482 0,606 41 0,308 0,398 | 300 | 0,113 0,148
18 0,468 0,590 42 0,304 0,393 | 400 | 0,098 0,128
19 0,456 0,575 43 0,301 0,389 | 500 | 0,088 0,115
20 0444 0,561 44 0,297 0,384 | 600 | 0,080 0,105
21 0,433 0,549 45 0,294 0,380 | 700 | 0,074 0,097
22 0,423 0,537 46 0,291 0,376 | 800 | 0,070 0,091
23 0,413 0,526 47 0,288 0,372 | 900 | 0,065 0,086
24 0,404 0,515 48 0,284 0,368 | 1000 | 0,062 0,081
25 0,396 0,505 49 0,281 0,364

0,388 0,496 50 0,279 0,361
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TABEL IV
HARGA-HARGA x DALAM TEST BINOMIAL
(Harga-harga dalam tabel adalah 0,...)

Zz
N|lO|]1 |2 |3 ]|4|5]|6 7 8 9 10 11 12 | 13|14 | 15
5 |031| 1 |500|812]|969
6 |016|188 | 344 | 656 | 981|984
7 | 008|109 | 227 | 500 | 773|938 | 992
8 | 004|062 | 145 | 363 | 637 | 855 | 965 | 996
9 | 002 | 035|090 | 354 | 500|746 | 910 | 980 | 998
10 | 001|020 | 055 | 172 | 377|623 | 828 | 945 | 989 | 999
1 011|033 | 113 | 274|500 | 726 | 887 | 967 | 994
12 006 | 019 | 073 | 194 | 387 | 613 | 806 | 927 | 981 | 997
13 003|011 | 046 {133 (291|500 | 709 | 867 | 954 | 989 | 998
14 002 | 006 | 029 | 090|212 |395| 605 | 788 | 910 | 971 | 994 | 999
15 001 | 004 | 018 | 059 | 151 | 304 | 500 | 696 | 849 | 941 | 982 | 996
16 002 | 011 | 038 | 105|227 | 402 | 598 | 773 | 895 | 962 | 989 | 998
17 001 | 006 | 025|072 | 166 | 315 | 500 | 685 | 834 | 928 | 975 | 994 | 999
18 001 | 004 | 015|048 | 119 | 240 | 407 | 593 | 760 | 881 | 952 | 985|996 | 999
19 002 |010| 032|084 | 180 | 324 | 500 | 676 | 820 | 916 | 968 | 990 | 998
20 001 | 00 (021|058 | 132 | 252 | 412 | 588 | 748 | 868 | 942|879 | 994
21 001 {004|013 (039 | 095 | 192 | 332 | 500 | 668 | 808 | 905 | 961 | 987
22 002 | 008 | 026 | 067 | 143 | 262 | 416 | 584 | 738 | 857 | 933|974
23 001|005 |017 | 047 | 105 | 202 | 339 | 500 | 661 | 798 | 895 | 953
24 001|003 |011| 032 | 076 | 154 | 271 | 419 | 581 | 729 | 846 | 924

25

002 {007 | 022 | 054 | 115 | 212 | 345 | 500 | 655|788 | 885
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TABEL V
HARGA FACTORIAL

N N!

0 1
1 1
2 2
3 6
4 24
5 120
6 720
7 5040
8 40320
9 362880
10 3628800
11 39916800
12 479001600
13 6227020800
14 87178291200
15 1307674368000
16 20922789888000
17 355687428096000
18 6402373705728000
19 121645100408832000
20 2432902008176640000

Formula untuk mencari skor faktorial adalah:
39916800 =FACT(11)
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TABEL VI
NILAI-NILAI CHI KUADRAT
dk Taraf signifikansi
50% 30% 20% 10% 5%, 1%

1 0,455 1,074 1,642 2,706 3,481 6,635
2 0,139 2,408 3,219 3,605 5,591 9,210
3 2,366 3,665 4,642 6,251 7,815 11,341
4 3,357 4,878 5,989 7,779 9,488 13,277
5 4,351 6,064 7,289 9,236 11,070 15,086
6 5,348 7,231 8,558 10,645 12,592 16,812
7 6,346 8,383 9,803 12,017 14,017 18,475
8 7,344 9,524 11,030 13,362 15,507 20,090
9 8,343 10,656 12,242 14,684 16,919 21,666
10 9,342 11,781 13,442 15,987 18,307 23,209
11 10,341 12,899 14,631 17,275 19,675 24,725
12 11,340 14,011 15,812 18,549 21,026 26,217
13 12,340 15,19 16,985 19,812 22,368 27,688
14 13,332 16,222 18,151 21,064 23,685 29,141
15 14,339 17,322 19,311 22,307 24,996 30,578
16 15,338 18,418 20,465 23,542 26,296 32,000
17 16,337 19,511 21,615 24,785 27,587 33,409
18 17,338 20,601 22,760 26,028 28,869 34,805
19 18,338 21,689 23,900 27,271 30,144 36,191
20 19,337 22,775 25,038 28,514 31,410 37,566
21 20,337 23,858 26,171 29,615 32,671 38,932
22 21,337 24,939 27,301 30,813 33,924 40,289
23 22,337 26,018 28,429 32,007 35,172 41,638
24 23,337 27,096 29,553 33,194 35,415 42,980
25 24,337 28,172 30,675 34,382 37,652 44,314
26 25,336 29,246 31,795 35,563 38,885 45,642
27 26,336 30,319 32,912 36,741 40,113 46,963
28 27,336 31,391 34,027 37,916 41,337 48,278
29 28,336 32,461 35,139 39,087 42,557 49,588
30 29,336 33,530 36,250 40,256 43,775 50,892
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TABEL Vll a
HARGA-HARGA KRITIS r DALAM TEST RUN

5%

SATU SAMPEL, UNTUK «a
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TABEL VIl b
HARGA-HARGA KRITIS r DALAM TEST RUN
DUA SAMPEL, UNTUK a=5 %
N2

N1

2 415 |6 |7|8]9|10|11|12]13|14|15|16 |17 18| 19| 20
2
3
4 9|9
5 9|10 |10 11|11
6 9|10 |11 |12 |12 |13 |13 | 13| 13
7 11|12 | 13|13 |14 |14 |14 | 14| 15| 15| 15
8 11|12 13|14 |14 |15 |15 |16 | 16| 16 |16 | 17 | 17 | 17 | 17 | 17
9 13|14 |14 |15| 16|16 |16 | 17 | 17 | 18 | 18 | 18 | 18 | 18 | 18
10 13|14 | 15|16 | 16|17 |17 |18 |18 | 18 |19 |19 | 19 | 20 | 20
11 13|14 (15|16 |17 |17 {18 | 19|19 |19 |20 | 20| 20 | 21 | 21
12 1314 |16 |16 |17 |18 |19 | 19|20 | 20 | 21 | 21 |21 | 22 | 22
13 15|16 |16 | 18|19 | 19|20 | 20 | 21 |21 | 22 | 22 | 23 | 23
14 1516 |18 | 18 |19 | 20 | 20 | 21 | 22 | 22 | 23 | 23 | 23 | 24
15 15116 (18 | 18 |19 | 20 | 21 | 22 | 22 | 23 |23 |24 | 24 | 5
16 17 |18 19| 20|21 |21 |2 | 23| 23| 2 |25 |25 |25
17 17 |18 |29 | 20 | 21 | 22 | 23 | 23 | 24 | 25 | 24 | 26 | 26
18 17 |18 |19 | 20 | 21 | 22 | 23 | 24 | 25| 25 | 26 | 26 | 26
19 17 | 18 | 20 | 21 | 22 | 23 | 23 | 24 | 25| 26 | 26 | 27 | 27
20 17 |18 |20 | 21 | 22 | 23 | 24 | 25| 25| 26 | 27 | 27 | 28
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TABEL VIII
HARGA-HARGA KRITIS UNTUK TEST WILCOXON

Tingkat Signifikansi Untuk Test Satu Fihak (One Tail Test)

N 0,025 0,010 0,005
Tingkat Signifikansi Untuk Test Dua Fihak (Two Tail Test)
0,05 0,02 0,01

6 0

7 2 0

8 4 2 0

9 6 3 2

10 8 5 3

11 11 7 5

12 14 10 7

13 17 13 10

14 21 16 13

15 25 20 16

16 30 24 20

17 35 28 23

18 40 33 28

19 46 38 32

20 52 43 38

21 59 49 43

22 66 56 49

23 73 62 55

24 81 69 61

25 89 77 68
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TABEL IX

HARGA-HARGA KRITIS MAN-WHITNEY U TEST

9 10 11 12 13 14 15 16 17 18 19 20
1
2 olo|o|o]o|o |11
3|1 11| 2]2]2]|3]3 4 | 4|5
4 3 3 4 5 5 6 7 7 10
5 5 6 7 8 9 10 11 12 13 14 15 16
6 7 8 9 11 12 13 15 16 18 19 20 22
7 9 11 12 14 16 17 19 21 23 24 26 28
8 11 13 15 17 20 22 24 26 28 30 32 34
9 | 14 | 16 | 18 | 21 | 23 | 26 | 28 | 31 | 33 | 36 | 38 | 40
10 16 19 22 24 27 30 33 36 38 41 44 a7
11 18 22 25 28 31 34 37 41 44 47 50 53
12 | 21 | 24 | 28 | 31 | 35 | 38 | 42 | 46 | 49 | 53 | 56 | 60
13 | 23 | 27 | 31 | 35 | 39 | 43 | 47 | 51 | 55 | 59 | 63 | 67
14 26 30 34 38 43 47 51 56 60 65 69 73
15 28 33 37 42 47 51 56 61 66 70 75 80
16 31 36 41 46 51 56 61 66 71 76 82 87
17 33 38 44 49 55 60 66 71 77 82 88 93
18 | 36 | 41 | 47 | 53 | 59 | 65 | 70 | 76 | 82 | 88 | 94 | 100
19 | 38 | 44 | 50 | 56 | 63 | 69 | 75 | 82 | 88 | 94 | 101 | 107
20 | 40 | 47 | 53 | 60 | 67 | 73 | 80 | 87 | 93 | 100 | 107 | 114
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TABEL X

TABEL HARGA-HARGA KRITIS DALAM TEST
KOLMOGOROV-SMIRNOV

One Tailed Test Two Tailed Test
N a=0,05 a=0,01 a=0,05 a=0,01
3 3
4 4 4
5 4 5 5 5
6 5 6 5 6
7 5 6 6 6
8 5 6 6 7
9 6 7 6 7
10 6 7 7 8
11 6 8 7 8
12 6 8 7 8
13 7 8 7 9
14 7 8 8 9
15 7 9 8 9
16 7 9 8 10
17 8 9 8 10
18 8 10 9 10
19 8 10 9 10
20 8 10 9 11
21 8 10 9 11
22 9 11 9 11
23 9 11 10 11
24 9 11 10 12
25 9 11 10 12
26 9 11 10 12
27 9 12 10 12
28 10 12 11 13
29 10 12 11 13
30 10 12 11 13
35 11 13 12
40 11 14 13
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z 0,00 0,01 0,02 0,03 0,04 0,05 006 | 007 0,08 0,09
00 | 05000 | 04960 | 04920 | 04880 | 04840 | 04801 |04761| 04721 | 04681 | 04641
01 | 04602 | 04562 | 04522 | 04483 | 04443 | 04404 | 04364 | 04325 | 04286 | 04247
02 | 04207 | 04168 | 04129 | 04090 | 04052 | 04013 | 03974 | 0,3936 | 0,3897 | 0,3859
03 | 03821 | 03783 | 03745 | 03707 | 0,3669 | 03632 | 03594 | 0,3557 | 0,3520 | 0,3483
04 | 03446 | 03409 | 03372 | 03336 | 0,3300 | 03264 |03228| 0,3192 | 0,3156 | 0,3121
05 | 03086 | 03050 | 03015 | 0,2981 | 0,2946 | 02912 |0,2877 | 0,2843 | 0,2810 | 0,2776
06 | 02743 | 02709 | 02676 | 02643 | 02611 | 02578 | 02546 | 0,2514 | 0,2483 | 0,2451
0,7 | 02420 | 0,2389 | 02358 | 02327 | 0,2297 | 02266 |0,2236 | 0,2206 | 0,2177 | 0,2148
08 | 02119 | 0,2090 | 02061 | 0,2033 | 0,2005 | 01977 | 01949 | 0,1922 | 0,1894 | 0,1867
09 | 01841 | 01814 | 01788 | 01762 | 01736 | 01711 |0,1685| 0,1660 | 0,1635 | 0,1611
10 | 01587 | 0,1562 | 0,1535| 0,1515 | 01492 | 0,1469 | 01446 | 0,1423 | 0,1401 | 0,1379
11 | 01357 | 0,1335 | 0,1314| 0,292 | 01271 | 01251 |0,1230 | 0,1210 | 0,1190 | 0,1170
12 | 01151 | 0,131 | 0,1112| 0,2093 | 0,1075 | 0,1056 |0,1038 | 0,1020 | 0,1003 | 0,0985
13 | 00968 | 0,0951 | 0,0934| 00918 | 00901 | 0,0885 |0,0809 | 0,0853 | 0,0838 | 0,0823
14 | 00808 | 00793 | 00778 | 00764 | 00749 | 00735 |0,0721| 0,0708 | 0,0694 | 0,0681
15 | 00668 | 0,0655 | 00643 | 0,0630 | 0,618 | 00606 |0,0594 | 0,0581 | 0,0571 | 0,0559
16 | 00548 | 0,0537 | 00526 | 0,0516 | 0,0505 | 00495 |0,0485 | 0,0475 | 0,0465 | 0,0455
1,7 | 0,0445 | 0,0436 | 0,0427 | 00418 | 00409 | 0,0401 |0,0392 | 0,0384 | 0,0375 | 0,0367
18 | 00359 | 0,0351 | 0,0344| 00336 | 00329 | 00322 | 00314 | 00307 | 0,0301 | 0,0294
19 | 00287 | 00281 |0,0274| 00268 | 00262 | 00256 | 00250 | 0,0244 | 0,0239 | 0,0233
20 | 00228 | 00222 | 00217 | 00212 | 00207 | 00202 |0,0197| 0,0192 | 00188 | 0,0183
21 | 00179 | 00174 | 00170 | 0,0166 | 00162 | 00158 | 00154 | 0,0150 | 0,0146 | 0,0143
2,2 | 00139 | 00136 | 00132 | 00129 | 00125 | 00122 |0,0119| 00116 | 0,0113 | 0,0110
2,3 | 0,0107 | 0,0104 | 0,0102 | 0,0099 | 00096 | 00094 |0,0091 | 0,0039 | 0,0087 | 0,0084
24 | 0,0082 | 0,0080 |0,0078 | 00075 | 00073 | 00071 | 00069 | 0,0068 | 0,0066 | 0,0064
25 | 0,0062 | 0,0060 | 0,0059 | 0,0057 | 0,0055 | 00054 |0,0052 | 0,0051 | 0,0049 | 0,0048
25 | 0,0047 | 0,0045 | 0,0044 | 0,0043 | 00041 | 00040 |0,0039 | 0,0038 | 0,0037 | 0,0036
2,7 | 0,0035 | 0,0034 | 0,0033| 0,0032 | 00031 | 00030 |0,0029 | 00028 | 0,0027 | 0,0026
28 | 00026 | 0,0025 | 00024 | 00023 | 0,023 | 00022 |0,0021| 0,0021 | 0,0020 | 0,0019
29 | 00019 | 0,0018 | 00013 | 00017 | 00016 | 00016 |0,0015| 0,0015 | 00014 | 0,0014
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30 | 0,013 | 0,0013 | 0,0013| 00012 | 00012 | 00011 |0,0011| 00011 | 0,0010 | 0,0010
31 | 0,0010 | 0,0009 | 0,0009 | 0,0009 | 0,0008 | 0,0008 |0,0008 | 0,0008 | 0,0007 | 0,0007
32 | 0,0007 | 0,0007 | 0,0006 | 0,008 | 00006 | 0,0006 |0,0006 | 0,0006 | 0,0005 | 0,0005
33 | 0,0005 | 0,0005 | 0,0005| 0,0004 | 00004 | 0,004 |0,0004| 00004 | 0,0003 | 0,0003
34 | 0,0003 | 0,0003 | 0,0003| 0,0003 | 00003 | 00003 |0,0003| 0,0003 | 0,0003 | 0,0002

35 | 00002 | 0,0002 | 0,0002 | 00002 | 00002 | 0,0002 |0,0002 | 0,0002 | 0,0002 | 0,0002

36 | 00002 | 0,0002 | 0,0001 | 0,001 | 00001 | 0,0001 |8,0001 0,0001 | 0,0001 | 0,0001

3,7 | 0,0001 | 0,0001 | 00001 | 00001 | 00001 | 0,0001 |0,0001| 0,0001 | 0,0001 | 0,0001

38 | 0,0001 | 0,0001 | 00001 | 00001 | 00001 | 0,0001 |0,0001| 0,0001 | 0,0001 | 0,0001

39 | 0,0000 | 0,000 |0,0000| 0,000 | 00000 | 0,0000 |0,0000| 0,0000 | 0,0000 | 0,0000
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TABEL XIl1
TABEL NILAI-NILAI RHO

Taraf Signif Taraf Signif
N 5% 1% N 5% 1%
5 1,000 16 0,506 0,665
6 0,886 1,000 18 0,475 0,626
7 0,786 0,929 20 0,450 0,591
8 0,738 0,881 22 0,428 0,562
9 0,683 0,833 24 0,409 0,537
10 0,648 0,794 26 0,392 0,515
12 0,591 0,777 28 0,377 0,496
14 0,544 0,715 30 0,364 0,478
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TABEL XIV
TABEL HARGA-HARGA KRITIS Z DALAM OBSERVASI
DISTRIBUSI NORMAL

Zz 0,00 0,01 0,02 0,03 0,04 0,05 0,06 0,07 0,08 0,09

0,0 ,5000 | ,4960 | ,4920 | ,4880 | ,4840 | ,4801 | ,4761 | ,4721 | ,4681 | ,4641

0,1 4602 | ,4562 | ,4522 | 4483 | 4443 | 4404 | 4364 | 4325 | ,4286 | ,4247

0,2 4207 | ,4168 | ,4129 | ,4090 | ,4052 | ,4013 | ,3974 | ,3936 | ,3897 | ,3859

0,3 ,3821 | ,3783 | ,3745 | ,3707 | ,3669 | ,3632 | ,3594 | ,3557 | ,3520 | ,3483
0,4 ,3446 | ,3409 | ,3372 | ,3336 | ,3300 | ,3264 | ,3228 | ,3192 | ,3156 | ,3121
0,5 ,3085 | ,3050 | ,3015 | ,2981 | ,2946 | ,2912 | ,2877 | ,2843 | ,2810 | ,2776
0,6 2743 | 2709 | ,2676 | ,2643 | 2611 | ,2578 | ,2546 | ,2514 | ,2483 | ,2451

0,7 ,2420 | ,2389 | ,2358 | ,2327 | ,2296 | ,2266 | ,2236 | ,2206 | ,2177 | ,2148

0,8 ,2119 | ,2090 | ,2061 | ,2033 | ,2005 | ,1977 | ,1949 | ,1922 | ,1894 | ,1867

0,9 ,1841 | ,1814 | ,1788 | ,1762 | ,1736 | ,1711 | ,1685 | ,1660 | ,1635 | ,1611

1,0 ,1587 | ,1562 | ,1539 | ,1515 | ,1492 | ,1469 | ,1446 | ,1423 | ,1401 | ,1379

11 ,1357 | ,1335 | ,1314 | ,1292 | ,1271 | ,1251 | ,1230 | ,1210 | ,1190 | ,1170

1,2 ,1151 | ,1131 | ,1112 | ,1093 | ,1075 | ,1056 | ,1038 | ,1020 | ,1003 | ,0985

13 ,0968 | ,0951 | ,0934 | ,0918 | ,0901 | ,0885 | ,0869 | ,0853 | ,0838 | ,0823
14 ,0808 | ,0793 | ,0778 | ,0764 | ,0749 | ,1735 | ,0721 | ,0708 | ,0694 | ,0681
15 ,0668 | ,0655 | ,0643 | ,0630 | ,0618 | ,0606 | ,0594 | ,0582 | ,0571 | ,0559
1,6 ,0548 | ,0537 | ,0526 | ,0516 | ,0505 | ,0495 | ,0485 | ,0475 | ,0465 | ,0455

17 ,0446 | ,0436 | ,0427 | ,0418 | ,0409 | ,0410 | ,0392 | ,0384 | ,0375 | ,0367

18 ,0359 | ,0351 | ,0344 | ,0336 | ,0329 | ,0322 | ,0314 | ,0307 | ,0301 | ,0294

19 ,0287 | ,0281 | ,0274 | ,0268 | ,0262 | ,0256 | ,0250 | ,0244 | ,0239 | ,0233

2,0 ,0228 | ,0222 | ,0217 | ,0212 | ,0207 | ,0202 | ,0197 | ,0192 | ,0188 | ,0183

2,1 ,0179 | ,0174 | ,0170 | ,0166 | ,0162 | ,0158 | ,0154 | ,0150 | ,0146 | ,0143

2,2 ,0139 | ,0136 | ,0132 | ,0129 | ,0125 | ,0122 | ,0119 | ,0116 | ,0113 | ,0110
23 ,0107 | ,0104 | ,0102 | ,0099 | ,0096 | ,0094 | ,0091 | ,0089 | ,0087 | ,0084
2,4 ,0082 | ,0080 | ,0078 | ,0075 | ,0073 | ,0071 | ,0069 | ,0068 | ,0066 | ,0064
25 ,0062 | ,0060 | ,0059 | ,0057 | ,0055 | ,0054 | ,0052 | ,0051 | ,0049 | ,0048
2,6 ,0047 | ,0045 | ,0044 | ,0043 | ,0041 | ,0040 | ,0039 | ,0038 | ,0037 | ,0036
2,7 ,0035 | ,0034 | ,0033 | ,0032 | ,0031 | ,0030 | ,0029 | ,0028 | ,0027 | ,0026

2,8 ,0026 | ,0025 | ,0024 | ,0023 | ,0023 | ,0022 | ,0021 | ,0021 | ,0020 | ,0019

2,9 ,0019 | ,0013 | ,0018 | ,0017 | ,0016 | ,0016 | ,0015 | ,0015 | ,0014 | ,0014
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3,0 ,0013 | ,0013 | ,0013 | ,0012 | ,0012 | ,0011 | ,0011 | ,0011 | ,0010 | ,0010
31 ,0010 | ,0009 | ,0009 | ,0009 | ,0008 | ,0008 | ,0008 | ,0008 | ,0007 | ,0007
3,2 ,0007
33 ,0005
34 ,0003
3,5 |,00023
3,6 |,00016
3,7 |,00011
3,8 |,00007
3,9 |,00005
4,0 |,00003
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CARA MENGHITUNG NILAI TABEL: t, F, x>, DAN z
DENGAN APLIKASI MICROSOFT EXCEL

Untuk mencari nilai tabel t adalah: TINV(Probality,Deg_freedom)
Contoh:

Diketahui pada sebuah penelitian bahwa degree of freedomnya
=276, pada a = 5%, maka Tabel t-nya adalah: 1,968596735

=TINV/(0,05;276)

Untuk mencari nilai tabel F adalah:
FINV(Probality,Deg_freedom1,Deg_freedom?2)
Contoh:

Diketahui pada sebuah penelitian bahwa degree of freedom1 =103,
degree of freedom2 = 74 pada o = 5%, maka Tabel F-nya adalah:
1,328514188

=FINV/(0,05;103;174)

Untuk mencari nilai tabel x° adalah:
CHIINV (Probality,Deg_freedom)
Contoh:

Diketahui pada sebuah penelitian bahwa degree of freedomnya =3,
pada a = 5%, maka Tabel xznya adalah: 7,814724703

=CHIINV/(0,05;3)

Untuk mencari nilai tabel z adalah: NORMADIST(z)
Contoh:

Diketahui pada sebuah penelitian bahwa skor z= 0,47, maka Tabel
z-nya adalah: 0,680822481

=NORMSDIST(0,47)
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DAN APLIKASINYA DENGAN SPSS DAN EXCEL

menyajikan aplikasi dalam menguji instrumen

: penelitian, menentukan besarnya sampel,
mendeskripsikan data dan menganalisisnya, serta menguiji hipotesis dengan menggunakan SPSS
dan Excel. Sebagai buku statistik terapan buku ini tidak menjelaskan bagaimana rumus-rumus
statistik itu disusundan drhasalkan =

Selama ini, Jika ol ndengar kata statistik, maka asosiasi mereka adalah tentang
sesuatu yang ruwet, memusmgkan penuh dengan rumus-rumus yang rumit, membosankan, dan
sebagainya. Mahasiswa yang menulis skripsi dengan pendekatan kuantitatif ternyata sering
menemukan kesulitan untuk menentukan anallsns statistik yang tepat dan mengaplikasikan
analisis yang telah dipilih.

Dengan semakin meluasnya ketersediaan perangkat keras dan lunak komputer, ia telah
memberikan banyak kemudahan kepada peneliti dalam menganalisis hasil penelitian dengan
statistik. Bila dahulu ada anggapan bahwa penelitian yang meneliti tiga variabel atau lebih hanya
dapat dilakukan oleh peneliti setingkat mahasiswa S2 atau bahkan S3, dikarenakan sulitnya
analisis multivariat, sekarang, hal tersebut dapat dilakukan oleh mahasiswa S1 atau oleh peneliti
pemula. Buku ini berusaha menunjukkan kemudahan statistik dengan memberikan contoh dan
aphkasmya dengan SPSS dan Microsoft Excel.
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nyayang sedang berkuasa berupa berbagai hambatan untuk dapat mengajukan kenaikan
isionalnya menjadi Guru Besar.

Bﬁkt} adalah buku keempat penulis yang ber-ISBN. Yang pertama, “Eksistensi Pendidikan
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